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METTLER TOLEDO Service

Congratulations on choosing the quality and precision of METTLER TOLEDO. Proper use of your new equipment
according to this Manual and regular calibration and mainfenance by our factory-trained service team ensures
dependable and accurafe operation, profecting your investment. Contact us about a service agreement tailored
to your needs and budget. Further information is available at p www.mt.com/service.

There are several important ways fo ensure you maximize the performance of your investment:

1 Register your product: \We invite you to register your product af www.mt.com/productregistration
S0 we can contact you about enhancements, updafes and important nofifications concerning your product.

2 Contact METTLER TOLEDO for service: The value of a measurement is proportional to its accuracy — an out
of specification scale can diminish quality, reduce profits and increase liability. Timely service from
METTLER TOLEDO will ensure accuracy and optimize uptime and equipment life.

= Installation, Configuration, Integration and Training: Our service representatives are factory-frained
weighing equipment experts. We make certain that your weighing equipment is ready for production in a
cost effective and timely fashion and that personnel are trained for success.

= Initial Calibration Documentation: The installation environment and application requirements are
unique for every industrial scale so performance must be tested and certified. Our calibration services
and certificates document accuracy fo ensure production quality and provide a quality system record of
performance.

= Periodic Calibration Maintenance: A Calibration Service Agreement provides on-going confidence in
your weighing process and documentation of compliance with requirements. \We offer a variety of
service plans that are scheduled to meetf your needs and designed to fit your budget.


http://www.mt.com/service
http://www.mt.com/productregistration

Safety Instructions

Compliance information

National approval documents, e.g. the FCC Supplier Declaration of Conformity, are available online and/or
included in the packaging.

www.mt.com/ComplianceSearch

Manuals download
Please scan the QR code below and download from p www.mt.com/IND700-downloads.
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/\ WARNING

Use the device only for weighing in accordance with its corresponding user
manual. Any other type of use and operation beyond the limits of technical
specifications is considered as not intended.

/\ WARNING

Only permit qualified personnel to service the equipment. Exercise care when
making checks, tests and adjustments that must be made with power on.
Failure to observe this precaution could result in bodily harm and/ or property
damage.

/\ WARNING

Keep the equipment away from processes that generate high charging potential
such as electrostatic coating, rapid transfer of non-conductive materials, rapid
air jets, and high pressure aerosols.

/\ WARNING

Avoid plastic covers over the equipment. The protection cover used must be
officially approved by METTLER TOLEDO.

/\ WARNING

Ensure proper equipotential grounding of the equipment, mounting accessories,
and the scale base.

/\ WARNING

If the keyboard, display lens or enclosure is damaged, the defective component
must be repaired immediately. Remove power immediately and do not reapply
power until the display lens, keyboard or enclosure has been repaired or
replaced by qualified service personnel. Failure to do so could result in bodily
harm and/or property damage.
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/\ WARNING

Only the components specified in the user manual can be used in this device.
All equipment must be installed in accordance with the installation instructions
detailed in the user manual. Incorrect or substitute components and/or
deviation from these instructions can impair the instrinsic safety of the
equipment and could result in bodily injury and/or property damage.

/\ WARNING

For continued protection against shock hazard, connect to properly grounded
power source only. Do not remove the grounding connection.

/\ WARNING

When this equipment is included as a component part of a system, the resulting
design must be reviewed by qualified personnel who are familiar with the
construction and operation of all components in the system and the potential
hazards involved. Failure to observe this precaution could result in bodily harm
and/ or property damage.

/\ WARNING

All equipment must be installed in accordance with the installation instructions
detailed in its corresponding user manual. Deviation from the instructions can
impair the intrinsic safety of the equipment and void the agency approval.

/\ WARNING

Before connecting/disconnecting any internal electronic components or inter-
connecting wiring between electronic equipment always remove power and wait
at least thirty (30) seconds before any connections or disconnections are made.
Failure to observe these precautions could result in damage to or destruction of
the equipment and/or bodily harm.

/\ WARNING

Replacing equipment components with non-original parts can lead to
performance losses and property damage. Use only original or compatible
spare parts and accessories from METTLER TOLEDO.

/\ WARNING

Be certain that the communication circuits are wired exactly as shown in the
installation section of its corresponding user manual. If the wires are not
connected correctly, the equipment or interface board may be damaged.

/\ WARNING

Observe precautions for handling electrostatic sensitive devices.



Avoid direct exposure to sunlight.

/N\

The mains connection of the power supply unit must be made by a professional
electrician authorized by the owner and in accordance with the respective
terminal diagram, the accompanying installation instructions as well as the
country-specific regulations.

Before service, disconnect power from this device.

> PP

The protective ground connection must be checked after service work is
performed. Perform the check between the protective ground contact on the
power plug and the housing. This test must be documented in the service
report.

>

Equipment (WEEE) this device may not be disposed of in domestic waste. This also applies
fo countries outside the EU, per their specific requirements.

Please dispose of this product in accordance with local regulations at the collecting point ]
specified for electrical and electronic equipment. If you have any questions, please contact

the responsible authority or the distributor from which you purchased this device. Should this

device be passed on to other parties, the content of this regulation must also be related.

In conformance with the European Directive 2012/19/EU on Waste Electrical and Electronic K

IND700
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1.1

Introduction

The IND700 is a PC-based weighing terminal with a color touchscreen. It represents the latest weighing
technology from METTLER TOLEDO and is the most versatile weighing terminal for multi-scale non-hazardous
area applications. The ferminal is available in fwo versions:

e Harsh Environment Enclosure with 7" / 178 mm color fouchscreen display and fascia function keys
» \Wedge Enclosure with 7" / 178 mm color fouchscreen display and fascia function keys

These ferminals are high-performance single- or multiple-range weighing indicators designed for use with High
Speed Analog Load Cells, digital POWERCELL/PowerDeck networks, and Precision scale bases. Precision
measurement data from milligrams fo tons is provided by a single cost-effective package that easily integrates
into existing systems.

The infernal power supply connects to line-level AC voltage using a standard power cord appropriate for the
region in which it is used.

Enhanced Industrial Network and PC communication interfaces are available, and discrete /O options are
included provide control for process applications such as filling. The versatile IND700 can be upgraded with a

variety of special application software packages that add performance feafures where needed. These features
make the terminal a perfect match for nearly any weighing application in many industries, including:

e Pharmaceuticals e Pefrochemicals * Refining

e Milling e Agriculture e Cosmetics and Fragrance
e Specialty Chemical e (Coatings and Inks

IND700 Overview

Mechanical

» Four types of enclosure to suit differenf uses and locatfions
- Harsh environment (desk/wall mounted) enclosure, with either M12 connectors or cable glands
— Wedge enclosure with cable glands, including version for hygienic application

Figure 1: Harsh Environment (rear) and Wedge (front) Enclosures

Type 304 stainless steel enclosure

178 mm / 7" TFT color display fouch screen (800 x 480), fouch screen supporting use with gloves
Intuitive color touchscreen user inferface

Capacitative fouch function keys with backlight feedback -- Clear, Tare, Zero, Transfer

Infroduction
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Interface

« Connect one or two scale bases, using High Speed Analog, POWERCELL®, PowerDeck™, or Precision

interface

¢ Scale interface boards add options:
— High Speed Analog interface with 2 in/2 out DIO inferface
— POWERCELL/PowerDeck scale inferface with 2 in/2 out DIO
— Precision scale inferface with 2 in/2 out DIO and COMx (RS232/RS422/RS485)
« Several communication interface options, including serial ports and Digital Input/Output:

— Standard Tx COMT (RS232/RS422/RS485), 1 x Ethernet 1000 Base-T Protocol, 1 x USB 3.0, T x USB
2.0, 1 x Discrete 1/0 (21/20)

— Optional RS232/RS422/RS485 serial port
e Support for the following Industrial Network interfaces:

— EtherNet/IP
— PROFINET
— PROFIBUS DP

Function

¢ Basic weighing including zero, fare, and data fransfer

* Real-fime clock with battery backup

 Alibi memory storage for up fo 500,000 records

¢ Unit switching between three different units, including custom units (Not supported in phase 1.)
¢ Ten customizable templates to support capturing data, and fo produce and fransfer reports

e CalFREE™ calibrafion without test weights

e Up to four logical scales with POWERCELL scale interface

Application

 Standard Application capability: ID Forms
 The following Application Soffware Modules, enabled by ProWorks Mulfi-Tools license:

- Counting

— Manual Target - Classification

— Manual Targef - Filling

- Manual Target - Over/Under

— Tofalization

Note: Totalization and Counting can be combined with any of the manual target applications.

1.2 Specifications IND700

Specifications

Enclosure Type

Type 304 stainless steel enclosure

Dimensions

Refer fo Physical Dimensions

Shipping Weight, 7

e Wedge: 3.6 kg
e Harsh environment: 3.8 kg

Environment Protection, 7

P69k

Environment Protection, 12

P69k

Environment Conditions

For indoor or outdoor use (Type 4) (panel mount enclosure must be
mounted in profective box)

Alfitude

Up to 5000 meter above sea level

Operating Environment

-10°t0 40° C (14° to 104°F), 10% fo 95% relative humidity, non-
condensing.

Operating Environment (Legal
for Trade)

-10° 10 40° C (14° to 104°F), 10% fo 85% relative humidity, non-
condensing.

Pollution Degree

2
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Specifications

Power AC: 100 — 240 VAC, -15% to +10%, 50 - 60 Hz, 650 — 275 mA
DC: 24 VDC, 2.2 A (Min.: 20 VDC)

Overvoltage Category Il

Display, 7 178 mm / 7” TFT color display, fouch screen (800 x 480)

Weight Display HSALC display resolution: 7-digits
POWERCELL®, PowerMount™, PowerDeck™, or Precision bases (PBD,
PBK, PFK) display resolution: determined by specific base in use

Scale Types Analog, POWERCELL, PowerMount, PowerDeck, Precision

Number of Analog Cells

Up to 8 x 350 Ohms, 2 or 3 mV/V

Analog/Digital Update Rates

HSALC option: internal analog 1,000 Hz, target comparison 1,000 Hz

POWERCELL option: 100 Hz per scale, 50 Hz dual scales, 25 Hz four
scales

Precision bases: determined by base

Analog Load Cell Excitation
\Voltage

10 VDC

Communications

Standard Interfaces:

e One COM1 (RS-232/RS-422/RS-485), 2400 to 115,200 baud

e Ethernet 1000 Base-T Profocol

e USB3.0

e USB2.0

« Discrete 10 (2120)

Optional Interfaces:

e HSALC*

¢ POWERCELL/PowerDeck*

e Precision**

o EtherNet/IP, PROFINET or PROFIBUS DP

e Serial port, RS232/422/485

e COMXx serial port on Precision option board, RS232/422/485
* Scale interfaces also include Discrete 10, 2 in/2 out

** Scale interface also includes COMx (RS232/RS422/RS485) serial port

and Discrete 10, 21/20
Protocols

e Serial Inputs: SICS (most level O and level 1 commands, select advanced

commands from levels 2 and 3), Transfer

e Serial Outputs: Demand with up to fen configurable templates or SICS
host protocol; interface with up fo 8 ARM100 Input/Output modules

Infroduction
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1.3

1.3.1

1.3.2

1.4

Infroduction

Specifications

Approvals Weights and Measures
e USA:
— Class Il 100,000d
— Class I, 1L 10,000d
e Canada:
— Class Il 100,000d
— Class Il 10,000d, and Class IIIHD 10, 000d
e Europe:
— Class Il, approved divisions defermined by platform
— Class Ill, 1lll, Analog 10,000e; POWERCELL 10,000e
e China:
— Class Ill, Analog 10,000e
— Class lll, POWERCELL 10,000e
Product Safety
e CSA

Operating Environment
 Use the weighing terminal only when electrostatic processes leading to propagation brush discharge is
impossible.

» Keep the terminal away from processes that generate high charging potential such as electrostatic coating,
rapid transfer of non-conductive materials, rapid air jets, and high pressure aerosols.

¢ Choose a stable, vibration-free surface o mount the terminal.

* Ensure there are no excessive fluctuations in temperature and no direct exposure to sunlight.
« Avoid drafts on the weighing platform (for example, from open windows or air conditioning).
 Calibrate the terminal affer any major change of geographical location.

Temperature and Humidity

The terminal can be sfored and operated af temperatures and relative humidity conditions as listed in Specifi-
cations old

Environmental Protection

The terminal has environment protection as listed in [Specifications IND700 » Page 8].

Inspection and Contents Checklist

Verify the contents and inspect the package immediately upon delivery. If the shipping confainer is damaged,
check for internal damage and file a freight claim with the carrier if necessary. If the confainer is not damaged,
remove the product from its protective package, noting how it was packed, and inspect each component for
damage.

If shipping the product is required, it is best to use the original shipping container. The product must be packed
correctly to ensure its safe fransportation.

The product package should include the below items but may vary by region:
e IND700 terminal * Bag of miscellaneous parts
e Safety Instructions

IND700



1.5 Physical Dimensions

1.5.1 Enclosure for Harsh Environments

260 mm/ 10.24"

.
.
..i..-

METTLER TOLEDO IND700
2 @B osrnzoza
o)
2 /.000
N = kg
E 0.250 kg PT NET
E
<
N

231.2mm/9.1"

Figure 2: Front View

170 mm /6.69'

130 mm/ 5.12"

Figure 3: Side View
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< 100 mm/3.94" e

100 mm / 3.94"

Figure 4: Bottom View Showing Mounting Holes

1.5.2 Wedge Enclosure
260 mm/ 10.24"

79.4 mm/3.13"

231 mm/9.1"

Figure 5: Front View
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170 mm/6.7"

132.5 mm/5.22"

Figure 6: Side View

TEE.

_ . - . ' |

Figure 7: Bottom View Showing Mounting Holes

1.6 Date of Manufacture

A terminal's date of manufacture is available to MT technicians in an internal databases.

IND700 Infroduction | 13
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1.7 Model Identification

Infroduction

r Product Type

— Model Number

— Version

Enclosure/Display/Primary Connector Type

—Interface 1 or Slot 1

— Interface 2 or Slot 2

Interface 3 or Slot 3

rInferface 4 or Slot 4

—Communication 1 or Slot 5

Communication 2 or Slot 6

—Connectivity

— Software Application License
[Soﬂwore Add-On License

Power
Approval
"

T]/7200] 0] o o/lolofJolololo ofJolo[l1 o]

L LO = None
1 = AC Power
0 = None
0 = ProWorks
1 = ProWorks Mulfi-Tools
— 2 = ProWorks Studio
3 = ProWorks Studio & Multi-Tools
0 = None
L E = EtherNel/IP (M12 x 2)
T = PROFINET (M12 x 2)

P = PROFIBUS DP (M12 x 1)
0 = None

—E = Standard Ethernet Connector (M12)
U = Standard USB Host Connector (M12)
0 = None
2 = COMx Optional Serial Port - M12 Connector Only (RS232/422/485)
LD = Standard DIOT Connector (M12)
3 = Standard DIO2 Connector (M12)
U = Standard USB Host Connector (M12)
tO = None
C = COM1 Standard Serial Port - M12 Connector (RS232-422-485)
D = Standard DIO Connector (M12)

— None

0 = None
1 = High Speed Analog (cable gland)
b = PowerDeck (M12)
| 6 =POWERCELL PDX and PowerMount (PDX cable gland)
8 = Precision (SICSPro M12)
B = Optional Serial Port (RS232/422/485)
2 = COMx Optional Serial Port - M12 Connector only (RS232/422/485)
D = Standard DIOT Connector (M12)
0 = None
1 = High Speed Analog (cable gland)
| b = PowerDeck (M12)
6 = POWERCELL PDX and PowerMount (PDX cable gland)
8 = Precision (SICSPro M12)
B = Optional Serial Port (RS232/422/485)
C = Wedge, 7" Display, M12 Connectors
L S = Wedge Hygienic, 7" Display, M12 Connectors, GoreTex Vent, NSF Glands for power cord and HSALC
G = Harsh, 7" Display, Cable Glands
M = Harsh, 7" Display, M12 Connecfors
— 00 = Standard/Non-hazardous areas

— 700
—Terminal

Figure 8: IND700 178 mm / 7" Version Model Identification
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1.8 Touchscreen

Main screen — Main Screen View
The IND700 touchscreen provides the Human-Machine Interface (HMI) for the terminal. The figures below show

the appearance of the 7 and 12 versions respectively.

IND700
2 B ounms

(3

e | Switch Units | Alibi Memory| Higher Res

2 3 4 5
é.% @ 25,Aug_2220:g:
1213 1+2 Max 560 kgd=20g —— 1 6
—17
74 . 5 8 kg
-8
lI ]—-H 1 Max 500 kg d =20 g M 2 Max 60 kgd=10g
70.00 ., 4,58
10
| HEEREIEREIEE £
Figure 10: Elements of the Main Screen
1 Menu bufton 7 Weight display with unit
2 Message box 8 Status line
3 Access level 9 To next softkey ribbon
4 Language selection 10 Softkey line

Infroduction
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5 Time and dafe 11 Number of the active scale

6 Metrological information, alternating with 12 Sum Scale indicator
the permissible temperature range

Main screen — Application View
When an applicatfion is active, the screen is divided info the weight display (fop) and the application display

(bottom).
A1 -10.0°C/ +40.0°C
L
2. ; 50 kg
2.750kg PT N
Material ID Material Name Under Tol. Target

Application configuration
information

Al v L4
4’— Bargraph display

D
ngherkes‘ f¥orm LMa\enaH’abm‘ Target .

1 Aluminum scrap - 1.5kg 35kg

Over Tol.
+3 kg

CACREN
Figure 11: Application View Example

13 Application information

14 Application display elements -- e.g. piece counting information, bar graph for Filling and
Over/Under applications

Menu button
Touching 5 opens the following menu:

' @ Terminal 3
2] Login/Logout
{3y Enter Setup

1
Main Screen View

() Power N |

Figure 12: Top Menu

* Nofe that the Power item only appears if the login level if Supervisor or Admin.

¢ Terminal — Shows the terminal's IP address, defailed metrology information and defailed terminal infor-
mation. Refer to [Accessing Terminal Information » Page 441].

e Login/Logout- refer to [Logging In and Logging Out » Page 33].
e Enter Setup — Enter IND700 setup. Refer to Operating the setup.
¢ Switch between Application View and Main Screen View:

Example: Counting is active and simple weighing is needed to weigh another sample. Switch to Main
Screen View, perform the simple weighing operation, then fouch the menu item again to return to Appli-
cation View.

« Exit application (supervisor or administrator level only) — Exif the IND700 application. The Windows
desktop will appear.

Message box
* The message box status icon varies depending on the last logged message.
e Messages are classified with the same icons.

16 | Infroduction IND700



Severe error

(X
A Warning
i)

Information

lv_—l No new message since the message box was last viewed

Sample of message box contents:

==

9 Scale 2 not responding. 23/Feb/2021 9:09 AM
A\ Scale not calibrated 23/Feb/2021 9:08 AM

@ Scale 2 not responding. 22/Feb/2021 10:16 AM

A\ Scale not calibrated 22/Feb/2021 10:16 AM
g Scale 2 not responding. 22/Feb/2021 10:11 AM
A\ Scale not calibrated 22/Feb /2021 10:10 AM

@ Scale 2 not responding. 22/Feb/2021 10:07 AM
@ Init zero could not be done  22/Feb/2021 10:07 AM
Access level display

The IND700 offers three access levels. The current level is indicated by the small squares included in the
operator symbol on the system bar:

Operator Supervisor Administrator
mO0O EERO EEN
Operation level only, no setup rights|  Full rights, except approval and | Full rights, including approval and
calibration rights calibration rights

For user setup, refer fo [User Security » Page 31].
All access levels can change the terminal language by fouching the globe icon: @.

Setup Access

Nofte that if the current Access Level is changed to a higher or lower level while Setup is
displayed, changes to access to configuration parameters will not be changed until setup is
closed and re-opened. Thus, if an Admin login is replaced by an Operator login while a
configuration screen is displayed, the ferminal system line will indicate an Operator login
level but will grant Admin level access.

Status line
The stafus line can display the following symbols:

>0< Set to zero X.xxx kg T |Current tare weight

IND700 Infroduction | 17
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B/G

Gross weight

X.XXX kg

PT | Current tare preset

NET

Netf weight

X.XXX kg M

Tare weight with net sign correction
(Memory), POWERCELL/PowerDeck
scales only

MinWeigh function active

MinWeigh error

>11l<, >12l<, |Current weighing range, mulfiple e Stability monitor
>13l< range/inferval scales only
Softkeys

The following softkeys are available, separated in up to 3 softkey ribbons. Nofe that some of these softkeys
display when an application is in use, and do not appear in the [Softkey Ribbon Editor » Page 212].

C  Clear (f7  Transfer data
vJ«  Tare PT PresefTare
Qe Zero View Tare table
Swifch scale Higher resolution -- foggles between
standard and high resolution weight
displays
Switch units Target

View Alibi memory

View Transaction Table

Fix reference number

View Identification form (ID Form)

DB &

<&  Switch weight display between weight Variable reference number
Suitch weight Value and number of pieces
+  Add fo fofal fl-&  Switch weight display between weight
suitch weight| Value and number of pieces inactive
':') Input Template -- displays pop-up list of S Call up / clear fotal
et empiace || AVOIlODIE templates. Softkey will appear
only if at least one template is assigned to
a [Connection » Page 233], and the
connection is configured with Selectable
by Softkey enabled.
EEE Apps -- toggle between Application View 4] Repeat Transaction (reprint)

Home

and Main Screen View

Repeat Tr.

Data entry can carried out either by connecting an exfernal keyboard and mouse, or by using the system's
keypads. Refer to [Data Enfry » Page 42] for defails on the use of these screens.

IND700
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1.9 Main PCB Connections, Ports and Switches

Connectors and other features on the IND700 main PCB are indicated in the illustration below.

1 12 13 14 15 16
Figure 13: IND700 Main PCB Connections and Switches
1 Discrete 1/0 2 COM1 (RS232/422/485)
3 SW2 4 SD Card Slot (not used)
5 USB 3.0 6 USB 2.0
7 1000Base-T LAN 8 Slot 1
9 Slot 2 10 |Industrial Network
11 12 VDC input 12 | Fan connector
13 |HMl interface 14 |SWI
15 | Debug (do not use) 16 |USB extension connector

Infroduction
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1.10 Scale Interface and Option Board Locations

The IND700 enclosures support the following option boards for connection of different types of scales, and for
Industrial Network communication. The figure below indicates locations for these options.

High Speed Analog Precision POWERCELL® /  Industrial Network:
Load Cell PowerDeck™  PROFIBUS, PROFINET,
EtherNet/IP
IO Scale
¥

ul
o -

hi

S ———— —
=y \\ // | 0
Moo 6 ﬂ
L —eoM1 (1s8'3.0~J000bdse-T L

Figure 14: IND700 Interface and Option Installation Locations

Scale interface option boards are mounted in either Slot 1 or Slot 2. The Industrial Network interface board
mounts fo the connector indicated in the figure above.

Infroduction IND700



1.11 Scale Interfaces and Option Boards

High Speed Analog (HSALC) Scale Interface Board

The HSALC scale interface kit, part number 305564297, allows connection of analog load cells. Each HSALC
interface is able to drive up to eight 350 ohm analog load cells. The board also provides 2 discretfe inputs and
2 discrefe outputs.

IND700

Figure 15: HSALC Scale Board

POWERCELL® Scale Interface Board

The POWERCELL scale inferface kit, part number 30521649, is used with METTLER TOLEDO POWERCELL
PDX/PowerMount load cells, installed in large tank and vehicle weighing systems, or with PowerDeck scales.
The board also provides two discrete inputs and two discrete outputs.

Figure 16: POWERCELL Board

Precision Scale Interface Board

The Precision scale interface kit, part number 30529386, supplies 12 VDC for precision weighing platorms.
This option board has two additional features -- an inferface for two discrete inputs and two discrete outputs,
and an additional RS232/RS422/RS485 serial port named COMx. The 7-pin serial port on the interface board
does not provide +5V and GND connections.

Infroduction
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Figure 17: Precision Scale Board

Industrial Network Option Board - PROFINET and EtherNet/IP

This option board can be configured for PROFINET (kit part number 30529337) or EtherNet/IP (kit part number
30708327). The dual RJ45 ports (Port A and Port B) enable the Media Redundancy Protocol (MRP) or Device
Level Ring (DLR).

Figure 18: Industrial Network Option Board
Industrial Ethernet Update Rates
Industrial Ethernet Option Update rates

System Configuration PROFINET EtherNet/IP
HSALC, 1 scale 66 Hz 64 Hz
HSALC, 2 scales 50 Hz 49 Hz
POWERCELL, 4 scales 156 Hz 14 Hz

IND700




1.12

1.12.1

IND700

Industrial Network Option Board - PROFIBUS DP

The PROFIBUS option board (kit part number 31112532) has dual connectors, but only one is used.

-
~
-
-~
-
-
=)

Figure 19: Industrial Network Option Board - PROFIBUS DP

Connections

Connections are made using the openings on the rear of the IND700 enclosures. Openings are assigned as

indicafed below.

Wedge Enclosure

Figure 20: IND700 Wedge Enclosure with Cable Openings
Wedge Enclosure Cable Opening Assignments

Position Connector Size Cable Function
Diameter
1 M12 x 1.5 connector - e Ethernet
» USB
2 M12 x 1.5 connector - e USB
e DIOT (all 10 from main board and Scale 1),
e DIO2 on Scale 2 (b-pin)
*  COMx
3 Depends on scale - e Scale 2
interface
M12 x 1.5 connector - e Serial M12 connector only for COMx (7-pin)
e DIO1 (all 10 from main board and scale 1, 12-pin)
4 M12 x 1.5 connector - e QOptional COM
Scale 1
M16 x 1.5 gland 5-10mm e Scale 1, if High Speed Analog Load Cell (HSALC)
5 M12 x 1.5 connector |- e DIOT (all 10 from main board and Scale 1)
COM 1 from main board
6 M16 x 1.5 gland 5-10mm * Power

Infroduction

23



\ 7 \M]Z vent - *  GORE-TEX vent; not standard for wedge model

Notes

e COMx in position 2 uses a cable harness with an M12 connector. This assignment is possible only if a
Precision inferface is installed as Scale 1

M12 connectors are used in all locations unless otherwise required by the scale interface
e The wedge model does not support Industrial Network opfions
e The GORE-TEX vent (7) is optional, and is not included in the default configuration
e Due to the physical layout and length of internal harnesses, only the following connector locations are

possible:
DIO M12 Positions 2, 3 or 5
USB M12 Positions 1 or 2
Ethernet M12 Position 1
COM1 M12 Position 5
COMx M12 (Precision Scale) Positions 2 or 3

1.12.2 Wedge Enclosure, Hygienic Option

|

Figure 21: IND700 Wedge Enclosure with Cable Openings
Wedge Enclosure (Hygienic Option) Cable Opening Assignments

Position | Connector Size Cable Function
Diameter
1 M12 x 1.5 connector |- e Ethernet
e USB
2 M12 x 1.5 connector |- * USB

e Sfandard DIOT on main board, or scale 1 (12-pin)
e DIO2 on Scale 2 (b-pin)

e Serial M12 connector only for COMx

Scale 2

3 See position 4 for scale
connectors

M12 x 1.5 connector

Serial M12 connector only for COMx (7-pin)
e Standard DIOT on main board, or scale 1 (12-pin)

4 M12 x 1.5 connector - e POWERCELL/PowerDeck

e Precision

e Optional serial port M12 (7-pin) (RS232/422/485)

M16 x 1.5 gland 5.5-7 mmor ¢ High Speed Analog Load Cell (HSALC)
7-10mm
5 M12 x 1.5 connector |- e Sftandard COMT M12 connector only (RS232/422/485)
Standard DIOT on main board, or scale 1 (12-pine

6 M16 x 1.5 gland 5.5-7mm  |e Power
7 M12 x 1.5 vent - »  GORE-TEX vent; nof insfalled at factory but included in

installation kit, noted as “NOT NSF” in documentation
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1.12.3 Harsh Environment Enclosure, M12 Option

IND700

Note
e The wedge model does not support Industrial Network options
Notes
» Special NSF glands are used for the HSALC and power connections
e A GORE-TEX vent is included in the installation kit. This vent is not NSF-approved
e PET cover is added to the touch panel

Figure 22: GORE-TEX Vent in Side of Wedge Model

Figure 23: IND700 Harsh Environment 174 mm / Model (M12 Opfion) with Cable Openings

Harsh Environment 174 mm / 12" Model (M12 Option) Cable Opening Assignments

Position

Size

Cable Diameter

Function

M21 x 1.5 connector

M12 cable for Industrial
Network

M21 x 1.5 connector

M12 cable for Industrial
Network

M25 x 1.5 connector

13 — 18 mm; requires
1- and 2-hole grommet

USB
Ethernet

Infroduction
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Position

Size

Cable Diameter

Function

M21 x 1.5 connector

Scale 1: PowerDeck
Scale 1: Precision

M16 x 1.5 connector

5—-10mm

Scale 1: High Speed
Analog Load Cell (HSALC)

Optional serial port
(RS232/422/485)

M16 x 1.5 PDX gland

5—-10mm

Scale 1: POWERCELL
(vehicle)

M16 x 1.5 gland

5—-10mm

DIO2 on Scale 2

M16 x 1.5 connector

5-10mm

DIOT (all 10 from main
board and scale 1, 12-

pin)

Reserved: M16 plug

M16 x 1.5 connector

5—-10mm

COM2 from Precision
scale, if installed as Scale
2

M21 x 1.5 connector

For optional second slof:
Scale 2: PowerDeck
Scale 2: Precision

M16 x 1.5 connector

5-10mm

Scale 2: High Speed
Analog Load Cell (HSALC)
Optional serial port
(RS232/422/485)

Additional DIO option
board

M16 x 1.5 gland

5—-10mm

Scale 2: POWERCELL

10

M16 x 1.5 connector

5—-10mm

COM1

11

M16 x 1.5 connector

5—-10mm

Power

Notes

e The harsh environment 174 mm / 7” version with cable glands uses only cable glands for connections
except for the Precision scale, PowerDeck scale, and PLC opfion, which always use M12 connectors

 In the harsh environment 174 mm / 7” version with cable glands, the M25 gland is installed with single-
and double-hole grommets, available in the installation kit for the USB and Ethernet options. Cable glands
are also included for COM1, COM2 and the standard DIO 1 and DIOZ2; it is not necessary to select these in

the SCK

¢ All harsh environment 174 mm / 7” versions support only M12 cable for the EtherNet/IP and PROFINET

options

IND700




1.12.4 Harsh Environment Enclosure, Gland Option

IND700

Figure 24: IND700 174 mm / 7" version (Gland Option) Cable Openings

Panel Mount Enclosure Cable Opening Assignments

Position Size Cable Diameter Function
1 M12 x 1.5 connector - e MT12 cable for Industrial Network
2 M12 x 1.5 connector - e MT12 cable for Industrial Network
3 Reserved - -
4 M12 x 1.5 connector - e Scale 1: PowerDeck
e Scale 1: Precision
e Opfional serial port M12 (7-pin) (RS232/
RS422/RS485)
M16 x 1.5 gland 5-10mm e Scale 1: High Speed Analog Load Cell
(HSALC)
M16 x 1.5 PDX gland 5-10mm e Scale 1: POWERCELL (Vehicle)
5 M12 x 1.5 connector - e DIO2 on scale 2 (5-pin)
e Serial M12 connector only for COMx (7-pin)
-- only if Scale 1 is a Precision interface
6 M12 x 1.5 connector - e DIO (all 10 from main board and scale 1,
12-pin)
7 M12 x 1.5 connector - o FEthernet
8 M12 x 1.5 connector - * USB
9 M12 x 1.5 connector - e Scale 2: PowerDeck
e Scale 2: Precision
e Scale 2: Serial (RS232/RS422/RS485)
M16 x 1.5 connector 5-10mm e Scale 2: High Speed Analog Load Cell
(HSALC)
M16 x 1.5 connector - e Scale 2: POWERCELL (Vehicle)
10 M12 x 1.5 connector - e COM1 Serial (RS232/RS422/RS485) M12
(8-pin)
11 M16 x 1.5 connector 5-10mm *  Power
Notes

e M12 connectors are used in all locations except for the power cord and HSALC, which always use cable

glands
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e M12 connectors for USB, Ethernet, COM1 and standard DIO are all included. There is no need to select
them in the SCK

e M12 connectors for COM2 and DIO2 are not included. There is no need to select them in the SCK

« The M12 connector can support up to 12 total DIO. If a second scale is installed, the ferminal will be
configured with all DIO connected except for INPUT 2 on the second scale board.

 All Harsh environment 7" versions support only M12 cable for the EtherNet/IP and PROFINET options

28 | Infroduction IND700



2 Operation
This section provides information about navigating the Human-Machine Interface, and basic features and
functions of the IND700.

Specific operation of each IND700 ferminal depends on enabled functions and parameters that are configured
in setup. These setup parameters are described in [Configuration » Page 80]. The configuration and operation
of optional Applications are described in the IND700 ProWorks Multi-Tools User's Manual (30753893).

2.1 Non-Weighing Operation

2.1.1 Turning the Terminal On and Off

Turning the Terminal On

If the ferminal is not connected to power, plugging it in will initiate the starf-up process. The function key
highlights will flash, and a start-up screen will display. When the star-up process is complete, the home
screen will appear.

e

L5

Figure 25: Connect Terminal to Power

METTLER TOLEDO

Current date/time (12/31/2011 11:01 ate/time (11/23/2022 10:37:40 AM).

ia application Satup menu

Figure 26: Startup Screen
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Shutting Down

To shut down the ferminal, access the menu B and touch Power | Shut Down. Note that shut-down from the

menu is only possible with a Admin level login.

© Terminal > =z
2] Login/Logout

Sy Enter Setup

App Screen View
D.0°C / +40.0°C | R 2
O Power > | X Exit Application
0 ‘ () Reboot
[ ]
() Shut Down

Figure 27: Shutdown from Menu

A confirmation message will display.
= B B soane

KA 1 Max10kad =1g
Shut Down

A Do you want to
shut down? O k
X

B/G

Mrioicfolalals] N

Figure 28: Shutdown Confirmation

Touch the check mark to complete the shut-down procedure.

. R B asowms
AE 1 Max10kgd =1g
'::". Shut down... O kg
B/G
Ml clelalos M

Figure 29: Shutdown in Progress
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2.1.2 User Security

Terminal Access

When the terminal is in its factory default state, no passwords are set for users at any login
level. If is strongly recommended that the terminal's configuration be protected by sefting a
password for the Admin user, as described below.

For an overview of User Security, refer to [Touchscreen » Page 17].

Access level control is important for safeguarding the terminal's configuration and weighing data. This control
may also be due to legal regulations or to customer preference. Some installations operate in a "trusted"
environment, where security is managed within the scope of the operation perimetfer and no additional security
is required from the weighing terminal. The opposite extreme may be found in highly-regulated industries where
every operation must be recorded and authorized by signature or login.

The terminal allows the creation of three types of user -- Operator, Supervisor and Admin. These are configured
in Setup at Terminal > Users.

An Operator can operate the terminal and view tables, buf cannot change the configuration or add table
records. An Operator login may or may not be password-protected, and it is possible to configure many
different Operators. By default, the terminal has one Operator login configured, with the user name Operator
and no password.

A Supervisor can add or modify table records (including Users at Supervisor or Operator level), but cannof
enable or disable tables.

An Admin user has complete access to, and can modify, all terminal configuration screens and tables. By
default, the terminal has one Admin operator configured, with the user name Admin and password. It is recom-
mended that a password be assigned to profect administrative functions and configurations from being alfered
without authorization.

Password Management

When setting a password for a user, be sure to remember it and protect it from access by
unauthorized personnel. If the password is changed or forgotten, access fo the setup menu
and some terminal functions will be lost. To regain access and functionality, a master reset
of the terminal must be performed. This will reset all user names and passwords, but will
also remove any custom configuration. Nofe that configurations can be backed up from,
and restored to, the terminal, to recover custom setfings.

User Management
To manage terminal users, access Setup > Terminal > Users. The Users list will display.

< Users + o
User Name Access Level Default User
Admin Administrator
Operator Operator v
Jean Administrator

Figure 30: User's List
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To select a user, touch the fable row. A popup will appear.

o+ ./ v

Figure 31: Table Record Management Popup

The options are delete [l or modify./ the selected user, or create+ a new user.
If Delete is tfouched, a warning will display. Touch the checkmark to continue, or the X to cancel the deletion.

Warning

A Delete User

X

Figure 32: Delete User Warning

If Add is touched, and the current login level is Supervisor or Admin, the Add User screen will display.

< Add User

User Name

Password

Access Level

Administrator

Default User

Confirm Password

Figure 33: New User Screen

Here, a new user's name, password and access level can be configured. If the current login is Admin, the
Default User slider will be active. The login dialog for the default user will display automatically at system start-
up or, if no password is assigned (for an Operator, for instance), the terminal will start up with that user logged

in by default.
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If Modify is fouched, the Edit User screen will display with the same configuration options as the Add User
screen.

£ Edit User

User Name

Jean

Password Confirm Password

Access Level

Administrator N

Default User

Figure 34: Edit User Screen
The Access Level options dropdown list is shown below.
Access Level

Administrator v

Administrator

Supervisor

Operator

Figure 35: Access Level Options

When user configuration is complete, fouch the Back arrow fo return to the Setup > Terminal menu.

Logging In and Logging Out

User Configuration

This section assumes that users have been configured with names and, as required,
passwords, in Setup at Terminal > Users. Refer to [Users » Page 199] for defails.

The user login screen can be accessed either by fouching the Login/Logout item from the main menu e
or by touching the user icon B#§ in the system line. In either case, the user account screen will display.

When the terminal is furned on, the login stafus shows the user configured as Default User. Typically, the
default user will be an Operator-level login, and the initial user account screen will appear as shown below. The
User Name drop-down list will contain all configured users, but will always include the default users Admin
and Operator. In this case, Operator 1 is the default user and is currently logged-in.

< User Account

User Name

Operator 1

Figure 36: User Account Screen - No Password Configured
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Note that, because the currently logged-in user is displayed, the password field is blank, and the logout icon is
not shown.

In the example shown below, the default Admin user has been selected from the User Name dropdown list.
The Password field is displayed and, if a password is configured for Admin, must be completed before touching
the OK & icon.

< User Account

User Name
Admin

Password

Figure 37: User Account Screen with Logout Button

<{ Password

o Y

Figure 38: Password Entry Screen

Note that the password characters are not displayed in the entry field.

< Password

® < || > || <=

Figure 39: Password Entered, not Displayed
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When the password has been enfered, press « tfo confirm it. If the password is correct, the User Account
screen appears with the Password field populated.

< User Account

User Name

Admin

Password

Figure 40: User Account Screen Completed

Touch the check button to complete the login, or the logout bufton to exit the screen the leave the login status
as it was before.

If a password is not entered, or is enfered incorrectly, an Error message will display:

< Error

8 Invalid Password

Figure 41: User Account - Invalid Password Message

To change users, fouch the User Name field to display a list of existing users.

< User Account

User Name

Admin

Admin
Operator 1

Super

Operator 2

<]

Figure 42: User Name Dropdown List

With the excepfion of the default Operator user, the currently logged-in user can be logged out by touching the
log-out icon €I. The system then reverts fo the default login.
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2.1.3.1 MT Service Login with One-time-password (OTP)

36 | Operation

Instead of logging in with a sef password, the METTLER TOLEDO service fechnician can login into the terminal
using a one-fime-password (OTP).

List of OTP use cases:

e Serial number change e Admin password reset

» Date and Time setting  Service Information

e License View e License Management

e POWERCELL Log Configuration e POWERCELL Log View

e Add Maintenance Log e Transaction Memory Reset (Only when DI is active)
e Material Reset (Only when DI is active) * Mainfenance Memory Reset (Only when DI is active)
e Audit Log Reset (Only when DI is active) e POWERCELL Log Reset

e Master Reset  Certification Management > Import/Export/Delete

e Local Access

Preconditions

¢ QTP tool running, e.g. Technician Dashboard
MT Technician Login

Hardware 1D: 123456

OTP Product ID: 2

Challenge code: 080432232
Enter response code

X

1 Open the Quick setting menu, refer fo Quick sefting menu.
2 Touch symbol .
= The window fo enfer User ID and password is displayed.
3 Enfer MT Technician ( ) in the field and confirm with v,
= The page is displayed.
Note This page will expire in one minute and then the challenge code will update. Users should take

a screenshot and send it fo MT service within this time. Afterward, click the response code input field to
await the response code. In the “Enfer code” page, the challenge code won’t expire and updafe.

4 Go to the OTP tool and enter the displayed .
= The OTP fool will generate the response code (6 digits).

Enter code EN

223456 X

102 (13,4 5|67 |8|9]|0

- W‘e‘r‘t‘y‘u‘i‘o‘p )

a‘s‘d‘f g‘h j k‘l‘ >

©t z x ¢ v b n m , . #
- v

5 Go back fo the terminal and enter the response code of the OTP tool.
6 Confirm the response code with v,
= MT fechnician is logged in.

Note The MT fechnician is logged out if there is no operation during the set timeout time (default: 3
minufes).
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2.1.4 Changing language temporarily

IND700

You can change the ferminal's display language temporarily, as required.

Terminal Language Selection
The ferminal's default language is configured in Setup at Terminal > Region > Language.

Touch the globe [& on the system bar. A list of available languages is displayed.

J— = mem g P [

el
|
|

+/ English (English)
French (francais) '
German (Deutsch) | k(
Italian (italiano) ' .
Spanish (espariol)

ime
Chinese (Simplified, PRC) (A3 (R H))

Figure 43: Temporary Language Selection Drop-Down List

Touch the required language fo select it. The language will remain selected until it is changed from this drop-
down list, or the terminal is restarted.

Understanding the HMI (Human-Machine Interface)

The following are used fo navigate within applications and to configure the terminal:
 Softkeys on the fouchscreen

» On-screen data entry fields (alphanumeric or numeric) on the touchscreen
 Scale Function keys on the terminal's fascia

METTLER TOLEDO IND700

Max10kgd=1g

~ 7.000.

<

Figure 44: IND700 Fascia and Touchscreen
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Scale Function Keys

Clear |In net weight mode, clears the current fare value; the display will revert fo B/
G mode.

In data entry mode, functions as backspace/delete or escape.

Tare | When fouched, weighs container on scale, switches display to NET mode,
and displays zero weight.

Zero | Captures a new gross zero reference point. Function depends on seftings
configured for each scale inferface at [Scale Setup » Page 801].

Transfer | Transmits dafa from the terminal to a printer or external storage, or registers
a transaction. [Connections » Page 233] must be correctly configured.
[Output templafes » Page 2397 can be used to format the exported infor-
mation.

Highlight \When a scale function key is touched a highlight appears briefly to confirm
the operation.

Power |Switches the terminal on and off.

Screen Areas

The following images identify the main components of the fouchscreen interface, in sequence from top fo
bottom.

The system bar includes access to the main menu B2, a messages inbox [, a current user display B, a
language selection icon and the fime and date (if the [display » Page 198] is configured to show them).

'Q @ 12:20
2o 05.0ct.2023

Figure 45: System Bar
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The messages inbox displays information, warnings and cautions detailing the sfate of the ferminal.
L B sonrn:

Figure 46: Messages Display
Metrological information, including capacity and increment, appears just under the menu bar.

Max10kgd =1g

Figure 47: Metrology Display Area
In a ferminal with a single scale, the weight display area occupies the middle of the screen.

Figure 48: Weight Display
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When a tare has been taken, its value is displayed below the main weight display, and the B/G indications
changes to NET.

0.250 kg PT

Figure 49: Tare

The legend area displays information about items such as MinWeigh, scale motion, when the scale is af zero,
the currently operative range, and the net/gross idnciation.

>0< >|1|< B/G

Figure 50: Legend Area
The softkey display will vary depending on the application in use, and on [terminal configuration » Page 212].

Tare Table | Switch Units | Alibi Memory | Higher Res. Material Table

Figure 51: Softkeys
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2.1.5.1 Switching from multi-scale to single-scale view

IND700

Including Sum Scale, the IND700 HMI may display as many as three weight display areas. The image below
shows a display from a terminal configured with fwo HSALC inferfaces and a Sum Scale display.

A B oo

2 1+2 CALC Max120kgd=20g
0.00 «q
ﬂ'] Max60kgd=20g MZ Max60kgd=20g

0.00 0.00

PT | [ |8 | 8 | A | @ | B | B

Preset Tare Tare Table Switch Scale | Switch Units | Alibi Memory | Higher Res. 1D Form Material Table

Figure 52: IND700 Displaying Two HSALC Scales and a Sum Scale

Any scale can be selected for full-screen display simply by double-tapping on its display area. In the image
below, the Sum Scale has been selected. This format provides maximum readability in cases where the focus is
a single scale.

| 2 1+#2 CALC Max 120 kgd=20¢g

0.00.

Figure 53: IND700 Focused on One of Three Weight Display Areas

Nofe that, in this display mode, the softkey ribbon is not available.
To return to the multi-scale display, simply double tap the screen again.
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2.1.5.2 Weight Display Only Mode

It is possible to display weight information for the currently-selected scale as a window against the Windows
desktop, as in the example below.

)

Figure 54: Weight Display Only Mode, Example

The size and behavior of this window is configured in setup at [Application mode » Page 220]. Configuration
of this behavior must be performed by a user with the necessary access rights to modify sefup parameters.

2.1.6 Data Entry

When an input of numbers or fext is required, fouch the corresponding input field. Depending on the required
input type, one of the two keypads shown below will display on the screen.

Alphanumeric Data Entry

< Name

Figure 55: Alphanumeric Keyboard, Default (Lower Case) Display
1 A small triangle at the top right corner of a key indicates that special characters are available. To access
these, touch and hold the character.

2 For example, when "s" is touched and held, a pop-up displays showing the available variants.
3 Touch the desired variant to add the letter or symbol fo the fext enfry field.
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Touch the shiff key to display the letfers in upper case. Note that when it is touched, the key is colored blue to
indicate that it is active.

< Name

v

Figure 56: Alphanumeric Keyboard, Upper Case Displayed

Error Correction and Cursor Control

Nofe that when an entry has been made, an X < appears at the right of the entry field. Touch this X fo clear the

field's contents completely.

If an error is made in the entry, two methods are available to make a correction:

» Use the delete key <Ito backspace through the entry fo the point where the error was made, deleting
characters.

» Use the cursor left and right keys < > fo position the cursor at the error, and then add or delete characters
to make the correction.

< Name
Prduct‘ < >
gl o) oo | A C ;e i o N n
< Name
Pﬂduct < >
< Name
Pro‘duct < >
£l i | i | A C = =7 o (o} a}
‘ < Name

Product <D

Figure 57: Correction of Erroneous Entry
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Numeric Data Entry

When the user touches an entry field for a numeric value, the numeric keypad displays.

Figure 58: Numeric Datfa Entry Keypad

When an entry has been made, nofe the X which appears in the entry field. Touch this X to clear the entry.

Figure 59: Numeric Enfry in Keypad

2.1.7 Accessing Terminal Information

Information about the terminal and its configuration can be viewed by touching the menu access iconBEH and

selecting Terminal.

© Terminal
&] Login/Logout

{0} Enter Setup

Figure 60: Terminal Information Menu

>

192.168.86.222

Metrology

© Terminal Information

~ M~

The options on the sub-menu include information about the terminal's network configuration, metrology, and

hard and software characteristics.
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2.1.7.1

IP

The sub-menu shows the terminal's IP address; touch the address shown in the Terminal Information Menu to

display a screen showing more detail about the connection.

< Ethernet Information

Name Details

MAC Address 00-E0-4B-73-A7-31
1P Address 192.168.86.222
Subnet Mask 255.255.255.0
Gateway Address 192.168.86.1
DHCP Enabled

Figure 61: Terminal Network Information

Touch the Back arrow fo refurn to the home screen.

2.1.7.2 Metrology

IND700

Touch Metrology fo view the W&M Information screen.

<  W&M Information O 1 & |
Status Log Time Name Version Serial I
Boot Service Version 5.41.150
Boot Service Thumbprint ID B827409295
Scale Server 5.41.150
Scale Lock V1.0.40
A 26.Jan.2024 Scale Module 1 - HSAL (1.0.40) V1.0.40
A 26.Jan.2024 Scale Module 2 - HSAL (1.0.40) V1.0.40 87654z

Scale Module 3
Scale Module 4
H Scale Module 5 - Sum Scale

Figure 62: W&M Information Screen

Touch the back arrow to return fo the W&M Information screen. Note the icons in the W&M Information screen

header row; a number of functions can be performed from here:

Pairing History
Touch &to display the Pairing History screen.

<{  Pairing History File

ID* LogTime Terminal Serial No. Pairing Information

1 18.Jan.2024 10:53 69569416D7 S1(, 355C4524)

2 18.)an.2024 11:47 69569416DZ S1(, 98BEBE37)
18.)an.2024 11:47 S1(, 98BEBE37)

3 69569416DZ
19Jan.2024 12:18 52(8765431, F293E1A5)
26.Jan.2024 08:37 51(, A593598F)

4 69569416DZ
26.)an.2024 08:37 52(8765431, 1A37B7A0)
26.Jan.2024 08:38 51(, 4D370F8A)

5 69569416DZ
26.)an.2024 08:37 52(8765431, 1A37B7A0)
26.Jan.2024 08:38 S1(, AD370F8A)

6 69569416DZ
26.)an.2024 08:39 52(8765431, 88CB2EDS5)

Figure 63: Pairing History File
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This file shows pairing information for each installed scale, together with the terminal's serial identifier.
Touch the back arrow to return to the W&M Information screen.

Scale Log Table
Touch & fo display the Scale Log table.

<{  Scale Log Table

Date and Time Version Version Index
11/17/2023 10:00:00 AM 4.0.102

Figure 64: Scale Log Table

Touch the back arrow fo return to the W&M Information screen.
Calibration Test

The Calibration Test & is not currently implemented in the IND700.

Alibi Table

Touch [ to display the Alibi Table view. The Search and Export functions work in the same way as described
in [Table Functions: Filter, Export, Import, Clear » Page 322].

< Alibi Table Y
Log Transaction Scale Gross Net Tare
ID Time Counter Weight Weight Weig

22 27.Feb.2023 04:04:18
21 27.Feb.2023 04:03:24
20 27.Feb.2023 04:03:15 2.8 2.8

#
1 3.2 3.2 0
1
1
19 27.Feb.2023 04:02:48 1 5.2 5.2
1
1
1
1
1
4

3.4 3.4

18 27.Feb.2023 04:01:50
17 27.Feb.2023 04:01:37
16 27.Feb.2023 04:01:03
15 27.Feb.2023 04:00:35
14 27.Feb.2023 03:51:38

15 ATl ANDD N A48T

3.8 3.8
3.6 3.6
5.8 5.8
4.2 4.2
3.2 3.2

coa c A

2o o o o o ololo

Figure 65: Alibi Table View

Touch the back arrow to return to the W&M Information screen.
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2.1.7.3

2.1.8.1

IND700

Terminal Information

Touch Terminal Information to display the terminal's hardware configuration, together with software version

numbers where applicable:

< Terminal Information

Slot Description

Part Number Software Version

Slot1  HSAL (HSAL )

Slot 2 HSAL (Analog )

0s Windows 10 1809 IoT Enterprise
BIOS Kontron

APP Supervisor

APP Client. MTApp

APP Engine

30726006
30726006

V1.0.40

Vv1.0.40

V2.6.30/2024-01-16 1
MTsXA4R_1.1_BETA1Z
5.41.150-freeze.2+02.
5.41.150-freeze.2+02
5.41.150-freeze.2+02

Legal www.mt.com/legal

Figure 66: Terminal Information Screen

Table Functions: Filter, Export, Import, Clear, Table Size Limits

Enabled tables include a number of functions, accessed by fouching an icon in the table's header row.

The Alibi Table is read-only, and its contents can be Y filtered and ™1 exported. Alibi data cannot be imported
41, records cannot be delefed, and the table cannot be cleared . Once the Alibi Table has reached its
maximum capacity, the terminal begins to overwrite the oldest data. To avoid loss of Alibi Table dafa, it is
recommended that an export schedule be implemented.

The contents of the Material Table and Tare Table can be filtered, exported to a file, imported from a file, and
cleared. The import function permits table contents to be configured outside the ferminal, or shared befween
terminals performing the same function.

The contentsof the Transaction Table can be filtered, exported and cleared.

Exported table contents are stored on the terminal in the C:\Export folder. Data to be imported must be placed
in the C:\Import folder. For details on file transfers in and out of the terminal, refer to [File Transfer »
Page 363].

Filter

For an account of the filter entry methods, refer to [Data Entry » Page 42].

Because it accumulates many records, the Alibi Table has a Filter function ' which filters the visible records
depending on up to three conditions.

Search Condition

The Search Condition fields permit the definition of three search criteria. The three filters screens are shown
below. Note the screen indicator dots and up/down arrows af left.

< Filter
#1
Field Operator
Log Time N is equal N

. First Parameter

26.Jan.2024 00:00:00

Figure 67: First Table Filter Screen
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The second and third Filter screens are shown with no Field selected. Filter #2 is shown enabled but not
configured. Filter #3 is shown disabled. The other filter options -- Operator and Parameter -- are not
accessible until a Filter Field is selected.

Figure 68: Second Table Filter Screen

< Filter

#3

A

Figure 69: Third Table Filter Screen

Field opfions are:

« None (filter not operational)
« ID

¢ Log Time

« Transaction Counter

e Scale #

e Tare Type

e Unit

The options provided by the Parameter value depend on the Field type selected. For example, if Scale # is

chosen, the Parameter field is a drop-down list of all available scales plus Sum Scale.

When a filter Field has been selected, the Operator field and a Parameter field becomes available -- two

Parameter fields, if in the range is selected as the Operator. Touch the Parameter field fo display its

associated enfry method. ([Data Entry » Page 427). The Parameter entry dialog shown below is for a numeric

parameter, in this case ID.
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First Parameter

Figure 70: Example Filter Parameter Enfry

Other Field types are associated with other enfry types. For example, if Log Time is selected under Field, the

Parameer field will display a calendar and Hour : Minute input dialog.

February 2024

Mo Tu We Th

29
5
12
19
26
4

Hour : Minute

0

30
6
13
20
2
5

1
7
14
21
28
6

1
8
15
22
29
7

Figure 71: Calendar Dialog for Log Time Field Parameter

Parameter options are:
* isequal
 freater

e greater or equal
e less than

* inthe range

£ Filter

#1

v

Operator

is equal

is equal

greater

greater or equal

less than

Figure 72: Filter Condition Operators

Operation

49



2.1.8.2

2.1.8.3

2.1.8.4

50 | Operation

Export

All tables permit the export tf1 of data. The export screen requires the selection of a File Type, and the choice of
a File Name. The default form of the filename has the form [terminal]_[Year_Month_Day]_[fime]_[Table
name], but this can be modified by touching the File Name field fo display an alphanumeric entry screen
([Data Entry » Page 427).

<{  Table Data Export

Directory

C:\Export\69569416DZ

Internal File ~

File Type

csv XML

File Name

IND700_2024_02_09_0813_Tare

v

Figure 73: Table Data Export Screen
Touch the blue check mark || fo confirm the export and return to the Table view screen.

Import

The Material and Tare fables both permit data to be imported. Data for import fo a fable must be confained in a
file of the appropriate format, either .csv or .xml. Touch the Import icon th fo display the Table Data Import
screen.

{  Table Data Import

Import Directory

C\lmport

Internal File N

IND700_2024 02 09 0813 _Tare.csv

v

Figure 74: Table Data Import Screen

Touch the blue check mark || fo confirm the import. The Table view screen will appear, with the new data
displayed.

Clear

To manage space in the terminal's memory, it may be necessary to clear a table. Before clearing a table, it is
recommended that a table export be performed. The dafa can be stored outside the terminal. This will prevent
unwanted data loss.
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2.1.9.1

2.1.9.2

IND700

When the clear icon @ is touched, a warning displays indicating that the entire table will be cleared.

Warning

Clear Entire Table?

X v/

Figure 75: Table Clear Warning

Touch the check mark to confirm the deletion, or the X to return fo the table view.

Table Size Limits

Each table has a maximum number of records it can contfain. These limits are as follows:
o Transaction Table: 1,500,000 records

» Alibi Table: 500,000 records
e Material Table: 100,000 records
e Tare Table: 1,000 records

Transferring Data

The print function (demand output) can be initiated by:
e Pressing the TRANSFER function key
e Through the automatic fransfer function

Demand output of data may also be initiated as part of a parficular sequence of operation or special application
software.

A system message appears for 3 seconds when the terminal is carrying out a demand output command.

Enabling Data Transfer

To execufe a data fransfer successfully, a serial, USB or Ethernet connection must be configured with a Demand
Output assignment and linked fo a template and trigger associated with the selected serial or Ethernet port. If a
transfer command fails because a Demand Output assignment is not programmed on any port, the
synchronous error message “Print Failed-No Demand Output” is displayed.

Transfer Interlock

A Transfer Interlock can be configured in sefup af [Log or Transfer » Page 172]. It is designed to enforce a
single demand output per transaction. The Interlock function can be disabled or enabled. If it is enabled, the
transfer command is ignored until the measured gross weight exceeds the inferlock threshold. After the first
fransfer command is executed, subsequent transfer commands are ignored until the gross weight indication
falls below the interlock reset threshold.

If a fransfer command is blocked by the Interlock function, a synchronous “Print Not Ready” error is generated.
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2.1.9.3

2.1.9.4

2.1.9.5

2.1.10

2.1.11

52 | Operation

Repeat Transfer

The Repeat Tr. softkey .2, permits the data output of the most recent demand output to be fransferred again with
a DUPLICATE header or footer fo distinguish it from the original transfer. To enable the Repeat Transfer function,
simply add the softkey to the Home Page softkey ribbon, in sefup at [Softkeys » Page 212]. Pressing this
softkey will initiafe a repeat transfer of the last Demand Output connection listed in the assignments found in
Connections.

The repeat oufput femplate can be flagged with a “DUPLICATE” header or foofer to indicafe that the data in the
oufput template was generated as a repeat of a previous communication.

Auto Transfer

Automatic initiation of a demand output occurs affer the gross weight exceeds the minimum threshold and there
is no motion on the scale. After inifiation, the gross weight must return below the reset threshold before the next
automatic transfer can occur.

Auto Transfer may be disabled or enabled. It can be friggered and reset by weight exceeding sef thresholds, or
by weight deviation from a previously stable reading.

Report Transfer

The IND700 does not include any standard Report formats. However, when a [Connection » Page 233] is
configured with the Assignment Transfer, and a Template is configured for use with the connection, the selected
template can be configured ([Output Templates » Page 239]) to include whatever data the report requires.

Selecting an Input Template

Different data inputs require differently configured input templates. For example, the input from a barcode reader
will differ from the input from a keyboard. The IND700 allows up fo ten input femplates fo be configured. The
basic method for selecting a template to use is fo access [Setup > Communication > Connections »

Page 233], and configure a connection with the required femplate associated with it. However, there is a
simpler and more direct way fo switch between input femplates, using a softkey in the ribbon on the screen.
Follow these steps to configure quick access fo input templates:

1. First, ensure that each of the input templates fo be used is [configured » Page 2507, and associated with a
connection.

2. In setup, access [Terminal > Softkeys » Page 212].
3. Drag the Input Template softkey ®to the ribbon.

4. Return fo the weighing screen. If af least one input template is properly configured, the softkey will now
show it as currently selected -- .2...

5. To switch between input templates, as well as between the configured connections, touch the Input
Template softkey fo display a list of available templates.

Template 1
Template 2

9_"

Template 1

Figure 76: Input Template Softkey Pop-Up List

Automatic Standard (Output) Template
For details on configuring femplates, refer to [Output Templates » Page 239] and [Input Template »
Page 250].

During weighing operations, Output Template 1 provides a powerful and convenient tool. This femplate is
automatically configured, in real fime, fo adjust its contents to capture information displayed on the main
screen. This information includes basic weighing data, application parameters, and the labels and confents of
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any ID forms in use. If the femplate is assigned to a [Connection » Page 233], a Transfer operation will
produce output in the format specified by the template. This functionality means that it is not necessary fo look
up the relevant Shared Data variables and enter template elements manually.

However, different weighing operations will require different output confent. The Automatic Standard Template

provides a simple way to reflect these differences in transferred data, and fo switch quickly between output

formats.

Follow these steps:

1. Configure the terminal as appropriate for one type of weighing operation. This will set Output Template 1 to
capture the data generafed by this operation.

2. Enfer Setup and access Communication > Output Templates.

3. From the menu, select Template 1 in order to view its content.

4. Touch the Duplicafe icon @ in the menu bar. The Copy Template screen will display. In the example
shown below, the To field template selection list has been expanded.

Copy Template

From

1

Figure 77: Copy Template Screen
5. The current template, Template 1, will be shown in the From field. Touch the To field and select an unused
template, then touch the RUN icon » at lower right.

6. Touch the BACK arrow twice fo return to the setup menu view, and access Connections. Either creafe or edit
a connection so that its Assignment is Transfer, with the newly-configured Output Template named in the
Template field.

7. Select Exit Setup &from the dropdown menu at upper left.

8. Configure the ferminal for a second type of weighing operation, then repeat steps 2 to 7, again copying
Output Templatfe 1 to an unused femplate (e.g. Template 3).

9. Assign the newly-created Template fo another Connection.
10. Repeat these steps until all required types of weigh operation are represented by one Output Template.

Alibi Memory Direct Access

The Alibi Memory stores individual fransaction data that can be refrieved for verification purposes. Information
stored in the Alibi Memory includes:

e Transaction counfer value

e Date and time of transaction

e (Gross, netf, and tare weights including units of measure

If the IND700 terminal is programmed as ““, Alibi memory enabling or
disabling is only accessible if the security switch (SW1-1) is in the OFF
position.

The Alibi memory can’t be cleared unless a Factory Reset is implement. Refer
to PCB Switch Settings for more information on Factory Reset.
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Creating an Alibi Memory Record

Alibi memory records can be created automatically or manually:
< Auto Transfer: Through an automatic initiation of a demand output prinf request

¢ Semi-automatic Transfer - Pushbutton: By pressing the Transfer scale key .

¢ Semi-automatic Transfer - Remote: Through a fransfer command initiated via a discrefe input, an ASCII P

serial command or an Industrial Network inferface.

View, Search and Transfer Alibi Memory

1 Press the ALIBI TABLE softkey [Al.
= The Alibi screen displays.

< Alibi Table Y

Log Transaction Scale Gross Net Ta

ID Time Counter # Weight Weight Wi

14 28.5ep.2022 09:38:15 1 1.595 0.845

13 28.5ep.2022 09:37:34 1 1.395 0.645

12 28.5ep.2022 09:34:52 1 1:395 0.645

1 28.5ep.2022 09:33:46 1 1.395 0.645

10 28.5ep.2022 09:29:45 1 1:395 0.645

9 28.5ep.2022 09:29:14 1 0.710 0.710

8 30.Nov.2022 23:40:29 d 0.000 0.000

7 30.Nov.2022 23:40:28 1 0.000 0.000

6 30.Nov.2022 23:40:27 1 0.000 0.000

- 20 Kiar AT 22 ANAE 4 A Ann A Ann

Figure 78: Alibi Table View
2 Touch the FILTER softkey Y.

3 Use the selection boxes and datfa entry fields to enter specific search information fo limit the search, or do

not enter any search limits to view all Alibi Memory Table information.

<  Search Condition

Search Condition
Field Operator

Log Time v =

Sort Condition

Field Sort Direction

D ~ | Ascending

First Parameter
28.5ep.2022

Figure 79: Sefting Alibi Table Search Conditions

4 Press the OK softkey v .
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= The filtered search results are shown. Records are ordered by dafe and fime with the most recent record

shown last.
< Alibi Table OY M

- Log Transaction Scale Gross Net Ta
ID Time Counter # Weight Weight Wi
9 28.5ep.2022 09:29:14 1 0.710 0.710
10 28.Sep.2022 09:29:45 1 1.395 0.645
11 28.Sep.2022 09:33:46 1 1.395 0.645
12 28.Sep.2022 09:34:52 1 1.395 0.645
13 28.Sep.2022 09:37:34 1 1.395 0.645
14 28.5ep.2022 09:38:15 1 1595 0.845

Figure 80: Alibi Table Search Results

5 Use the navigation keys to view the records: Date, Time, Transaction, Gross Weight, Net Weight, Tare
Weight, Calculafed, Tare Type, and Unit. Note: In the Tare Type column, "PT" is shown if the fransaction
uses a preset tare.

In this screen, fouch the Filter softkey Y, which is filled o indicate that a search has been carried out, fo
renew the search information, or press the Filter Clear softkey ) fo clear the search information.

6 To ouput the entire Alibi Table, or a filtered part of it, touch the TRANSFER softkey th on this screen.

< Export

Target For Export

Internal File

Type For Export
XML

Export File Name
IND700_69569326DZ_2023_04_17_1033

Export Directory
CAExport

Figure 81: Alibi Table Export
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Quick Access to Input Templates by Softkey

When a Connection is defined with an Input Template Assignment, the Selectable by Softkey slider will
display.

<{  Add Connection
Port Input Template
Ethernet N Template 1 AV
it Selectable by Softkey
Assignment
Input Template NV
Ethernet Connection
Server '
Ethernet Port
1701 O
v

Figure 82: New Connection, Inpuf Template Assignment

When af least one connection has been assigned to an input templafe, the Templafe softkey ® can be seen in
the softkey ribbon, if it has been added in setup af [Terminal > Softkeys » Page 212].When it appears on the
home screen, this softkey displays Template 1 by default: .2, When multiple femplates are configured and
assigned fo connections, touching the softkey will display a context menu, listing all available femplates:

hoy

Template 1
Template 2
Template 3

o)

5 Template 1
Figure 83: Templates Softkey with Confext Menu

Touch the desired template to load it. The softkey will show the number of the currently selected template: 2.

Remote Operation using the Web Server

Note: In the following sections, a user of the web server is referred to as a remote user, while a terminal user is
referred to as a local user.

Introduction and Overview

Note: In the following sections, a user of the web server is referred fo as a remote user, while a terminal user is
referred to as a local user.

Features and Functions

The web server interface allows access fo the ferminal from a web browser. It provides increased usability for
complex configurafions by showing setup screens and parameters on a large computer monitor, rather than the
terminal’s own display. The server also facilitates remote setup, configuration and monitoring, making it easier
to work on terminals installed in inaccessible locations.

Without inferrupting ongoing weighing operations or other processes on the terminal, the remote user’s read-
only access:

« Allows the user to view the ferminal’s setup menus

« Allows the export of data fables and logs
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Access to these functions is confrolled by the login level of the user:
* e An administrator or supervisor can export and import data, change configurations remotely, and check
on configurations without interrupting the work process

When the web server is granfed write access, depending on the login level of the user all terminal setup pages
and parameters available in the web server interface are accessible to the remote user.

The web server can also be used fo demonstrate terminal functions, when it is connected fo the terminal
simulator

Web Server Setup

The image below shows the ferminal’s Communication sefup menu view with the Web Server ifem
highlighted.

& B o

Setup > Communication
Scales Ethernet OPC UA
Application Interfaces Web Server
Terminal Connections Industlal
Network
Communication Output Templates
Maintenance Input Templates

Figure 84: Communication Menus

Click on the Web Server menu item fo display the configuration page at Communication > Web Server.

{  Web Server

Web Server

80

Timeout for Write Access (min)

1

Remote T/C/Z

Remote T/C/Z Lock (min)

5

Figure 85: Web Server Configuration Page

« Enable or disable the Web Server
e Set a Port number for the server

e Set a Timeout for Write Access (min) value. When a request is sent to the terminal for write access, if no
operator response is received within the set time access is automatically granted

» Enable or disable remote control of the terminal’s Tare, Clear, and Zero functions. By default, these functions
are locked

 |f a remote user with admin or supervisor login privileges foggles Remote T/C/Z to unlocked, the Remote T/
C/Z Lock (min) value, in minutes, defermines how long access persists. Affer the set time has elapsed, the
web server will automatically re-lock Remote T/C/Z

Changes are confirmed by fouching the OK [Edbutton.
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Connect to Terminal

To connect a browser to the terminal and access the web server, the terminal’s IP address must first be estab-
lished. On the terminal, click the main menu E=, select the Terminal menu ifem, and note the IP address
which displays.

Open a web browser, enter the IP address in its menu bar, anc press ENTER. If the terminal is connected fo the
network and [Remote Deskfop Server » Page 215] is enabled, the Login screen will display.

IND700 METTLER TOLEDO

Please Sign In

Username

Password -

Figure 86: Web Server Login Screen

Login
The login screen displayed on the host computer’s monitor occupies a window, which can be moved and
resized as usual.

Login credentials and access levels are configured in the IND700 ferminal. Login requirements and options
include:

e A user name, which must be enfered each time the user logs in

« A password. By default the password characters appear as asterisks (*). Click the Preview On button <@>to
show the password’s characters

* A Forgot Password link, visible only for Administrator level logins. Note that when a remofe user logs in on
via the web server, this does not log that user in on the IND700 ferminal. Similarly, if a local user is logged
in on the terminal, this does not log them in on the web server

Note that when a remote user logs in on via the web server, this does not log that user in on the IND700
terminal. Similarly, if a local user is logged in on the ferminal, this does not log them in on the web server.

Reset Password

The Forgot password function is only available to Administrator level logins. When an administrator-level
remote user clicks the link, the Reset Password screen displays.

IND700 METTLER TOLEDO

Figure 87: Reset Password Screen

The Reset Password screen shows the ferminal’s Hardware ID and OTP Product ID, and a Challenge Code.
Contact METTLER TOLEDO technical support and provide this information. A Response Code will be provided.
Enter this code in the appropriate field and click OK, or click CANCEL to abandon the reset.

« If the information supplied was invalid, a popup message will display indicating that the reset failed
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8 Error

Code validation failed.
Password reset cancelled.

Figure 88: Password Reset Failed Error

» If a password is enfered which is incorrect or does not meet the password requirements, a \Warning
message will display.

A Warning

Password is incorrect or does not meet the
security requirements.

Figure 89: Password Policy Warning

 |f the Resef Password information is completed successfully, a User Account screen will display, permitting
the entry of the new password. This screen includes an Information bufton. When this button is clicked, a
popup displays the password requirements, which can be configured only from the terminal, not remotely.

User Account

Old Passwi At least 1 upper case character
At least 1 number
At least 1 special character

New Password @
TRk R EFAE

®

Confirm Password
B

Figure 90: Password Reset Dialog

2.1.14.2.3 Access Levels

The configuration access granted fo users of the Web Server is defermined by their login privileges. These are
configured in setup at [Terminal > Users » Page 199] and [Terminal > Roles » Page 202].
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2.1.14.2.4 Web Server Initial View

When a remote user enfers a correct user name and password to log in fo the web server, the server's Home
screen will display in the browser. Here, the web server shows a representation of the ferminal’s home screen,
with all attached scale inferfaces visible. In the example shown below, two scales are visible. When more
scales are aftached, the display area for each is reduced to enable them to fit on-screen.

To enhance the clarity of any view in the web server, Click the Menu icon Eat upper left to hide or display the
navigation pane at left.

IND700 METTLER TOLEDO

@ Home Home

& Application ~ Floor scale, high capacity (1)
- Terminal - —
& Communication ~ 0 OO

2 User = kg
@ Information A

Home

Bench scale, high resolution

2)

0.000 kg

L L r——

Figure 91: Web Server Home Screen
2.1.14.3 Access to Terminal Functions

2.1.14.3.1 User

From the leff pane of the Home screen, select User to display the page from which write access requests can
be sent fo the terminal, and where theremote user can cancel access and log out of the server.

= IND700 METTLER TOLEDO
% Home Users

# Application A~ Write Access
® Terminal @ X Inactive
S Communication ~

A, User

© Information ~ Logout

METTLER TOLEDO & All righs reservecl

Figure 92: Web Server User Page

Write Access

The Write Access area shows the current status of the connection and the access Request button.In the
example shown above, the server has read-only access to the terminal.

Logout

The Logout area displays the current remote user’'s User Name, and includes a LOGOUT button. Click this
button to restore the local user’s configuration access fo the terminal.

An automatic logout function is provided at Setup > Terminal > Users > General User Settings > Logout time
(min). Once configured this function will logout the remote user affer a specified period of inactivity. If there are
unsaved changes when the time expires, they are discarded, the web server is disconnected from the ferminal,
and the user is logged out of the web server.
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2.1.14.3.2 Web Server/Terminal Communication

IND700

To ensure consistency of access and to avoid contradictory changes to ferminal configuration, the web server
facilitates communication between the remote user and the local user. This communication takes the form of
popup messages and warnings which alert a user fo actions faken by the other user and allow them fo make,
approve or reject access requests.

Note: Af no time do remote and local users have simultaneous write access to terminal sefup and configuration
opfions.

Web Server Access to Terminal Setup Functions

The following table indicafes when a remote user’s read and write access does not affect the local user. When
the remote user has read-only access, the local user can perform any function permitted by their login level.
When the remote user has write access, the local user is blocked from accessing either the weighing screen or
the setup menus.

Web Server Access to Terminal Functions

Operation Available When User has Read Available when User has Write
Access Access

Browse configurations, switch Yes Yes

between menus, open forms and

tables

Export fables — Material table, Tare | Yes Yes

table, Transaction table, Alibi table

Filter tables Yes Yes

Export logs — Change log, Yes Yes

Maintenance log, Error log

All other operations: restore, No Yes

software update, changes to config-

urafion, adding/editing/deleting

table records, tests, calibrations,

efc.

Remote User Wishes to ViewTerminal Configuration

The various ferminal configuration screens available in the connected Web Server can be viewed without
communication with the remote user. In this read-only mode no changes can be made by the remote user.
Note that all the parameters in the example shown below are greyed and inaccessible to the remofe user.

Changes made by the local user will be shown in the web server view as they are performed.

E] IND700 METTLER TOLEDO

) Fome Region

) Language Time and Date
i Application ~

Terminal ~ Format set

Region 11:38 27

User Management Use 24 haur clack

Licensing Display Seconds

settings
Shaw 2 Digit

Month Daylight Savings Time ¥ od
s Time unspecified
3 Communication A f
Sham 2 Dicit Year

A User
Time Separator

@ Information ~

METTLER TOLEDD &l ighic e

Figure 93: Read Access View of Terminal > Region Screen
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Remote User Wishes to Make Configuration Changes to Terminal

When a write access request is made from the web server’s User page, an Information message on the
terminal’s screen will ask the remote user to approve remote configuration write.

Remote configuration

access is requested

X

Figure 94: Remote Configuration Access Request Displayed on Terminal Screen

If no local user is logged in, write access is granfed automatically after the delay specified in setup at Commu-
nication > Web Server > Timeout for Write Access.

If the local user clicks the X fo decline access, a message displays in the Web Server.

A Warning

The write access was declined on the terminal

Figure 95: Local User Declines Access
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If the local user clicks the check mark to permit access, the web server is granted write access to the ferminal
and a Warning message will appear on the terminal indicating that it is locked while the web server has config-
uration access.

Warning

Remote configuration in
A process. Request

unblocking?

Figure 96: Terminal Display Indicating Remote Write Access in Progres

The remote user now has configuration access and can make changes fo the terminal’s setup. Note that all the
parametfers in the view shown below can be modified.

= IND700 METTLER TOLEDO
1 Home Region
- language Time and Date
& Application
= Terminal v Format Set
Region rm;cj ~ e Qv prococe

Type

f—
User Management O Use 24 hour clock 3 ~

teensing @ oipiyseconts
(UTC-05:00) Eastern Tim. 2
Settings

@) show2 Digit Last e
Wonth P o:yighe savings Time 10/27/2025 10:45:14 4
= Communication ~
@ ) show2 Digit vear
A User
Time separator
@ Information A

& s now

METILER TOLEDD. (5 Al ighs reservac -

Figure 97: Remote Access fo Terminal Configuration Options - Terminal > Region > Time and Date

Local User Wishes to make Configuration Changes to Terminal

The 'Remote configuration in process' warning includes a Request unblocking? check mark.

Warning

Remote configuration in
A process. Request

unblocking?

Figure 98: Request Unblocking Opfion in Remote Blocking Warning
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To resume making changes fo the terminal, the local user must fouch this button. The web server will inform
the remote user of the request.

A Write Access Requested

The terminal access is requested
Grant will discard your changes

X DECLINE +/ GRANT

Figure 99: Write Access Request from Local User

The remote user can DECLINE or GRANT this request.

If the remote user clicks the DECLINE button, the web server's write access to the terminal is continued and a
warning message is displayed on the terminal.

Warning

Remote blocking was not
A released.

Reason: Declined by remote

Figure 100: Terminal Write Access Declined

When the local user clicks the check button, the “Remote configuration in process” warning reappears, and the
local user can make a further request for access.

If the remote user clicks the GRANT buiton, configuration access reverts to the terminal and the web server view
becomes read-only. The web server displays a message confirming this.

©® Information

The terminal was granted the write access.

v 0K

Figure 101: Web Server Information - Terminal Granted Write Access

When the remofe user clicks OK, the web server reverts to read-only access.

Remote User Refreshes the Browser View

If the remote user is connected to the terminal with configuration access and has made changes which are not
yet saved, and then refreshes the browser view, the server will display a message alerting the user that unsaved
changes may be lost when the view is refreshed.
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Reload site?

Changes you made may not be saved

Figure 102: Web Server Browser Refresh Warning

Remote User Ends Configuration Access to Terminal

Once the desired operations have been performed, and configurations selected in the web server are saved, the
remote user logs out, and the message displayed on the terminal disappears.

Using the Web Server

The representation of the terminal’s screens, and its access to terminal functions and setup provided in the web
server inferface, match those available to the local user. The menu structure and hierarchy parallel each other,
but the web server’s inferface always displays both the terminal’s menu tree and its system line.

System Line and Menu Structure
The System Line displays the model name of the connected terminal at its center.

= IND700 METTLER TOLEDO
Figure 103: Web Server System Line
The menu structure of the web server includes the following:
* Home*
e Application
e Terminal
e Communication
o User*
e Information*
Asterisks (*) indicate server-specific pages.

Generally speaking, the Application, Terminal and Communication items replicate the menu options in the
root of sefup, as seen in the ferminal by the local user. However, the web server takes advantage of the greater
display space available fo make the user interface simpler and more informative. Examples of these views are
included in the following sections. Refer to [Web Server Inifial View » Page 607 and [User » Page 60] for infor-
mation on those pages.

There is a single item under Information, Terminal. Two fabs are shown in the Terminal page -- Ethernet and

Software. Respectively, these display the information accessed on the terminal at Information > Terminal > IP
and Terminal > Terminal Information.

= IND700

@ Home Terminal

- Ethernet Software

#i Application

L TEal N Device Ethernet Information
Vodel MAC Address

@ Communication A IND700 00-E0-4B-70-48-FC
Serial Numbe: 1P Address

% Us €1260000 192.168.86.231

© Information v o

Terminal ID #1 255.255.255.0

Terminal
eway Address

Terminal ID #2 :;’2168 86.1

DHCP

Terminal ID #3 Enabled

Figure 104: Terminal > Ethernef View
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= IND700
@ Home Terminal

Ethernet Software
~

# Application

& Terminal ~

Slot Description Part Number Software Version
SCon Iy cation S s sicspro 0726001 108
A User os Windowrs 10 1808 0T Enterprise \26.30/2025.09-17 07:00:00 A
O Information v eos Koriron MTSXAIROTP 1.2
Terminal s Supervisor 54430
e Client.MTAgp 54430
APP Enging 5.44.30
Legal wuewmcom/lega

Figure 105: Terminal > Software View

Table Functions

Some setup screens behave differently in the web server. For example, when a local user is editing a table and
clicks the Add or Edit bufion above the table, an edit screen replaces the table view on the terminal’s display.
However, when a remofe user performs the same action, the table display is reduced in size, but remains on
screen, while the Add or Edit screen is displayed to its right.

ND700 METTLER TOLEDO
@ Home Memory
i seale ¥ WiTables AlbiTable TransactionTable Material Table Tare Table
Applicat ~ =
Memory O o rame Doscripion alue e Lowlimit  igh timit it Tare
10 Form =] L

Figure 106: Web Server View of Table Edit Screen

When the remofe user clicks the Save button, a message confirms “Changes were saved,” the editing pane
closes and the fable is restored to its full size. This permits a clearer sense of the structure of a table while its

elements are being created or modified.

Linking Table Records

Linking records is also simplified. When modifying a Material Table record, for instance, clicking Tare 1D/

Name on the edit page opens the Tare Table view, allowing a rare record to be selected.

= IND700 METTLER TOLEDO

Hom Memory
f Seake - AllTables  Aliki Table  Transaction Table Material Table Tare Table

*oplcs %

Memory O © e T i Despten  Apalicstion ATy,

Drorm e - .

o
4

2w . ]
0 nf i v

[——

Figure 107: Modifying Material Record

IND700



2.1.14.4.3

2.1.14.4.4

2.1.14.4.5

IND700

METTLER TOLEDO

Memary

~  AliTables AliciTable TransactionTable Material Table @ Tare Table

Memory O ®  Nom " Descriztion  Value Unie LowLinie

Figure 108: Linking Tare Record to Material Record

Reporting Remote Actions to Local User

Certain actions taken by a remote user will cause the terminal fo display a message to the local user. For
example, when a remote user exports a table or log, the terminal’s message center will display an Information
message indicating (for example) “Material Table was exported from the web page.”

Performing Dangerous Operations

When a remote user clicks to confirm an operation defined as dangerous, such as deleting a certificate used by
OPC UA, the web server will display a warning message. Most dangerous operations (such as performing 10
tests) cannot be performed using the Web Server inferface.

IND700 Setup Menu ltems

For procedures used to configure the IND700 from its setup menus, refer fo the [Configuration » Page 80]
section of the manual. Not all configuration functions are available in the web server inferface. The sections
below emphasize the advantages of the web server view.

Application

The Application > Memory displays include the same table management (editing, deletion, export, etc.) found
in the ferminal’s menu system. Messages such as fable deletion warnings also work in the same way but use
the web server’s graphic presentation.

The Application display shows multiple sefup pages simultaneously, simplifying the configuration of appli-
cations.

METTLER TOLEDO

Applications

i scake v MllApps Counting Classification Totalization

Selectad Applications. 10 Form

@ » N £ 1
g § = g

o <

Figure 109: Web Server Application Menu View

A further example of this richer user inferface can be seen in the manual filling configuration screens shown
below. Note that fabs af the top of the right pane provide access to the various application modes available, so
that it is not necessary to navigate back in the menu structure to access them.
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IND700 METTLER TOLEDO
Q) Home Applications
& Scale ~ AllApps  Counting  Manual Filling  Tosalization
O L=y - App Screen View Configuration
Memory & oo .
o Form B ierances
Discrete /O e
Applicarions e
s
Comparators
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Q Communication
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5 User

© tormation -

Figure 110: Web Server Manual Filling Menu View

Terminal

Another example of the web server’'s more efficient display of setup options can be seen in the Terminal >
Region submenu. Time and dafe can be configured and sef in the same view, without having to switch
between pages.
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Figure 111: Web Server View of Terminal > Region > Time and Date Menu Ifems

Communication

The Communication menu provides web server access to [Ethernet » Page 2277 seftings, installed [Inferfaces
» Page 228], and [Connections » Page 233] configuration. It also enables Certificate Management.

Basic Weighing Operation

This section provides information about the basic weighing functionality of the IND700 terminal. For details on
the use of Applications, refer to the ProWorks Multi-Tools User's Manual.

Simple weighing

In its most basic form, the weighing operation consists of the following:
1. Zero the scale.

2. Place the item o be weighed on the scale.

3. Wait for the instability indication === to disappear from the display.
4. Read the result of the weighment from the screen.
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The illustrafion shows the resulf of a simple weighing operation in a terminal configured with fwo analog
(HSALC) scales installed and configured fo provide a Sum Scale display.

;l‘ @ 11:09
&
mas - 03.Apr.2023

2 1+2 CALC Max 2.06 td =0.2 kg
7000
KA1 Max10kgd=20g KR 2 10.0°C / +40.0°C
PT B3 | 03 &
Preset Tare Tare Table Switch Scale | Switch Units | Alibi Memu(y Higher Res. 1D Form Material Table

Figure 112: Example Simple Weighing Display
The digit size of the weight display adjusts dynamically depending on the resolution of the scale.

Simplified Large Weight Display

Any of the scales displayed on screen can be viewed in a larger, simplified format by double-tapping anywhere
within the desired scale's display area. The larger display will appear:

A B o

2 1+2 CALCSu...

13740.

To return to the standard weight display, simply double-tap anywhere on the screen.

)

Higher Res.

PT

Preset Tare

Figure 113: Simplified Large Weight Display

Tare Table

A%

Switch Scale

(3

Switch Units

[

Alibi Memory

1D Form

Zero

Before performing a weighment, it is important that the scale or scales be precisely af their zero point. If the

weight value has deviafed from zero, it can be resfored fo zero by either of two methods:

1. Touch the Zero function keyf#l on the terminal's fascia. The key's surround will illuminate briefly fo confirm
the action EEH.

2. Touch the Zero softkey icon *Q, if it is configured to display in the softkey ribbon.
The Zero operation functions depending on the parameters configured in setup af Scales > Scale © > ASM >

Zero. If the current scale weight is outside the range set there, the Zero operation will fail. Refer to [POWERCELL
- Zero » Page 131] for details on these settings for the various scale types used with the IND700.

Automatic Zero Maintenance

Automatic Zero Maintenance (AZM) enables the terminal fo compensate for the buildup of small amounts of
weight and frack itself back to the center of zero. Within the AZM operating range (programmable from 0.00 fo
10.00 divisions), when the terminal is in a no motion condition, it makes small adjustments to the current zero
reading to drive the weight reading toward the true center-of-zero. When the weight is outside of the
programmed AZM range, this feafure is not functional.

Operation
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Power-Up Zero

Power-Up Zero enables the terminal to capture a new zero reference point after power is applied. If the terminal
defects motion during a power-up zero capture function, it will continue to check for a no-motion condition until
zero is captured. Power-up zero can be disabled or enabled, and the acceptable range above and below
calibrated zero configured. The range is programmable from 0% fo 100% of capacity and can include a
positive range and also a range below calibrated zero.

Pushbutton Zero

The pushbutton (semi-aufomatic) zero function can be accomplished by:

« Pressing the ZERO scale function key 8] or the ZERO softkey *Qv, if configured.
« Programming a discrete inpuf for zero and then activating this discrete input
 Industrial Network command to the terminal

¢ Serial command (SICS or CTPZ protocols)

« A custom application

The range for all types of pushbutton zero is selectable (0% fo 100%) plus or minus from either the calibrated
zero point (if power-up zero is disabled) or from the initial zero setfing point (if power-up zero is enabled).

Remote initiation of the pushbutton zero command is possible via a discrete input, an ASCIl 2" command sent
serially (CPTZ and SICS), a command initiated by the Industrial Network inferface, or from an application.

Tare

The use of a tare value switches the terminal's weight display from Gross mode, in which the absolute weight
on the scale is displayed, fo Net mode, in which the displayed weight accounts for the weight of a container, for
example, and shows only the weight of material or items added to the container.

When a tare is loaded, the weight display's indication changes from B/G (gross weight display) to NET, the
weight display shows zero weight on the scale, and a fare indication af lower left of the main screen shows the
tare value and its type (T or PT).

A Tare value can be loaded in several different ways:

e Manually, from the terminal's function bufton or from a softkey in the softkey ribbon
Manually, by enfering a Preset Tare value

e Manually, by selecting a Tare record from the Tare Table
Automatically

Similarly, a tare can be cleared by:

 Touching the ferminal's Clear function key
Automatically

See also
& Data Entry » Page 42

Pushbutton Tare

The simplest way to take a tare is to place an empty container on the scale

& @ 03‘Apr.1220:.21:

| -10.0°C / +40.0°C
O . 7 O kg

Figure 114: Weight Display in Gross Mode

With the container on the scale, touch either the terminal's Tare function key @K or the Tare softkey *I+, if it is
configured fo display in the softkey ribbon.
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The display will change from gross weight on the scale fo net mode, and display a tare indication with T,
showing that the tare was taken by pushbutton

é?h @ 03.Apr.1220:.21:

E&1 -10.0°C / +40.0°C
0.00 kg

Figure 115: Weight Display in Net Mode, with T Indication

Keyboard Tare

A Keyboard tare, also called a preset tare, is a numeric tare value that is entered manually through the numeric
keypad, received serially or via Ethernet from a peripheral device, or refrieved from the Tare Table memory. The
preset tare value cannot exceed the capacity of the scale. A manually enfered Tare value is interpreted to have
the same units as the current displayed value. Motion does not impact the entry of preset tare values.

Keyboard tare can be configured in Setup as enabled or disabled. When disabled, the numeric keypad and the
TARE scale function key @B cannot be used fo obfain a fare.

— To enter a keyboard tare or preset tare value manually, use the numeric keypad or external fo enter the fare
value (data entered will display just above the softkeys with a “Data:” label) and press the TARE scale
function key 3R .

If configured in Setup, remote equipment can enter a Keyboard Tare or Preset Tare value using a serial
command or Industrial Network command (refer fo [Industrial Network » Page 2566] and [Communication
Setup » Page 2267).

If the Keyboard Tare or Preset Tare is successful, the display changes fo a net weight indication, and the
entered preset tare value is stored as the tare value in the active tare register. If Tare display is enabled, the
pushbutton tare value will be shown with a PT label.

Several conditions could inhibit the keyboard tare or preset fare function:

Keyboard Tare Disabled If keyboard fare is disabled in setup, the numeric keypad and the TARE scale
function key @B cannot be used to obtfain a fare.

Over-Capacity or Under- Preset tare is nof allowed when the weight display indicates over capacity or

Zero Conditions under zero conditions. Any preset tare attempted when the scale is over capacity
is ignored and a “Tare Failed—Over Capacity” error displays. Any preset tare
attempted when the weight display indicafes a blanked under zero condition is
ignored and a “Tare Failed—Below Zero” error displays.

Preset fare can be entered in free format. If the enfered value does not maich the displayed weight decimal point
location or display inferval, the entered tare value is rounded fo the nearest display interval and the decimal
point adjusted fo match the gross weight. The rounding method is that 0.5 or more of a display inferval (d) is
increased to the next display interval and 0.49 or less of a display interval is decreased to the next lower
display interval.

When enfering a preset tare value less than 1.0, the operator can enfer the data without the leading zero (left of
the decimal point), but all subsequent display, storage, or printing of this value will include the leading zero.
For example, a preset tare eniry of .05 will display as 0.05.

If a preset tare has already been established and another preset tare is entered, the second preset tare replaces
the previous value (it does not add to the previous value). The replacement tare can be larger or smaller than
the original tare value.

Auto Tare

The terminal can be configured so that tare is automatically taken (auto tare) affer the weight on the scale
exceeds a programmed fare threshold weight. Auto fare can be configured in Setup as enabled or disabled.
When auto fare is enabled, the display changes to a zero net weight indication after the weight exceeds the
threshold value. The previous weight on the scale is stored in the fare register as the tare value.

Auto tare operations involve:

Tare Threshold Weight ~ \When weight on the scale platform exceeds the fare threshold value, the terminal
automatically tares.
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Reset Threshold Weight  The reset threshold weight must be less than the tare threshold weight. When the
weight on the scale platform falls below the reset threshold value, such as when a
load has been removed, the terminal automatically resets the aufo tare trigger.

Motion Check A mofion check is provided to confrol the re-arming of the auto fare function. If
disabled, the auto tare trigger will be reset as soon as the weight falls below the
reset value. If enabled, the weight must seftle fo no-motion below the reset
threshold before the next aufo tare can be initiated.

Several conditions could prevent the auto tare function from working:

Motion Auto tare cannot be taken when the scale is in motion. If motion is defected after
the weight on the scale exceeds a preset fare threshold weight, the ferminal will
wait for a no-motion condition. If a stable (no motion) weight condition occurs
within 3 sceonds, the auto tare command is executed.

Auto Tare Disabled Aufo tare can be configured in Sefup as enabled or disabled.

Special Tare Operation in Multi-interval Scale Applications

When the terminal is configured for multi-interval operation (refer to # Ranges/Intervals), the terminal only
permits a preset tare fo be taken in interval # 1. A preset tare, including the recall of a stored tare from the Tare
Table (refer to [Tare Table » Page 184]) must be a value in inferval # 1 as well. If a tare is atfempfed with a
weight value found in inferval 2 or 3, a “Tare Failed — Over Range” error is given.

Note: Because of the way the terminal manages the tare, it is required that the final weighing system has
a label displayed that indicates the maximum tare value within the capacity of interval # 1: T = nnn,
where nnn is the capacity of interval 1.

The requirements for this marking are as follows:
¢ Required only for OIML approved ferminals that are programmed for multi-interval (not multiple range).

» The descriptive markings shall be indelible and of a size, shape and clarity allowing easy reading.
It shall be located in a clearly visible place on a sticker fixed permanently o the instrument.

* In case the sticker is not destroyed when removed, a means of securing shall be provided, e.g. a control
mark that can be applied

Using the Tare Table

Tare Table Records

Tare records can be added, modified and deleted in the Tare Table view whether it is
accessed via the softkey or in setup at Application > Memory > Tare Table, butf only if the
user's login level permits.

If tare records have been stored in the Tare Table, they can be recalled by fouching the Tare Table softkey
and selecting a tare record from the list which appears.

{  TareTable

ID* Name 4 L

1 Sandbag 1.25 kg

escription Value Unit Low Limit

2 BB box Box for counting ball bearings 0.15 kg

Figure 116: Tare Table with Record Selected
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Touch the check mark to load the fare and refurn to the weighing screen, now in NET mode with a PT (preset
tare) indication.

Loading Records from the Tare Table

The TARE MEMORY softkey can be used in two ways to active records from the Tare Table.

Quick Access to Records \When the ID of the Tare Table record fo be used is known, use the Quick Recall
method. Enter the ID using the numeric keypad and then press the TARE MEMORY
softkey [#] to load the record info the active Tare register/memory. If the record is
available, the data is loaded. If the record is not found, an “ID not found” error
displays.

List Selection When the ID of the Tare Table record is unknown, use the List Selection method.
To use the List Selection mode:

1 Press the TARE MEMORY softkey [r] without any preceding dafa entry. The Tare
Search screen displays.

2 Enter any search restrictions required or leave selections as they are to retrieve
all records.

3 Press the SEARCH softkey Q 1o view the selected records in the fable.

4 Use the UP and DOWN navigation keys fo scroll through the list until the
desired record is highlighted.

5 Press the OK softkey v 1o load the selected record from the list

6 Press the EXIT softkey <= to return to the weighing operation screen without
loading the record.

Clearing a Tare

Clearing Tare Manually

To clear a tare and return the terminal to B/G (gross) mode, either touch the Clear function key [, or the Clear
softkey 1+, if it is configured fo appear in the softkey ribbon.

The weight display will refurn to gross mode, and display the weight of the container as a positive value .

Clearing Tare Automatically

If Auto clear tare is configured in Setup at Scales > Scale n > ASM > Tare, the terminal will refurn to gross
mode and display zero as soon as the container is removed from the scale. The Auto clear tare threshold
must be lower than the weight of the container.

Manual Clear

Press the CLEAR function key [el when the ferminal is in the net mode and has completed the weighing
operation. Mofion on the scale will not impact a manual clear.

Auto Clear

The terminal can be configured fo clear tare automatically when the weight returns to a value below a
programmable threshold, or when a print command is issued. Once the tare is cleared, the display returns to
the gross weighing mode.

Auto clear is disabled or enabled in Setup. If auto clear is enabled the following parameters, configured in
Setup, affect the auto clear operation:

Clear Threshold Weight  The clear threshold weight is the gross weight value below which the terminal will
automatically clear a tare after seftling to a value above this threshold value.

Motion Check A motion check is provided to control the automatic clearing of fare. If the motion
check is disabled, the tare value is cleared as soon as the weight drops below the
threshold weight (aufo clear threshold), regardless of the motion status.

If the motion check is enabled, after meeting the requirements for weight value
above and then below the threshold weight (auto clear threshold), the IND700
waits for a no motion condition before automatically clearing the fare.

Clear After Transfer If enabled, tare is aufomatically cleared and the scale returned to the gross mode
after data has been fransmitted by pressing the TRANSFER scale function key
or from a remote source.

Operation
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Clear With Zero If enabled, pressing the ZERO scale function key B8 will first clear the tare then
issue a zero command.

Refer to Aufo Tare for further information about configuring auto clear.

Checking a Container Tare

This function aufomatically detects and identifies different sizes of container by weight, using the Lower Limit
and Upper Limit defined in the Tare Table record. Note that a fare record can either specify an absolute Tare
Value or these limit values.

To use the checking function:
1. Place the empty container on the scale.

2. Touch the Tare Table softkey and load the required record ([Using the Tare Table » Page 727).

3. If the weight of the container falls within the range specified by the record, an automatic tare operation is
performed.

4. If the weight of the container is not within the range, the terminal will remain in gross mode and an error
message will display:

< Error

Container tare check
8 failed. Weight is not in

corresponding limits.

Figure 117: Confainer Tare Weight Outside Limits

Chain Tare

For analog (HSALC) scales only, when Chain Tare is enabled in sefup it is possible fo tare several times
sequentially. This is useful, for instance, when multiple items are fo be weighed, and are placed in a single
container. Each item can be compared to the same tare without resetting the loaded tare value.

In the following example of a chain fare operation, a box is placed on the scale, and items added to it with
packaging material between each item. The nef weight of each of the added items is to be determined:

1. Place the container on the scale and touch Tare (function key or softkey).

2. The package weight is stored as the tare weight, and the NET mode display appears showing zero weight.
The status line shows a fare value with the T indication.

3. Load the first item, and read or fransfer (print) the resulting weight.

4. Place packing material in the container, to profect the first item, and touch Tare again. The total scale
weight is saved as the new tfare value (the status line tare value increases), and the display shows zero
NET weight.

5. Load the second item, and read or transfer the resulting weight.
6. Repeat the process for the remaining packing materials and items.

Switching units

If a second unit is defined for the scale (in Setup af Scales > Scale < > ASM > Units), the display can be
switched from the primary fo the secondary unit and, if configured, a third unit, and back by touching {3 When
the unit is switched, the capacity and increment display is also updated to reflect the change.
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}.ln @ 03.Apr.121t;gg

Max 10kgd=20g

0.00 «

Figure 118: Example Primary Unit Display

}1. ('15 10:56
' 03.Apr.2023

Max 25Ibd =0.051b

0.00 i

Figure 119: Example Secondary Unit Display

When swifching units, the capacity of the converted units is dictafed by the original number of divisions estab-
lished in Capacity and Increments, in sefup. In some situations, this may reduce the capacity of the terminal
when converting fo second or third units.

« Possible units depend on the active scale and the local Weight and Measures regulations.

« When in Counting mode, use the o softkey fo switch the display between weight and number of
pieces.

PowerDeck scales
In the factory sefting, the device offers the display unit kg. A second and third display unit can be defined in the
Scales setup. Then it is possible fo switch between weight units.
1 Touch {d.
= The weight value is displayed in the second unit.
2 Touch £ again.
= The weight value is displayed in the third unit, if defined.
e Possible units depend on the active scale and the local Weight and Measures regulations.
« To switch between weight unit and number of pieces, use the o softkey.

Higher Resolution

The Higher Res. softkey €3 is used fo increase the selected weight display resolution by one additional digit.
For example, a weight display of 40.96 could increase by one additional digit to display as 40.958. To
indicate this increased resolution mode onscreen, the weight display digits turn orange, and an asterisk (*) is
shown at the end of the weight value.
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P 0937 |
.Q @ 26.Jan. 2024

K& 1 Max 66.50 kgd =1g

1.000.

PT | B | @

Preset Tare Tare Table Switch Units | Alibi Memory | Higher Re: ID Form Material Table Target

Figure 120: Standard Weight Display

@ 09:38
D 26Jan.2024

AR 1 -10.0°C / +40.0°C

1.0004:,

PT G NES |
Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. 1D Form Material Table Target
Figure 121: Higher Resolution Weight Display

Touch the Higher Res. softkey@ again fo return to normal weight display.

Approved Scales

When the terminal is programmed as Approved with the metrology switch (SW1-1) ON, the Higher Resolufion
mode is displayed for five seconds, then automatically returns to normal resolution. The transfer of data is
disabled when the weight is expanded and the terminal is approved.

Loading Alert (PowerDeck Platforms Only)

Figure 122: IND700 Displaying Loading Alert Screen

For accurate weighing, loads should be placed so that their center of gravity is near the geometric center of the
platform's load cell arrangement. This is particularly important in cases where the platform is flush with the
floor, and it is possible for partf of the load to overhand the platform and be supported by the floor, reducing the
measured weight.
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When a PowerDeck platform is connected fo the ferminal, an additional operational feature is available to assist
a user in centering the load on the platform. Once enabled and configured in Setup, whenever the center of
gravity of the load is outside of the user configured "OK" Zone, a Loading Alert screen is shown.

The Loading Alert displays as a rectangle representing the scale base, keyed with load cell numbers 1 through
4. The acceptable zone, relatfive to the cenfer of the scale, is indicated by a light blue box. If an off-cenfer
condition is defected, the loading alert displays with a dot indicating the quadrant experiencing the most
extreme deviation, and an arrow indicating the direction in which the load should be moved. The operafor
should visibly inspect the load to make sure it is completely on the platform and if not, fake steps to properly
center the load or container for which a weight is fo be captured.

Depending on how the Loading Alert feature is [configured » Page 1447, the loading alert display can either be

dismissed by

e Removing the load from the scale.

» Repositioning the load within the OK zone.

* Pressing the left arrow <. to dismiss the alert. This option may be suppressed, so that the alert will
continue to display unfil the load is removed or its position is corrected.

Two example screens are shown below, one for a square platform, one for a rectangular platform. In both
cases, the alert indicates the position of the load's center of gravity on the platform, and the direction in which
the load should be moved for accurate weighing.

3 Please check loading
or move container into
center to continue

Follow InStructhons:

)’

Plrase gl k Iuh:ilh; (T}
EoVE OO s ner o
CRn el 2O Conlinue,

Folow Ingrecsong:

=

Figure 124: Loading Alert Display, Rectangular Platform

2.2.7 Run Flat Operation (POWERCELL Only)

When Run Flat is configured in sefup (af [ASM > Maintenance > Predictive Maintenance » Page 138]), when a
load cell fails the system will femporarily compensate for the failure by estimating the total load on the scale
based on the readings provided by the good load cells. When Run Flaf is in operation, the weight display will
show E after ifs last digit, indicating that the displayed value is estimated, and an alert message will appear in
the Message area of the menu bar -- Scale n Build adjustment needed.
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2.2.8 Transfer/Export

To print the results of a weighing operation, or to export them to an external storage location, the following
must be true:

« An appropriate connection is defined in sefup
« Atemplate is associated with the connection
¢ The terminal is connected fo a printer or fo a network

If these conditions are fulfilled, touching the Transfer function key [Ed will cause the terminal to fransfer the infor-
mation to the configured destination. The function key surround will illuminate briefly, and a message Trans-
ferring will appear at upper right on the screen.

An alternative way to export weighing data is fo access the Alibi Memory Table [A). If this fable is enabled in
setup, a new record is created each fime a weighing operation is fransferred. The whole contents of this fable
can be transferred, or a selection of records defined by using the fable's Search Condition options.

Refer to [Transferring Data » Page 517 for further defails.

2.2.9 Setting Region, Time and Date

Location information for the terminal, including its dafe and time settings, are configured in the Terminal branch
of setup at [Region » Page 209]. Local preferences such as date order and time delimiter can be selected, in
addition fo sefting the current time and date. Time and date values can be set automatically if the terminal is
connected fo a network and Enable NTP Network Time Protocol is enabled.

2.2.10 Target Entry

Target operations are available only in IND700 terminals licensed to run the ProWorks Multi-Tools Applications.
Refer to the ProWorks Multi-Tools User's Manual (30753893), which details the configuration and operation
of the applications.

2.3 Applications

For details concerning IND700 applications, please refer to the IND700 ProWorks Multi-Tools User's Manual
(30753893), which details the configuration and operation of the applications.

2.3.1 ID Forms

ID forms are an easy way to associate a weighment with specific data such as Product, Batch, Lot No., efc.
The fields included in an ID Form are defined in setup at [Application > ID Form » Page 1877, where up to 10
values can be enabled and named. Data entered in an ID form and associated with a weighing operation is
available in the Transaction Table, and can be fransferred using a properly-configured output template.

The illustrafion below shows the ID Form which displays when the ID Form softkey 2 is touched. In this case,
five fields are configured.

e ID Form

Product
Batch
Lot No.
Shift

Operator ID

Figure 125: ID Form Example

78 | Operation IND700



IND700

Each field in the ID form can be configured either to preserve the previously entered value (useful when a series

of similar items is weighed, each with a different serial number, or when a series of weighments is associated
with a specific Operator), or to clear ifs value on each use.

Even if the previous value is preserved, touching the relevant field will allow if to be edited using either an
[alphanumeric entry or a numeric enfry keypad » Page 42]. The type of entry keypad displayed depends on
whether or not the field is configured (in sefup af [Application > ID Form > Edit ID » Page 187]) to accept only
numeric data.

. < Operator ID

i <>

Figure 126: Alphanumeric Entry to ID Form Field

Fields in the ID form can also be defined as Numeric Only, in cases where an alphanumeric character would
be an incorrect entry.
Transaction Table Display of ID Form Data

The Transaction Table records a number of ifems of data for each transaction; touch the screen and swipe left
to show further columns, and swipe down to scroll through the rows.

{  Transaction Table il
Gross Net Tare Preset User Material Mat
Weight Weight Weight Tare Unit Name ID Nam
4.38 1.70 2.68 iT; kg Admin 4 Sant
9.28 8.02 1.26 PT kg Admin 4 Sant
10.04 4.98 5.06 T kg Admin 4 Sani
9.88 5.02 4.86 T kg Admin 4 Sani
6.22 4.96 1.26 PT kg Admin . 4 Sant
6.26 5.00 1.26 PT kg Admin 4 Sant
0.00 0.00 0.00 kg Admin
0.00 0.00 0.00 kg Admin
3.2 3.2 0.0 kg Admin 1 Coo

L ] nn [P A rdmim 1 Fan

Figure 127: Transaction Table, Example of Initial View

<  Transaction Table il
Material Lot Operator
Name Product Batch No. Shift 1D APW pcs Ta
Sand 5 55 3 2 Halliday
Sand

Figure 128: Transaction Table Scrolled to Show ID Form Data
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3 Configuration

Overview

Access to the terminal's setup, or configuration, menus is provided in the drop-down list af top right of the
home screen

’51 @ 09:48
3 I
2/ 26Jan.2024

© Terminal >

2] Login/Logout
@} Enter Setup
App Screen View
() Power > k
2o g
B/G

PT | R | & | @ | B | B | &

Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. 1D Form Material Table Target

Max 66.59kgd=1g

Figure 129: Home Screen with Drop-Down Menu

Touch Enter Setup to access the menu sysfem. The main setup menu screen appears.
&L B ugm

Scales

Application

Terminal

Communication

Maintenance

Figure 130: Main Setup Menu
Touch any of the sefup ifems to access its options.

Data Entry in Configuration Screens

Various parameters require the entry of numeric or alphanumeric data. Refer fo [Data Entry » Page 42] for
details on how to enter data using the IND700 HMI.

Confirming or Reverting Changes

When changes are made to a configuration screen, in most instances the terminal offers an option fo confirm
the changes by selecting a check mark, or revert them by selecting a circular arrow.

O Vv

Figure 131: Change Confirmation/Reversion Icons

3.1 Scale Setup

The options available in the Scale Setup menu differ depending on the type of scale/s connected. The ferminal
supports one or two scales, which can be of a different types, and Sum Scale which totals the weight values
from all included scales. Scale Setup is performed using the ASM (Advanced Setup Mode) embedded in the
scale.
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The main Scale setup menu includes all installed Scale interfaces -- from 1 to 4 -- and Sum Scale. The image
below shows one scale interface installed.

= 14:34
a(.'l:\ @ 15,Jul.2025

Setup > Scales

Scales Scale 1
Application Sum Scale
Terminal General

Communication

Maintenance

Figure 132: Setup Menu - Scales

In each of the setup screens, access the previous screen by touching the leff arrow at upper leff of the screen, or
by touching the 'breadcrumbs' at the top of the menu. For example, in the screen shown above, touch Setup fo
close the Seale opfions view and return to the main sefup view.

Scale Compatibility

When the IND700 is connected fo an existing scale platform, a Service Technician should
refer fo the DSM to check the scale's compatibility with the ferminal. It may be necessary fo
update the Load Cell firmware. Refer to the [Scale Inferface » Page 275] and [Load Cell »
Page 278] update information under [Software Update » Page 271] in the Maintenance
setup section.

Rate

To configure the scale's Rate function, fouch the Rate menu block.
The initial view of the Rate screen shows the feature disabled.

< Rate

Enable Rate

Figure 133: Scale Rate Configuration, Disabled
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Touch Enable Rate fo enable the feafure. The screen will now display Rate parameters.

£ Rate

Enable Rate

Weight Unit
kg
Time Unit

Seconds

Measurement Period

0.5 seconds

Qutput Average Period (s)
5

Increment

|| 0.00 A
Preview
v 123.01 kg/s
Show in weight window
N

Figure 134: Scale Rate Configuration, Enabled

Options are:
Seconds, Minutes, Hours

Parameter Settomgs
Weight Unit Options are:
lg, kg, g, t, fon, 0z
Time Unit Depending on the type of material being handled, the

time unit for rate can range from seconds fo hours.

Measurement Period

unit defined..

Sets the period between measurements, in the time

Output Average Period (S)

which may vary slightly.

Defines the period over which rafe values are
averaged, to get a more accurate measure of rates

display on the Home and Application screens.

Increment Increment sets the precision of the displayed Rate
value. In the example below, the seffins is 0.00.
Options are:
000, 00, 0, -, 0.0-, 0.00, 0.000

Preview The Preview shows how the Rate as configured will

Show in weight window

The display of Rate in the Home and Application
windows can be enabled or disabled.

A& 1 Floor 1

RATE: 0.00 kg/s

O w0046
é?h @ 14.Jul.2025

Max 60 kgd=20g

© kg

B/G

PT | B | B

Preset Tare | Material Table | Tare Table

[a)

CRRISIERNS-

[Transaction Tall Higher Res 1D Form Apps Target

Figure 135: Home Screen with Rate Display Enabled
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3.1.2 General

The General screen provides a Timed Zero function which detects an out-of-zero condition and, once a time

IND700

limit has elapsed, issues an alarm

General

Timed Zero

30 Minutes

Discrete Output Scale 1

1/scale 1 alarm

Figure 136: Scale Setup - General
General (Timed Zero) Options

Parameter

Options

Timed Zero

Determines the length of time an out-of-zero condition
exists before an alarm is issued.

Discrete Output Scale €

Configures the triggered alarms output parameters

(see image below).

Touch the link icon in the Discrete Output Scale n field to display the parameters for the triggered alarm.

<{  General > Discrete output 1

ID Assignment

1 Zero required scale 1

Name

scale 1 alarm

Type
Scale Card

Location

Scale 1

Position

1

Figure 137: DIO Settings for Timed Zero Alarm
DIO Parameters for Timed Zero Alarm

Parameter Options

ID The ID number is automatically generated and cannot
be edited.

Name The Name of the alarm will appear in the Notfification
Cenfer and the Message Center, fo indicate where the
alarm has been generated.

Type In this case, Scale Card is the only option.

Location This drop-down lists includes all scale interfaces
insfalled in the terminal.

Position Position indicates where the scale interface is

physically mounted in the terminal. Options are:
1, 2 (for model 7); 1, 2, 3, 4 (for model 12)

Configuration
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3.1.3 High Speed Analog Load Cell

3.1.3.1 Scalen
The Scales branch of the setup menu displays options for each scale (1 or 2, depending on how many
inferfaces are installed in the ferminal) and for a Sum Scale.
When either scale is selected, two further options appear -- ASM, which provides access to all the scale config-
uration menus, and Log or Transfer, which determines whether and how each weighing operation is recorded
or exported.

é?i‘\ @ 15 u|1;l}g;

Setup > Scales > Scale 1

Scales Scale 1 ASM
Application Sum Scale Log or Transfer
Terminal General Rate

Communicatinn

Maintenance

Figure 138: Scale n Menus, HSALC

3.1.3.1.1 ASM
The ASM (Advanced Setup Mode) menu includes the items show in the figure below.
= A B sugon

.. > ASM
Metrology Units MinWeigh
Identification Zero Reset
A Tare Maintenance
Increments
Linearization & Fil
Calibration liter
Control mode Stability

Figure 139: HSALC ASM Menus

The ASM system runs on the scale interface, and is separate from the terminal's own firmware which runs on
the terminal's CPU.

Metrology
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The Metrology screen allows the configuration of per-scale approvals and GEO values, as well as lower and
upper operating Temperature Limits.

Metrology

Approval

Not approved

Not approved
OIML
NTEP

Lower temperature limit (°C)

10

Upper temperature limit (°C)

40

Figure 140: ASM - Metrology Screen
When an approval (OIML or NTEP) is selected, additional options are displayed.

<  Metrology

Approval Lower temperature limit (°C)
OIML N -10

Country Upper temperature limit (°C)
Global A4 40

GEOQ value
20

Verification Class
Class 1II b7

Verification Interval
e=d Y

Figure 141: Approval Options
In addition to the GEO and temperature values, an approval requires the selection of Country and Verification
Class values.

For both OIML and NTEP approvals, the Country options are Global [default], Argentina, Australia, Koreq,
Thailand, and the Verification Class options are Class Il, Class Ill, Class IlIL, Class IIIHD and Class Ilil.

When the device has been set as Approved -- either OIML or NTEP -- and the metrological sealing screw has
been installed, the fields on this page are greyed out and cannot be modified.

Identification

The Identification screen allows the scale's Serial number, Scale model and Scale location to be defined. An
additional Scale Identification field is provided. The entry made in this field will be displayed on the Home and
Application screens, to the right of the Scale Number shown af upper left. For analog scales, these fields are
opfional and must be completed manually. Touching any of the fields opens an alphanumeric entry dialog.
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< Identification

Serial number

Scale model

Scale location

Scale identification

Figure 142: Identification

EEI
AR 1 Floor 1

'@

Figure 143: Scale ID Displayed in Home Screen

HSALC: Capacity and Increments

Capacity and increment values allow the weighing parameters to be sef for each of a series of scale setups,
depending on the # ranges value:

e Single range

e 2 mulfi inferval

e 2 mulfi range

e 3 mulii inferval

e 3 mulfi range

The figure below shows the default Single range selected.

< Capacity & Increments
# ranges
Single range
Primary unit
kg
Capacity 1
500
Resolution 1

0.02

Blank over capacity (d)
5

Figure 144: ASM - Capacity and Increment

If either multi interval or mulfi range is selected, additional Capacity and Resolution fields display. The Blank
over capacity field is always displayed last, and defermines the weight value beyond scale capacity, measured
in display increments, at which the terminal blanks the weight display..
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< Capacity & Increments

# ranges Resolution 2

3 multi range v 0.02
Primary unit Capacity 3
kg v 250
Capacity 1 Resolution 3
20 0.1
Resolution 1 Blank over capacity (d)
0.01 v 5

Capacity 2
100

Figure 145: Capacity and Increment - Multi Range Example

If 3 multi interval or 3 multi range is selected, fwo sefs of capacity and resolution fields are added.

Multi-Range and Multi-Interval Weighing

Precision Scales and Multi-Range, Multi-Interval Operation

PBK and FPK scale platforms support both multi-range and multi-interval operation. PDB
platforms support only multi-range operation.

Both Multi-Range and Multi-Interval seftings allow a scale to be used fo weigh two or more types of item
which differ significantly in weight. Each weight range can have its own Capacity and Resolution values, so
that one scale can behave like two or more different scales.

For instance, for small and light items a finer resolution might be required, while for large and heavy items a
coarser resolution is adequate. The scale changes the display increment size af the Capacity points defined in
this screen. In the example shown here, three ranges are defined -- up fo 50 kg, up fo 500 kg, and up fo
1,000 kg.

< Capacity & Increments
# ranges Resolution 2
3 multi range A4 0.5 N
Primary unit Capacity 3
kg | | 1000
Capacity 1 Resolution 3
50 1 N
Resolution 1 Blank over capacity (d)
0.05 N 5
Capacity 2
500

Figure 146: Capacity & Increments Screen Configured for Three Ranges

In Multi-Range mode, the range currently in use appears on screen beside the weigh mode (B/G or Net)
indicafor -- >11l<, >l2l<, >I3l< -- depending on how many ranges are configured.

The increment sizes, or Resolutions, are set fo 0.01, 0.5 and 1, respectively. Thus, for ifems weighing up to
50 kg, the weight display will increment in 100 gram steps; befween 50 kg and 500 kg of scale weight, the
display will increment in half-kilogram steps; and for items weighing over 500 kg the resolution is reduced by a
factor of 10 compared fo the lowest range, and increases in 1 kg sfeps.

There is one significant difference between Multi-Range and Multi-Interval configurations, affecting how the
terminal behaves as scale weight is reduced:

* Multi-Range: When scale weight is reduced, the terminal continues to display the Resolution size for the
largest configured range.
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e Multi-Interval: When scale weight is reduced, the display conforms to the configured intervals and shows
Resolution sizes corresponding to current scale weight

In both cases, the terminal resets the display to the Resolution fo the lowest range when the weight falls fo

Zero.

Display

The two modes also differ in the way the IND700 indicates the capacity and increment seftings for the

displayed scale.

e Multi-Range: The ferminal's metrology line cycles through a display of both capacity and increment for each
Configured ronge in sequence -- W1 Max50kgd=01kg ~W2Max500kgd=05kg =~ W3Max1td=1kg

e Multi-Interval: The terminal's metrology line cycles through a display of capacities for each configured
range, and then increments for each -- Maxs0/500/1¢  d=2/500/1000 g
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Example

The following diagram illustrafes the distinction between Multi-Range and Multi-Interval modes, showing the
behavior of the terminal configured as in the screen shown above, during one weighing operation:

Scale Status Display Status

Figure 147: Multi-Range vs Mulfi-Interval

Resolution,
Multi-Range

0.002 kg
>| 1<

0.002 kg
>|1l<

0.05 kg
>[2]<

1 kg
>|3l<

0.002 kg

>|21<

0.002 kg
>|1l<

Resolution,
Multi-Interval

0.002 kg

0.002 kg

0.05kg

1 kg

1 kg

0.002 kg

Scales with Multiple Ranges or Multiple Intervals have specific Approval

requirements.
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HSALC: Linearization and Calibration

The Linearization and Calibration menu offers four sub-menus.

... > ASM > Linearization & Calibration

Metrology Units MinWeigh Calibration
Identification Zero Reset Span adjustment
SR Tare Maintenance Step calibration
Increments

Linearization &

Filter CalFree
Calibration

Control mode Stability

Figure 148: ASM - Linearization and Calibration

Calibration

The seftings available in this screen will change depending on the [Linearity » Page 91] setting selected. The
default screen is shown below, and then a screen showing additional fields used to capture linearization.

< calibration

Calibration unit
kg

Linearity Adjustment
Disabled

Test load 1
500

Gain jumper

2 mvv

CALIBRATE

Figure 149: ASM - Linearization - Calibration

If [Linearity Adjustment » Page 91] is enabled (i.e., notf set to Disabled), additional Test load fields (2, 3 and
4, depending on the number of points selected) display. Note that when hysteresis is specified, after the
highpoint is captured the calibration sequence includes unloading the scale to an intermediate test weight.

<  calibration
Calibration unit Test load 4
kg v 250
Linearity Adjustment Gain jumper
5 point with hysteresis N 2 mviv

Test load 1

1

Test load 2

10

Test load 3

100 CALIBRATE

Figure 150: Calibration with Five-Point Linearization and Hysteresis

The Calibration unit is defermined by the Primary Unit selecfed in [Capacity and Increments » Page 121].
The [Gain Jumper » Page 92] setting applies only to analog load cells
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When the linearity settings have been entered, touch the CALIBRATE bution to begin the calibration sequence.
The sequence prompts for the placement and removal of the various test weights, depending on the Linearity
Adjustment selected. A message will indicafe when a calibrafion is missed.

Calibrate

Error
Failed to execute PROC Command: PROC E 114 "Insufficient test load"

X

Figure 151: Calibration Error Message

When the calibration sequence is completed successfully, a message displays:

Calibrate

Finished

Figure 152: Calibration Complete Message

Linearity

Linearity Adjustment is used to adjust the maximum deviation between the scale indication and the linear value

from zero to max. capacity. linearity adjustment with hysteresis compensation is recommended for better
linearity in applications involving discharge or loss-in-weight,

The menu seftings noted affect the calibration steps.

Disabled [default] Use only zero and one span point (test load #1)

3 point Use zero, midpoint (fest load #1), and highpoint (fest load #2)

4 point Use zero, lowpoint (fest load #1), midpoint (fest load #2), and highpoint
(fest load #3)

5 point Use zero, lowpoint (fest load #1), midpoint (fest load #2), mid-highpoint
(fest load #3), and highpoint (fest load #4)

3 point with Hysteresis Use zero, midpoint (fest load #1), and highpoint (fest load #2), then unload
to midpoint (fest load #1)

4 point with Hysteresis Use zero, lowpoint (fest load #1), midpoint (test load #2), and highpoint
(fest load #3), then unload fo midpoint (test load #2) and lowpoint (fest load
#1)

5 point with Hysteresis Use zero, lowpoint (fest load #1), midpoint (fest load #2), mid-highpoint
(fest load #3), and highpoint (fest load #4), then unload to mid-highpoint
(fest load #3), midpoint (fest load #2), and lowpoint (fest load #1)
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Analog Gain Jumper

The analog gain jumper setting on the Main PCB can be either 2 mV/V or 3 mV/V. The terminal is shipped from
the factory in the 3 mv/V seffing. In order for the CalFreel feature to operate properly, the selected parameter
must indicafe the physical position of the jumper on the Main board.

The jumper settings are:
Analog Gain Jumper Settings

2 mV\/ Jumper installed on both pins ‘
3 mV/ [default] Jumper installed on only one pin \

Span Adjustment

The Span adjustment screen permits the scale's whole span to be defined. The units used for the parameters
enfered here are the Primary Unit sef on the Capacity and Increments page.

<  Span adjustment

Test weight (kg)
60

Displayed weight (kg)
60

Control mode

0.000 kg

ADJUST

Figure 153: ASM - Linearization and Calibration - Span Adjust

Enter the calibrafion fest weight value in the Test weight field.

Enter the current weight reading from the scale, as shown in the Control mode display, in this field. The
terminal will account for any difference between the fest weight and the weight shown on screen, and adjust the
displayed weight accordingly. Perform this adjustment before carrying out the linearity adjustments from the
[Calibration » Page 90] screen.

Note that the Control mode field is read-only, and displays the current scale weight.

To perform the span adjustment, place the test weight on the scale and fouch Adjust. A message will appear fo
indicate that the adjustment is complete, and the Control mode will change to reflect the offset, displaying a
corrected value.

See also
¢ HSALC: Capacity and Increments » Page 86
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Step Calibration

L Step calibration

Test load (kg)

2

CALIBRATE

Figure 154: Step Calibration Screen

Step Calibration provides a way fo calibrate fanks and hoppers with a "build up" method. In this procedure, the
same amount of weight is added fo the scale af each step of the procdure untfil the weight specified in the Test
Load field is reached.

The Test load units are defermined by Primary Unit set in [Capacity and Increments » Page 121].

Step Calibration Procedure

Note that test weight values in the images below are for illustration only, and do not correspond to values for a
typical POWERCELL system.

The procedure involves placing and removing test weights of the size specified, and filling the tank or hopper to
intermediate target weights. The sequence is prompted by messages on-screen, as shown here. When a
prompted action is complete, touch the next icon to :

1 Set the zero value. At each screen, the procedure can be continued P, or cancelled X fo complete the
procedure at the current step. Note that the current scale weight is shown as the first line in the screen.

Calibrate

0.00 kg
Empty scale

2 Place the first test load.

Calibrate

Testload 2.00 kg
Place test load
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3 Remove the first test load. The current scale weight is displayed again.

Calibrate

2.00kg
Target 2.00kg
Remove test load
Fill to target

X »

4 Fill the vessel to the indicated farget.

Calibrate

2.00 kg
Target 4.00 kg
Testload 2.00 kg
Place test load

X

Follow the steps indicated until the required span is reached, then touch the X (close) button. The Step
calibration screen will display.

CalFree

The terminal provides a method fo calibrate a scale without using fest weights. This is based on manual entry
of capacity and performance data from the load cell or load cell platform. This method of calibration can be
used for initial check-out and festing of systems or when a large structure is used as the weighing vessel and it
is not possible fo apply test weights fo the structure.

The analog gain jumper (refer to [Calibration » Page 907]) must be set correctly
for the cell type in use, or CalFree will not produce an accurate result.

< CalFree

Cell capacity
0

Cell unit
kg

Rated cell output (mV/V)
3

Use zero

Calibrated

CALIBRATE

Figure 155: ASM - Linearization and Calibration - CalFree

For Cell capacity, the fotal load cell capacity should be entered. For example, for a tank with three 5000 kg
cells, cell capacity would be 3 x 5000, or 15000 kg.

If Use zero is sef to Estimated, enter an estimated value. The value entered here will be included in the
terminal's calculation for analog load cell saturation. If this value is unknown, leave this field blank. This
preload value is used only fo determine overload conditions and is not used as a zero reference point.
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Touch the CALIBRATE button to perform the procedure. If calibration succeeds, a message will appear o
indicate this. Otherwise, an error message will display.

See also

& HSALC: Linearization and Calibration » Page 90

Control Mode

The Control Mode screen shows the current scale weight. This is useful for viewing the weight reading during
setup and diagnostics without leaving the setup menu system.

<  Control mode

0.000 kg

Figure 156: Confrol Mode Screen
HSALC: Units

Units
Secondary unit
None
Host / auxiliary unit
kg

Startup unit

Primary

Figure 157: ASM - Units
Units Settings

Parameter Options

Function

Secondary unit |g, kg, 1, Ib, oz, fon

Sets the Secondary unit.

Host / auxiliary |g, kg, t, Ib, oz, ton
unit

Sets unit type for Host / auxiliary unit.

Startup unit Primary [default], Restart

Determines whether, when the terminal is restarted, the units
revert to the Primary unit defined in [Capacity and Increments »
Page 1217, or remain as modified by the selection made from

the home screen by touching Switch Units {4
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HSALC: Zero

<

Zero

Startup zero

Use last

Auto zero tracking

On

Auto zero range (d)

0.5

Blank under zero (d)

20

Push button zero

On

Figure 158: ASM - Zero
Zero Settings

Push button zero -range (%)

2

Push button zero +range (%)

2

SET ZERO

Parameter

Options

Function

Startup zero

Use last [default], Use
calibrated, Capture new

Determines how the scale defines zero when it is
restarted.

Power up zero -range (%)

Opens a numeric entry
dialog; default value is
2%

Power up zero +range

(%)

Opens a numeric entry
dialog; default value is
18%

These parameters appear if Startup zero is set fo
Capture new.

Values define the range within which the ferminal, af
power up, will automatically zero the scale. If scale
weight is outside the configured range, Startup zero
will not execute.

Auto zero tracking

On [default], Off

Auto zero tracking is an automatic zero maintenance
function which fracks zero when the scale is empty,
and compensates for conditions such as terminal or
load cell drift, or slow debris buildup on a scale
platform.

Auto zero range (d)

Opens a numeric entry
dialog; default value is 0.5

Parameter appears if Auto zero tracking is set to On.

Defermines the range, in scale display units, within
which Auto zero will be applied.

Blank under zero (d)

Opens a numeric entry
dialog; default value is 20

Determines the sub-zero point, in scale display units,
at which the terminal will blank its weight display.
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Push button zero

On [default], Off

\When On, the ferminal's zero softkey can be used to
set the ferminal to zero, if the current scale weight
value is within the range defined by the -range and
+range values.

The push button zero softkey is visible if at least one
connected scale has push button zero active. If push
button zero is nof activated for a scale, the Zero
softkey will display greyed out when that scale is
selected.

If the Zero scale function key is touched when Push
button zero is off for the selected scale, an error
message will display indicating that Push button Zero
is disabled.

Push button zero -range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.

Push Button zero +range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.

HSALC: Tare

The fields visible in this screen vary depending on the seftings for Auto tare mode, Auto tare reset threshold
and Auto clear tare. Each of these requires additional parameter settings

{ Tare

Startup tare

Use last

Auto tare mode

Off

Chain tare mode

Off

Auto clear tare

On

Auto clear tare threshold (kg)

0.5

Figure 159: Tare Settings

Push button tare

On

Keyboard tare

Oon

Clear with zero

On

Parameter

Options

Function

Startup tare

Use last [default], Clear

Defermines whether an existing tare value is preserved
at system restart, or cleared.

Auto tare mode

Off [default], On

Determines whether the terminal will automatically
take a fare once the Auto tare threshold value is
exceeded. An aufo tare is cleared once the weight
value falls below the Auto tare reset threshold.

Auto fare threshold (kg)

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Auto tare reset threshold
(kg)

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.
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Chain tare mode Off [default], On When Chain tare mode is ON, if is possible fo take
multiple tares in sequence by fouching the Tare softkey
— for example, when filling multiple similar containers
on a pallet. Once one container is filled, touch Tare
again fo reset the scale fo Nef zero.

Auto clear tare Off [default], On Determines whether the terminal will preserve a fare
value when scale weight returns to zero, or aufomat-
ically clear it when the weight value falls below the
Auto clear tare threshold.

Aufo clear fare threshold | Displays a numeric entry | Refer fo Auto clear tare, above.
(kg(|dialog. Default is O.

Pushbutton tare On [default], Off When Push button tare is On, the Tare softkey on the
home screen is functional. Touch this softkey to create
a tare value based on an empty container on the
scale. The ferminal then shows a zero weight and
indicates that it is Net mode. When the container is
filled, the terminal shows the net weight of the
confents.

The Tare softkey is visible if af least one connected
scale has push button fare active. If push butfon tare
is not activated for a scale, the Tare softkey will
display greyed out when that scale is selected.

If the Tare scale function key is touched when Push
button fare is off for the selected scale, an error
message will display indicating that Push button Tare
is disabled.

Keyboard tare On [default], Off When Keyboard tare is On, the known value for the
empty weight of a confainer (fare) can be enfered
manually. The terminal will then display the net weight
of the contents of the container. Keyboard tares are
automatically rounded to the closest display division.

Clear with zero On [default], Off When On, a scale zero command, issued by a softkey
or any other input, will clear any stored tare value.

HSALC: Filter

< Filter

Low pass filter
Medium

Stability filter

Off

Figure 160: Filter Settings
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The IND700 has a low-pass, multi-pole vibration filter that can be set for several conditions when using analog
load cells. The heavier the filtering, the slower the display settling time will be.

Parameter Options Function

Low pass filter Very light, Light, Medium | Defermines how strongly the low pass filter is applied.
[default], Heavy, Very The low pass frequency is the frequency above which
heavy all disturbances are filtered out. The heavier the low

pass filter, the better the disturbance rejection, but the
longer the settling fime required for the scale.

Stability filter Off [default], On The stability filter works in conjunction with the
standard low pass filter to provide a more stable final
weight reading. The stability filter should only be used
in transaction weighing applications, since the
nonlinear action of the filter switching may cause
inaccurate cufoffs in batching or filling applications.
Stability settings are made on the [Stability »

Page 134] screen.

Stability

< Stability

Motion range (d)

0.5

No motion interval (seconds)

0.3

Timeout (seconds)

3

Figure 161: HSALC Stability

The Stability parameters defermine how the terminal responds to mofion on the scale.
HSALC Stability Parameters
Parameter Function

Motion range (d) Sets the motion range to the weight value in divisions that the weight is permitted
fo fluctuate and still have a no-motion condition. Values from 0.1 fo 99.9 are
possible with the default value being 1.0 d.

No motion interval The no motion interval defines the amount of time in seconds that the scale weight
(seconds) must be within the motion range to have a no-motion condition. Values from 0.0
(motion defection disabled) to 2.0 are possible, the default value being 0.3
seconds. A shorter interval means that a no-motion condition is more likely, but

may make weight measurement less precise.
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Parameter

Function

Timeout (seconds)

Defines the period in seconds affer which the terminal stops attempting to perform
a function that requires a no-motion condition (such as a zero, fare or transfer
command) and aborts the function. This timeout is used regardless of the source
of the command such as the keypad, discrete input, Industrial Network or SICS.
Values from O to 99 are possible with the default value being 3 seconds. A
smaller value means that less time will be used to check for no-motion before
aborting a command. When a value of O is entered, there must be no-motion
when a command is given or it will fail immediately. A value of 99 is a special
condition which permits the terminal to wait indefinitely for a no-motion condition -
a command would never be aborfed.

MinWeigh

Certain industries such as pharmaceuticals and food processing require a guarantee that the weighing
equipment selected for a particular measurement is adequate for the task. One way fo ensure that appropriate
weighing equipment is selected is by the creation and use of a minimum weighment value (MinWeigh), below
which a particular piece of weighing equipment cannot be used.

The MinWeigh function compares the current weight with the programmed MinWeigh value. In the configuration
screen shown below, MinWeigh has been enabled and its value set to T kg.

<

MinWeigh

MinWeigh mode

On

MinWeigh value (kg)

1

Figure 162: MinWeigh Setup Screen

Parameter

Options

Function

MinWeigh
Mode

Off

On [default], |If the displayed weight (B/G or NET) is greater than or equal to the

MinWeigh value, the MinWeigh symbol appears below the weight display,
to the right of the tare display. All terminal functions behave normally.

KA 2 Max10kgd=20g

116 kg

When the absolufe value of the nef weight is less than the MinWeigh value,
the MinWeigh symbol flashes in red & .
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MinWeigh Displays a This field displays if MinWeigh mode is sef to On. The unit is the default unit
value (kg) numeric enfry | set

dialog. Default

value is 0
Reset

Scale Branch Reset

Note that this Reset function refers only fo parameters configured in the currently selected
setup branch. For general Terminal reset options, refer fo [Reset » Page 284].

Figure 163: Scale Reset Options

RESET CALIBRATION
DATA

RESET SETTINGS
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This screen allows the user fo reset either calibration data or settings. If seffings is selected, calibrafion data are
preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 164: Reset Confirmation Dialog

See also
& Reset » Page 284

HSALC: Maintenance

— o) 2325
— By 25.Aug.2021

ASM > Maintenance

Metrology Units MinWeigh Cell counts
Identification Zero Reset Calibration values
c .

el Tare Maintenance
Increments

Linearization &

" . Filter
Calibration

Control mode Stability

Figure 165: ASM - Maintenance Menu
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Touch the Cell counts buitfon to display a screen showing the scale's current reading in raw counts.

< Cell counts

Node Cell counts
1 209585

Figure 166: Cell Counts Screen

Touch the Calibration Values button to display raw count values for a variety of calibration seftings. The
number of load fields displayed will vary depending on the Linearity Adjustment selected af [Linearization and
Calibration > Calibration » Page 901].

< Calibration values

Zero
1253
Load 1 (kg)
60000

Counts 1

9433825

Figure 167: Calibrafion Values Screen

When touched, each of the fields displayed on this screen opens a numeric entry dialog. The values displayed
in the fields represent current settings; these seftings can be over-ridden by direct entry.

3.1.3.1.2 Log or Transfer

The Log or Transfer menu sets the conditions which determine how and when a demand output is friggered.
Normal demand mode transfer occurs whenever a transfer request is made , depending on the options selected
here, and providing the scale is within the acceptable range configured in [Stability » Page 134], and the
weight is above gross zero (a negative gross weight will not be printed).

Data is sent to:

* Interfaces for which the Connection has been defined as Transfer

e The Alibi Table

* The Transaction Table

Weight values shown on this screen are gross weights in primary units.
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When Log or Transfer is selected from the Scale n menu options, a default configuration screen appears, with

no options selected.

<

Log or Transfer

Minimum Weight (kg)

0

Interlock

Auto Transfer

Figure 168: Log or Transfer Screen,

___
Default View

Additional fields appear depending on the initial selections for Interlock and Auto Transfer. The follow illus-

tfrafion shows the menu with all

options selected.

<

Log or Transfer

Minimum Weight (kg)
0

Interlock

Auto Transfer

Reset Trigger

Threshold Weight

Motion Check

Auto Transfer

() With first stable value

":,‘ After last stable value

Active

'.:) Only if scale is selected
( i‘ Always

“  Reset Threshold (kg)

0

Figure 169: Log or Transfer, All Options Selected

Note that some of the Auto Transfer and Active sub-sections appear only if Auto Transfer is enabled.

Log or Transfer Options

Option Settings

Minimum Weight (k@) This value defermines the minimum scale weight required to trigger the
Interlock and/or Aufo Transfer actions. The weight unit for this and the other
fields on this screen is defermined by the Primary Unit set in ASM at Capacity
and Increments.

Interlock When enabled, the Interlock option responds to scale data fo determine when

a log action is performed. This prevents repeat logging of the same weighing
operation.

When enabled, this inferlock requires that the live weight reading be reset
according fo the Reset Trigger parameter sefting (see below). The live weight
must then settle fo a weight greafer than the Minimum Weight value (see
above) before the terminal will respond fo the next log or transfer request.

If Interlock is enabled, or Auto

Transfer and With first stable value is selected

Resef Trigger

The Reset Trigger action can be performed in response to Threshold Weight
[default] or Deviation This trigger is defined either by an absolute value
(Threshold Weight) or by a minimum change in weight (Deviation).

If either Interlock or Auto Transfer is enabled

Reset Threshold (kg) or Resef
Deviatfion (kg)

The weight value which triggers a reset and indicafes the sfart of a new
weighing operation and a new log entry.
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Option

Seftings

Auto Transfer

When enabled, Auto Transfer causes data about each weighing operation to be
sent fo the destination defined in the [Communication » Page 226] section of
setup, depending on the parameters selected in Auto Transfer and Active.

If Auto Transfer is Enabled

Auto Transfer

When enabled, the trigger conditions defined by the Interlock settings will
automatically export data about each weighing operation either With first
stable value or After last stable value.

With first stable value: dafa is sent when the first stable weight is captured,
even if the weight changes afterward. This selection would typically be used for
static weighing.

After last stable value: dafa is sent based on the last stable weight captured.
This selection might be used for manual filling, where the scale weight will
briefly be unstable affer the last material is added.

This selection determines whether the Reset Trigger option appears.

Active

The options fo activate the Aufo Transfer function are Only if scale is selected
and Always.

Motion Check

When enabled, the Motion Check prevents the interlock from triggering a log or
transfer action until scale weight display is within the parameters defined as
stable af [ASM > Stability » Page 134].

See also

& Communication Setup » Page 226

& Stability » Page 134

3.1.4 POWERCELL

3.1.4.1 Scalen

The Scales branch of the setup menu displays options for each scale (1 or 2, depending on how many
interfaces are installed in the terminal) and for a Sum Scale.

When either scale is selected, two further options appear -- ASM, which provides access fo all the scale config-
uration menus, and Log or Transfer, which determines whether and how each weighing operation is recorded
or exported. For PowerDeck scale systems, two additional items appear: Loading Alert and Leveling

IND700

Guidance.

Scales

Application

Terminal

Communication

Maintenance

.j.:;. @ 15.May.12t:;:§

Setup > Scales > Scale 1

Scale 1 ASM
Sum Scale Log or Transfer
Loading Alert

Leveling Guidance

Figure 170: Scale n Menus, POWERCELL
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3.1.4.1.1 ASM
The POWERCELL ASM screen shows the following menus:

L B iswayamn

... > ASM

Metrology Control mode Stability
Identification Units MinWeigh
Load Cell Zero Reset

| Capadity & Tare Maintenance
Increments

| Linearization & Filter
| Calibration
|

Figure 171: POWERCELL ASM Menus

The ASM system runs on the scale interface, and is separate from the terminal's own firmware which runs on its
CPU.

Metrology

The Metrology screen allows the configuration of per-scale approvals and GEO values, as well as lower and
upper operating Temperature Limits.

Metrology

Approval

Not approved

Not approved
OIML
NTEP

Lower temperature limit (°C)

-10

Upper temperature limit (°C)

40

Figure 172: ASM - Metrology Screen
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When an approval (OIML or NTEP) is selected, additional options are displayed.

{  Metrology

Approval Lower temperature limit (°C)

OIML -10

Country Upper temperature limit (°C)

Global 40

GEO value

16

Verification Class

Class III

Verification Interval

e=d

Figure 173: Approval Options

In addition to the GEO and temperature values, an approval requires the selection of Country and Verification
values.

For both OIML and NTEP approvals, the Country options are Global [default], Argentina, Australia, Koreq,
Thailand, and the Verification Class options are Class Il, Class Ill, Class IlIL, Class IIIHD and Class IIl.

When the device has been set as Approved -- either OIML or NTEP -- and the metrological sealing screw has
been installed, the fields on this page are greyed out and cannof be modified.

Identification

The Identification screen allows the scale's Serial number, Scale model and Scale location to be defined. It
also provides an additional Scale Identification field. For analog scales, these fields are optional and must be
completed manually. Touching any of the fields opens an alphanumeric entry dialog.

< Identification

Serial number

Scale model

Scale location

Scale identification

Figure 174: Identification
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Load Cell

p da 13:59
O 09.5ep.2021

... > ASM > Load Cell

Metrology Control mode Stability System
|
Identification Units MinWeigh Single cell address
Load Cell Zero Reset Manual address |
Capacity & . . .
pacity Tare Maintenance Shift adjust scale
Increments
Linearization & . Shift adjust a cell/
. . Filter .
{  Calibration pair |

-
Figure 175: Load Cell Menu

The POWERCELL Load Cell menu

includes the following five items:

System

< System
Application
Vehicle
Number of load cells

4

Address range

01-24

Number of logical scales

1

Figure 176: POWERCELL Load Cell - System

The Application options are Floor, Tank / Hopper and Vehicle.

Touch the Number of load cells field fo display a numeric entry dialog.
Available Address ranges are 01-24, 31-54, 61-84 and 91-114.

By default the Number of logical scales is 1. However, when using a POWERCELL multi-scale interface, from
1 to 4 logical scales can be configured. Refer to [POWERCELL Multi-Scale Capability » Page 116].
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Single cell address

{ Single cell address

0

Value is out of range 1-114.

FIND CELL

Figure 177: POWERCELL - Single cell address

When the Single cell address screen is first displayed, the Serial number and Node fields appear as above.
Touch FIND CELL fo start the addressing process. A confirmation dialog will display, indicating that the search
has completed; touch +/ to return to the Single cell address screen, which will now display a node number
and the serial number of the cell at that node.

Single cell address

Serial number

728647E549

Node

1

Figure 178: POWERCELL - Single cell address, cell found

Single Cell Address - detail

Single cell addressing can be performed manually or automatically af power-up, as required. In either case, the
procedure cannot be performed if the terminal is in Weights and Measures Approved mode.
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Manual Cell Address

e Manual address

Serial number

DISCOVER CELLS

Figure 179: POWERCELL - Manual Address Screen

The Manual Address screen initially displays the connected cells' Serial numbers and Node numbers. Touch
the DISCOVER CELLS button to begin discovery. If discovery is successful, a confirmation dialog will appear.

Discover cells

Finished

Figure 180: Cell Discovery Confirmation Dialog

Touch the check mark acknowledge the confirmation. The original screen will reappear with an EDIT ./ button

in place of the DISCOVER CELLS button.

< Manual address

Figure 181: Cells Discovered
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Serial number Node
7290310478 1
729027H521 2
728913D525 3
729030Q752 4
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Node Address Editing
Touch a row to highlight a cell.

& Manual address

Serial number Node
729031L478 1
729027H521 2
728913D525 3
729030Q752 4

Figure 182: Cells Discovered, Node Selected
With the cell highlighted, touch the EDIT butfon to display the address Edit screen.

< Edit

729031L478

Node

1

Figure 183: Cell Address Edit Dialog
Touch the Node field to display a numeric keypad. Enter the desired node address.

Figure 184: Node Address Entry
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Finally, fouch the Back arrow at upper leff fo return fo the Manual address screen. In the example below, Node
1 from the discovery step above has been readdressed as Node 4, and the original Node 4 is now Node 1.

<  Manual address

Serial number Node
729030Q752 1
729027H521 2
728913D525 3
729031L478 4

Figure 185: Node 1 Readdressed as Node 4

Manual address

< Manual address

Serial number
728647E549
7286485108
728647G122

728647F845

DISCOVER CELLS

Figure 186: POWERCELL - Manual address
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The Manual address screen initially displays the connected cells' Serial numbers and Node numbers. Touch a
row fo highlight it:

< Manual address

Serial number
728647E549
7286485108
728647G122
728647F845

DISCOVER CELLS

Figure 187: POWERCELL - Manual address, node selected

Touch the DISCOVER CELLS butfon to begin discovery. A confirmation dialog will appear; when it is dismissed,
the original screen reappears with an edit butfon in place of the DISCOVER CELLS button.

< Manual address

Serial number
728647E549
7286485108
728647G122

728647F845

Figure 188: POWERCELL - Manual address, cells discovered
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Touch the Edit butfon # fo display the screen shown below. Here, the Node number can be changed by
touching the field to display a numeric entry dialog.

< Edit

7286485108

Node

2

Figure 189: POWERCELL - Manual address, edit screen

Shift adjust scale

Small mismatches in mechanical and electronic gain of the load sensing paths can cause the same test weight
to produce slightly different readings, depending on the location of the test weight on the scale. The IND700
provides two types of adjustment — adjustment by individual cells or adjustment by pairs of cells.

The Shift Adjust by Cell or Pair parametfer is preset to Cell and cannot be changed when a single load cell is
used.

Adjust by Cell

Adjustment by Cell adds a factor fo each load cell output fo compensate for the slight differences between them.
The scale will then output the same weight value regardless of the physical location of the weight on the scale.
Adjust by Pair

Adjustment by Pair ensures a constant reading from the scale regardless of where the load is placed on the
long axis between pairs of cells — for instance, in vehicle weighing applications. Before beginning the shift
adjustment procedure, select whether the adjustment will be done by cell or by pair. The procedure for shift
adjusting by pair of cells is listed below. The procedure for shift adjusting by individual cell follows the same
sequence, buf cells are read and adjusted one at a time.

< Shift adjust scale

Shift adjust by

Cell

ADJUST

Figure 190: POWERCELL - Shifft adjust scale
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From the Shift adjust by drop-down list, select either Cell or Pair, then touch the Adjust button fo begin the

process. The Adjust dialog will appear.

Adjust

X »

Figure 191: Shift Adjust - Ready fo Execute

Touch P> to start the process, or X to return to the Shift adjust scale screen.

The dialog will indicate the progress of the capture and, when the process has completed, the dialog will
confirm capture.

Adjust

Capture complete

X »

Figure 192: Shift Adjust, Capture Complete

Touch X to return fo the Shift adjust scale screen.

See also
& Shift adjust a cell/pair » Page 115

Shift adjust a cell/pair

<{  Shift adjust a cell/pair

Adjust cell/pair
1

2

3

ADJUST

Figure 193: POWERCELL - Shift Adjust a Cell
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The illustration above shows the options available in the Adjust cell/pair dropdown list on this page, when
[Shiff adjust scale » Page 114] is set to Cell.

< Shift values

Node Coefficient
1&2 0.990182
384 0.996145

/

»

Figure 194: POWERCELL - Shift Adjust a Pair

When [Shift adjust scale » Page 114] is set to Pair, the opfions become 1&2 and 3&4.

Once an option is selected from the dropdown list, fouch ADJUST to execute the adjustment. A confirmation
dialog will appear:

Adjust

X »

Figure 195: Shift Adjust Confirmation Dialog
Once the process has completed, touch X to return fo the Shift adjust a cell/pair screen.

POWERCELL Multi-Scale Capability

The IND700 POWERCELL interface can support a network of up to 14 load cells (up fo 24, with an external
power supply). These load cells can be grouped into 2, 3, 4 or four logical scales. The number of logical
scales is configured on the [Load Cells > System » Page 108] page. In the examples shown in this section, a
simple four-cell network is used to illustrafe this functionality.

Logical Scale Configuration

When a single, multi-cell scale is divided into multiple logical scales, each logical scale will
show the same configuration paramefers as the original scale. However, each logical scale
can be configured separately as required.
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To confirm that the terminal has this capability, visit the [Terminal Information » Page 44] screen.

{  Terminal Information

Slot Description

Part Number

Software Version

Slot 1 MultiscalePowercell (Powercell3)

0s Windows 10 1809 IoT Enterprise
BIOS Kontron

APP Supervisor

APP Client.MTApp

APP Engine

Legal www.mt.com/legal

30726003

V4.0.12

V2.6.30/2024-01-16 1
MTsXA4R_1.1_BETA1:
5.41.150-freeze.2+02
5.41.150-freeze.2+02
5.41.150-freeze.2+02

Figure 196: Terminal Information Showing Multi-Scale Capability

Configuring the System with Multiple Logical Scales

Before mulfiple scales are configured, the POWERCELL Scale Setup menu looks like this, with a single scale:

B

Setup > Scales > Scale 1

Communication

Maintenance

Scales Scale 1
Application Sum Scale
Terminal

ASM

Log or Transfer

08:09

21.5ep.2023

Figure 197: Scale Sefup Menu
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To create a system with multiple logical scales, the first step is fo visit Scale 1 > ASM > Load Cell > Sysfem,
and select 4 Logical scales.

< System

Application
Wehicle

Number of load cells
4

Address range
01-24

Number of logical scales

4

Figure 198: Load Cell System Screen, 4 Logical Scales Selected

Note that the Address range parameter indicates the addresses that can be assigned to this scale's load cells.
Once multiple logical scales have been configured, each scale's Load Cell > System page will offer a different
range of addresses.

Touching the BACK arrow at upper left will cause the terminal to display a message:

< Warning

Number of scales
A changed. Restart

required.

Figure 199: Reboot Warning
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The ferminal will aufomatically reboot. Once this process has completed the scale sefup menu will show four
scales:

ré?h @ :1SEPE§-:}:I£§

Setup > Scales
I —————
Scales Scale 1
Application Scale 2
Terminal Scale 3
Communication Scale 4
Maintenance Sum Scale

Figure 200: Scale Setup with Four Logical Scales Displayed
The [Sum Scale » Page 1197 can now be configured fo display any or all of these logical scales.

Sum Scale in a System with Multiple Logical Scales

When multiple logical scales are configured, this is reflected in the options in the Sum Scale Settings page:

{  Settings

Sum Component Scales

Enable Sum Scale
Scale 1

Scale ldentification Scale 2

Vehicle
Scale 3

Sum Type

Display Weights Scale 4

High Resolution Weights

Figure 201: Sum Scale Seftings with Multiple Logical Scales

Configuration

119



As usual, a descriptive name can be included for the Sum Scale. In the configuration shown above, all logical
scales are selected for display, and the weighing screen will appear like this:

> 1+2+3+4 CALC Vehicle

Max 2400 kg d = 1 kg

0.

v,
=

o

AR T1FL Max 600 kg d = 1 kg AR 2FR Max 600 kg d = 1 kg
EBRL Max 600 ka d = 1 kg EARR Max 600 ka d = 1 kg

0

kg

PT

Preset Tare

Tare Table

iy

Switch Scale

(3

Switch Units

A

Alibi Memory

Higher Res.

ID Form

Material Table

Figure 202: Weight Display - Four Scales and Sum Scale

Note that any of the displayed scales, including the Sum Scale, can be viewed in a larger simplified format by

double-tapping on the screen within the desired scale's weight information area:

S 1+2+3+4 CALC...

Figure 203: Sum Scale Large Format View
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M 1 FL Max 600 kg d = 1 kg

kg

Figure 204: Single Scale Large Format View

To return to the normal display, double fap anywhere on the screen.

POWERCELL - Capacity and Increments

Capacity and increment values allow the weighing parameters to be set for each of a series of scale setups,
depending on the # ranges value:

» Single range

e 2 mulfi inferval

e 2 mulfi range

e 3 mulfi inferval

e 3 mulii range

The figure below shows the default Single range selected.

¢ Capacity & Increments
# ranges
Single range
Primary unit
kg
Capacity 1
5000

Resolution 1

1

Blank over capacity (d)

98

Figure 205: ASM - Capacity & Increments

If either mulfi inferval or multi range is selected, additional Capacity and Resolution fields display. The Blank
over capacity field is always displayed last, and determines the weight value beyond scale capacity, measured
in display increments (d), at which the ferminal blanks the weight display.
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< Capacity & Increments

# ranges Resolution 2

3 multi range v 0.02
Primary unit Capacity 3
kg v 250
Capacity 1 Resolution 3
20 0.1
Resolution 1 Blank over capacity (d)
0.01 v 5

Capacity 2
100

Figure 206: Capacity and Increment - Multi Range Example

If 3 multi interval or 3 multi range is selected, fwo sefs of capacity and resolution fields are added.

Multi-Range and Multi-Interval Weighing

Precision Scales and Multi-Range, Multi-Interval Operation

PBK and FPK scale platforms support both multi-range and multi-interval operation. PDB
platforms support only multi-range operation.

Both Multi-Range and Multi-Interval seftings allow a scale to be used fo weigh two or more types of item
which differ significantly in weight. Each weight range can have its own Capacity and Resolution values, so
that one scale can behave like two or more different scales.

For instance, for small and light items a finer resolution might be required, while for large and heavy items a

coarser resolution is adequate. The scale changes the display increment size af the Capacity points defined in
this screen. In the example shown here, three ranges are defined -- up fo 50 kg, up fo 500 kg, and up fo

1,000 Kg.
< Capacity & Increments
# ranges Resolution 2
3 multi range A4 0.5 N
Primary unit Capacity 3
kg | | 1000
Capacity 1 Resolution 3
50 1 N
Resolution 1 Blank over capacity (d)
0.05 N 5
Capacity 2
500

Figure 207: Capacity & Increments Screen Configured for Three Ranges

In Multi-Range mode, the range currently in use appears on screen beside the weigh mode (B/G or Net)
indicafor -- >11l<, >l2l<, >I3l< -- depending on how many ranges are configured.

The increment sizes, or Resolutions, are set fo 0.01, 0.5 and 1, respectively. Thus, for items weighing up fo
50 kg, the weight display will increment in 100 gram steps; befween 50 kg and 500 kg of scale weight, the
display will increment in half-kilogram steps; and for items weighing over 500 kg the resolution is reduced by a
factor of 10 compared fo the lowest range, and increases in 1 kg sfeps.

There is one significant difference between Multi-Range and Multi-Interval configurations, affecting how the
terminal behaves as scale weight is reduced:

e Multi-Range: When scale weight is reduced, the terminal continues to display the Resolution size for the
largest configured range.
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e Multi-Interval: When scale weight is reduced, the display conforms to the configured intervals and shows
Resolution sizes corresponding to current scale weight

In both cases, the terminal resets the display to the Resolution fo the lowest range when the weight falls fo

Zero.

Display

The two modes also differ in the way the IND700 indicates the capacity and increment seftings for the

displayed scale.

e Multi-Range: The terminal's metrology line cycles through a display of both capacity and increment for each
Configured ronge in sequence -- W1 Max50kgd=01kg ~W2Max500kgd=05kg =~ W3Max1td=1kg

e Multi-Interval: The terminal's metrology line cycles through a display of capacities for each configured
range, and then increments for each -- Maxs0/500/ 1t d=2/500/1000 g

Configuration
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Example

The following diagram illusirafes the distinction between Multi-Range and Multi-Interval modes, showing the
behavior of the terminal configured as in the screen shown above, during one weighing operation:

Scale Status

Display Status

Figure 208: Multi-Range vs Mulfi-Interval

Resolution,
Multi-Range

0.002 kg
>| 1<

0.002 kg
>|1l<

0.05 kg
>[2]<

1 kg
>|3l<

0.002 kg

>|21<

0.002 kg
>|1l<

Resolution,
Multi-Interval

0.002 kg

0.002 kg

0.05kg

1 kg

1 kg

0.002 kg

Scales with Multiple Ranges or Multiple Intervals have specific Approval

requirements.
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Linearization & Calibration

R @ 11:00
¥ 31.Aug.2021

... > ASM > Linearization & Calibration

Metrology Control mode Stability Calibration
Identification Units MinWeigh Span adjustment
Load Cell Zero Reset Step calibration
Capacity & Tare Maintenance CalFree
Increments

Linearization &

Calibration FRet

Figure 209: POWERCELL - Linearization and Calibration Menu

Calibration

< Calibration
Calibration unit
kg
Linearity Adjustment

Disabled

Test load 1

60

CALIBRATE

Figure 210: POWERCELL - Linearization and Calibration - Calibration
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Linearity Adjustment

Disabled -

3 point
4 point
5 point
3 point with hysteresis
4 point with hysteresis
5 point with hysteresis

Figure 211: Linearity Adjustment Options

Linearization allows the terminal to account for variations in accuracy over the whole capacity of a scale, by
calibrafing performance af three or more points in the span. The fields displayed in the Calibration sub-menu
vary depending on the Linearity Adjustment sefting. Options are:

« Disabled [Default]

e 3 point

e 4 point

e 5 point

e 3 point with hysteresis

e 4 point with hysteresis

e b point with hysteresis

The number of points selected determines the number of calibrations taken between the scale's zero and span
(highpoint) values. Depending on this sefting, linearization may require as many as four intermediate
measurements.

When linearization is enabled, additional fields are displayed, permitting the infermediafe calibration poinfs fo
be defined.

< Calibration

Calibration unit Test load 4

kg 500

Linearity Adjustment

5 point with hysteresis

Test load 1

20

Test load 2

50

Test load 3

100 CALIBRATE

Figure 212: POWERCELL Linearization - 5 Points with Hysteresis
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Span Adjustment

The Span adjustment screen permits the scale's whole span to be defined. The units used for the parameters
entered here are the Primary Unit set on the Capacity and Increments page.

<  Span adjustment
Test weight (kg)
60
Displayed weight (kg)
60

Control mode

0.000 kg

ADJUST

Figure 213: ASM - Linearization and Calibration - Span Adjust

Enter the calibrafion fest weight value in the Test weight field.

Enter the current weight reading from the scale, as shown in the Control mode display, in this field. The
terminal will account for any difference between the test weight and the weight shown on screen, and adjust the
displayed weight accordingly. Perform this adjustment before carrying out the linearity adjustments from the
[Calibration » Page 90] screen.

Note that the Control mode field is read-only, and displays the current scale weight.

To perform the span adjustment, place the test weight on the scale and touch Adjust. A message will appear to
indicate that the adjustment is complete, and the Control mode will change fo reflect the offset, displaying a
corrected value.

See also
& HSALC: Capacity and Increments » Page 86

Step Calibration

< Step calibration

Test load (kg)

2

CALIBRATE

Figure 214: Step Calibration Screen

Step Calibration provides a way fo calibrate fanks and hoppers with a "build up" method. In this procedure, the
same amount of weight is added fo the scale at each step of the procdure until the weight specified in the Test
Load field is reached.

The Test load unifs are determined by Primary Unit set in [Capacity and Increments » Page 121].
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Step Calibration Procedure

Note that test weight values in the images below are for illustration only, and do not correspond fo values for a
typical POWERCELL system.

The procedure involves placing and removing test weights of the size specified, and filling the tank or hopper to
intermediate target weights. The sequence is prompted by messages on-screen, as shown here. When a
prompted action is complete, touch the next icon to :

1 Set the zero value. At each screen, the procedure can be continued P, or cancelled X to complete the
procedure at the current step. Note that the current scale weight is shown as the first line in the screen.

Calibrate

0.00 kg
Empty scale

2 Place the first test load.

Calibrate

Testload 2.00 kg
Place test load

X »

3 Remove the first test load. The current scale weight is displayed again.

Calibrate

2.00 kg
Target 2.00 kg
Remove test load
Fill to target

X »

4 Fill the vessel to the indicated target.

Calibrate

2.00kg
Target 4.00 kg
Testload 2.00 kg
Place test load

X

Follow the steps indicated until the required span is reached, then touch the X (close) button. The Step
calibration screen will display.
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CalFree

< CalFree

Use zero

Calibrated

CALIBRATE

Figure 215: POWERCELL - Linearization and Calibration - CalFree

The Zero selection can be either Calibrated [default], in which case the scale's currently calibrated zero is
used, or Estimated. If Estimated is selected, additional fields display.

< CalFree

Use zero

Estimated

Estimated preload

0

Preload unit

kg

CALIBRATE

Figure 216: CalFree with Estimafed Zero

Touch the Estimated preload field to open a numeric enfry dialog and define a value, and select a Preload
unit from the dropdown list.
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Control Mode

The Control Mode screen shows the current scale weight. This is useful for viewing the weight reading during
setup and diagnostics without leaving the setup menu system.

<  Control mode

0.000 kg

Figure 217: Confrol Mode Screen

POWERCELL Units

< Units

Secondary unit

None
Host / auxiliary unit
kg

Startup unit

Primary

Figure 218: ASM - Units
Units Settings

Parameter Options Function
Secondary unit g, kg, f, Ib, oz, fon | Sets the Secondary unit.
Host / auxiliary unit g, kg, 1, Ib, 0z, fon | Sets unit type for Host / auxiliary unit. The Host / auxiliary unit
Startup unit Primary [default], |Determines whether, when the terminal is restfarted, the units
Restart revert fo the Primary unit defined in [Capacity and Increments »
Page 121], or remain as modified by the selection made from
the home screen by touching Switch Units {3

130 | Configuration

IND700



POWERCELL - Zero

{ Zero

Startup zero

Use last

Auto zero tracking

On

Auto zero range (d)

0.5

Blank under zero (d)

20

Push button zero

On

Figure 219: ASM - Zero
Zero Settings

Push button zero -range (%)

2

Push button zero +range (%)

2

SET ZERO

Parameter Options

Function

Startup zero Use last [default], Use

calibrated, Capture new

Determines how the scale defines zero when it is
restarted.

Auto zero fracking On [default], Off

Auto zero range (d) Opens a numeric entry

dialog; default value is 0.5

When Auto fracking is On, the scale will automatically
display zero, if the weight deviation does not exceed
the Auto zero range value, measured in increments
().

Blank under zero (d) Opens a numeric entry

dialog; default value is 20

Determines the sub-zero point, in increments (d), at
which the terminal will blank its weight display.

Push button zero On [default], Off

Push button zero -range  |Opens a numeric entry

(%) dialog; default value is 2.
Push Bufton zero +range |Opens a numeric entry
(%) dialog; default value is 2.

When On, the terminal's zero softkey can be used fo
set the terminal fo zero, if the current scale weight
value is within the range defined by the -range and
+range values.

The push button zero softkey is visible if at least one
connected scale has push button zero active. If push
button zero is nof activated for a scale, the Zero
softkey will display greyed out when that scale is
selected.

If the Zero scale function key is touched when Push
bufton zero is off for the selected scale, an error
message will display indicating that Push button Zero
is disabled.
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POWERCELL - Tare

The fields visible in this screen vary depending on the seftings for Auto tare mode, Auto tare reset threshold
and Auto clear tare. Each of these requires additional paramefer settings

{ Tare

Startup tare

Use last

Auto tare mode

On

Auto tare threshold (kg)

0

Auto tare reset threshold (kg)

0

Chain tare mode

On

Figure 220: Tare Settings

Auto clear tare

On

Auto clear tare threshold (kg)

0

Push button tare

On

Keyboard tare

On

Clear with zero

On

Parameter

Options

Function

Startup tare

Use last [default], Clear

Defermines whether an existing tare value is preserved
at system restart, or cleared.

Auto tare mode

off [default], On

Determines whether the terminal will automatically
take a tare once the Auto tare threshold value is
exceeded. An auto fare is cleared once the weight
value falls below the Auto tare reset threshold.

Aufo tare threshold (kg)

Displays a numeric enfry
dialog. Default is O.

Refer to Auto tare mode, above.

Auto tare reset threshold
k@)

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Chain tare mode

off [default], On

When Chain tare mode is ON, it is possible fo take
multfiple tares in sequence by touching the Tare softkey
— for example, when filling mulfiple similar containers
on a pallet. Once one container is filled, touch Tare
again tfo reset the scale fo Nef zero.

Auto clear tare

off [default], On

Defermines whether the terminal will preserve a tare
value when scale weight returns fo zero, or aufomat-
ically clear it when the weight value falls below the
Auto clear tare threshold.

Auto clear tare threshold
(kg(

Displays a numeric entry
dialog. Default is O.

Refer to Auto clear tare, above.
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Pushbutton tare On [default], Off When Push button tare is On, the Tare softkey on the
home screen is functional. Touch this softkey to create
a tare value based on an empty container on the
scale. The terminal then shows a zero weight and
indicates that it is Net mode. When the container is
filled, the terminal shows the net weight of the
contents.

The Tare softkey is visible if af least one connected
scale has push button tare active. If push button tare
is not activated for a scale, the Tare softkey will
display greyed out when that scale is selected.

If the Tare scale function key is fouched when Push
button tare is off for the selected scale, an error
message will display indicating that Push button Tare
is disabled.

Keyboard tare On [default], Off When Keyboard tare is On, the known value for the
empty weight of a container (fare) can be entered
manually. The terminal will then display the net weight
of the contents of the container. Keyboard tares are
automatically rounded to the closest display division.

Clear with zero On [default], Off When On, a scale zero command, issued by a softkey
or any other input, will clear any stored fare value.

POWERCELL - Filter

< Filter

Low pass filter
Medium

Stability filter

On

Figure 221: POWERCELL ASM - Filter

The IND700 has a low-pass, multi-pole vibration filter that can be set for several conditions when using analog
load cells. The heavier the filtering, the slower the display settling time will be.

Parameter Options Function
Low pass filter Very light, Light, Medium | Defermines how strongly the low pass filter is applied.
[default], Heavy, Very The low pass frequency is the frequency above which
heavy all disturbances are filtered out. The heavier the low
pass filfer, the better the disturbance rejection, but the
longer the settling fime required for the scale.
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Stability filter

Off [default], On

The stability filfer works in conjunction with the
standard low pass filter o provide a more stable final
weight reading. The stability filter should only be used
in fransaction weighing applications, since the
nonlinear action of the filter switching may cause
inaccurate cufoffs in batching or filling applications.
Stability settings are made on the [Stability »

Page 134] screen.

Stability

4 Stability

Motion range (d)

0.5

No motion interval (seconds)

0.3

Timeout (seconds)

3

Figure 222: Stability Settings

Parameter

Options

Function

Motion range (d)

Displays a numeric entry
dialog. Default is 0.5

Set the Motion range fo the weight value (in divisions)
within which the weight is permitted to fluctuate and
still have a no-motion condition.

No motion interval
(seconds)

Displays a numeric enfry
dialog. Default is 0.3

Defines the amount of time in seconds during which
the scale weight must be within the mofion range, for
the scale fo have a no-motion condition.

Timeout (seconds)

Displays a numeric entry
dialog. Default is 3

Defines the period (in seconds) after which the
terminal stops aftempting to perform a function that
requires a no-motion condition (such as a zero, tare
or print command) and aborts the function. This
timeout is used regardless of the source of the
command, such as the keypad, discrefe input,
Industrial Network or serial input. Values from O to 99
are possible, the default value being 3. A smaller
value means that less time will be spent checking for
no-motion before the command is aborfed.

MinWeigh

Certain industries such as pharmaceuticals and food processing require a guarantee that the weighing
equipment selected for a particular measurement is adequate for the task. One way fo ensure that appropriate
weighing equipment is selected is by the creation and use of a minimum weighment value (MinWeigh), below
which a particular piece of weighing equipment cannot be used.
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The MinWeigh function compares the current weight with the programmed MinWeigh value. In the configuration
screen shown below, MinWeigh has been enabled and its value set to 1 kg.

< MinWeigh

MinWeigh mode

On

MinWeigh value (kg)

1

Figure 223: MinWeigh Setup Screen

Parameter Options Function

MinWeigh On [default], |If the displayed weight (B/G or NET) is greater than or equal to the

Mode Off MinWeigh value, the MinWeigh symbol appears below the weight display,
to the right of the tare display. All terminal functions behave normally.
KA 2 Max 10kgd=20g

116 kg

When the absolute value of the nef weight is less than the MinWeigh value,
the MinWeigh symbol flashes in red &.

MinWeigh Displays a This field displays if MinWeigh mode is set to On. The unit is the default unit

value (kg) numeric enfry | set
dialog. Default
value is 0

Reset

Scale Branch Reset

Note that this Reset function refers only fo parameters configured in the currently selected
setup branch. For general Terminal reset options, refer fo [Reset » Page 284].
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RESET CALIBRATION
DATA

RESET SETTINGS

Figure 224: Scale Reset Options

This screen allows the user fo reset either calibration data or seftings. If settings is selected, calibration data are
preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 225: Reset Confirmation Dialog
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POWERCELL - Maintenance

The POWERCELL ASM Maintenance option provides access fo the menus shown below.

11:12

15.May.2023

... » ASM > Maintenance

Metrology Control mode Stability Cell counts

Predictive

Identification Units MinWeigh .
maintenance

Load Cell Zero Reset Zero & overload
!
I i ity &
apacit
i pacity Tare Maintenance Calibration values
| Increments

Linearization &

, . Filter Shift values
Calibration

Figure 226: POWERCELL Maintenance Menus

Cell counts

The Cell counfs maintenance screen displays current cell counts for each load cell in the scale system,
providing a useful diagnostic fool.

< Cell counts

Cell counts
8036
8977
8377

9612

Figure 227: POWERCELL Maintenance - Cell Counts
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Predictive maintenance

By default, the Predictive maintenance screen opens with Symmetry monitor set fo Off, in which case no
further fields are visible.

4 Predictive maintenance

Symmetry monitor

Off

Figure 228: POWERCELL Maintenance - Predictive Maintenance, Default View

Radial symmetry should be used on any system where all the cells see almost identical loads (such as a cylin-
drical tank or hopper scale). Setting Symmetry monitor fo Radial displays the fields shown below.

4 Predictive maintenance

Symmetry monitor

Radial

Start threshold (%)

10

Difference threshold (%)

10

Time interval (seconds)

0

On failure

Alarm only

Figure 229: POWERCELL Maintenance - Predictive Maintenance
When Symmetry monitor is set o Radial, Run flat can be set to Manual or Automatic.

Symmetry Monitor Settings

To prevent a false trigger of a symmetry error due to light loads, the ferminal allows for a symmetry check Start
threshold value. This value is entered as a percentage of the calibrated scale capacity. The default value is
0%. Symmetry checking will be triggered only if the load on the scale exceeds the start threshold value.
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In the Difference threshold field, enfer the maximum permissible percent deviation in span between
symmefrical cells. The defaulf value is 0%. Execution of radial symmetry checking is based upon a
comparison between the current distribution of values between load cells and the distribution at calibration. A
symmetry error is triggered if the change in load distribution exceeds the Difference Threshold value.

The Time Interval defermines how long the system will wait affer a “no-motion” condition is achieved, before it
can trigger a symmetry error. The alarm is triggered if the symmetry error occurs after the timer has expired. The
time is measured in seconds, and valid values are from O to 120. O is the default setting, and means that the
timer is disabled.

Set the On failure option to determine the alarm level when a possible failure is defected. The options are:
e Alarm only
e Disable and alarm

The [Maintenance Log » Page 264] must be enabled for Alarms to be recorded. For Alarm Only conditions, the
alarm message will remain on the display untfil the values fall to 90% of the parameters specified in sefup. If
the scale has been disabled, Symmetry Monitoring must be turned off or changed to Alarm Only (and the
values fall fo 90% of the parameters specified in Set Up), and the home screen displayed before the error will
clear.

Run Flat

If the ferminal determines that a load cell is operating out of tolerance or fails to detect communication with a
single load cell, it can invoke the Run Flat algorithm fo compensate for the cell’s questionable readings until the
cell can be replaced. Load cell symmetry monitoring is required for the algorithm to run properly. There are 3
options for Run Flat

» Off: Run Flat does not function
e Manual: The user selects which cell to replace
e Automatic: The Run Flaf algorithm uses threshold settings to determine which cell to replace

The Manual mode of Run flat requires the entry of a node to ignore in the run flat calculation. This is used to
exclude a failed POWERCELL, pending replacement.

Run flat

Manual ¥

Run flat node

0

Value is out of range 1 - 4.

Figure 230: Run Flat Mode - Manual

Click on the Run flat node field fo display a numeric entry dialog which is used fo designafe the failed node.

When Run flat is sef to Automatic, and Temp. trigger run flat is On, the function is set to frigger automatically
when a failed cell is defected.

Run flat

Automatic ¥

Temp. trigger run flat

On v

Figure 231: Run Flat Mode - Automatic
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Zero and overload

< Zero & overload

Zero drift check

Alarm only

Zero threshold (%)

50

QOverload threshold (%)

100

Figure 232: POWERCELL Mainfenance - Zero and Overload

Parameter Options

Function

Zero drift check Alarm only [default], No
action, Disable & Alarm

Determines what the ferminal does when a zero drift
condition (defined by the Zero threshold parameter) is
detected. By default, the terminal issues an alarm, but it can
also be set fo disable the scale.

Zero threshold (%) | When clicked, displays a
numeric entry dialog.

Defines the value, expressed as a percentage of the
configured [Auto Zero range » Page 1317, at which a
deviation from zero is considered a drift.

Overload threshold | When clicked, displays a
(%) numeric eniry dialog.

Defines the value, expressed as a percentage of the
configured [Span Adjustment » Page 92], at which a value
exceeding the scale capacity is considered an overload.
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Calibration values

< Calibration values

Zero

0

Load 1 (kg)
20

Counts 1

800000

Figure 233: POWERCELL Maintenance - Calibration Values
This screen allows each of the values fo be entered manually, using a numeric entry dialog.

Shift values

< Shift values

Coefficient
1.000000
1.000000
1.000000

1.000000

Figure 234: POWERCELL Mainfenance - Shiff Values
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To modify a cell's shift value, select the appropriafe row, then click on the Edit icon at lower right.

1

Coefficient

1

Figure 235: POWERCELL Mainfenance - Edit Shift Value

The screen displays the number of the selected node; this value cannot be edited. Click the Coefficient field to
display a numeric entry dialog where the value can be modified.

3.1.4.1.2 Log or Transfer

The Log or Transfer menu sefs the conditions which determine how and when a demand outfput is triggered.
Normal demand mode transfer occurs whenever a transfer request is made , depending on the options selected
here, and providing the scale is within the acceptable range configured in [Stability » Page 13417, and the
weight is above gross zero (a negative gross weight will not be printed).

Data is sent to:

« Interfaces for which the Connection has been defined as Transfer

« The Alibi Table

e The Transaction Table

Weight values shown on this screen are gross weights in primary units.

When Log or Transfer is selected from the Scale n menu opfions, a default configuration screen appears, with
no options selected.

< Log or Transfer

Minimum Weight (kg)
0

Interlock

Auto Transfer

—
Figure 236: Log or Transfer Screen, Default View
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Additional fields appear depending on the initial selections for Interlock and Auto Transfer. The follow illus-

tration shows the menu with all

options selected.

<  Log or Transfer

Minimum Weight (kg)
0

Interlock

Auto Transfer

Reset Trigger

Threshold Weight

Motion Check

Auto Transfer

() With first stable value
() After last stable value
Active
() Only if scale is selected
() Always
“  Reset Threshold (kg)

0

Figure 237: Log or Transfer, All Options Selected

Note that some of the Auto Transfer and Active sub-sections appear only if Auto Transfer is enabled.

Log or Transfer Options

Option

Settings

Minimum Weight (kg)

This value defermines the minimum scale weight required to frigger the
Interlock and/or Auto Transfer actions. The weight unit for this and the other
fields on this screen is determined by the Primary Unit set in ASM at Capacity
and Increments.

Interlock

When enabled, the Interlock option responds to scale data to determine when
a log action is performed. This prevents repeat logging of the same weighing
operation.

When enabled, this interlock requires that the live weight reading be reset
according to the Reset Trigger parameter setting (see below). The live weight
must then settle fo a weight greafer than the Minimum Weight value (see
above) before the ferminal will respond to the next log or fransfer request.

If Interlock is enabled, or Auto

Transfer and With first stable value is selected

Reset Trigger

The Reset Trigger action can be performed in response to Threshold Weight
[default] or Deviation This frigger is defined either by an absolute value
(Threshold Weight) or by a minimum change in weight (Deviation).

If either Interlock or Auto Transfer is enabled

Resetf Threshold (kg) or Reset
Deviatfion (kg)

The weight value which triggers a reset and indicafes the start of a new
weighing operation and a new log entry.

Auto Transfer

When enabled, Auto Transfer causes data about each weighing operation to be
sent to the destination defined in the [Communication » Page 2267 section of
setup, depending on the parameters selected in Auto Transfer and Active.

If Auto Transfer is Enabled

Auto Transfer

When enabled, the trigger conditions defined by the Interlock settings will
automatically export data about each weighing operation either With first
stable value or After last stable value.

With first stable value: data is sent when the first stable weight is captured,
even if the weight changes afferward. This selection would typically be used for
stafic weighing.

After last stable value: data is sent based on the last stable weight captured.
This selection might be used for manual filling, where the scale weight will
briefly be unstable after the last material is added.

This selection determines whether the Reset Trigger option appears.

Active

The options fo activate the Auto Transfer function are Only if scale is selected
and Always.
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Option

Settings

Motion Check

When enabled, the Motion Check prevents the interlock from triggering a log or
transfer action until scale weight display is within the parameters defined as
stable at [ASM > Stability » Page 1341].

See also
& Communication Setup »
& Stability » Page 134

3.1.4.1.3 Loading Alert

Page 226

When the IND700 is connected fo a PowerDeck floor scale, the system can be configured to provide a loading
alert. This alert appears on the weighing screen as a graphical warning, and offers guidance to the operator for
correct loading. Weighing is most accurate when the load is placed in the center of the platform.

This branch of the scale setup menu system allows the configuration of the loading alert. By default, loading

alert is disabled. The screen

below shows the Loading Alert enabled.

< Loading Alert

Enable Loading Alert Cancel and Continue

OK Range (%)

30

Platform shape
(L) square
(_) rectangular

Threshold Weight (Ib)

0

Walue '0° exceeds its limits. Current limits are from '25

Orientation

0

Figure 238: Loading Alert Enabled

The following parameters must be configured for the loading alert:

Loading Alert Parameters

Parameter

Seftings

Enable Loading Alert

When enabled, the loading alerf will function during weighing operations. By
default, Loading Alert is disabled.

OK Range (%)

The range sefs the positioning folerance, and represents the relationship between
the cenfer of gravity of the load and the center of the scale. The value is expressed
as a percentage of the distance between load cells. Valid range values are from
5% 10 50%. The default value is 30%. The loading alert graphic shows the OK
zone as a light blue rectangle, and the cenfer of gravity of the load as a dark blue
dot. The on-screen size of the light blue rectangle indicates the relationship
between the OK zone and the overall distance between load cells.

When a load is placed on the scale outside the OK range, the loading alert will
display.

Threshold Weight
Pelq

If the weight on the scale is below this threshold value, the loading alert will not
frigger. The value selected should represent 5% of the scale capacity; this value is
shown by default. The unit shown is the Primary Unit selected in ASM af [Capacity
& Increment » Page 121].
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Parameter

Seftings

Cancel and Confinue

If Loading Alert is enabled, and this option is selected, the operator can cancel the
loading alert and continue working.

If the option is not enabled, the <. in the loading alert display is hidden, and the
alert cannot be dismissed until the load is removed or properly centered.

Plafform shape

Select either square or rectangular to define the platform shape. The selection
made will modify the loading alert graphic.

Orientation

Rotafe the scale image on-screen by the selected angle.

Scale orientation on-screen should provide the operafor with an intuitive under-
standing of the relationship between the loading alert display and the scale
platform. E.g., if the #1 load cell is on the operator's side, and to the left, the
correct selection is 0.

Touch the information icon ‘@ to display an explanation of this function. In each
case, the blue triangle labeled 1 represents the first load cell in the PowerDeck

platform.
30 (i} g
0 90 180 270 el
Threshold V
0
Value '0" exceed

Orientation o

The following images show how the Orientation selection adjusts the Loading Alert
display:

¢ Loading Alert

Please check loading ar
. mowe centainer into
canter to continue.

Followy instructions:

)"
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Parameter Settings
90

¢ Loading Alert

#lease check loading or
mowe container into
center to centinue,

Enllews inSLruclinns:

" 4

180
Loading Alert
Please check leading or
rrCAE coelainer into
cenler 1o canlinue.
Follzw insoructions:
270

Loading Alert

Flezse check loading or
mowve container into
center Lo continue,

Foliay instruclions:

o

R

3.1.4.1.4 Leveling Guidance

The Leveling Guidance screen provides a real-time readout of count values for each load cell in the PowerDeck
scale system. Values shown in the images below capture raw count values for scale plafforms at Zero. In each
case, the load cell with the lowest count is highlighfed in cyan.
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<{ Leveling Guidance

Figure 239: Leveling Guidance Screen, 4 Cells

< Leveling Guidance

Figure 240: Leveling Guidance Screen, 6 Cells

The information presented here allows the scale platform fo be leveled more precisely than by traditional
means. Shims may be used fo level the scale so that the values shown on this screen are as close as possible
to equal. The cyan highlight is used fo determine which cell to shim first.

For further information about the use of this feature, refer to Service and Maintenance, [Leveling Guidance »
Page 298].
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3.1.4.2 Cell Addressing

3.1.4.2.1 Single cell address

< Single cell address

0

Value is out of range 1 - 114,

FIND CELL

Figure 241: POWERCELL - Single cell address

When the Single cell address screen is first displayed, the Serial number and Node fields appear as above.
Touch FIND CELL to start the addressing process. A confirmation dialog will display, indicating that the search
has completed; touch +/ to return to the Single cell address screen, which will now display a node number
and the serial number of the cell at that node.

< Single cell address

Serial number

728647E549

Node

1

Figure 242: POWERCELL - Single cell address, cell found

Single Cell Address - detail

Single cell addressing can be performed manually or automatically af power-up, as required. In either case, the
procedure cannot be performed if the terminal is in Weights and Measures Approved mode.
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3.1.4.2.2 Manual Cell Address

& Manual address

Serial number

DISCOVER CELLS

Figure 243: POWERCELL - Manual Address Screen

The Manual Address screen initially displays the connected cells' Serial numbers and Node numbers. Touch
the DISCOVER CELLS button to begin discovery. If discovery is successful, a confirmation dialog will appear.

Discover cells

Finished

Figure 244: Cell Discovery Confirmation Dialog

Touch the check mark acknowledge the confirmation. The original screen will reappear with an EDIT ./ button
in place of the DISCOVER CELLS button.

e Manual address

Serial number
729031L478
729027H521
728913D525
729030Q752

Figure 245: Cells Discovered
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Node Address Editing
Touch a row to highlight a cell.

e Manual address

Serial number Node
729031L478 1
729027H521 2
728913D525 3
729030Q752 4

Figure 246: Cells Discovered, Node Selected
With the cell highlighted, touch the EDIT butfon to display the address Edit screen.

< Edit

7290310478

Node

1

Figure 247: Cell Address Edit Dialog
Touch the Node field to display a numeric keypad. Enter the desired node address.

Figure 248: Node Address Entry
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Finally, fouch the Back arrow at upper leff fo return fo the Manual address screen. In the example below, Node
1 from the discovery step above has been readdressed as Node 4, and the original Node 4 is now Node 1.

< Manual address

Serial number Node
729030Q752 1
729027H521 2
728913D525 3
729031L478 4

Figure 249: Node 1 Readdressed as Node 4

3.1.4.2.3 Manual address

< Manual address

Serial number
728647E549
7286485108
728647G122

728647F845

DISCOVER CELLS

Figure 250: POWERCELL - Manual address
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The Manual address screen initially displays the connected cells' Serial numbers and Node numbers. Touch a
row fo highlight it:

< Manual address

Serial number
728647E549
7286485108
728647G122
728647F845

DISCOVER CELLS

Figure 251: POWERCELL - Manual address, node selected

Touch the DISCOVER CELLS butfon to begin discovery. A confirmation dialog will appear; when it is dismissed,
the original screen reappears with an edit button in place of the DISCOVER CELLS button.

< Manual address

Serial number
728647E549
7286485108
728647G122

728647F845

Figure 252: POWERCELL - Manual address, cells discovered
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Touch the Edit butfon # fo display the screen shown below. Here, the Node number can be changed by
touching the field to display a numeric entry dialog.

<  Edit

7286485108

Node

2

Figure 253: POWERCELL - Manual address, edit screen
3.1.5 Precision Scale

3.1.5.1 Scalen
The Scales branch of the sefup menu displays options for each scale (1 or 2, depending on how many
inferfaces are installed in the ferminal) and for a Sum Scale.

When either scale is selected, two further options appear -- ASM, which provides access to all the scale config-
uration menus, and Log or Transfer, which determines whether and how each weighing operation is recorded
or exported.

(:':.l. @ 17.Apr:lz?;::

Setup > Scales > Scale 1

Scales Scale 1 ASM
Application Sum Scale Log or Transfer
I
[}
Terminal

Communication

Maintenance

Figure 254: Scale n Menus, Precision
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3.1.5.1.1 ASM
The Precision scale ASM shows the following menus:

& @ 15.May?2i;z§

... > ASM
Metrology Control mode Stability
I
Ramp Units MinWeigh
Identification Zero Reset
Capacity &
pacity Tare Diagnostics
Increments
Linearization & :
Filter

Calibration
|

Figure 255: Precision Scale ASM Menus

Unlike HSALC and POWERCELL scale interfaces, the settings found in the Precision Scale ASM system are
provided by, and configured on, the scale platform in use. Precision scales offer slightly different options from
the other scale inferfaces, and there are differences between different Precision platforms. The menu system
shown here, and the settings described in this section, should be taken as examples.

Metrology

The Metrology screen allows the configuration of per-scale approvals and GEO values, as well as lower and
upper operating Temperature Limits.

Metrology

Approval

Not approved

Not approved
OIML
NTEP

Lower temperature limit (°C)

10

Upper temperature limit (°C)

40

Figure 256: ASM - Metrology Screen
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When an approval (OIML or NTEP) is selected, additional options are displayed.

{  Metrology

Approval Lower temperature limit (°C)

OIML -10

Country Upper temperature limit (°C)

Global 40

GEO value

16

Verification Class

Class III

Verification Interval

e=d

Figure 257: Approval Options
In addition to the GEO and temperature values, an approval requires the selection of Country and Verification
values.

For both OIML and NTEP approvals, the Country options are Global [default], Argentina, Australia, Koreq,
Thailand, and the Verification Class options are Class Il, Class Ill, Class IlIL, Class IIIHD and Class IIl.

When the device has been set as Approved -- either OIML or NTEP -- and the metrological sealing screw has
been installed, the fields on this page are greyed out and cannof be modified.

Precision Scale: Ramp

Ramp is the output of the load cell installed in the scale platform. The value shown is a percentage of the load
cell's output in the scale system. If the ramp value shows an increase, this means that the load cell is detecting
force on the scale. This value is used to adjust the load cell parameters as part of the whole platform. This
information is available in METTLER TOLEDO PBK and PBD platforms.
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{ Ramp

Ramp

53.2

Figure 258: Ramp Screen

Identification

The Identification screen allows the scale's Serial number, Scale model and Scale location to be defined. It
also provides an additional Scale Identification field. For analog scales, these fields are optional and must be
completed manually. Touching any of the fields opens an alphanumeric entry dialog.

< Identification

Serial number

Scale model

Scale location

Scale identification

Figure 259: Identification

Precision Scale: Capacity and Increments

Capacity and increment values allow the weighing parameters to be setf for each of a series of scale setups,
depending on the # ranges value:

e Single range

¢ 2 mulfi inferval

e 2 mulfi range
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e 3 mulii inferval
e 3 mulfi range

The value selected here will affect the function of the Linearization and Calibration screens.

The figure below shows the default Single range selected.

4 Capacity & Increments

# ranges
Single range

Primary unit
kg

Capacity 1
10

Resolution 1

0.005

Blank over capacity (d)

9

Figure 260: Precision Scale ASM - Capacity and Increments Screen

Capacity conversion

Fixed number of increments

If either mulfi inferval or multi range is selected, additional Capacity and Resolution fields display. The Blank
over capacity field is always displayed last, and determines the weight value beyond scale capacity, measured
in display increments, at which the ferminal blanks the weight display..

< Capacity & Increments

# ranges
3 multi range
Primary unit
kg
Capacity 1
10
Resolution 1
0.005
Capacity 2

12

Resolution 2
0.005

Capacity 3
12.03

Resolution 3

0.01

Blank over capacity (d)

9

Capacity conversion

Fixed number of increments

Figure 261: Precision Scale ASM - Capacity and Increments Screen with Mulfi-Range Fields Displayed

If 3 multi interval or 3 multi range is selected, two sets of capacity and resolution fields are added.
Capacity conversion is used in Precision scales with NTEP approval, when metric and avoirdupoids units are

used in parallel.
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The following options are available from the drop-down list:

Capacity conversion

Fixed number of increments v

Fixed number of increments

Fixed factor

MNone

Figure 262: Capacity Conversion Options
Capacity Conversion Parameters

Setting Purpose
Fixed number of increments A legacy mode, not used in the IND700 terminal.
Fixed factor The Weights and Measures line on the main screen

displays Cap and d in the same unit as the weight
value unit. Conversions are performed by the attached
scale.

None Used for non-approved systems. The Weights and
Measures line on the main screen displays the unit
configured as primary. Overload and range change
occur af the same actual load on the scale.

Multi-Range and Multi-Inferval Weighing

Precision Scales and Multi-Range, Multi-Interval Operation

PBK and FPK scale platforms support both multi-range and multi-interval operation. PDB
platforms support only mulfi-range operation.

Both Multi-Range and Multi-Increment settings allow a scale to be used fo weigh two or more types of item
which differ significantly in weight. Each weight range can have its own Capacity and Resolution values, so
that one scale can behave like two or more different scales.

For instance, for small and light items a finer resolution might be required, while for large and heavy items a
coarser resolution is adequate. The scale changes the display increment size af the Capacity points defined in
this screen. In the example shown here, three ranges are defined -- up to 50 kg, up to 500 kg, and up fo
1,000 kg.
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< Capacity & Increments
# ranges Resolution 2
3 multi range AV 0.5 AV
Primary unit Capacity 3
kg /| 1000
Capacity 1 Resolution 3
50 1 N
Resolution 1 Elank over capacity (d)
0.05 N 5
Capacity 2
500

Figure 263: Capacity & Increments Screen Configured for Three Ranges

In Multi-Range mode, the range currently in use appears on screen beside the weigh mode (B/G or Net)

indicafor -- >11l<, >l2l<, >I3l< -- depending on how many ranges are configured.

The increment sizes, or Resolutions, are set fo 0.01, 0.5 and 1, respectively. Thus, for items weighing up to

50 kg, the weight display will increment in 100 gram steps; befween 50 kg and 500 kg of scale weight, the

display will increment in half-kilogram steps; and for items weighing over 500 kg the resolution is reduced by a

factor of 10 compared fo the lowest range, and increases in 1 kg sfeps.

There is one significant difference between Multi-Range and Multi-Interval configurations, affecting how the

terminal behaves as scale weight is reduced:

e Multi-Range: When scale weight is reduced, the terminal continues to display the Resolution size for the
largest configured range.

» Multi-Interval: When scale weight is reduced, the display conforms to the configured infervals and shows
Resolution sizes corresponding fo current scale weight

In both cases, the terminal resets the display to the Resolution fo the lowest range when the weight falls o
zero.
Display

The two modes also differ in the way the IND700 indicates the capacity and increment seftings for the

displayed scale.

e Multi-Range: The terminal's metrology line cycles through a display of both capacity and increment for each
Conﬂgured range |n Sequence -- W1 Max50kgd=0.1kg , W2 Max 500 kg d = 0.5 kg , W3 Max1td=1kg

e Multi-Interval: The terminal's metrology line cycles through a display of capacities for each configured
range, and then increments for each -- Maxs0/500/1¢  d=2/500/1000g
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Example

The following diagram illustrafes the distinction between Multi-Range and Multi-Increment modes, showing the
behavior of the terminal configured as in the screen shown above, during one weighing operation:

Scale Status

Display Status

Figure 264: Multi-Range vs Mulfi-Interval

Resolution,
Multi-Range

0.002 kg
>| 1<

0.002 kg
>|1l<

0.05 kg
>[2]<

1 kg
>|3l<

0.002 kg

>|21<

0.002 kg
>|1l<

Resolution,
Multi-Interval

0.002 kg

0.002 kg

0.05kg

1 kg

1 kg

0.002 kg

Scales with Multiple Ranges or Multiple Intervals have specific Approval

requirements.
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IND700

Precision Scale: Linearization and Calibration

The Linearization and Calibration menu offers five sub-menus.

11:00

... » ASM > Linearization & Calibration

Metrology Control mode Stability
Ramp Units MinWeigh
Identification Zero Reset
Capacity & Tare Diagnostics
Increments

Linearization &

Calibration ERiec

Figure 265: Precision Linearization and Calibration Menus

Autoprint Calibration

{  Autoprint calibration

Autoprint calibration

On

Figure 266: Autoprint Calibration Screen
Autprint calibration can se On [default] or Off. FUNCTION??

17.Apr.2023

Autoprint
calibration

External
calibration

3-point lin&cal

5-point lin&cal

Span adjustment
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External Calibration

The Precision Scale External calibration screen allows a standard calibration routine using test weights to be
performed.

< External calibration

EXTERNAL
CALIBRATION

Figure 267: Precision Linearization and Calibrafion External Calibration Screen

Touch the EXTERNAL CALIBRATION button to start running the calibration routine. The number of steps
performed during this process depends on the number of infervals or ranges specified in the [Capacity and
Increments » Page 1567 screen.

External calibration

Test Load (kg)
0.000

Empty Scale

Figure 268: Precision External Calibration in Progress - Example Screen
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3- and 5-Point Linearization and Calibration

The number of points selected determines the number of calibrations taken between the scale's zero and span
(highpoint) values. Depending on this sefting, linearization may require as many as four intermediate
measurements.

< 3-point lin&cal

POINT LIN&CAL-3

Figure 269: 3-Point Linearization and Calibrafion Screen

4 5-point lin&cal

POINT LIN&CAL-5

Figure 270: 5-Point Linearization and Calibration Screen

Touch the butfon af lower right fo start the linearization and calibration process. The number of steps varies
depending on how many intermediate measurements are required for lineariafion.

See also
& Precision Scale: Capacity and Increments » Page 156
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Span Adjustment

The Span adjustment screen permits the scale's whole span to be defined. The units used for the parameters
enfered here are the Primary Unit set on the Capacity and Increments page.

<  Span adjustment
Test weight (kg)
60
Displayed weight (kg)
60

Control mode

0.000 kg

ADJUST

Figure 271: ASM - Linearization and Calibration - Span Adjust

Enter the calibrafion fest weight value in the Test weight field.

Enter the current weight reading from the scale, as shown in the Control mode display, in this field. The
terminal will account for any difference between the test weight and the weight shown on screen, and adjust the
displayed weight accordingly. Perform this adjustment before carrying out the linearity adjustments from the
[Calibration » Page 90] screen.

Note that the Control mode field is read-only, and displays the current scale weight.

To perform the span adjustment, place the test weight on the scale and touch Adjust. A message will appear to
indicate that the adjustment is complete, and the Control mode will change fo reflect the offset, displaying a
corrected value.

See also

& Precision Scale: Capacity and Increments » Page 156

Control Mode

The Control mode screen shows the current scale weight. This is useful for viewing the weight reading during
setup and diagnostics without leaving the setup menu sysfem.

< Control mode

1.0005 kg

Figure 272: Confrol Mode Screen
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Precision Scale: Units

£ Units

Secondary unit

MNone

Host / auxiliary unit

None

Startup unit

Primary

Legacy mode

Off

Figure 273: Precision Scale Units Screen

Units Settings

Parameter Options Function
Secondary unit g, kg, t, Ib, 0z, ton | Sets the Secondary unit.
Host / auxiliary unit g, kg, 1, Ib, 0z, fon | Sets unit type for Host / auxiliary unit. The Host / auxiliary unit
Startup unit Primary [default], |Determines whether, when the terminal is restarted, the weight is
Use Last displayed using the Primary unit, or in the unit most recently
selected (e.g. secondary unit).
Legacy mode Off [default], This parameter is not used in IND700
Version 2

Legacy mode

Off X
off |
Version 2 I

Figure 274: Precision Scale Units: Legacy Mode Options
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Precision Scale: Zero

{ Zero

Startup zero

Capture new

Power up zero -range (%)

2

Power up zero +range (%)

18

Center of zero

On

Center of zero for net weight

Off

Figure 275: Precision Scale Zero Screen, Page 1

Zero

Push button zero -range (%)

2

Push button zero +range (%)

Figure 276: Precision Scale Zero Screen, Page 2

Zero Settings

Auto zero tracking

On

Auto zero range (d)

0.5

Blank under zero (d)

20

Push button zero

On

SET ZERO

SET ZERO

Parameter

Options

Function

Startup zero

Capture new [default],
Use last

Determines how the scale handles zero when it is
restarted.

Power up zero -range (%)

Opens a numeric entry
dialog; default value is
2%

Power up zero +range

(%)

Opens a numeric entry
dialog; default value is
18%

These parameters appear if Startup zero is set fo
Capture new. Values define the range within which the
terminal, at power up, will aufomatically zero the
scale. If scale weight is outside the configured range,
Startup zero will not execute.
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Center of zero

Off [default], On

\When enabled, the >0< indicator will appear on
screen when the scale gross weight is at zero.

Center of zero for net
weight

On [defaul], Off

\When enabled, the >0< indicator will appear on
screen when the scale nef weight is at zero.

Auto zero tracking

On [default], Off

Auto zero tracking is an automatic zero maintenance
function which tracks zero when the scale is empty,
and compensates for conditions such as terminal or
load cell drift, or slow debris buildup on a scale
platform.

Auto zero range (d)

Opens a numeric entry
dialog; default value is 0.5

Determines the range, in scale display units, within
which Auto zero will be active.

Blank under zero (d)

Opens a numeric entry
dialog; default value is 20

Determines the sub-zero point, in scale display units,
at which the terminal will blank its weight display.

Push button zero

On [default], Off

\When On, the ferminal's zero softkey can be used to
set the terminal fo zero, if the current scale weight
value is within the range defined by the -range and
+range values.

Push button zero -range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.

Push Butfon zero +range

(%)

Opens a numeric entry
dialog; default value is 2.

Refer to Push button zero, above.

Precision scale: Tare

The parameters available on this screen change depending on the Auto tare mode, Auto tare reset mode and
Auto clear tare seffings. The screen below shows these parameters all sef to On.

£ Tare

Startup tare

Clear

Auto tare mode

On

Auto tare threshold

0.01

Auto tare reset mode

On

Auto tare reset threshold

0.01

Figure 277: Precision Scale Tare Screen

Auto clear tare

On

Auto clear tare threshold

0.01

Push button tare

On

Keyboard tare

On

Parameter

Options

Function

Startup tare

Use last [default], Clear

Determines whether an existing fare value is preserved
at system restart, or cleared.

Auto tare mode

Off [default], On

Determines whether the terminal will automatically
take a tare once the Auto tare threshold value is
exceeded. An aufo tare is cleared once the weight
value falls below the Auto tare reset threshold.
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Auto tare threshold (kg) [if
Auto tare mode = On]

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Auto fare reset mode [if
Auto tare mode = On]

off [default], On

Determines whether tare is reset according to the value
defined in Auto tare reset threshold.

Aufo fare reset threshold
(kg) [if Auto tare reset
mode = On]

Displays a numeric entry
dialog. Default is O.

Refer to Auto tare mode, above.

Chain tare mode

off [default], On

When Chain tare mode is ON, it is possible fo take
mulfiple tares in sequence by touching the Tare softkey
— for example, when filling mulfiple similar containers
on a pallet. Once one container is filled, touch Tare
again to reset the scale to Net zero.

Auto clear tare

off [default], On

Defermines whether the terminal will preserve a tare
value when scale weight returns to zero, or aufomat-
ically clear it when the weight value falls below the
Auto clear tare threshold.

Auto clear fare threshold
(kg) [if Auto clear tare =
On]

Displays a numeric enfry
dialog. Default is O.

Refer to Auto clear tare, above.

Push button tare

On[default], Off

When Push button tare is On, the Tare softkey on the
home screen is functional. Touch this softkey to create
a tare value based on an empty container on the
scale. The terminal then shows a zero weight and
indicates that it is Net mode. When the container is
filled, the terminal shows the net weight of the
contents.

Precision Scale: Filter

<

Filter

Vibration filter

Standard

Process filter

Universal

Figure 278: Precision Scale Filter Screen

Parameter Options

Function
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Vibration filter | vibration filter By default, the Vibration filter is set fo Standard. This

Standard - | paramefer is used to adapt the scale to ambient conditions.
Stable This sefting determines how rapidly the scale will seftle on a
e weight value when vibration is present.

nstabile

Stable: the scale works very rapidly, but ifs accuracy is
extremely sensitive fo exfernal influences.

Unstable: the scale works slowly, but its accuracy is
relatively unaffected by external influences.

Process filter | process filter This parameter allows the scale fo adapt to the weighing
Universal o proceSS in use.
S oersal Universal: this setting is used for normal, fransaction
weighing.

Absolute (Dosing): This sefting is used for extreme
conditions, such as when extreme vibration is present, or
when the scale is measuring a filling process.

See also
& Precision Scale: Stability » Page 169

Precision Scale: Stability

< Stability

Stability detection

Standard

Figure 279: Precision Scale Stability Screen

Parameter Options Function
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Stability Stability detection The stability defection parameters determine the

detection e .| update rate of the displayed weight value. The appro-
— priate update rate is relafed fo the scale's stability. A
AT Precise update rate will reflect smaller effects on scale
Precise stability, while a Fast rate will ignore small fluctu-

ations and permit a fransaction fo proceed. For
environments where external factors such as floor
vibration do not disturb the scale, the Precise opfion
can be selected. In noisy environments the Fast option
ensures that the weighing process can continue
despite some scale instability. In most circumstances,
the Standard option is appropriate, unless scale insta-
bility interrupts the ability fo perform a transaction.
Note that this parameter does not [filter » Page 168]
vibration; it simply decides how the ferminal's display
responds to the vibration.

MinWeigh

Certain industries such as pharmaceuticals and food processing require a guarantee that the weighing
equipment selected for a particular measurement is adequate for the task. One way fo ensure that appropriate
weighing equipment is selected is by the creafion and use of a minimum weighment value (MinWeigh), below
which a particular piece of weighing equipment cannot be used.

The MinWeigh function compares the current weight with the programmed MinWeigh value. In the configuration
screen shown below, MinWeigh has been enabled and its value set to 1 kg.

< MinWeigh

MinWeigh mode
On

MinWeigh value (kg)

1

Figure 280: MinWeigh Setup Screen

Parameter Options Function
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MinWeigh On [default], |If the displayed weight (B/G or NET) is greater than or equal to the
Mode off MinWeigh value, the MinWeigh symbol appears below the weight display,
to the right of the fare display. All terminal functions behave normally.
KA 2 Max 10kgd=20g
1 . 1 6 kg
When the absolufe value of the net weight is less than the MinWeigh value,
the MinWeigh symbol flashes in red &.
MinWeigh Displays a This field displays if MinWeigh mode is sef to On. The unit is the default unit
value (kg) numeric enfry | sef
dialog. Default
value is 0
Reset

Scale Branch Reset
Note that this Reset function refers only fo parameters configured in the currently selected
setup branch. For general Terminal reset options, refer o [Reset » Page 284].

Figure 281: Scale Reset Options

RESET CALIBRATION
DATA

RESET SETTINGS
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This screen allows the user fo reset either calibration data or settings. If seffings is selected, calibrafion data are
preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 282: Reset Confirmation Dialog

3.1.5.1.2 Log or Transfer

The Log or Transfer menu sefs the conditions which determine how and when a demand output is triggered.
Normal demand mode transfer occurs whenever a transfer request is made , depending on the options selected
here, and providing there is no motion on the scale and the weight is above gross zero (a negative gross
weight will not be printed).

Data is sent to:

« Interfaces for which the Connection has been defined as Transfer

e The Alibi Table

e The Transaction Table

Weight values shown on this screen are gross weights in primary units.
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When Log or Transfer is selected from the Scale n menu options, a default configuration screen appears, with

no options selected.

< Logor Transfer

Minimum Weight (kg)

0

Interlock

Auto Transfer

Figure 283: Log or Transfer Screen, Default View

Additional fields appear depending on the initial selections for Interlock and Auto Transfer. The follow illus-

tration shows the menu with all options selected.

< Logor Transfer

Minimum Weight (kg) Auto Transfer

0 (L) With first stable value

'L:j' After last stable value
Interlock

Active

Auto Transfer .
() Only if scale is selected

Reset Trigger () Always

Threshold Weight “ Reset Threshold (kg)

Motion Check 0

Figure 284: Log or Transfer, All Options Selected

Note that some the Auto Transfer and Active sub-sections appear only if Auto Transfer is enabled.

Log or Transfer Options

Option Seftings

Minimum Weight (kg) This value defermines the minimum scale weight required to trigger the

and Increments.

Interlock and/or Auto Transfer actions. The weight unit for this and the other
fields on this screen is defermined by the Primary Unit set in ASM at Capacity
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3.1.5.2

Option

Settings

Interlock

When enabled, the Interlock option responds to scale data to determine when
a log action is performed. This prevents repeat logging of the same weighing
operation.

When enabled, this inferlock requires that the live weight reading be reset
according to the Reset Trigger paramefer sefting (see below). The live weight
must then settle to a weight greater than the Minimum Weight value (see
above) before the ferminal will respond to the next log or fransfer request.

If Interlock is enabled, or Auto

Transfer and With first stable value is selected

Reset Trigger

The Reset Trigger action can be performed in response to Threshold Weight
[default] or Deviation This frigger is defined either by an absolute value
(Threshold Weight) or by a minimum change in weight (Deviation).

If either Interlock or Auto Transfer is enabled

Resetf Threshold (kg) or Reset
Deviatfion (kg)

The weight value which triggers a reset and indicafes the start of a new
weighing operation and a new log entry.

Auto Transfer

When enabled, Auto Transfer causes data about each weighing operation to be
sent to the destination defined in the [Communication » Page 2267 section of
setup, depending on the parameters selected in Auto Transfer and Active.

If Auto Transfer is Enabled

Auto Transfer

When enabled, the trigger conditions defined by the Interlock settings will
automatically export data about each weighing operation either With first
stable value or After last stable value.

With first stable value: data is sent when the first stable weight is captured,
even if the weight changes afterward. This selection would typically be used for
static weighing.

After last stable value: dafa is sent based on the last stable weight captured.
This selection might be used for manual filling, where the scale weight will
briefly be unstable after the last material is added.

This selection determines whether the Reset Trigger option appears.

Active

The options fo activate the Aufo Transfer function are Only if scale is selected
and Always.

Motion Check

When enabled, the Motion Check prevents the inferlock from friggering a log or
transfer action until scale weight is within the paramefers defined as stable at
[ASM > Stability » Page 1341].

See also

¢ Communication Sefup » Page 226

& Stability » Page 134

SICS Scale Configuration

When a SICS scale is connected to the IND700, the ferminal functions as the client, sending commands to @
Lab Balance, another IND terminal, or other SICS-enabled device. Those devices function as a server, reacting
to the IND700’s commands and sending data when requested.
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To use RS232, RS485, or Ethernet inferfaces for this client/server connection, simply set the connection’s
Assignment as SICS Scale. The example shown here is for the main board serial port.

e Add Connection

Port

MNone N
None
Assignment
SICS Scale N
Scale Number
Scale 4 N

Figure 285: Main Board Serial Port Assigned for SICS Scale

To connect fo a SICS scale via the terminal’s USB port, the SICS Scale item will appear in the Assignment drop-
down only if a SICS scale is connected to the USB interface.

Note: If a SICSpro option board is to be used as a serial interface (i.e. in addition to the COM1 port on the
IND700 main board), to avoid adding a non-functional scale fo the home screen weight display, the option
board’s SICSpro port must be disabled. In the Edit Interface screen for the option board, under Hardware touch
the SICSpro — Serial port setting fo disable i, as shown below.

& Edit Interface

Port Location Baud Rate
Slot 1 9600
Hardware Stop Bits
Vs SICSpro - Serial Port One
Interface Custom Device
1/2 RS232 " None
v Data Bits Number of Remote 1/O
7 8
Parity
None A4 O \/

Figure 286: SICSpro Serial Port Disabled

3.1.6 Sum Scale

For terminals with multiple scales connected, a Sum Scale can be configured. When the Sum Scale is enabled,
a number of other screens become available, in which the Sum Scale parameters can be configured.
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Note that the Sum Scale calculation affects the terminal's status if it is in an Approved mode -- either OIML or
NTEP. This difference is reflected in the selectiosn offered by the [Metrology » Page 1777 and [Capacity &
Increment » Page 178] screens.

L B srennn
¥ 05.Feb.2024
! Setup > Scales > Sum Scale

Scales Scale 1 Settings Scale Reset

Application Scale 2 Metrology
D

Terminal Sum Scale Gapactly 8.

Increment

H ot ;

Communication Units
I

Maintenance Tare

Figure 287: Sum Scale Menu System

3.1.6.1 Settings

The Identification screen is used fo enable or disable Sum Scale, and fo configure its name, component scales
and type of sum.

{  Settings
Sum Component Scales
Enable Sum Scale
Scale 1
Scale Identification Scale 2
SumScale
Sum Type

Display Weights

High Resolution Weights

Figure 288: Sum Scale Seftings

Parameter Options Function

Enable Sum Scale Enabled, Disabled [default] When Sum Scale is not enabled,
touch this butfon to move the slider
bufton fo Enable Sum Scale and
display the other items on this
page.

Scale Identification Sum Scale [default] Touch the field fo display an
alphanumeric entry dialog,
permitting the sum scale fo be
assigned a name other than the
default.
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3.1.6.2

IND700

Sum Type

Display Weights, High Resolution
Weights

Choose the resolution of the Sum
Scale. High Resolution Weights
provides an arithmetic summation
based on the included scales’
internal fine resolution weight
values. Display Weights provides
an arithmetic summation based on
the included scales’ displayed gross
weight values.

Sum Component Scales

Sliders display, representing each
connected scale.

Determines which of the aftached
scales are included in the sum.

See also
& Scale Setup » Page 80

Metrology

The Metrology screen allows an approval to be set for the Sum Scale -- OIML or NTEP. This setting is
independent of the Metrology settings for the component scales.

{  Metrology

Approval

Not approved

Not approved

OIML

NTEP

Figure 289: Sum Scale - Metrology

Once an approval type is selected, the parameters configured for it in the scales' ASM screens are displayed,

but cannot be modified.

<{  Metrology

Approval
OIML

Verification Class

Classlll

Lower temperature limit (°C)

-10

Upper temperature limit (°C)

40

Figure 290: Sum Scale - Metrology: Approval Selected
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3.1.6.3

3.1.6.4

Capacity & Increment
The Sum Scale's capacity and increment are configured in this screen.

{ Capacity & Increment

Primary Unit Preview

kg N/ 120020 kg
Capacity

120000
Incremental step

1 2 5

Increment

20 WV

Figure 291: Sum Scale - Capacity & Increment

The Primary Unit and Capacity are set as for the component scales. In the screen shown above, the capacity
is the sum of two scales with a capacity of 60,000 kg each. An Incremental Step paramefer sefs the
magnitude of the differences between Sum Scale increments. In the example shown above, the step options are
1,3 and 5.

If 1 is selected, the default Increment size is 10, and the dropdown list offers options from 0.01 fo 10000.

o o o i den s

10

0.1

0.01

10 N

Figure 292: Drop-down List for Sum Scale Incremental Step 2

If 2 is selected, the defaulf increment size is 20, and the dropdown list offers options from 0.02 to 20000.
Similarly, selecting 5 offers options from 0.05 to 50000, with a default value of 50.

These incremental steps facilitate the sum scale calculation for Approved scales.

Units

The Sum Scale's Units screen displays the Primary Units selected in the Sum Scale [Capacity & Increment »
Page 178] screen -- which may differ from the Primary Units configured for the component scales. A
Secondary Unit can be selected here, from the usual sef of unit fypes -- g, kg, t, Ib, oz, fon.
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< Units
Primary
kg
Secondary Unit

9 A"

Figure 293: Sum Scale - Units
3.1.6.5 Tare
The Sum Scale's Tare opfions are configured in a series of screens, as seen in the image below.

é;l‘ @ 05.| Feb,‘;:;:

| Setup > Scales > Sum Scale > Tare

Scale 1 Settings Scale Reset Types

Scale 2 Metrology Auto Tare

Sum Scale f:ﬁ:ﬁ:gn% Auto Clear
Units Restart Tare

Tare

Figure 294: Sum Scale - Tare: Menu System

3.1.6.5.1 Types
Pushbutton Tare can be enabled or disabled using the slider displayed on this page. By default, it is disabled|

{ Types

Pushbutton Tare

Figure 295: Sum Scale - Tare: Types

When Types is enabled, and Sum Scale is the active scale on the home screen, touching the Tare button @R or
the Tare sofktkey *T+ (if configured) will set the current scale weight as the Sum Scale's tare value.
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3.1.6.5.2 Auto Tare
By default, the Sum Scale - Auto Tare option is disabled. When it is enabled, additional fields appear.

{  Auto Tare
Auto Tare

Tare Threshold Wt. (kg)
0

Tare Reset Threshold Wt. (kg)

0

Tare Reset Motion Check

Figure 296: Sum Scale - Tare: Auto Tare Enabled

The threshold and reset threshold parameters are the same as those shown for the respective component
scales. The only additional option is a Tare Reset Motion Check. \When this is enabled, the terminal will check
for scale stability before clearing the tare affer a fransaction. This ensures thaf zero is captured correctly affer a
tared transaction complefes.

3.1.6.5.3 Auto Clear
Tare can be cleared automatically after each transaction by enabling this paramefer.

<  Auto Clear

Auto Clear Tare

Clear Threshold Wt. (kg)

0

Clear Tare Motion Check

Figure 297: Sum Scale - Tare: Aufo Clear

The threshold value functions in the same way as for the respective component scales and, like the [Auto Tare
» Page 180] option, Auto Clear includes an optional Clear Tare Motion Check, to ensure scale stability when
tare is automatically cleared.
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3.1.6.5.4 Restart Tare
The Restart Tare option...

< Restart Tare

Restart Tare

Figure 298: Sum Scale - Tare: Restart Tare

When Restart Tare is enabled or disabled, an OK button [v| appears af lower right. Click this bufton fo confirm
the change.

3.1.6.6 Reset

Scale Branch Reset
Nofe that this Reset function refers only to parameters configured in the currently selected
setup branch. For general Terminal reset options, refer to [Reset » Page 284].

RESET CALIBRATION
DATA

RESET SETTINGS

Figure 299: Scale Reset Options
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This screen allows the user fo reset either calibration data or settings. If seffings is selected, calibrafion data are
preserved. In either case, a confirmation dialog will appear and the operation can be continued or cancelled.

Reset settings

Are you sure?

Figure 300: Reset Confirmation Dialog

See also
& Reset » Page 284

3.2 Application Setup

The Application menu offers four items, which control various application-specific features of the terminal.

For setup and operation of the optional ProWorks Mulfi-Tools applications, refer to the ProWorks Multi-Tools
User's Manual, provided when the ProWorks license is purchased. The screen below shows the menu as it
appears in a terminal without this license.

12:31

25.May.2023

Setup > Application

Scales Memory
Application ID Form
: Auto Start
Terminal e
Application
Communication Discrete [/O

Maintenance

Figure 301: Application Menu
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3.2.1 Memory
The Application > Memory menu offers the following options.

fé}n @ 25.May_122:;z§

Setup > Application > Memory
e
Scales Memory Alibi Enable
Application ID Form Alibi Table
Terminal Auto‘ Sta.rt Tare Table
Application
Communication Discrete I/O Transaction Table

Maintenance

Figure 302: Application Memory Menus

3.2.1.1 Alibi Enable

< Alibi Enable

Alibi Memory Table

Figure 303: Application - Memory - Alibi Enable Screen
This screen simply determines whether Alibi memory is enabled (storing data) or disabled.
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3.2.1.2 Alibi Table

< Alibi Table Y M

Log Transaction  Scale  Gross Net Tare
ID Time Counter # Weight Weight Weil
7 06.Feb.2024 09:39:08 1 2129 1.989 0
6 06.Feb.2024 09:38:51 1 2.140 1.990 0
5 06.Feb.2024 09:38:46 1 2.140 1.990 0
4 06.Feb.2024 09:37:09 1 2.140 1.990 0
3 06.Feb.2024 09:36:52 1 2139 1.989 0
2 06.Feb.2024 09:36:11 1 2212 2.062 0
1 01.Feb.2024 20:12:45 1 0.000 0.000 0

Figure 304: Alibi Table View

This screen displays the current contents of the Alibi Table.

Alibi table data can be filtered and exported. For details on these functions, refer to [Table Functions: Filter,
Export, Import, Clear, Table Size Limits » Page 47].

3.2.1.3 Tare Table

Access the Tare Table screen to manage tare records. Records can be created, delefed, imported or exported
from this screen.

{ TareTable Y + bt i
ID Name Description Value Unit Low Limit
1 RS-1 Sugar bin #1 1.5 kg
2 Aggregate hopper Medium container 15.0 kg
3 Sand, fine kg 9.
4 Cement, standard Wheeled bin kg g.
5 Gravel, medium Bedding gravel kg 47
6 Box, SS screws 2.0 kg
7 Cement, sp 10.0 kg
8 Box, medium Box for rubber balls 1.5 kg

. __________________________________________________________________________________________________|]

Figure 305: Tare Table
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3.2.1.4

IND700

< Add Tare

ID Tare Value Unit
9 0 kg v/
Invalid Value
Name Lower Limit
0
Invalid Value
Description Upper Limit
0
Invalid Value

Scale 1 (Gross Weight)

1.45 kg

Figure 306: Add New Tare Record

Parameter Setting

ID These three fields can be modified fo provide a user-friendly Name and functional

Name Description of the tare, fogether with a tare ID number. If a duplicate tare ID is enfered,

Description the ferminal will indicate this, and a different ID number must be entered.

Tare Value The tare can be given an absolute weight value. The associated unit is also configured

Unit here.

Lower Limit Instead of an absolute value, the tare record can have upper and lower limit values,

Upper Limit defining the acceptable range of variation in container weight. If the container's weight
does not fall within this range, the terminal will indicate a tare failure.

Scale e This field shows the current scale weight. When a container is on the scale, its weight
will be displayed here, permitting the absolute or limit values to be set.

’T‘ Touch this butfton to use the current scale weight in the Tare Value field.

E@ Touch this button to switch between available scales for the source of the fare value.

For further information on configuring tare records, refer to [Tare Table » Page 317] in [Table and Log File
Structure » Page 312].

For information on table operations, refer to [Table Functions: Filter, Export, Import, Clear, Table Size Limits »
Page 471].

See also

¢ Tare Table » Page 184

Transaction Table

The Transaction Table is enabled by default, and cannot be disabled. Each transaction performed by the
terminal is stored here, with one transaction per row. Access the Transaction Table either at Setup > Appli-
cation > Memory > Transaction Table, or by fouching the Transaction Table softkey, which can be added fo
the ribbon on the main screen at [Softkeys » Page 212].
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Transaction Table columns adapt to the terminal configuration dynamically, so that all available information is

represented in the table. The image below shows a Transaction Table with the default columns.

{ Transaction Table Y i
Log ” Transaction Scale Gross Net Tare
Time Counter # Weight Weight Weight
12.Feb.2024 08:11:24 4400 4400 00
12.Feb.2024 08:11:14 ¥ 10700 10700 00
12.Feb.2024 08:11:05 > 9750 9750 00
12.Feb.2024 08:10:58 > 9200 9200 00

Figure 307: Transaction Table with Default Columns

Table dafa can be exported and deleted, using the icons in the menu bar. Selecting delete displays a confir-

mation dialog:

Warning

Clear Entire Table?

X

Figure 308: Confirmation Dialog for Clearing Transaction Table
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The Export function displays the sfandard Table Data Export screen:

{  Table Data Export

Directory

Internal File v Ch\Export\e9569416DZ

File Type

Ccsv

File Name

IND700_2023_08_03_1246_Transaction

Figure 309: Table Data Export Screen

The type and name of the exported file can be changed; the Directory where the file is stored in the IND700
cannot be changed. Click the check icon at lower right to perform the export and return to the Transaction Table
view.

3.2.1.5 Clearing Tables

The contents of the Tare Table and Transaction Table can be cleared by touching the CLEAR M icon at upper
right in the table view screen. A confirmation dialog will display:

Warning

A Clear Entire Table?
X

Figure 310: Clear Table Confirmation Dialog

3.2.2 ID Form

The ID Form is configured by naming and enabling up to ten fields of data.
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To modify the form, access Setup > Application > ID Form. A list of ID Form fields will display, indicating the
name and configuration of each available field.

Fields will only appear in the ID Form accessed from the home screen by touching the ID Form softkey [ if the
Status column shows that it is Enabled.

To edit a field, touch ifs row in the table. An edit icon will appear.

ID Form
Name Status Numeric Only Preserve Prev. Value
Product Enabled Enabled Enabled
Batch Enabled Enabled Enabled
Lot No. Enabled Enabled Enabled
i Enabled Enabled Enabled
|:h/;jator 1D Enabled Disabled Enabled
Ident F Disabled Disabled Disabled
Ident G Disabled Disabled Disabled
Ident H Disabled Disabled Disabled
IdentI Disabled Disabled Disabled
Ident ] Disabled Disabled Disabled

Figure 311: ID Form Edit Icon Pop-Up

Touch the edit icon to open the Edit ID screen in its defaulf state.

S Edit ID

D
6

Name

Ident F

Status

Numeric Only

Preserve Prev. Value

Figure 312: Edit ID Screen

To give the field a descriptive name, fouch the Name field. An alphanumeric entry screen will display.

< Name
Carrier
1 2 | 3
q |w| e
a|s|d
Zg Lt
il

6 || 7
Yy u
h
b | n

Figure 313: Naming the ID Form Field
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Enter the name and touch the check mark to confirm the entry. The Edit ID screen will now show a check mark,
indicating that there are changes to be saved.

< Edit ID

1D

Status
6

Name

Numeric Only
Carrier

Preserve Prev. Value

v
Figure 314: ID Field Named
The other fields in this screen are as follows.
Edit ID Options
Option Function
Status When active, this setting causes the ID field to appear in the ID Form.

Numeric Only | When active, this setting constraints the field's input options to a numeric value. This helps
ensure the correct type of enfry. When this setting is not actfive, field entry can be
alphanumeric.

Preserve Prev. |\When this sefting is not active, field entries made during a transaction are cleared when a
Value new fransaction starts. In many cases, much of the ID Form content -- such as the name of
the operator or the product -- will remain constant from one weighing operation to the next.
When this sefting is active, the fields remain filled-in. Each field can be modified as usual
from the ID Form screen, simply by touching the field and making the appropriafe entry to
overwrite or simply delete the existing confent.

Touch the check mark to confirm the changes and refrurn fo the Application > ID Form view.

3.2.3 Application-Specific Menus

In its default state, the Select Application menu shows only the standard application, [ID Form » Page 187].

A ProWorks Multi-Tools license is necessary fo enable the other applications -- Counting, Classification,
Filling, Over/Under weighing and Totalization. For details on the configuration and use of these applications,
refer to the ProWorks Multi-Tools User's Manual, which is provided when the application license is purchased.
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3.2.4 Auto Start Application

Please verify that the required license is activated before enabling a customized application such as Axle View.
If the correct license is not applied, the system will need to be restarfed, and will revert to the previous appli-
cation.

<{  Auto Start Application

MT.Singularity.Platform.Client. MTApp

Figure 315: Application - Auto Start Application

This screen displays a drop-down list which includes all installed applications. Select Applications from this list
to determine whether or not they start automatically when the terminal is started.

3.2.5 Discrete I/0

1253
25.May.2023

Setup > Application > Discrete I7/0

Scales Memory Discrete Inputs
Application ID Form Discrete Outputs
: Auto Start
Terminal o
Application
|
|
| Communication Discrete I/O

Maintenance

Figure 316: Discretfe /0 Menus
Discrete Inputs and Discrefe Outputs are configured from the Discrete I/0 menus.
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3.2.5.1 Discrete Inputs

The screen image below shows the Discrete Inpufs screen in its default state, with no inputs configured.

<{  Discrete Inputs +

ID Name Type Location IP Address Node Position

+  Add new discrete input

Figure 317: Discrete Inpufs List

To add a Discrete Input, click on + in the list view. The following screen will appear:

<  Add new discrete input

1D Assignment
1 None b i
Name Polarity
* ~
Type
None N7

Figure 318: Discrefe Inputs -- Add New

<  Add new discrete input

ID Assignment

1 None N
Name Polarity
F AV

Type

Scale Card N
Location

Scale 1 AV
Position

1 74

Figure 319: Discrefe Inputs -- Add New, Scale Card Type Selected

The table below summarizes the options available in the Add new discrete input screen, which change
depending on the Type and Assignment selected.

Parameter Settings

inpufs and re-creating them in the desired order.

ID The Discrete Inpuf ID is automatically set and cannot be changed, except by deleting existing

inpuf should be entered.

Name Touch the Name field fo display an alphanumeric entry screen where a descriptive title for the
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Parameter

Settings

Type

Select from the Type list to determine the location of the input -- either on the main PCB, or on
a scale inferface, or in an ARM100 Remote 1/0 module (if connected).

Type

Mone

MNone
Scale Card
Main Board

Location

Determines which sef of DIO connections are to be used by this input. If Main Board is
selected, this field does not appear. If Scale Card or ARM100 is selected, Location permits
the selection of one of the scale interfaces or modules.

Position

The Main Board and each of the scale interface cards includes 2 digital inputs and 2 digital
outputs. Position refers to these; 1 selects output 1, 2 output 2. ARM100 module output
addresses include a module designator.

Assignment

The input's Assignment can be selected from this dropdown list. The input will be triggered by
the selected assignment:

MNone

Blank Display
Tare

Clear
Transaction
Disable Setup

i e e

Mone

Transaction
Disable Setup
Switch Units
Primary Unit
Secondary Unit
Zero

Mone

A4

Channel

If the input’'s Assignment is Tare, Switch Units, Primary Unit, Secondary Unit or Zero a
Channel field appears. Touch this field fo display a drop-down list of available scale
channels, including Active Scale, Scales 1, 2, 3 and 4.

Polarity

Polarity can be either positive (+) or negative (-). This setfing defermines which state of the
assigned trigger causes the input to be active.
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3.2.5.2 Discrete Outputs

The screen image below shows the Discrefe Outpufs screen in ifs default state, with no outpufs configured.

<  Discrete Outputs -

ID Name Type Location IP Address Node Position

4+  Add new discrete output

Figure 320: Discrefe Oufputs List

To add a Discrete Output, click on the + in the list view. The following screen will appear:

< Add new discrete output

1D Assignment
1 None N

Name

Type
None ~/

Figure 321: Discrefe Oufputs -- Add New

Once an Assignment and Type have been chosen, additional fields appear:

<  Add new discrete output

D Assignment
2 Over Capacity WA
Name Channel
Active Scale N
Type
Naone N

Figure 322: Discrefe Output Options, Assignment Selected

If the Assignment is Comparators, a Comparators field will display. Touch this screen to view the Discrete
Outputs list. Here, the output can be associated with a comparator so that the output is triggered when the
comparator's condition is satisfied. Note: Comparators are available in the IND700 only when the ProWorks

Multi-Tools license is activated. Refer to the ProWorks Multi-Tools User's Manual for further details on
Comparators.
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D Assignment
1 Comparators N
Name Comparators
Within target tolerance 1/ Within range &
Type
Main Board N
Position
1 v
v
Figure 323: Discrefe Oufput, Comparator Assignment

Touch the Comparators field to display a list of available comparators.

{  Comparators

03
04
05
06
07
08
09

ID Name Data Source Channel Operator Lim
01 Within range Displayed Weight Scale 1 > < 2.
02 Process underway Displayed Weight Scale 1 >

Figure 324: Comparators List

Touch the required comparator and select the check mark from the confext menu which appears:

<

ID

Comparators

Name

01
02

Sy

O /L Vooe

e
Process underway

Figure 325: Comparafor Selection Context Menu

The table below indicates the function of each of these options.

Parameter

Settings

ID

The Discrete Output ID is aufomatically set and cannot be changed, except by deleting
existing oufpufs and re-creating them in the desired order.

Name

output can be entered.

Touch the Name field fo display an alphanumeric entry screen where a descriptive title for the
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Parameter Settings
Type Select from the Type list to determine the location of the output -- either on the main PCB or
on a scale interface, or in an ARMT00 Remote I/0 module (if connected).
Type
Virtual N/
None
Scale Card
Main Board
Virtual
Options are:
* None
¢ Scale Card
e Main Board
e Virtual
e ARMT10O (if connected)
Location Type = Scale Card: Scale 1, Scale 2
Type = Main Board: 1, 2
Type = Virtual: Virtual |0 Device
Type = ARM100: Up fo 8 modules
Note: The Virtual option is used for system diagnostics only; outputs triggered from the
Maintenace > Run > Diagnostics >[DIO Test » Page 281] do not affect attached devices.
Position If Type is set to Virtual or ARM100, a Position field displays, from which the address of the

output can be selected.
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Parameter

Settings

Assignment

The output's Assignment can be selected from this dropdown list. The oufput will be triggered
by the selected assignment:

None

Center Of Zero
Net

Motion

Over Capacity
Over Zone

£l i1 e

MNone

Assignment options are:

None

Center of Zero

Net

Motion

Over Capacity
Under Zero

Over Zone

Ok / Tolerance Zone
Under Zone

Classes 1 -8

Low Zone

High Zone
Comparators
System Error Alarm
System OK

Scale T - 4 selected
Sum Scale selected

If Assignment is set to a scale-related parameter (Center of Zero, Net, Notion, Over Capacity,
Under Zero), the Channel field appears. This drop-down lists offers the following options:

Active Scale
Scale 1 - Scale 4
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3.3 Terminal Setup

The Terminal branch includes the following menu options:

E—
| — e 12Jul.2025

Setup > Terminal
Scales Device Region Application mode
Application Display Softkeys Message Center
Terminal. Transaction Counter  Security Options Smart5
Communication Users Windows
Maintenance Roles Licensing

Figure 326: Terminal Menus

3.3.1 Device

{ Device

Terminal ID #1

Terminal ID #2

Terminal ID #3

Terminal Serial Number

69569416DZ

Figure 327: Terminal - Device

Parameter Options Function
Terminal ID #1, 2, 3 Displays an alphanumeric entry Three opfional sfrings used fo
dialog. identify the terminal. These could
include location, function, etc.
Terminal Serial Number Displays a value. This serial number is fixed and
cannot be modified.
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3.3.2

Serial Number Mismatch

If the Terminal Serial Number field is editable and shows a "Serial Number Mismatch" warning in red, click on
the field. If necessary, enter the correct serial number from the terminal's data plate, and then confirm the entry

in the alphanumeric entry kepad. Finally, click the check mark |v| which appears af lower right in the Device
screen. The serial number mismatch will be cancelled, and the serial number will no longer be editable.

Display

< Display

Backlight Timeout

Backlight (minutes)

30

Screen Saver

Figure 328: Terminal - Display

All Scale View
Auxiliary Display
Tare Active

Message Timeout (seconds)

3

Backlight (brightness)

50

Backlight Timeout and Screen Saver
Either the Backlight Timeout or the Screen Saver can be enabled, but not both af the same

time.
Parameter Options Function
Backlight Enabled, Disabled  Determines whether the backlight timer is operative.
Timeout
Backlight Displays numeric Determines how many minutes the terminal must be inactive before the
(minutes) entry dialog. Default |backlight is turned off.

is 30.

Screen Saver

Enabled, Disabled

Determines whether the screen saver is operative.

Screen Saver

Displays numeric

Determines how many minutes the terminal must be inactive before the

(minutes) entry dialog. Default | screen saver is invoked.
is 30.
All Scale View | Enabled, Disabled | Determines whether the main screen displays information for all scales
at once, or one at a time (using Scale Swifching to change between
Views).
Auxiliary Tare Active, Tare Determines when the tare display appears af lower left of the weight
Display Always. display window. By default, this display appears only when a tare

Auiliary Display

Tare Active v

Default is Tare
Always.

value is active and the terminal is in Net mode.
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Message Default is 3 seconds.  Determines how long fo display the popup which appears when a

Timeout message arrives in the message area at fop left of the screen. The

(seconds) maximum value is 30 seconds. A value of O prevents the message
alert from displaying, but messages stfill accumulate in the message
area.

Backlight Default is 50. The brightness of the backlight is configurable, so that the display can

(brightness) be adapted to its environment. In a darker space, a lower number will
be adequate. The value is relative, where O represents no backlight,
and 100 represents the backlight's highest possible value.

3.3.3 Transaction Counter

< Transaction Counter

Transaction Counter

Allow Counter Reset

Next Transaction Number

1

Figure 329: Transaction Counter

When the Transaction Counter is Enabled (the default is Disabled), an Allow Counter Reset option becomes
available; when this is Enabled, a field displays which, when touched, opens a numeric entry dialog permitting
a new transaction count start number to be defined.

3.3.4 Users

<  Users

User Name Access Level Default User

Admin Administrator

Operator Operator

Figure 330: Users List

The Users list displays all currently configured users.
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General Users Settings
Touch the Settings icon & to display the General Users Settings screen.

< General Users Settings

Connect device to Domain Automatic logout

Logout time (min)

5

Domain User Login

Figure 331: General Users Settings Screen

Automatic Logout and its associated Logout time (min) parameter can be disabled only when Connect
device to Domain and Domain User Login are disabled.

Before enabling the Connect device to Domain function, make sure that the Unified Write Filter (UWF) is
disabled af [Security Options » Page 215]. Otherwise, an attempt fo make this setting will result in a warning:

< Warning

UWEF is enabled. Turn off UWF in
A setup > terminal > security options

and cycle power. Then retry.

Figure 332: UWF Warning Dialog

Nofe that disabled the UWF in the Security Options screen requires a terminal re-boot. When UWF is disabled,
touch the Connect device fo Domain slider to display fields used for domain access.

< General Users Settings

Connect device to Domain .
Domain Name Logout time (min)
5
Service Account Name
Domain User Login
Service Account Password LDAP/LDAPS Access String

Computer Name

WIN-MUUPIHFGDEN

Figure 333: Device Access fo Domain Parameters Displayed

200 | Configuration IND700



IND700

When Domain User Login is enabled, a LDAP/LDAPs Access String field is displayed.

Domain User Login

LDAP/LDAPS Access String

Figure 334: LDAP/LDAPs Access String Field
Touch this field to display an alphanumeric keypad for string entry.

< LDAP/LDAPS Access String

< | 2 |

i) . v

Figure 335: Access String Entry Dialog

Enter the required string and fouch the check mark fo connect fo the domain.
Adding, Editing and Deleting Users

Touch a row to display the options for that row; neither of the default users can be delefed, but can be edited.

Additional users of any access level can be creafed, edited and delefed.

To set a default user, click the Default User slider in the Edit screen. There can be only one default user. To
delete a default user, first visit the user Edit screen and set the Default User slider fo disabled. The user can
then be deleted from the Users list.

itnr
Figure 336: User Edit Options

< Edit

User Name

Admin

Password

Access Level

Administrator

Default User

Figure 337: Admin User Edit Options
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<  Edit User
User Name
Operator

Password

Access Level

Operator d

Default User

Figure 338: Edit Standard User Opfions

3.3.5 Roles

This table permits the creation of users with very specifically defined access to IND700 configuration and
functionality. Roles definitions are more refined than those between the basic Operator, Supervisor and Adminis-
frafor logins. New roles can have custom names (for example, corresponding fo role fitles atf the customer’s
site) and cusfomized access to configuration and operational features. Because a role’s permissions can be
very fightly controlled , a ferminal may include a large number of different roles which users can occupy,
depending on workplace requirements.

A “base role” must be selected for the default settings.

3.3.5.1 Roles Table

The Roles table view is accessed in setup at Terminal > Roles Refer to [Terminal Setup » Page 197].
A list shows all existing roles, indicafing their name, description, level and status.

< Roles @ '+-
Mame Description Active Level
Admin v System Administrator
Supervisor o System Supervisor
Operator " System Operator

Figure 339: Roles Table View

To view all currently configured Levels, click on the setup icon ;. Refer to [Levels » Page 204].
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Touch a row in the Roles fable and, if the current login has the appropriafe permissions, an Edit pop-up will
display.

& Roles

Access Level Description Active Level

Administra | Everyday admin v System Administrator
K

Operator v System Operator

Figure 340: Roles Table View, Row Selected

Click the Edit icon to display the Role configuration screen. For the basic Admin, Supervisor and Operator
roles, the seftings in this screen can be viewed, but not modified.

<  Roles

Supervisor & @ Aciive

Description

Based on role

Supervisor

Level D

System Supervisor

Figure 341: Role Configuration Display, Non-Editable Fields

For all other roles, all fields in the Edit screen can be modified.

<  Roles
Name
Super-User Active

Description

Admin performing production role

Based on role

Administrator b
Level ©
Troubleshooting bV

Figure 342: Role Configuration Display, Editable Fields
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The Level field is a drop-down menu which lists all configured levels, as shown in the Levels Table view
above. A pop-up dialog explains the purpose of the field.

Level ©

Trd |evels help to compare _ s
custom roles between each
other.

Figure 343: Level Information Pop-Up
Click the check mark at lower right to confirm the configuration changes.

3.3.5.2 Levels

To access the Levels table, click the setup icon at upper right in the Roles table view. The Levels fable view will

display.
< Levels
Level Custom Level Name
System Administrator System Administrator

Expert Administrator
Senior Administrator
Intermediate Administrator
Junior Administrator

System Supervisor System Supervisor

Expert Supervisor
Senior Supervisor

Intermediate Supervisor

Figure 344: Levels Table View
The System Administrator level cannot be modified. Click on any other Level to display an Edit pop-up.

Level Custom Level Name
System Admin _/ or System Administrator

Expert Administrator
Senior Administrator

Figure 345: Edit Pop-Up for Custom Level Name
Click the Edit icon to display a screen in which a Custom Level Name can be defined.

<  Level name

Level
Expert Administrator

Custom Level Name

Figure 346: Level Custom Name Definition Screen
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Enter a custom name for the selected Level.

< Level name

Level
Expert Administrator

Custom Level Name

Troubleshooting

Figure 347: Custom Name Defined

Click the check mark at lower right to confirm the custom name and return fo the Levels screen. The new
custom name is displayed.

< Levels
Level Custom Level Name
System Administrator System Administrator
Expert Administrator Troubleshooting

Senior Administrator

Intermediate Administrator

Junior Administrator

System Supervisor System Supervisor

Expert Supervisor

Senior Supervisor

Intermediate Supervisor

Figure 348: Levels Screen, New Custom Level Name Displayed

3.3.5.3 Creating a New Role

IND700

Click the + icon at upper right in the [Roles table view » Page 202]to configure a new role.

< Role

Name

NewRole Active

Description

Expert user for ABC process

Based on role

Administrator

Level ©@

Senior Administrator

Figure 349: Role Creation Screen

To simplify configuration, each new role is based on an existing role. The new role is assigned a Name, an
optional Description, and a Level. A toggle sets the new role to Active, or inactive. If the role is set to Active, a
check mark will appear on the role’s row in the Roles table.
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3.3.5.4 Permission Groups

Touch a row in the Roles table and select the Edit . icon. The Roles edit screen will display. Touch the Setup
icon & at lower right. The Permission Group screen will display. This eight-page screen is used fo configure
the role’s access to ferminal configuration and functionality, including any installed applications. Permissions
can be set that correspond to functional distinctions between positions in the workplace. The Description field
in the Role creation screen is useful for making clear the relationship between an IND700 Role and existing
employee levels.

The first Permission Group screen configures overall access o scale configuration via the ASM. The Levels 1, 2
and 3 options configure an initial combination of permissions, to facilitate the customization.

< Permission Group

Scales

ASM

Level 1 (Admin)

~ General
Level 2 (Supervisor)

1/8
Level 3 (Operator)

S

Figure 350: Permission Group Screen, Page 1 of 8

In addition to the three 'basic' role levels, a General slider appears. When it is enabled, each transaction
performed by a user occupying this role will frigger a Log or Transfer action or a Loading Alert, if those
features are active.

The second screen defines specific scale configuration functions as available or unavailable to the role.

<  Permission Group

Scales

Sum Scale

Settings Tare

Identification Restart Tare

Metrology Scale Reset

Capacity & Increment

Units

Figure 351: Permission Group Screen, Page 2 of 8
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The third page covers general Application configuration. Note that access to an application’s configuration and
function is all or nothing — it is not possible to give permission fo only part of an application.

<  Permission Group

Application

Configurations

Discrete I/O

ID Form

Comparators

Memory

Material Table

Alibi Enable

Counting

Totalization

Manual Filling

Over/Under

Classification

Figure 352: Permission Group Screen, Page 3 of 8

The fourth page sets permissions for Data Integrity functionality.

<  Permission Group
Application

Data Integrity

DI Transaction Operations

@ DI Transaction View

DI Audit Log Operations

@ DI Audit Log View

DI Configuration

Figure 353: Permission Group Screen, Page 4of 8

The fifth page sefs access fo the first set of Terminal configuration functions.

<  Permission Group

Terminal
Region
N Device
Language
5/8
Time & Date Format
v

Setting Time & Date

Application Mode

Windows settings

Security

Remote connections

Softkeys

Figure 354: Permission Group Screen, Page bof 8
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The sixth page completes the list of Terminal configuration functions. User Management is available when the
role being defined has an Administrator level login.

<  Permission Group

Terminal
Transaction Counter @  User Management
N Display
All Scale View
6/8
Auxiliary Display
A4

Licensing

Message Center

Figure 355: Permission Group Screen, Page 6 of 8

The seventh page deals with the Communication section of setup.

< Permission Group
Communication

Ethernet Industrial Networks
Interfaces Web Server
Connections

Output Templates

Input Templates

Figure 356: Permission Group Screen, Page 7 of 8

Finally, page eight covers access fo Maintenance functions. An information pop-up explains the options
enabled by the Power foggle. The options are Exit Application, Reboot, Shut Down.

<  Permission Group
Maintenance

Logs Power @
Backup & Restore

Software Updates

Diagnostics

Resets

Figure 357: Permission Group Screen, Page 8 of 8
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3.3.6 Region

;L @ D2.Augg':;g§

Setup > Terminal > Region

Device

Display

Transaction
Counter

Users

Region

Figure 358: Region Menu

Softkeys

Clear Messages

Security Options

Windows

Licensing

The Region menu offers the three options listed below.

3.3.6.1 Language

{ Language

User Language Selection

Display Messages

English

On-Screen Keyboard

QWERTY

External Keyboard

Windows

Default

Figure 359: Region - Language

Application mode

The Language page allows a language to be defined for the following items.

Language |

Time and Date
Format

Set Time and Date

Messages.

Parameter Options Function
User Language Enabled [default], |\When Enabled, the user can select a Display Messages language
Selection Disabled from the globe icon [@on the home screen. When User Language

Selection is Disabled, the globe icon is not displayed and the
terminal's language is fixed to the selection made in Display

IND700
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Display Messages  English [default], | Defermines the language in which displayed messages are
Francais, Deutsch,  shown.
[taliano, Espaniol

On-Screen Keyboard 1 QWERTY [default], |Determines the keyboard layout for alphanumeric input screens.
QWERTZ, AZERTY

External Keyboard ' Windows Keyboard | Determines the layout for an external (USB) keyboard.
[default], English
(United States)-US,
German (Germany)-
German, French
(France)-French,
[talian (ltaly)-Italian,
Dufch (Netherlands)-
United Stafes-Inferna-
tional, Chinese
(Simplified, China)-
Chinese (Simplified)
- US, Spanish
(Spain, International
Sort)-Spain

3.3.6.2 Time and Date Format

< Time and Date Format

Preview of Time and Date Time Separator

23:37

25.Aug.2021 Date Format

Day Month Year
Use 24 hour clock

Date Separator
Display Seconds

Show 2 Digit Month

Show 2 Digit Year

Figure 360: Time and Date Format Options

Parameter Options Function

Preview of Display only Shows how time and dafe are currently formatted.

Time and Date

Use 24 hour  |Enabled [default], |Selects a 12 or 24 hour clock display. If 12 is selected AM or PM is
clock Disabled appended fo the time display, depending on the current 12 hour period.
Display Enabled, Disabled | Seconds can be displayed or hidden.

Seconds [default]

Show 2 Digit  |Enabled, Disabled | The month is either displayed in abbreviated alphabetical form (e.g.
Month [default] Aug) or as two digits (e.g. 08).

Show 2 Digit  |Enabled, Disabled | The year is either displayed as four digits (e.g. 2021) or two (e.g. 21).
Year [default]

Time Separator |. [default], , Determines the character used to separate elements of fime display.
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Date Format

Day Month Year Detfermines the sequence of the date display.

[default], Month
Day Year, Year
Month Day

Date Separator

None, (space), Determines the character used to separate elements of the dafe display.

Dash, .
[default], /, :

3.3.6.3 Set Time and Date

{ SetTime and Date

Time Zone

(UTC-08:00) Pacific Time (US & Canada)

25.May.2023

NTP Network Time Protocol

NTP Server Address

time.windows.com

NTP Polling Interval (s)

Daylight Savings Time

3600

Last Sync

Figure 361: Set Time and Date

unspecified

By default, when the terminal is connected to a network the NTP Network Time Protocol option is selecfed, and
only the Daylight Savings Time slider remains acfive.

If the tferminal is not connected to a network, the fields on this screen can be used to set the appropriate time

and date.
Parameter Options Function
Time Zone All time zones and regions from UTC-12 fo Sets local time zone.
utC+14
Hour : Minute | Each field opens a numeric entry dialog. Sefs the current fime.
Daylight Enabled [default], Disabled Determines whether or not Daylight Savings
Savings Time Time is observed.
Set Date Displays a calendar screen Current date can be selected from the

=

| August 2021 >

Su Mo Tu We Th Fr Sa

25 26 27 28 29 30 31
1 2 3 4 5 6 7
8 9 10 11 12 13 14

15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30 31 1 2 3 4

calendar screen.
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NTP Network
Time Protocol

Enables or disables NTP.

If the terminal is connected to a domain
which provides its own rules, this toggle is
greyed out and the data fields are
populated with information from the
Windows registry.

Otherwise, enabling NTP allows the
terminal to set ifs fime and date automat-
ically, by referring to the configured Server
Address.

NTP Server
Address

Default is time.windows.com.

NTP Polling
Interval (s)

Determines the frequency of NTP polling. The
default value is 3600 seconds, or 1 hour.

By default, this value is read from the
Windows registry.

Last Sync

Displays the time stamp of the last synchro-
nization with the NTP. Default is Not specified,
indicating that no synchronization has taken
place.

In a terminal that is not connected to a
network, polling cannot fake place, and
this value will remain unspecified.

@

Synchronizes time and date with NTP server,
then exits o Setup > Terminal > Region menu
view.

3.3.7 Softkeys

The softkeys displayed in the ribbon on the IND700 home screen are configurable, and can be used fo access
various functions and features directly. By default, the Softkey Ribbon Editor screen appears as shown here:

<

Softkey Ribbon Editor

O ¥ Vv

PT

Preset Tare

C I T

Tare

M

Transfer

A%

Switch Scale

#!

Switch Units

Alibd Mernory

Transaction Tab

Tare Table

[&)

Higher Res.

3,

Input Template

Drag and Drop Softkeys in and

out

Preset Tare

5E || O A

Switch Scale Switch Units Alibi Mermory

Tare Table

Higher Res.

ID Form Input Termplate

Figure 362: Softkey Ribbon Edifor: Softkeys Displayed with Labels -- Default
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To display softkeys without labels, touch the T.Z at upper right.

<{ Softkey Ribbon Editor O T

[=)
®
)
=
[
)

Drag and Drop Softkeys in and out 115

Brejzm|c|n|aln]|>

Figure 363: Softkeys Displayed Without Labels

Additional softkeys can be selected from the scrolling array at the bottom of the screen, and dragged to a
position in the editor. The predefined softkeys cannot be moved or deleted.

Touch the reset icon @.at the fop right fo reset the softkey ribbon to its default configuration. A confirmation
dialog will display:

Warning

Reset Softkeys to
A default

configuration?

<

Figure 364: Reset Softkeys Confirmation Dialog
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3.3.8 Clear Messages

{ Clear Messages

Press Run to clear all messages from the system bar.

Figure 365: Clear Message

Touch the RUN arrow at lower right to clear all messages from the system bar on the home screen. A confir-
mation dialog will display:

< Messages have been deleted.

Figure 366: Clear Messages Confirmation Dialog
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3.3.9 Security Options

IND700

Security Options

Watchdog Timer (s)

Unified Write Filter

30

Keyboard Filter FTP Server (Port: 50001)

External Mass Storage Bloc...

Enable Windows Desktop

Firewall

SFTP Server (Port: 22)

Remote Desktop Server

Figure 367: Terminal Security Optfions

Parameter Options Function
Unified Write  |Enabled The Unified Write Filter is a Windows feature that helps to profect drives by
Filter [default], intercepting and redirecting any writes fo the drive (app installafions, setfings
Disabled changes, saved data) fo a virtual overlay. This virtual overlay is a temporary
location which is cleared during a reboot. For this reason, take care when
performing an installation: If UWF is set to Enabled, the installation will be
lost when the terminal is rebooted. When installing software outside folders
excluded from UWF, first disable UWF. The following files, folders and
registry keys are excluded -- their confents will be preserved during a reboof:
Keyboard Filter 'Disabled The Keyboard Filter suppresses undesirable key presses or key combi-
[default], nations -- for example, Cirl+Alt+Delete, and the Windows key. Applying the
Enabled Keyboard Filter can block any key combination or system keys which would

allows the user to exit the application and access the Windows deskiop. The
following keys and key combinations are suppressed by this filter:

Windows key Application key Function keys F1-F24

Security Keys Security Keys Shft-Cirl- | Accessibility Keys

Cirl+Alt+Del Esc LShift+LAlt+PrniScr

Accessibility Keys Application Keys Alt+F4 | Application Keyes

LShift+LAlt+NumLock Cirl+F4

Alt+Space Cfrl+Esc Alt+Tabe

Cirl+Tab LaunchMail LaunchMediaSelect

LaunchApp1 LaunchApp2 Microsoft Surface Key
F21

VolumeMute VolumeDown VolumeUp
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External Mass | Disabled Infroducing an unknown USB storage device into the system can cause
Storage [default], security issues. Removable storage media can be blocked from read/write
Blocking Enabled access. If this feature is Enabled, an external USB sforage device will not be
defected and cannof be used. The USB storage device will be accessible only
if this feature is Disabled.

Enable Enabled To avoid changes in the Windows OS, access to the deskfop can be limited.
Windows [default], When this feature is Enabled, the Windows desktop will appear when the
Desktop Disabled user exits the Application. If it is Disabled, a black screen will appear when

the user exits the application. Remove and restore power to restarf the
terminal with the application running.

Firewall Enabled The Windows Firewall can be Enabled or Disabled; by default, it is
[default], disabled.
Disabled
Watchdog 30 The Watchdog Timer monifors the function of the ferminal's CPU. If the CPU
Timer (s) is prevented from performing scale functions because it is execufing a

Windows process, the watchdog will perform a system reset

Note: Setting a value of 10 or less for the Watchdog Timer will cause the
system fo reboot continuously.

FTP Server Disabled If this feafure is Enabled, files -- such as saved configuration files or log files

(Port: 50001) |[default], -- can be read from and writfen fo the terminal using an FTP utility.
Enabled

SFTP Server Disabled A Secure File Transfer Profocol (sFTP) can be enabled for devices accessed

(Port: 22) [default], through a PC network. For access, the user name is Admin and password
Enabled 248163264. These seftings cannot be changed. The SFTP server connects

to the root directory, C:\, on connection.

Remote Disabled \When the Remote Desktop Server is Enabled, a remote connection can

Desktop Server | [default], view the terminal's screen and control its function, including logging in and
Enabled modifying configuration and calibrafion values.

Data+ Disabled When Data+ is enabled, the METTLER TOLEDO Data+ application is granted
[default], access to the ferminal and can be used to configure and run it remotely.
Enabled

3.3.10 Windows

i 23:40
3 ®
T 1 25.Aug.2021

Setup > Terminal > Windows
Scales Device Softkeys ?;tr:j;ehtvr:?edr?::i
Application Display Clear Messages ?;tr:j;ehv:liﬁnodnoews
Terminal Transaction Security Options License
Counter
Communication Users Windows Update Now
Maintenance Region Licensing

Figure 368: Windows Menu
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3.3.10.1 Activate Windows Through Internet

< Activate Windows Through Internet

After pressing the run button
please follow the instructions.

Figure 369: Windows Activatin by Internet

3.3.10.2 Activate Windows Through Phone
< Activate Windows Through Phone

After pressing the run button
please follow the instructions.

Figure 370: Windows Activation by Phone
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3.3.10.3 License

< License

Partial Product Key

Figure 371: Windows License

3.3.10.4 Update Now

{ Update Now

Target

Internal File

File

Directory @

...MT.Singularity.Platform.Client. MTApp\Temp

Figure 372: Windows Update

Parameter Options Function

Target Internal File [default], USB Determines where the terminal will
Memory look for the Windows update file.

File Dropdown list of available update | If no files are found, this list is
files. empty.

Directory Display only Directory location for update file.
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3.3.11 Licensing

IND700

+
For details on managing licenses, refer fo [Application Software Activation » Page 288].

< License Manager

State Name License Key

4+ Add License

Figure 373: License Manager

The License Manager displays installed licenses, fogether with the key and the product to which they refer. In
an IND700 licensed to run the ProWorks Multi-Tools applications, this screen will appear as shown here:

{ License Manager + & M

State Name License Key Product
v ProWorks Multi-Tools IND700 Licel

Figure 374: License Manager Screen Showing ProWorks Multi-Tools License
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3.3.12 Application mode

The Application mode options determine how the IND700 will display its weight information. By default, the
terminal is set to display weight information in Full Screen mode:

<  Application mode

Application mode

Full Screen SN

Figure 375: Application Mode, Default View
The Application mode dropdown list offers the following options:

Application mode

Full Screen N/

Weight Window Only Mode

Full Screen

Figure 376: Application Mode Dropdown List Options

Weight Window Selection

The Weight Window Only Mode display shows weighing information for the scale currently
selected (showing a blue highlight: Tmz) when the configurafion is made. To change the
scale displayed, it is necessary to return fo setup, select Full Screen, exit sefup, select the
desired scale, and then reapply the appropriafe Weight Window Only Mode seffings.

When Weight Window Only Mode is selected, additional options become available:

<  Application mode

Application mode Window Height
Weight Window Only Mode NS 100
Docking Style

Block Drag and Drop
None A4

Top window position

0

Left window position

0

Window Width

350 v

Figure 377: Application Mode Options, Weight Window Only Mode Selected

The options shown above are defailed in the table below.
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Application Mode Parameters and Settings

Parameter

Seftings

Application mode

The selection made here determines whether the other
parameters are available. The default sefting is Full
Screen. \When Weight Window Only Mode is
selected, additional parameters defermine the
appearance and behavior of the weight window.

Docking Style

Opfions for Docking Style are None [default], Top,
and Boftom. If Top or Boftom is selected, the weight
display window will be attached to the respective edge
of the screen, and the two position parameters will be
unavailable.

Top window position

If Docking Style is None, the vertical window position
can be set here, measured in pixels from the top of the
IND700 display.

Left window position

If Docking Style is None, the horizontal window
position can be set here, measured in pixels from the
leff of the IND700 display.

Window Width

Window Height

Whichever Docking Style is selected, the window size
-- width and height in pixels -- can be set here. Default
values are 350 pixels wide by 100 pixels high.

When either of these fields is touched, a numeric entry
screen displays. If the entered value is outside the
permitted range, a message will display -- "Value
exceeds the limits from 'x' fo 'y"", where x and y are
the smallest and greafest permissible values:

< Window Width

Yalue exceeds the limits from '330' to "800

50

=

Block Drag and Drop

Whatever Docking Style is selected, the weight
display screen floats and can be moved by touching
the screen and dragging -- unless Block Drag and
Drop is enabled, to fix the window's screen position.

The figure below shows a Weight Window Only Mode display with the following parameters set:

» Docking Style: None
e Top window position: 250
e Left window position: 150
e Window Width: 500
e Window Height: 200

IND700
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When Block Drag and Drop is not enabled, the window can be repositioned on screen by touching any part of
it and dragging:

rien

Z 142 CALC

4 > 1+2 CALC Max 120kgd =209

0.00 i

Figure 379: Weight Display Only Mode Dragged fo a Different Location

Exit Weight Window Only Mode

To exit the Weight Window Only Mode of display, a user with Setup Menu access and configuration privileges
must touch the Menu icon E5, access Setup > Terminal > Application Mode, and change Application mode
to Full Screen Note that the User login icon is available in the menu bar of the weight window.

3.3.13 Message Center

The Message Center expands on the functionality of the Notification Center accessed from the Home screen
=

Note: fouching the Netification icon on the Home screen will display and then clear the notification view.
However, the Message Center table will not be cleared.
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IND700

Touching the Message Cenfer block ([Terminal Setup » Page 1977) displays a table. This table may occupy
mulfiple pages; use the scroll bars at right and botfom of the screen to view further information and additional
rows.

Message Center i th

N

(o)
o
L
I
[t=]
=}
S
<

Log Time ~ User Name Alarm Code Scale Message I

11.Jul.2025 08:08:59 PLC NOT COMMU!
11.Jul.2025 08:08:58 Admin PLC NOT COMMUI
18.May.2025 04:43:24 PLC NOT COMMU!
18.May.2025 04:43:24 PLC NOT COMMU!
16.May.2025 02:37:07 PLC NOT COMMU!
16.May.2025 02:37:07 PLC NOT COMMU!
15.May.2025 23:27:44 PLC NOT COMMU!
15.May.2025 23:27:44 PLC NOT COMMU!
15.May.2025 08:58:11 PLC NOT COMMUT
15.May.2025 08:58:10 PLC NOT COMMU!

BUJ 00 0

Figure 380: Message Cenfer View

The Message Center view is a fable which can be cleared i, filtered ¥ and exported 1.
Clear Message Center

Touch the clear icon 1 to delete all fable rows. A warning dialog will appear.

Warning

A Clear Entire Table?
X

Figure 381: Clear Message Center Warning

Click the X to cancel the action, or the check mark fo confirm and clear the table.

Filter

The filter function differs from filters used in other tables. Three filter conditions can be configured, each on its
own page. The first page shows Filter #1 enabled but not configured.

& Filter

#1

Operator

Figure 382: Message Table Filter, Inifial View
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Touch the Field drop-down to see a list of available opfions.

Field

#1

Operator

None

Category

Log Time

User Name

Figure 383: Message Table Filter, Field Drop-Down Selected

Once a Field selection is made, an Operator and one or more Parameters drop-down lists will appear.

<

Filter

#1
Field Operator
Log Time v B
Second Parameter
16.Jul.2025

First Parameter
12.Jul.2025

Figure 384: Message Table Filter, Configured
Standard Field Options

None Log Time User Name
Alarm Code Scale Message
Action Read Time Archived

If Field is set to Category, the Parameter options list Smartb items together with their icons. In this case, the
only Operator available is equal.

4

Filter

#2
Field Operator
Category ~  equal
First Parameter

Normal Condition

O Predictive Alarm

? Out of specification

Imminent failure

Figure 385: Message Cenfer, Smartb Parameter Options 1
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IND700

#1

Field Operator
Category v equal

First Parameter

@ Catastrophic failure
@ Error
A\ Warning

o Information

Figure 386: Message Cenfer, Smartb Parameter Options 2
Smart5 Parameter Options

Normal Condition Predictive Alarm

Out of Specification

Imminent Failure

Catastrophic Failure Error

Warning

Information

Once one or more filters have been applied, a reset icon O will appear with the other icons at upper right.

Touch this icon fo resef the filters and display all table records.

4 Message Center

Category Log Time ~ User Name Alarm Code Scale

mO Yt

Message

12.Jul.2025 02:13:59  Admin 0
12.Jul.202502:09:28 Admin 1

12Jul.202502:09:28 Admin 1

Figure 387: Message Center, Filtered Result
Export

To export the contents of the Message Center, fouch the export icontti. A standard export dialog will display.

& Table Data Export

Device Directory

Internal File

File Type
csv XML

File Name

IND700_2025_07_12_0110_Notificatic

Figure 388: Message Centfer, Export

Select the desired format and fouch the check mark fo perform the export. A dialog will display briefly indicatfing

that the export was completed successfully.

PLC NOT COMMUNIC
Scale 1: Node 1 comr

Scale 1: Node 1 comr

C:\Export\20240722
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3.3.14 Smarts

The Smartd setup page in the Terminal Configuration menus allows the customization of Smartb events.

When enabled, the Symmetry Error option allows the creafion of a tolerance band, expressed as percentages,
for scale symmetry errors. A Smartd message is generated if the scale symmetry exceeds this folerance band.

<  Smart5 (Scale 1)

Symmetry Error Customer Under/Overload
Low Threshold (%)
25

High Threshold (%)
30

Figure 389: Smartb Screen, Initial State

Enable the Customer Under/Overload option to crate a similar tolerance band for scale underloads and
overloads. If an under- or overload falls oufside this band, a Smart5 message is generated.

( Smart5 (Scale 1)

Symmetry Error Customer Under/Overload

Low Threshold (%) Customer Overload (%)
25 20

High Threshold (%) Customer Underload (%)

30 20

Figure 390: Smartb Screen, Customer Under/Overload Enabled

3.4 Communication Setup

The Communication menu allows access fo configuration options for the following items. Note that Industrial
Network appears only if an Industrial Network option is installed, and OPC UA appears only if the required
license is installed. For information on the OPC UA opfion, please refer to the IND700 ProWorks OPC UA
User's Guide.
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10:38

27.0ct.2025

Setup > Communication

Scales Ethernet OPC UA
Application Interfaces Web Server

g : Industrial
Terminal Connections

Network

Communication Output Templates
Maintenance Input Templates

Figure 391: Communication Menu
3.4.1 Ethernet

<  Ethernet

MAC Address

00-E0-4B-70-49-2A 192.168.86.1

192.168.86.21
255.255.255.0

192.168.86.1

Figure 392: Ethernet Options, DHCP Enabled

When DHCP is disabled, the fields on the page become editable and fixed address parameters can be enfered.

<  Ethernet

MAC Address Preferred DNS Server
00-EQ-4B-70-49-2A 192.168.86.1

Secondary DNS Server

IP Address

192.168.86.21

Subnet Mask
255.255.255.0

Gateway Address

192.168.86.1

Figure 393: Ethernet Options, DHCP Disabled
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3.4.2 Interfaces

The Interfaces screen shown below displays entries for an IND700 with two HSALC scale interfaces installed.

{ Interfaces

Port Hardware Status Baud Rate Data Bits
Mainboard Discrete I/O Enabled

Mainboard Serial Port Enabled
Slot 1 Scale Slot 1 Discrete I/O Enabled
Slot 2 Scale Slot 2 Discrete I/O Enabled

Figure 394: Interfaces

The Interfaces screen lists the terminal's configured interfaces. Touch a row to display the Edit icon.

< Interfaces

P ./ Hardware Status Baud Rate Data Bits
Mairboard Discrete I/O Enabled

Mainboard Serial Port Enabled
Slot 1 Scale Slot 1 Discrete I/O Enabled
Slot 2 Scale Slot 2 Discrete I/O Enabled

Figure 395: Edif Icon

Touch the Edit icon to access the interface's parameters. The contents of this screen vary depending on the type
of interface selected. In the screen shown below, the Mainboard DIO opfion can bee enabled or disabled. When

it is enabled, the inputs and outpufs on the main board can be configured with assignments from the
[Connections » Page 233] screen.
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IND700

Edit DIO Interface

4 Edit Interface

Port Location

Mainboard

Hardware

Discrete [/O

Figure 396: Edit Inferface - Discrete I/0

Parameter Options Function

Port Location Display only Indicates location of port. Not
editable.

Hardware Enabled, Disabled Allows the interface to be turned on
and off.

When a Serial Interface is selected for editing, a two-page configuration screen appears.

Edit Serial Interface

£ Edit Interface

Port Location

Mainboard

Hardware

Serial Port

Interface

R5232

Data Bits

Figure 397: Edit Inferface - Serial, Page 1

LV

Baud Rate

9600

Stop Bits

One

Custom Device

None
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Note that in the following image, the character sef change is disabled: | =

<  Edit Interface

String Frame Flow Control

CR MNone

LF

<STX=...<ETX=

. BCC

Figure 398: Edit Inferface - Serial, Page 2

When the character sef change icon is fouched to enable this function = ,the second page of the Edit Interface
screens appears like this:

£ Edit Interface

String Frame Flow Control

CR MNone

Character Set
LF

<STX>...<ETX>

BCC

Figure 399: Edit Inferface, Second Page with Character Set Option Enabled
Character Set options are as follows:

Parameter Options Function

Port Location Display only Indicates location of port. Not
editable.

Hardware Enabled, Disabled Allows the interface to be turned on
and off.

Interface RS232 [default], RS422, RS485 | Selects the serial inferface type.
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Data Bits 7, 8 [default] Sets the data bits for the serial

interface.
Parity None [default], Even, Odd Sefs the parity selection for the
serial interface.
Baud Rate 4800, 9600 [default], 19200, Sets the baud rafe at which the
38400, 57600, 115200 serial interface will operate.
Custom Device Drop-down, listing all custom Allows selection of a Custom Device
devices such as an ARM100 Remote 1/0
module.
Number of Remote I/0 Not accessible [default] This drop-down list becomes

available when at least one
ARMT100 Remote I/0 module is

connected.
String Frame - CR Enabled, Disabled When enabled, adds a Carriage
Return to the datfa string frame
String Frame - LF Enabled, Disabled \When enabled, adds a Line Feed to
the dafa string frame
<STX>...<ETC> Enabled, Disabled \When enabled, the communication

control characters STX and ETC are
used to ensure synchronization
between the IND700 and another
communicating device

BCC Enabled, Disabled \When enabled, a Block Check
character calculation is performed
Flow Control None, XON-XOFF Toggles between no flow control

and XON-XOFF flow control

3.4.2.1 ARM100 Interface Configuration

When a least one ARM100 remote /0 module is connected to the terminal, additional options appear in the
Edit Interface screen. First, access the screen by fouching a serial inferface, either on the mainboard or on the
Precision scale interface board:

{ Interfaces

Port Hardware Status Baud Rate Data Bits
Miﬁrd Discrete I/O Enabled
Mainooard Serial Port Enabled
Slot 1 SICSpro/Serial Enabled
Slot 1 Scale Slot 1 Discrete I/O Enabled

Figure 400: Accessing the Interface Edit Function

In addition to the standard serial port parameters, the Edit Interface screen will show an ARM100 option in the
Custom Device drop-down list, and the Number of Remote I/0 dropdown will be accessible. Note that with the
ARM100 selected, 8 Data Bits are configured.
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< Edit Interface

Port Location

Mainboard

Hardware

Serial Port

Interface

RS485

Data Bits

Figure 401: Edit Inferface Screen

Standard parameters for the ARM100 I/O are:

e Baud Rate: 115200
¢ Data bits: 8

e Parity: Even

e Stop bits: 1

¢ Flow Control: None
e Interface: RS-485

Baud Rate
57600

Stop Bits

One

Custom Device

ARM100

Number of Remote /O

1(4/6)

Touch the Number of Remote 1/0 field to display all the available I/0 opfions, including those in the ARM100
remote modules. Refer fo the Type, Location and Position fields in setup at Application > [Discrete 1/0 »
Page 190] configuration screens to associate a discrete input or oufput with an address either in the terminal

or in any of the attached ARM100 modules.

< Edit Interface

Port Location

Mainboard

Hardware

Serial Port

Interface

R5485

Data Bits

Figure 402: Edit Inferface Screen, Remote 1/O List expanded
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6 (24/36)
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8 (32/48)
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3.4.3 Connections

IND700

{  Connections

Port Hardware Assignment Trigger Template

<+  Add Connection

Figure 403: Connections List

When it is first displayed, the Connections list includes no items. Touch the + icon to add a new connection.
Once a connection has been defined, touching it in this list will display three icons -- delete, add and edit:

m+ 7

Figure 404: Delete, Add, Edit Icons

£ Add Connection

None

Assignment

SICS

Trigger

Active Scale

Figure 405: Add Connection Screen
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The confents of the Add Connection screen vary depending on the selections made in the available fields. In
the image above, no Port assignment has been made. The image below shows options displayed when Port is
set to Mainboard.

<  Add Connection

Part

Mainboard

Serial Port

Assignment

SICS

Trigger

Active Scale

Figure 406: Add Connection - Mainboard Port Selected

When Port is set fo Ethernet, the screen appears as shown below.

{  Add Connection

Part Ethernet Port

Ethernet 1701

Ethernet

Assignment

SICS

Trigger

Active Scale

Ethernet Connection

Server

Figure 407: Add Connection - Ethernet Port Selected
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When Port is set fo File, the screen appears as shown below.

<  Add Connection

Part

File

File

Assignment

Trigger

Active Scale

File Name

Must be 1 to 200 characters

Figure 408: Add Connection - File Port Selected

Append to File

Each of the Port types has different parameters associated with it, as shown in the following tables.

Key to Connection Options and Parameters Table

APP: Append fo File

AS: Active Scale

ASG: Assignment

CO: Confinuous

CE: Continuous

Output Extended
CMT: Continuous - |CM2: Continous - CS: With Checksum |CTPZ: CTPZ Input ENC: Ethernet
Multi1 Multi 2 Connection
ENP: Ethernet Port  FN: Filename HW: Hardware [PT: Input Template |KB: Keyboard
MB: Main Board SD: Shared Data SK: Selectable by SP: Serial Port SS: SICS Scale
Softkey

T: Templafe TG: Trigger TR: Transfer
Connection Options and Parameters
Pot HW ASG T Scale#IPT T  ENC ENP FN SK CS APP
None |HW SICS AS, 1-4

SD

None

TR AS, 1-4 1-10

IPT 1-10 Yes

co AS, 1-4 Yes |

CTPZ AS, 1-4

SS Scale

1-4
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Pot HW ASG T Scale#IPT T ENC ENP  FN SK CS APP
MB SP SICS AS, 1-4
SD
None
Transfer |AS, 1-4 1-10
IPT 1-10 Yes
co AS, 1-4 Yes |
CTPZ AS, 1-4
SS Scale
1-4
KB HW None
Input 1-10
Template
CTPZ AS, 1-4
Input
Slots 1 |SICSpro | SICS AS, 1-4
-2 /S SD
None
TR AS, 1-4 1-10
IPT 1-10 Yes
co AS, 1-4 Yes |
CTPZ AS, 1-4
SS Scale
1-4
EN EN SICS AS, 1-4 Server |1701
SD Server 1701
None Server 1701
TR AS, 1-4 1-10  |Server 1701
IPT 1-10 Server 1701
CcOo AS, 1-4 Server |1701
CE AS, 1-4 Server |1701
CM1 Server 1701
CM2 Server 1701
CTPZ AS, 1-4 Server |1701
SS Scale Server 1701
1-4
File HW None Free entry
field
TR AS, 1-4 1-10 Free entry Yes
field
Parameters and their Functions
Parameter Function
Port Sefs the physical hardware associated with the connection.
Hardware Display only; shows type of port installed

Port: None, Mainboard, Ethernet -

Assignment

Assigns the selected port to a type of data.

Port: File - Assignment

Sefs the assignment of the File port.
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Port: None, Mainboard, Ethernet, |Sefs a Trigger for the connection, which causes data to be fransmitted.
File - Trigger
Assignment: Transfer - Template |\When the Assignment is set to Transfer, one of the IND700's fen

templates can be specified as the destination for the fransmitted data.

Assignment Transfer - File Name |When the Port type is File, and Assignment is Transfer, a name must
be specified for the file which will receive the data. Touch this field fo
display an alphanumeric data entry dialog.

Assignment Transfer - Append To | This parameter determines whether new data are added to a new file, or
File appended to an existing one. The name of the file is specified in the File
Name field.
Port: Ethernet - Assignment: Input Template
Remote Server IP Sets the IP of the remote Client.
Remote Server Port Sets the port for the remote Client.
Ethernet Connection: Server

Ethernet Port \When an Ethernet port is specified, the Ethernet Port is selected here.
The default port is 1701, but fouching this field displays a numeric entry
dialog permitting the definition of a different port number.

When changes are made to a connection, and the changes are saved, the terminal will restart the hardware
affected by the modification.

When connections have been defined, the Connections list will display them.

< Connections

Port Hardware Assignment Trigger Template

Slot1003 Serial Port Print Template 1

Slot1003 Serial Port SICS Active Scale

Figure 409: Connections List Showing New Connections
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When a Connection is defined with an Input Template Assignment, the Selectable by Softkey slider will

display.

< Add Connection

Port

Ethernet

Ethernet
Assignment

Input Template
Ethernet Connection

Server
Ethernet Port

1701

N

Input Template

Template 1

Selectable by Softkey

Olv

Figure 410: New Connection, Input Template Assignment

When af least one connection has been assigned fo an input femplate, the Template softkey 2 can be seen in
the softkey ribbon, if it has been added in sefup at [Terminal > Softkeys » Page 212].When it appears on the
home screen, this softkey displays Template 1 by default: .2, When multiple femplates are configured and
assigned fo connections, touching the softkey will display a context menu, listing all available femplates:

hovy

Template 1
Template 2
Template 3

&)

5 Ternplate 1

Figure 411: Templates Softkey with Context Menu

Touch the desired femplate to load it. The softkey will show the number of the currently selected template: 2.

See also

& Softkeys » Page 212
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3.4.4 Output Templates

IND700

Output Templates are configured from the Output Templates menus, shown below.

& B smgrn |

. Setup > Communication > Output Templates
I ——

Ethernet Output Templates Template 1 Template 6

Interfaces lemplate 2 Template

Connections Template 3 Template &

| FTPSErVer lfemplate Template ©

Remote Desktop
' Server

Figure 412: Output Templates Menu

Touch a Templafe name to open its configuration page.

The Output Templates menu allows each of the fen available femplates to be viewed and edited. Only Template
1 is already configured.

Each element has a serial number, a Type, the Data it contains, an Alignment, a number of Characters, and a
Quantity (e.g. for mulfiple CR/LF elements). Touch the headline row fo sort the elements by any of these
atfributes.

Templates can be creafed in two ways: Manually, which involves looking up the SD codes and ensuring that all
the necessary formatting is included; or by using the terminal's [Automatic Standard Templafe » Page 336],
which automates the process.

The content of a typical templafe is shown below in a series of images, followed by an image showing the
template's output. It will be noted that the template includes 54 rows; this is why the Automatic Standard
Template represents an extremely efficient, time-saving method of creating cusfomized output templates.
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{ Template 1 -« T O 4+ i1

Element Type Data Alignment # Chars Quantity
1 String Date: Left 6 1
2 SD Var xd0103 Exact - -
3 CR/LF - - - 1
4 String Time: Left 6 1
5 SD Var xd0104 Exact - -
6 CR/LF - - - 1
7 String User: Left 6 1
8 SD Var xd0171 Exact - -
9 CR/LF - - - 1
10 String Material Name: Left 15 1

Figure 413: Output Template Content, Page 1

{ Template 1 -« T O 4+ i3
Element Type Data Alignment # Chars Quantity
11 SD Var ma0002 Exact - -

12 CR/LF - - - 1
13 String APW: Left 5 1
14 SD Var cd0104 Exact - -
15 String Exact 1 1
16 SD Var wt0003 Exact - -
17 CR/LF - - B 1
18 String Weight: Left 8 1
19 SD Var wt0002 Exact - -
20 String Exact 1 1

Figure 414: Output Template Confent, Page 2
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{ Template 1 eee |._|j + E!;ﬂ
Element Type Data Alignment # Chars Quantity
21 SD Var wt0003 Exact - -

22 CR/LF - - - 1
23 SD Var pr0131 Left 13 -
24 String Exact 2 1
25 SD Var pa0101 Exact - -
26 CR/LF - = = 1
27 SD Var pr0132 Left 13 -
28 String Exact 2 1
29 SD Var pa0102 Exact - -
30 CR/LF - - - 1
Figure 415: Output Template Confent, Page 3

{ Template 1 vee ﬁ |._|j + EES_T]
Element Type Data Alignment # Chars Quantity
31 SD Var pr0133 Left 13 -

32 String Exact 2 1
33 SD Var pa0103 Exact - -
34 CR/LF - - - 1
35 String Scale: Left A 1
36 SD Var xt0107 Exact - -
37 CR/LF - - - 1
38 String Gross: Left 7 1
39 SD Var wt0001 Exact - -
40 String Exact 1 1

Figure 416: Output Template Confent, Page 4
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{ Template 1 -« M [0 4+ &

Element Type Data Alignment # Chars Quantity
45 String Exact 1 1
46 SD Var wt0003 Exact - -
47 String Exact 1 1
48 SD Var ws0009 Exact - -
49 CR/LF - - - il
50 String Net: Left 5 1
3| SD Var wt0002 Exact - -
52 String Exact 1 1
53 SD Var wt0003 Exact - -
54 CR/LF - - -~ 1

Figure 417: Output Template Confent, Page 5

Date: _27.Feb.2024
Time: _16:56

User: _Admin
Order____.___._:_0T-456

Batch_ID____._: _BT-700
Vendor__._._._._._:_Supplier_ABC
Scale: _1

Gross: . _.__._._.._._2840_g
Tare: _0_g._T._

T S S S T T S )

Figure 418: Output Template Output, as Configured Above

Template Fields

Columns available in the template configuration screen update as other changes are made
to the ferminal -- e.g. when an Application is enabled.

Automatic Standard Template

The IND700 features an AST (Automatic Standard Template) function which simplifies the preparation of
templates customized for particular uses and applications. Shared Data variables representing all available
information (which adds columns fo the [Transaction Table » Page 1857) are automatically added to Output
Template 1.

To create mulfiple Output Templates with different automatically-generated content, make the necessary
changes fo the terminal configuration, then access Setup > Communication > Output Templates > Template

1. Here, all the currently configured Transaction Table fields are automaticaly represenfed as rows in the table
(refer fo the five-screen example shown above).
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Select the Copy icon mat top left . From the Copy Template dialog, click the To dropdown list and select the
desired template.

<  Copy Template

From

1

Figure 419: Copy Template Dialog

Click the Run icon P at lower right to execute the copy, then use the left arrow af top leff twice fo refurn to the
Output Templates menu view. Templafe 2 is now shown as configured.

(F 11:29
®
e 03.Aug.2023

Setup > Communication > Output Templates

Scales Ethernet Template 1 Template 6
Application Interfaces Template 2 Template
Terminal Connections Template 3 Template 8
Communication Output Templates Template 4 Template 9
Maintenance Input Template Template 5 Template 10

Figure 420: Output Templafes Menu View, Template 2 Configured

This customized femplate -- in this case, Output Template 2 -- can now be used to determine the confent and
format of the output from a Connection. Multiple connections can be configured and use for different appli-
cations using other output templates.
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<  Edit Connection

Port Ethernet Connection
Ethernet Server
Ethernet Port
Ethernet 1701
Assignment
Transfer
Trigger
Active Scale
Template

Template 2

Figure 421: Connection Configuration Screen Showing Template 2 Selected
Template 1 will continue to reflect changes made to the configuration of the weight display. These can then
copied fo another femplate.

Remember that femplates can be Exported ™ and Importedth, so that they can be kept safely outside the
IND700, and restored fo the same ferminal or shared with other ferminals. This opfion makes it very easy to
standardize output data across multiple terminals.

To access these options in an Oufput template, click the ellipsis =< in the menu bar.

e @ @+ 6
#i} I'l'i Quantity

1

Figure 422: Output Templates Menu Bar, Import and Export Icons Displayed

Manual Template Editing

To configure a new template, or fo modify an existing one, first touch the templafe's name in the Templates
menu. If the templafe has not been configured, a blank template will display, with no elements defined and a +
icon fo add a new element. Otherwise, the existing femplate configuration will display. In either case adding,
removing and editing template elements use the same method.
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< Template 2 (]

ElementType Data Alignme # Chars Quantit

+ Add new template element

Figure 423: Undefined Template
When the + icon is touched, the template editor screen displays.

< Editor - Template 2

Element Alignment

1 Exact

Must be 1 to 256 characters

Quantity

1

Figure 424: Template Editor
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The fields available in the editor screen vary depending on the Type selected.
Type

String N

String
CR/LF
Special Character

Shared Data Variable
JOaETToy

Figure 425: Template Editor - Type Opfions
CR/LF Options

For example, if CR/LF (carriage return/line feed) is chosen, the editor screen appears like this:

< Editor - Template 7

Element

1

Type
CR/LF

Quantity
1

Figure 426: Template Editor, CR/LF Selected
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Special Character Options
If Special Character is the selected Type, a drop-down lists the opfions.

Editor - Template 7

Element

3

Type

Special Character

Data

Figure 427: Template Editor - Special Character Selections

Refer to [Control Characters » Page 371] for an explanation of these characters.

Shared Data Options

Commonly Used Shared Data Variables
A list of most commonly used Shared Data is included in the [Communication » Page 358]

section. For a complete account of available Shared Data in the IND700, refer to the
IND700 Shared Data Reference (30753890).
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For Shared Data variables, only the Data and Alignment fields are shown in addition to Type.

£ Editor - Template 7

Element

3

Type

Shared Data Variable

Data

Must be 1 to 256 characters
Alignment

Exact

Figure 428: Template Editor - Shared Data Variable Selected
Available Shared Data Variables are listed and explained in the IND700 Shared Data Reference.

Alphanumeric Data Entry
For String and Shared Data Variable fypes, fouching the Data field opens an alphanumeric dafa entry keypad.

< Data

:Shift1Summary < > @
9 0

1 21 314 |5|6]| 7|8

Figure 429: Template Editor - Alphanumeric Data Entry
Summary of Options

\ Element \Options Function \
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3.4.4.1

IND700

Element | Serial number of element; not editable Once elements are defined, fouching a row in the
Template screen displays a set of delete/add/edit
icons. If + (add) is selected, the new element is
assigned the number of the element initially
touched, and the element number of all
subsequent existing elements increases by one.

Type String [default], CR/LF, Special Character, The selection made here determines which other

Shared Data Variable editing opfions are offered.

Data Displays an alphanumeric entry screen Displayed if Type is String or Shared Data
Variable.

Data None [defaulf], 01 h -SOH, 02h - STX, 03h - Displayed if Type is Special Character

ETX, 04h - EQT, 05h - ENQ, 06h - ACK, O7h -
BEL, 08h - BS, 09h - HT, OAh - LF, OBh - VT,
OCh - FF, ODh - CR, OEh - SO, OFh - SI, 10h -
DLE, TTh - DC1, 12h - DC2, 13h - DC3, 14h -
DC4, 156h - NAK, 16h - SYN, 17h - ETB, 18h -
CAN, 19h - EM, 1Ah - SUB, 1Bh - ESC, 1Ch -
FS, 1Dh - GS, 1Eh - RS, TFh - US

Alignment | Exact [default], Left, Cenfer, Right Determines how the element will be aligned in
the template.

# Displays the count of characters in the Data field. Displays if Type is String.

Character

S

Format of Automatic Standard Output Template

The Automatic Standard Template includes a number of standard elements, together with elements derived from
the application screen seftings made in App Screen View page. Note that this page does not appear in the menu

system unless a ProWorks Multi-Tools license is activated. Refer to the ProWorks Multi-Tools User's Manual
for defails on the display of application-specific data.

Automatic Standard Template Contents

Type Data Alighnme # Comment
nt Cha

ract

ers
String "Date: " | Left 6
SDVar xd0103 |Exact Date
CR/LF Carriage return, line feed
String "Time: " | Leff 6
SDVar xd0104 |Exact Time (format as configured)
CR/LF
String "User: " Leff 6
SDvar xc0171 |Exact Logged-in user
CR/LF
CR/LF

All items form the App Screen View are added here, between the header and the weight data.
Below is an example for farget information in a manual filling application.

String "Upper Left 12
Tol.. "
SDvar sp0011 |Exact Upper tolerance (deviation or absolute); sp0014 if tolerance type is
percentage
String "Lower  Leff 7
Tol.: "
SDVar sp0012 Lower folerance (deviation or absolute); spO015 if folerance type is
percentage
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Type Data Alighnme #  Comment
nt Cha

ract

ers
CR/LF
CR/LF
String "Scale: " | Leff 7
SDVar xt0101  |Exact Currently selected scale
CR/LF
String "Gross: " | Leff 7
SDVar witO00T  |Exact Gross weight, selected scale
String " Exact 1 Blank space
SDvar wi0003  Exact Unit, selected scale
CR/LF
String "Tare: " | Left 6
SDvar ws0002  Exact Tare weight, selected scale
String " Exact 1 Blank space
SDVar wt0003 Unit, selected scale
String " Exact 1 Blank space
SDVar ws0009 |Exact Tare type (T or PT)
CR/LF
String "Net: " Left 5
SDvar wt0002  Exact Net weight, selected scale
String " Exact 1 Blank space
SDvar wi0003  Exact Unit, selected scale
CR/LF

3.4.5 Input Template

The IND700's advanced Input templates functionality can be used to parse and modify operational data
captured by a QR code scanner and pass the processed data to an assigned target. Input femplates can be
refrieved quickly and easily via a softkey, and different input templates can be used simultaneously on different
ports. The same port can also be assigned to several different input templates. In this case, Selectable by
Softkey must be set in the [Add Connection » Page 238] configuration screen.

When the input device is a QR code scanner, the data is treated as if the input device was a keyboard. The
parameters available in the femplate element editing screen are used fo structure the captured data to make it
usable by the function selected in the Assignment field. Refer to [Input Template » Page 253], below.

When the Input Template menu option is first visited, it displays ifs default confents.

< Input Template 1: Template 1 === @ rlj [ﬂ I'IJ
Element Preamble Data Postamble Termination Timeout
1 0 1 0 CR ON
|

Figure 430: Input Template 1, Unconfigured
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To add template elements, select the existing element (the CR Termination character) and click the + in the
context menu which appears.

e ® 0O o
Element Preamble + @ V4 I’ostamble Termination Timeout
{ " K

1 0 CR ON

< Input Template 1: Template 1

Figure 431: Input Template Context Menu

The following screen will appear. Nofe that the menu bar shows Element 2.

< Input Template 1 > Template 1 > Element 2

Preamble Length Assignment

0 Tare N

Maximum Data Length
g With Unit

. Postamble Length
0

\_J  Termination Char
v CR Nt

Timeout

Figure 432: Input Template Element Edit Screen, Page 1 -- Assignment Tare

< Input Template 1 > Template 1 > Element 2

Preamble Length
0

Maximum Data Length

1

Assignment
File

File Directory
C\Temp

. Postamble Length File Name

o] BarcodeCapture

Termination Char

VCR

Append to File

Timeout

Figure 433: Input Template Edit Screen, Page 1 -- Assignment File

4 Input Template 1 > Template 1 > Element 2

Data Position Data Position
1 1

Editing Editing h
None N None N

Figure 434: Input Template Element Edit Screen, Page 2
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Input Template configuration

Parameter

Seftings

Preamble Length

Maximum Data
Length

Postamble Length

These parameters sef the expected length, in characters, of the incoming data. The pre-
and postamble lengths indicafe the amount of data to be discarded from the start and
end of an incoming data string. Similarly, the payload data string length is defermined
here. By default, the Pre- and Postamble length is 0, and the Dafa Length is 1.

These values must conform to those for the incoming data, or an error will be
generated.

Termination Char

This dropdown list permits the selection of the character which indicates the end of @
data string. The default value is CR (carriage return). Possible values are:

None, SOH, STX, ETX, EOT, ENQ, ACK, BEL, BS, HT, LF, VT, FF, CR, SO, SI, DLE, DC1,
DC2, DC3 DC4, NAK, SYN, TB, CAN, EM, SUB, ESC, FS, GS, RS, US.

Timeout When an input device — for example, a barcode scanner — is expected to send a specific
number of fields of data, each of a specific length, and the received data does not
correspond to those specifications, the input process fimes out and an alarm is
generated.

By default, this opfion is enabled.
Assignment The Assignment parameter determines which function should be executed when the
template receives data. The default value is Tare.
Assignment
Tare Vg
Application
Tare
Tare ID
Material ID
Keyboard
Tare ~
Material ID
Keyboard
1D Form
File
Possible values are Application, Tare, Tare ID, Material ID, Keyboard, ID Form (ID), ID
Form (Name), File, User Name, Scale #.
With Unit When enabled, this switch automatically appends the appropriate unit to any weight-

based element.

Data Position T and
2 / Editing 1 and 2

The options on the second page of the templafe element editing screens are used fo
Insert, Delete, or Move character strings within the element. Two such functions can be
performed at the same fime, each affecting a different Data Position. Refer to Modifying
a Template Element, below. The two actions are performed in sequence -- position 1
then position 2.
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Modifying a Template Element

The options on the second page of the templafe element editing screens are used fo Insert, Delete, or Move
character strings within the selected template element. Two such functions can be performed at the same fime,
each affecting a different Data Position in the selected element.

Editing When Insert is selected as the Editing action, a
m— - Characters to Insert field is displayed. Touch the field
to display an alphanumeric entry screen. Characters
Characters To Insert entered here are inserted af the Data Position specified
for this editing action.
Editing When Delete is selected as the Editing action, a
_— v Number of‘churactgrs to Delete fi_eld is displayed.
Touch the field to display a numeric entry screen. The
Number of characters to Delete number of characters entered here are deleted starting
1 at the Data Position specified for this editing action.
Editing When Move is selected as the Editing action, two
additional fields appear: Number of characters to
bos b4 Move and Move to Target Position. In this case, the
Nurber of charactor to Move Data Position parameter determines the starting
position of the characters to move; the other two fields
! display a numeric entry screen, and are used to
Move To Target Position defermine how many characters to move, and where
1 to move them fo.

Once all the required seffings are made, fouch the OK button at bottom left.

Example of Data Parsing Using Input Template Parameters

An input from a barcode scanner is received; the seftings chosen in the template setup screens determine the
data passed on tfo the assigned function. The table below shows an example of an input string being modified
and ready for use. Bold items correspond to parameters which must be configured in the sefup screen.

Input Template Modification of Captured Data

Process Step

Example

Comments

The Input String arrives from the
barcode reader

v1.234xy kg<CR>

An Input String of 11 characters,
plus the Termination Character
<CR>, is received.

The Preamble is removed

1.234xy kg<CR>

The Preamble has been set to 1, so
the first character ("v") is removed.

The Data Field is parsed

1.234xy kg<CR>

The Data Field Length has been set
fo b, so the first 5 characters of the
remaining string are exiracted.

The Postamble is removed

1.234 kg<CR>

The Postamble Length has been
sef to 2, so the two characters after
the Data Field ("xy") are removed.

If fewer or no postamble characters
are present, the process continues
uninterrupted.

The remaining sfring is used, until
the Termination Character is
reached

1.234 kg

Finally, the Termination Character
must be removed. What remains is
the Processed String fo be sent fo
the assigned subsystem -- for
example, Tare.

The string must now be shorter or
equal to the Termination Byte Count
—-inthiscase 1 +5+2=28.
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Editing Existing Template Elements

Existing elements can be edited in the same way, by selecting a row and clicking the edit icon .« from the
context menu.

<

Input Template

Preamble Length Assignment

0 Tare

Data Length Termination Char

1 CR

Postamble Length
0

Timeout

Figure 435: Input Template - Edit an Existing Element

General Template Settings
Touch the Setup softkey & to display the General Template Settings screen.

<

Template Name

General Template Settings

Template 1

Element Timeout

Figure 436: Input Reset Confirmation Dialog

When enabled, the Element Timeout opfion permits the template to continue fo the next element if an element
generates an error.

Resetting an Input Template to Default

To restore a template's default configuration, fouch the ellipses = in the menu bar and select the delete
icon from the context menu.

eee {0}

=

Ter [l ation

=

Figure 437: Input Template Reset Option
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A confirmation dialog will appear. Touch the check mark to confirm the operation.

< Warning

Reset template to default?
Delete with X

X

Figure 438: Input Template Reset Confirmation

3.4.6 Web Server

The IND700 includes an embedded Web Server. The Web Server can be used fo access and control the
terminal remotely, using an ethernet connection. Access to terminal sefup features is controlled using different

levels of login.
) 1038
&% B 27.0¢t.2025
Setup > Communication
Scales Ethernet OPC UA
Application Interfaces Web Server
Terminal Connections It
Network
Communication Output Templates
Maintenance Input Templates

Figure 439: Communication Menu Showing Web Server

Touch the Web Server item fo access the Web Server configuration page.

<  Web Server

Web Server

Timeout for Write Access (min)

1

Remote T/C/Z

Remote T/C/Z Lock (min)

5

Figure 440: Web Server Configuration Page

The settings on this page control the behavior of the web server.
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Web Server Configuration

Web Server Enables or disables the web server. If the server is
disabled, an attempt fo log in to the web server will
result in a "failed" message on-screen in the browser.

Port Sets the ferminal port for the web server to use for ifs
connection.
Timeout for Write Access (min) When terminal configuration access is requested from

the web server, after the set number of minutes has
elapsed without a response from the terminal's user
the remote user is granfed configuration access. This
ensures that an unattended terminal does of block
server access indefinitely.

Remote T/C/Z Determines whether a web server connection with
admin or supervisor login privileges and write access
can perform Tare, Clear and Zero commands on the
terminal.

Remote T/C/Z Lock (min) Once the Remote T/C/Z function is enabled, the
remote administrator or supervisor can perform the
respective operations during the period specified here.
After this period has elapsed, the terminal automat-
ically locks Remote T/C/Z.

For details on using the web server, refer fo [Remote Operation using the Web Server » Page 56] in the
Operation section.

3.4.7 Industrial Network

If an Industrial Ethernet opfion installed, the Communication > Industrial Network menu will appear. It
includes two sub-menus: Option Board and Protocol.

'j-l\ @ 4:20 pm
D 12/04/2020
Setup > Communication > Industrial Network

Scales Ethernet Industrial Network Option Board

Application Interfaces Output Templates Protocol

Terminal Connections

Communication FTP Server

Remote Desktop
Maintenance e

Figure 441: Communication > Industrial Nefwork Menu
Option Board is used fo configure the installed option's hardware. Protocol controls the format of the data
associated with that option.
3.4.7.1 Option Board
The harsh enclosure version of the IND700 supports the installation of one Industrial Network Option Board --
either PROFIBUS, PROFINET or EtherNet/IP. The following sections detail the parameters for each type.
3.4.7.1.1 PROFIBUS

For the PROFIBUS optfion, only a single seffing is required -- the Device Slave Address. If an address has
already been assigned, and is read from the option board, it will appear in this field. If no address is shown,
touch the field tod display a numeric entry keypad and enfer a value. The valid range for addresses is from O fo
126.
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3.47.1.2

IND700

The Current Network Firmware is a read-only display of information.

{  Option Board

Device Slave Address

PROFIBUS V1.0.0

Current Network Firmware

<

Figure 442: PROFIBUS Option Board Configuration

Touch the setup icon & at upper right to access [Option Board Configuration » Page 258]. This page is used

to update the option board's firmware.

PROFINET
The PROFINET screen offers the following options:

<  Option Board

Network Protocol Type
PROFINET

Device Name
mt-ind

IP Address
000.000.000.000

Subnet Mask
000.000.000.000

Gateway Address
000.000.000.000

Figure 443: PROFINET Option Board

PROFINET Configuration

Parameter Settings

Network Profocol Type This value is display only, and cannot be modified.

Device name Touch this field to open an alphanumeric entry screen.
Enter a descriptive name for this IND700. This is the
name the IND700 will display in the PROFINET
network.

IP Address Touch each of these fields fo open a numeric entry

Subnet Mask screen, and enter the appropriafe information

Gateway Address

Touch the Setup icon at upper right to access [Option Board Configuration » Page 2568]. This page is used fo

update the option board's firmware.
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3.4.7.1.3 EtherNet/IP

The EtherNet/IP screen offers the following options:

<{  Option Board {0}

Network Protocol Type
EtherNet/IP

IP Address
000.000.000.000

Subnet Mask
000.000.000.000

Gateway Address
000.000.000.000

Figure 444: EtherNet/IP Optfion Board

Touch the setup icon ¢ at upper right to access [Option Board Configuration » Page 258]. This page is used
to update the option board's firmware.

EtherNet/IP Configuration

Parameter Settings

Network Protocol Type This value is display only, and cannot be modified.

IP Address Use these fields fo add or modify an address or mask.
Subnet Mask Touch a field fo display a numeric data enfry keypad,
Galeway Address and enfer the appropriate value.

3.4.7.1.4 Option Board Configuration

The firmware for each Industrial Network option board can be updated using this page. In this example, an
EtherNet/IP option board is installed.

If updated firmware is available, it will appear above the dropdown list.

<  Option Board Configuration

New Network Firmware

MTINXS0 EthernetlP v5.3.0

Figure 445: Option Board Configuration - EtherNet/IP
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Touch the dropdown list fo expand it and see available firmware.

< Option Board Configuration

New Network Firmware

MTINX90 EthernetIP v5.3.0

MTINX90 Profinet v5.4.0

Figure 446: Firmware Dropdown List

Note that, because the option board hardware is the same for both types of Industrial Network, both EtherNet/IP
and PROFINET firmware options are shown. Once a selection is made, the run » button will appear at lower
right. Touch it fo start the update procedure. The ferminal will display a confirmation dialog.

Firmware Download

You are about to download a new firmware

for the Industrial Network Option Board.
A A restart is required after downloading.

The Industrial Network is interrupted.

Press Cancel to abort or Confirm to continue

Figure 447: Firmware Download Confirmation Dialog

Touch the check mark to continue, or the x fo cancel the download. If the download is confirmed, a progress
message will display.

Firmware Download

Please wait while the
firmware is being
downloaded. This process
will take about 30 seconds.

Figure 448: Firmware Download Progress Message

If the download was successful, a message will display confirming the success.

Firmware Download

Firmware Download was successful.
In order to restore functionality
o of Industrial Network, a restart is required.

Press X to continue and restart later.

Or press  to restart now.

Figure 449: Firmware Download Success Confirmation Dialog

As indicated, the terminal can be restarfed immediately s/"fo complete the firmware update. If the X is chosen,
the Industrial Network option board will be updated af the next terminal restart.
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If the firmware download fails, the terminal will display a message indicating this.

Firmware Download

Firmware Download was not successful,
check log and try download again.

Figure 450: Firmware Download Failure Message

3.4.7.2 Protocol

The Protocol page is used to configure communication between the terminal and the Industrial Network.
2 Block and 8 Block formats are available, selected from the Format drop-down list..

{  Protocol

Mode

SAI - Standard Blocks Autodetett Byt Otder

Format

2 Block N

Figure 451: Protocol Page, Initial View

By default, Auto-detect Byte Order is enabled. Touch the toggle to turn off auto-detection. The screen will now

show a dropdown list of byte order options.

<  Protocol

Mode

Autc-detect Byte Order
SAI - Standard Blocks ¥

Format Byte Order
2 Block N Big Endian N

Figure 452: Byte Order Options
Touch the Byte Order field fo display the available options. Options are:

e Big Endian
e Litfle Endian
* Byte Swap
¢ Word Swap
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<  Protocol
Mode
SAL- Standard Blocks Auto-detect Byte Order
Format Byte Order
28008 ™ || BigEndian ~
Little Endian
Byte Swap i

Figure 453: Byte Order Options

3.4.8 Data Interface Configuration for SICS Server

For the IND700 fo function as a SICS server, first an [Interface » Page 228] must be configured appropriately
for the type of connection to be used by the SICS server. Settings such as baud rate, number of data bits, parity,
handshake protocols and connector pin assignments are configured here. Refer to [Configuration > Communi-
cation Sefup > Interfaces » Page 228].

The example below shows a serial port configuration, with SICSpro - Serial Port selected as ifs assignment.

o Edit Interface

Port Location Baud Rate
Slot 1 3600 v
Hardware Stop Bits
N\ SICSpro - Serial Port One AV
Interface Custom Device
1/2 RS232 N None Nt
Ay Data Bits Number of Remote I/O
i 8
Parity
None bV

Figure 454: Editing an Interface for the SICS Server, Page 1
e |
£ Edit Interface

Port Location
Slot 1

Hardware

SICSpro - Scale Channel

Figure 455: Editing an Interface for the SICS Server,Page 2
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Once an inferface has been configured for SICS, it will appear in the Interfaces list. In the example shown
below, two inferfaces have been assigned for SICSpro communication.

{ Interfaces

Port Hardware Status Baud Rate Data Bits Pa
Mainboard Discrete I/0 Enabled
Mainboard  Serial Enabled 9600 8 Bits Nc
Slot 1 SICSpro - Serial Port Enabled 9600 8 Bits Nc
Slot 1 SICSpro - Scale Channel  Enabled
Slot 1 Discrete I/0 Enabled

Figure 456: Interfaces List

Next, a [Connection » Page 233] must be configured with Ethernet Connection defined as Server, and

Assignment as SICS.

<  Add Connection

Port

Mainboard N
Serial
Assignment
SICS. N
Trigger
Active Scale N

Figure 457: Configuring a Connection for SICS Use
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Once the connection has been defined, it will appear in the Connections list.

{  Connections

Port Hardware Assignment Trigger Template

Mainboard Serial SICS Active Scale

Figure 458: Connections List Shwoing SICS-Assigned Serial Connection

3.5 Maintenance Setup

The Maintenance menu provides access to the following items:

A.:L @ 30.Aug.11?0:2‘;

Setup > Maintenance

Scales Configure
Application Run
Terminal Diagnostics
Communication Reset
Maintenance Information

Figure 459: Maintenance Menus
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3.5.1 Configure

R @ 01:30
¥ 28.Aug.2021

| Setup > Maintenance > Configure

Scales Configure Enable Logs

Application Run View Change Log

View Maintenance

Terminal Diagnostics

Log
Communication Reset View Error Log
Maintenance Information

Figure 460: Mainfenance - Configure Menus

The Configure screens are used to determine the behavior of the Terminal's logs, and to view their contents.

3.5.1.1 Enable Logs

The following logs can be enabled in the IND700. Note that the POWERCELL log appears only in terminals with
at least one POWERCELL scale interface installed.

<  Enable Logs
Change Log
Maintenance Log

Error Log

Powercell Log

Powercell Log Interval

24

Figure 461: Enable Logs Screen

Each of the logs -- Change, Maintenance, Error and POWERCELL -- can be Enabled or Disabled. By default,
both the Change Log and Error Log are enabled. Only enabled logs appear in the Configure menu.

When the POWERCELL Log is enabled, a polling interval must be set. This is expressed in hours, and
defermines the frequency with which the log collects POWERCELL data. The default value is 24 hours.
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When one or more enabled logs is disabled from this screen, ifs contents will be cleared. When a change in
log configuration is made, a blue confirmation check mark |v] appears at bottom right.

{  Enable Logs
Change Log
Maintenance Log
Error Log

Powercell Log

24

Figure 462: Logs Disabled, Confirmation Check Mark Displayed

Touching this check mark fo confirm the changes will display one or more warning dialogs, one for each
newly-disabled log, requesting confirmation for clearing the confents of the log. These dialogs will display one
after the other, and each must be acknowledged to exit the screen.

Warning

A Delete all change log data

X

Figure 463: Clear Log Content Confirmation Dialog

3.5.1.2 View Change Log

IND700

<  View Change Log

ID Log Time ™ User Name Configure

10 26.)an.2024 09:00:44 Admin Sum5

9 26.Jan.2024 09:00:44 Admin Sumb5

8 26.Jan.2024 09:00:43 Admin Sumb5

7 26.Jan.2024 09:00:43 Admin Sum5

6 19.)an.2024 09:42:58 Admin LicensingService
5 19.Jan.2024 09:38:55 Admin LicensingService
4 18.)an.2024 11:55:07 Admin IND700

3 18.)an.2024 10:53:30 Admin IND700

2 18.)an.2024 10:36:47 Admin IND700

1 18.)an.2024 10:35:48 System Log Configuration
— N

Figure 464: Change Log
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When the log is enabled, entries are added automatically.

The Change Log can be filtered, searched, and exported. Refer to [Table Functions: Filter, Export, Import, Clear
» Page 322].

3.5.1.3 View Maintenance Log

<  View Maintenance Log

Log Time Username Channel Cell Event Description Status

+ Add Maintenance Log Record

Figure 465: Maintenance Log

Entries to the Maintenance Log are made manually, by touching the + sign fo open the Add Maintenance Log
Record screen.

< Add Maintenance Log Record
Channel
Terminal

Event

MAINT. OPTION COMPONENT ADDED

Status

Figure 466: Mainfenance Log Record

Item Options Function

Channel | Terminal [default], Scale 1, Scale 2, Scale 3, Defines the affected component of the terminal,
Scale 4 or the terminal itself.

266 | Configuration IND700



Event MAINT. OPTION COMPONENT ADDED [default], | Defines the type of mainfenance action taken.
MAINT. OPTION COMPONENT REMOVED, MAINT.
OPTION COMPONENT REPLACED

Status Displays an alphanumeric entry dialog Text description of action taken, and any
maintenance notes.

The Mainfenance Log can be filtered and searched, and exported. Refer to [Table Functions: Filter, Export,
Import, Clear » Page 322].

3.5.1.4 View Error Log

View Error Log ? [11
Log Time ™ Username Severity Error Code Scale
18.Jan.2024 10:38:58 Admin E A70008

18.Jan.2024 10:36:02 Admin £ A70008

Figure 467: Error Log
Error Log entries are created automatically by the terminal. Errors are described in more defail in
[Troubleshooting » Page 299].

The Error Log can be filtered, searched, and exported. Refer fo [Table Functions: Filter, Export, Import, Clear »
Page 322].

3.5.1.5 View POWERCELL Log

In IND700 terminals with at least one POWERCELL scale inferface installed, the POWERCELL Log displays a
selection of read-only data, including a fime stamp and node number fo assist in diagnosing POWERCELL
problems. In its default state, the log is shown with the lock icon closed & .

{  View Powercell Log o

ID Log Time User Channel Node Serial Number Cell Col

Figure 468: POWERCELL Log View
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Touch the lock icon fo unlock the log. Addifional options now appear.

<  View Powercell Log

w ¥ M T

1D Log Time User Channel Node Serial Number
24 29Jan.2024 11:33:51 Admin Scale 1 4
23 29Jan.2024 11:33:51 Admin Scale 1 3
22 29.)an.2024 11:33:51 Admin Scale 1 2
21 29Jan.2024 11:33:51 Admin Scale 1 1
20 28.Jan.2024 11:33:52 Admin Scale 1 4
19 28.Jan.2024 11:33:52 Admin Scale 1 3
18 28.)an.2024 11:33:52 Admin Scale 1 2
17 28.Jan.2024 11:33:52 Admin Scale 1 1
16 27)an.2024 11:33:51 Admin Scale 1 4
15 27.)an.2024 11:33:51 Admin Scale 1 3

Figure 469: POWERCELL Log Unlocked

In addition to the Filter Y and Export rfiicons, touching the ellipsis e« displays a Delete @il and an Add

=+ icon.

Touch the =+, either in the menu bar or from the record list, to display the Add POWERCELL Log Record
screen.

<{  Add Powercell Log Record

Channel

Scale 1

Figure 470: Add POWERELL Log Record

Choose the scale for which a log record should be added, and touch the blue check mark fo confirm [v].
Note that one new record is added for each of the scale's nodes.

Figure 471: POWERCELL Log Records Added
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Log Time ™ User Channel Node Serial Number
02.Feb.2024 09:24:30 Admin Scale 1 4

02.Feb.2024 09:24:30 Admin Scale 1 3

02.Feb.2024 09:24:30 Admin Scale 1 z

02.Feb.2024 09:24:30 Admin Scale 1 1
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3.5.2 Run

The current configuration of an IND700 can be backed up and saved, either within the ferminal or on an
external USB device. The configuration backup file can then be stored safely in another location. Keeping a
current backup of the parameters configured in Setup ensures that the terminal's function can be restored if

3.5.2.1

IND700

necessary, without the user having to remember and enfer settings.

él @ 25.Aug.2230:g:

Setup > Maintenance > Run
Scales Configure Backup
Application Run Restore
Terminal Diagnostics Software Update
Communication Reset
Maintenance Information

Figure 472: Maintenance - Run Menus

The Run menu provides access to the following items:

Backup

The ferminal's backup function requires only a Target specification (Internal File [default] or USB Memory)

and a farget filename. The export directory is determined by the chosen target.

<{  Backup

Target for Backup

Internal File AV

File

IND700_69569446D7 2024 01_29 1223

Directory
C:\Backup

>

Figure 473: Run - Backup Configuration, Internal File Target

If a USB device is connected to the terminal, it will appear as an option in the Target for Backup dropdown list.

<  Backup

Target for Backup

Internal File ~

USB Memory

Internal File

Directory
C:\Backup

Figure 474: Run - Backup Configuration, USB Memory Target
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The backup function saves the ferminal's configuration in an .mtbak file. A confirmation dialog indicates that
the process complefed successfully.

< Save Configuration Successful

Save the configuration to

C:\Backup
\IND700_69569446DZ_2024_01_29_

1223.mtbak

Figure 475: Backup Success Confirmation

3.5.2.2 Restore

When a configuration backup file is saved to the IND700 C:\Backup directory, the terminal automatically

detects it and asks the user o confirm the restoration of settings.

<

Restore
Target for Restore

Internal File N
File

IND700_69569446DZ_2024 01_29 1223\

Directory
C:\Backup

>

Figure 476: Run - Restore Configuration from File Stored in the Terminal

If the backup file is stored on an external USB device, or being transferred from an exfernal storage location
using a USB device, the device must be connected to the ferminal when the resfore process is begun. In this

case, the Target for Restore dropdown list will include the external device.

<

Restore

Target for Restore

Internal File A

USB Memory

Internal File

Directory
C:\Backup

Figure 477: Run - Restore Configuration from External Device

Once the Target for Restore is defined (the file from which the restore will take place, either from an Internal
File [default] or from USB Memory), the File dropdown list will include all saved .mtbk configuration files in

that location. Select a file and touch the RUN button at lower right. A warning dialog will display, allowing the
user either to continue or stop the restore procedure.
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3.5.2.3

IND700

Warning

Security changes
A require the terminal

to restart

x

Figure 478: Restore Caution Dialog

Software Update

The Software Update menu includes three sub-menus -- Windows Servicing & Deployment, Scale Interface
and Load Cell.

13:33

25.May.2023

Setup > Maintenance > Run > Software Update
Windows
Scales Configure Backup Servicing &
Deployment
Application Run Restore Scale Interface
Terminal Diagnostics Software Update Load Cell
Communication Reset
Maintenance Information

Figure 479: Software Update

To run a Software Update, the update file must be saved in the terminal's C:\ToUpdate folder. Use an FTP
client or some other utility to copy tne necessary file/s info this location. For an example of this procedure, refer
to [Scale Interface » Page 275]. This procedure does not apply to Windows Servicing & Deployment, for
which other sources are used.

The Scale Interface update is an update fo the firmware on the interface installed in the IND700. The Load Cell
update updates load cells in the scale base, and applies only to Precision scales.

Once the Source is selected, the File dropdown list will show all available update files at that location. Select a
file and touch the RUN button » which will appear af lower right on the screen.
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3.5.2.3.1 Windows Servicing & Deployment

The options provided on this page are shown below:

<  Windows Servicing & Deployment

Service / Deployment Type Installation Type

Offline N QS & Proworks N
File Source

C:A\Service

Figure 480: Software Updafe - Windows Servicing & Deployment
Select the Service / Deployment Type, then click the RUN butfon » af lower right. A message will appear:

Waiting for installation packages.

Figure 481: Message: Waiting for Installation Packages

Then a list of available Update Files will display.

< Update Files

File Name

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB502228€
sftp://ftp-static. mt.com/PUB/IND-Update-Server/Windows Updates/KB502228€
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB5027222
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB5027222
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProwWorks/MT.Sin

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications Proworks/MT.Sin

OO0/ o0oojooooojo

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Applications ProWorks/MT.Sin

Figure 482: List of Update Files
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To see which type of file is in each row, scroll the screen to the right.

{  Update Files v

Updates/KB5022286/Windows10.0-KB5022286-x64.cab
Updates/KB5022286/Windows10.0-55U-17763.3641-x64.cab
Updates/KB5027222/Windows10.0-KB5027222-x64.cab
Updates/KB5027222/Windows10.0-SSU-17763.4121-x64.cab

ns ProWorks/MT.Singularity.Platform.Client.4.0.13-g3ef26ee7c5.mtapp
ns ProWorks/MT.Singularity.Platform.Client. MTApp.3.0.5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.3.0.5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.4.0.13-g3ef26ee7c5.mtapp

ns ProWorks/MT.Singularity.Platform.Engine.Simulation.3.0.5.mtapp
ns Proworks/MT.Singularity.Platform.Engine.Simulation.4.0.13-g3ef26ee7c5.mtapp

Figure 483: List of Update Files, Scrolled
Touch one or more check boxes to select the desired file/s.

< Update Files v

File Name

O

Q

sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB502228€
sftp://ftp-static. mt.com/PUB/IND-Update-Server/Windows Updates/KB502228€
sftp://ftp-static.mt.com/PUB/IND-Update-Server/Windows Updates/KB5027222

O R

Figure 484: Update Files selected

Once at least one file is checked, a check mark appears at the right of the menu bar. Touch this check mark to
initiate the update. A confirmation message will appear:

Information

Start update now?
Terminal will restart

x

Figure 485: Update Confirmation Message

The terminal will reboot, with the update installed.
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Windows Servicing & Deployment Options

Parameter

Options

Service\Deploy
ment Type

The type options are:
Service / Deployment Type
Offline N

Offline
Local

Online
All

In each case, if the necessary parameters are set, touching the RUN button B will display a
list of update files.

Offline: A deployment file has been copied into the ferminal's C:\Service folder. If a valid file is
found, touching RUN will perform the update.

Local: A deployment file is available on the customer's local network. The login information
(FTP File Source, Anonymous Login, User Name and Password) are visible, but cannot be
changed. The customer's IT department must code these values in the Windows registry.
Online: A deployment file is available on an FTP server provided by METTLER TOLEDO. This
static IP is fixed -- sftp://anonymous@ft-static.mt.com/PUB/IND-Update-Server.

All: This option displays a list of files from all available deployment opfions.

Installation
Type

Installation type options are:

Installation Type

05 & ProWorks A
0S & ProWorks

Operating System

ProWworks

Script

Windows Servicing & Deployment

The Script item refers fo scripts used to update and/or customize specific functions such as
the Universal Writer Filter (UWF), Keyboard Filter, NTP - for example, to exclude a specific
folder from the UWF profection. Only signed MT scripts will be updated:

* UWF

* Keyboard filter

* NITP

e Production scripfs

* Reset to factory default

e Join domain

e Change OS language

A script update is not a software update, but a list of parameters or aftributes used to change
the behavior of particular functions.

Select the fype of installation required, then touch the RUN button. A list will appear,
containing only files of the selected type.

File Source

The default value is C:\Service. If a USB drive is attached fo the ferminal, it may be selected
as a local location.

274 | Configuration

IND700



3.5.2.3.2 Scale Interface

Scale Firmware Update Note

\When more than one scale interface is installed in a terminal, each scale must be updated
separately.

To update the firmware on a scale interface board, the .mot update file must be saved to the terminal's C:
\Service\ToUpgrade folder. The example below uses the UliraVNC application. Other methods are detailed in
[File Transfer » Page 363] in the Communication section.

Copying Update Files to the Terminal

To transfer the .mot file to the terminal's C:\Service\ToUpgrade folder, use an ftp ufility. In the example shown
here, UltraVNC Viewer is used.

First, click on the Open File Transfer... icon in the VNC window's menu bar.

| ﬁ win-muupihfgden ( 192,168.86.222 ) - agnlication mode

SESSELOOT MMM N

K A CALLC Co i Cmala

Figure 486: VNC Open File Transfer Icon

The File Transfer initial view will display, with fwo panes representing the host computer and the connected
IND700, respectively.

I h Fa— 2 Fan — P T A FEWFN
| B File Transfer with < win-muupihfgden ( 192.168.86.222 ) - application mode > - UltraVNC m - (] x
~ LOCAL MACHINE A = ~ REMOTE MACHINE 4
Mame Size Modified Mame Size Modified
e [C] Local Disk ] Local Disk
e [D:] Local Disk E [ Desktop ]
E E [ Desktop ] E [ My Documents ]
ww [Er] Local Digk D [ Metwork Favorites ]
|| & [F] Local Digk
we[Gr] Local Disk
) Send >>
(| wel:] Local Disk
| L[ My Documents ] << Receive
| CO [ Metwork Favorites ]
Delete
New Folder
Rename
Minirmize
Close
[ Forced Close [
History = 102325 11:50:43 - Connected... '
Progress
Connected...

Figure 487: File Transfer Initial View
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In the right (IND700) pane, navigate to the C:\Service\ToUpdate folder.

Figure 488: Navigating fo the ToUpdate Folder
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T T T = — B m——— T T | o — —r e " —
[ B File Transfer with < win-muupihfgden ( 192.168.86.222 ) - application mode > - UltraVMNC @ - O *
~ LOCAL MACHINE 4 [C:1 - Local Disk ~ | REMOTE MACHINE !
E. C:h
|| | Name Size Modified Name Size Modified
|| s [C:] Local Disk L[ tRecyde.Bin] Folder
we [D:] Local Disk [ Backup] Folder
[ Desktop ] [ bevicelockDown ] Folder
W [E:] Local Disk [ Documents and Settings ] Folder
|| [F:] Local Disk D [Export] Folder
s [Gr] Local Disk D [ Import ] Folder
e [1] Local Disk D [ INDFOOTools ] Folder
[ My Documents ] — [ IND830Boot ] Folder
D [ Metwork Favorites ] D [ IND330Log ] Folder
[ ND3s0Toals ] Folder
COlntel] Folder
[ Packages ] Folder
L[ Perflogs] Folder
[ Program Files (x88) ] Folder
I L[ Program Files ] Folder
Delete > [ ProgramData ] Folder
CJ[Recovery ] Folder
Mew Falder - D[ service Folder
—— D [ System ¥olume Informati... Folder
D [temp] Folder
] D[Users Folder
D [ Winddfvs ] Folder
hiberfilEys 1.53Gb 10/23/2025 10:40
&) pagefilf.sys 1.37Gb 10,23/2025 10:40
uwfaviap.sys 3.50 Gb 01/13/2024 14:33
B File Transfer with < win-muupihfgden ( 192.168.86.222 ) - application mode > £ UltraWNC @ - O x
v | LOCALMACHINE \ [C: ] -pheal Disk v |  REMOTE MACHINE \
C:l\Servicel,
Mame Size Modified Mame Size Modified
e [C:] Local Disk =1 Folder
e [D:] Local Disk C[ToUparade ] Folder
[ Desktop ] MT.SingularityPlatform.Cli... 0 bytes 02/28/2024 10:25
e [Er] Local Disk MT.Singularit Platform.En... 0 bytes 02/23/2024 10:25
e [Fr] Local Disk
w [Gr] Local Disk .
e [I] Local Disk ! .
D [ My Documents ]
[ Network Favorites ]
B File Transfer with < win-muupihfgden ( 192.168.86.222 ) - application mode > - URraWNC @ - O x
v | LOCAL MACHINE \ [C: ] -Locallbisk ~ | REMOTE MACHINE \
C:\Service\ToUpgrade,
Mame Size Modified Mame Size Modified
e [C:] Local Disk =1 Folder
we[D:] Local Disk HSALv1_0_40.mot 1.69 Mb 11/08/2023 10:14
E [ Desktop ]
e [Er] Local Disk
e [Fr] Local Disk
w [Gr] Local Disk .
w1 ] Local Disk - .
[ My Documents ] -
[ Network Favorites ] .
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IND700

In left (host computer) pane, navigate fo the folder confaining the update file/s.

B File Transfer with < win-muupihfgden ( 192.168.86.222 ) - application mode > - UltraVNC

= = O *
[D:] - Local Disk s | LOCAL MACHINE \ . [C:]-Local Disk ~ REMOTE MACHINE |
DMy Documents00 Industrial projects - terminals, transmitters and mod C:\Service\ToUpgrade’,
MName Size Modified Mame Size Modified
Car..1 Folder Cr..1 Folder
DigiCell-07x50_2,4.0.mat 1.23 Mb 080420 HSALv1_0_40.mot 1.69Mb 11/08/2023 10:14
DigiCel-MFR_3,2. 2.mot 1.23 Mb 080420
DigiCell-5G_2.4.0.mot 1.17 Mb 080420
PBDS555 & PBK7SS firmware reference.jpg 21.75kKb 03/04/20
Send =
<< Receive
<-Delete
<-New Folder
<-Rename
Minimize
Close

= 6 File(s) fFolder (s)
Histary

Forced Close » 2 File(s)/Folder(s)
= 10/23/25 11:50:43 - Connected...

Progress

| Connected...

Figure 489: Source Folder on Host Computer

In the left pane, select the file or files fo be transferred to the ToUpdate folder.

DigiCell-56_2.4.0.mot
PBDSSS & PBKFES firmware reference.jpg

21.75Kb

Send >>

<< Receive

B File Transfer with < win-muupihfgden ( 192.168.86.222 ) - application mode > - UltraVWNC m= — O X
[D: ] - Local Disk ~||  LOCALMACHINE \ . [C:] - Local Disk v | REMOTEMACHINE \
D:'YMy Documents\00 Industrial projects - terminals, transmitters and mod C:\ServiceiToUpgrade,

Mame Size Modified Name Size Modified

0.1 Folder 0.1 Folder

DigiCell-07x50_2.4.0.mot 1.23Mb 08/04/20 HSALv1_0_40.mot 1.69 Mb 11/08/2023 10: 14
DigiCell-MFR_3.2.2.mot 1.23Mb

Figure 490: Update File Selected

With the file/s selected, click the Send >> button in the File Transfer window. A progress bar af the botfom of

the window will indicate the success of the transfer.

> 1 File(s)/Folder(s) selected for transfer
Histary

Forced Close » 3 File(s)/Folder(s)
= 10/23/25 12:30:11 - Tranzfer completed
Progress

Transfer completed

I 100°: (1200 kb @ ~150% kb/5)

w

File 1/1

Figure 491: FTP Transfer Complefe
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Performing the Update
With the correct file type saved in the ToUpdafe folder, the Maintenance > Run > Software Update > Scale

Interface screen will appear as below, with the most recent file already selected in the File field.

<

Update Scale Interface Firmware

Scale Channel Scale Interface Type
Slot 1 Powercell ~ Powercell v4.0.12
File
IND890Pwcl3v4 0_12.mot ~

File Source

C:\Service\ToUpgrade\

Figure 492: Firmware Update - POWERCELL Scale Interface

<

Update Scale Interface Firmware

Scale Channel Scale Interface Type

Slot 1 SICSpro N SICSpro V1.1.08

File

No files found for this scale interface type
File Source
C\Service\ToUpgrade\

Figure 493: Firmware Update - Precision Scale Interface

To perform the upgrade, click the RUN button » at lower right. The terminal will reboot to the home screen
without further action from the user. When the reboot is complete, the firmware update is complete. The udpated

scale interface will retain its settings from before the update.
The update file will remain in the C:\Service\ToUpgrade folder, ready for use in updating a second scale

interface if one is installed.

3.5.2.3.3 Load Cell

The Load Cell Firmware Update is only available for the IND700 with Precision scale interface. To update the
firmware on a Precision scale interface, first copy the update file fo the terminal's C:\Service\ToUpdate folder.

Refer to [Scale Inferface » Page 2757, and fo [File Transfer » Page 363].
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<{  Update Scale Load Cell Firmware

Scale Channel Load Cell Type
Slot 1 SICSpro G
File
b7
No files found for this Ioad cell type
File Source
C:\Service\ToUpgrade\

Figure 494: Load Cell Firmware Update - Precision Scale

3.5.3 Diagnostics

The Diagnostics menu provides access to the following items:

13:07

30.Aug.2023

Setup > Maintenance > Diagnostics

Scales Configure Network Test
Application Run fggggggﬁst
Terminal Diagnostics DIO Test
Communication Reset

Maintenance Information

Figure 495: Mainfenance - Diagnostics Menus
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3.5.3.1 Network Test

{  Network Test

IP Address

192.168.86.24

Ping Response

Destination Host Unreachable

Figure 496: Network Test
Touch the IP Address field to display an IP entry dialog and define the IP address.

< IP Address

Figure 497: IP Address Entry Dialog
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Once the IP address is defined, touch the &/ button in the dialog, then the RUN butfon at lower right. The
Terminal will ping that address and, if the test is successful, display the response time.

<  Network Test

IP Address

192.168.86.105

Ping Response

Success (0 ms)

Figure 498: Network Test - Success

3.5.3.2 Serial Port Loopback Test

{  Serial Port Loopback Test

Slot Mainboard (Serial Port)

Test Status

Figure 499: Serial Port Loopback Test
This test requires the installation of a loopback device on the terminal's serial port.

3.5.3.3 DIO Test

To facilitafe testing and diagnostics, the DIO Test screen displays the stafus of the IND700 digital inputs and
oufpufs.
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/\ WARNING

DIO Test and Device Control Power

Before running the DIO test, ensure that power is removed from all devices controlled by
outputs. Injury or equipment damage can result from a failure to observe this precaution.

This precaution does not apply if Virtual 10 Device is selecfed under Port.

< DIO Test

1\ Remove output control power

Port

Mainboard v O Green indicates I/O ON
Output @ @

Figure 500: DIO Test

Select the inpufs and outputs to fest by making a Port selection.The list shows all installed DIO devices.

Port

Mainboard v ‘

Mainboard

Scale 1

Virtual IO Device

—

Figure 501: DIO Test Port Options

This screen allows each installed input and output to be fested, by fouching the Output indicafors. When an

Output indicafor is fouched, it will turn green to indicate that that output is active. In the example shown
mainboard DIO inputs and outputs are represented.

below,

IND700
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< DIO Test

'\ Remove output control power

Port

Mainboard v O Green indicates I/O ON

w O ©
— Q@ ©

Figure 502: DIO Test, Output Active

The Virtual 10 Device option is a diagnostic tool which represents a consolidated view of all available inputs
and outputs. This display is not connected to external hardware, and the state of its output bits does not affect
any external device.

< DIO Test

'\ Remove output control power

Port

Virtual IO Device v O Green indicates I/O ON
- QO @ @ 0
HONORIONNORNONNO

Figure 503: DIO Test Screen, Virtual 10 Device Selected
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3.5.4 Reset

{ Reset
Scales Interfaces
Terminal Master Reset
Application @

Communication

Maintenance

Figure 504: Mainfenance - Reset Opfions
The Reset screen allows any combination of menu branches and types of configuration dafa to be reset. Once
at least one item is selected, a RUN button appears at lower right.

If a Master Reset is selected, only the Reset Calibration slider remains acfive. A Master Reset can include or
exclude the terminal's calibration data.

Main PCB Switch Settings and Master Reset

When the terminal is in Approved mode, SW1-1 must be ON and SW1-2 OFF. In this
condition, metrological data are protected and cannot be reset. Refer to PCB DIP Switch

Seftings.

Touch the RUN button  » to carry out the selected reset. Depending on which kind of resef is carried out,
different warning dialogs appear, allowing the user fo continue or abandon the reset.

Warning

Reset changes Configuration Settings to
ﬁ default values. Approved Scale Settings,

Table Data, Calibration Data and the serial
number won't be reset.

x

Figure 505: Reset Scale Menu Warning Dialog
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Warning

Master Reset deletes all Configuration
H including all Scale Settings and Table Data.

Calibration Data, serial number not reset.
Security changes require the terminal to

restart!
X

Figure 506: Master Reset without Calibration Warning Dialog

Warning

Master Reset with Calibration resets

terminal to factory defaults. All
A Configuration Settings, Table Data, and

Calibration will be deleted. Terminal Serial
number not reset.

x

Figure 507: Master Reset with Calibration Warning Dialog

3.5.5 Information

The Information screen provides information about many terminal configurations and parameters.

The Category selections are :

e CountingService, CurrentMaterialService, CurreniTareService, IDDataService, FillingService, OverUnder-
Service, Classification, TotalizationService, EngineModules, ClientModules, ScaleUpdateRate, OptionBoard-
Information, Hardwarelnformation, AllConfigured

An example of an Information screen is shown below. Category selections may or may not display any infor-
mation, depending on terminal configuration.
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Some examples of these screens are shown below.

< Information

Category

EngineModules N

Name

Value

Build Information

Module: ScalelF.dll

Module: FieldbusHilscher.dll

Module: MT.Singularity.Platform.Engine.Host

Module: MT.Singularity.Platform.Engine

Module: MT.Singularity.Platform

Module: MT.Singularity.Core

KA~ dae AAT Cimmilaicitn s Pinin

Build on build server with commit

5.41.1
5.41.1
5.41.1
5.41.1
5.41.1
5.41.1

C A1 4

50-freeze.0+9bd6c9163b
50-freeze.2+025150dad2
50-freeze.2+025150dad2
50-freeze.2+025150dad2
50-freeze.2+025150dad2
50-freeze.2+025150dad2

EN femmmn D 1ANEACAL~AN

Figure 508: Maintenance - Information Screen: Engine Modules

< Information

Category

ClientModules N

Name

Value

Build Information

Module:
Module:
Module
Module:
Module:
Module

KA~ dan

ScaleIF.dll
MT.Singularity.Platform.Client. MTApp

: MT.Singularity.Platform.ULShell. WPF

MT.Singularity.Core
MT.Singularity.Platform.Client

: MT.Singularity.Platform

AT Climms sl aitn e Teamalasine

Build on build server with commit

5.41.
5.41.
5.41.
5.41.
5.41.
5.41.

C A4

150-freeze.0+9bd6c9163b
150-freeze.2+025150dad2
150-freeze.2+025150dad2
150-freeze.2+025150dad2
150-freeze.2+025150dad2
150-freeze.2+025150dad2

ACA femn—mn AIANCACAA~AD

Figure 509: Maintenance - Information: Client Modules

<  Information

Category

ScaleUpdateRate N

Name

Value

Scale 1

111

Figure 510: Maintenance - Information: ScaleUpdateRate
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<  Information ™
Category
OptionBoardInformation “\/ S
Name Value
Slot 1 Part Number 30726003
Slot 1 PCBAC Number 0030521649
Slot 1 Serial Number 0110069045410001
Slot 1 Hardware Version OE
Slot 1 Software Version V4.0.12
Slot 1 Manufacturer Date 2147

Figure 511: Mainfenance - Information: OptionBoardInformation

{ Information ™
Category
Hardwarelnformation N
Name Value
SMARC Part Number 30648170
Carrier Board Part Number 30677199

Figure 512: Maintenance - Information: Hardwarelnformation

Information for each cafegory can be exporfed fo an internal file, saved to the C:\Export folder, or to an external
USB device. Refer to [Export » Page 325].
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4 Service and Maintenance

The ferminal is designed to provide years of dependable operation. However, METTLER TOLEDO recommends
that — as with any industrial measurement equipment — the terminal and the connected scale system be
serviced periodically. Timely, factory-specified maintenance and calibration by a METTLER TOLEDO service
technician will ensure and document accurate and dependable performance to specifications.

4.1 Application Software Activation

Application software such as ProwWorks Mulfi-Tools can be registered and activated in two ways:
e From within the METTLER TOLEDO intranet

e From outside the METTLER TOLEDO intranet -- e.g., at a customer's sife

Terminal Serial Number

Before attempting fo activate application software, ensure that the terminal's serial number (in sefup af

[Terminal > Device » Page 197]) does not show a mismatch. A mismatch may appear when the terminal's

firmware has been updated, for example.

1. Check that the displayed serial number corresponds to the number on the ferminal's data plate:
mnwm : [ SCK: TT0000G 1000001010 |

Figure 513: Terminal Data Plate Showing Serial Number

<  Device

Terminal ID #1

Terminal ID #2

Terminal ID #3

Terminal Serial Number

69569416DZ

Figure 514: Terminal > Device Screen Showing Serial Number

2. Ifthe Terminal Serial Number field is editable, and shows a "Serial Number Mismatch" warning in red,
click on the field. If necessary, enter the correct serial number in the entry screen which displays.

3. Click on the check mark K at lower right.

4. Finally, click the check mark at lower right of the Device screen. The serial number will now appear as d
displayed item which cannot be edited.

Software License key

When a software license is purchased, a license key envelope is provided.

Software License Key

METTLER TOLEDO

Figure 515: License Key Envelope
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4.1.1

IND700

This envelope contfains a card showing the license key, in five groups of characters separated by dashes.

P -~
= .

g Multi—Tools

Snel

(= License Key

o [ TNy

E NN I

E https://activation.mt.com

_
Figure 516: License Key Card

Save this card in a secure place. The Key will be required if the software needs fo be re-activafed, or moved to
another terminal (for example, when the original ferminal is no longer functional.)

For additional information on moving files to and from the terminal, refer to [File Transfer » Page 363].

Activation from Within the METTLER TOLEDO Intranet

If the terminal is connected to the network inside the METTLER TOLEDO infranet, an automatic acfivation

procedure can be used:

1. Make sure that the IND700 is connected to the network via an Ethernet connection.
2. Enter setup and access Terminal > Licensing. The License Manager page will appear.

¢{ License Manager

State Name License Key Product

+

+  Add License

Figure 517: Licensing Manager

3. Click the 4 either in the menu bar, or in the license list pane. The Add License screen will appear.

¢{  Add License

Mame

License Key

Figure 518: Add License Screen

4. Enter a name to associate with this license -- e.g. ProWorks Multi-Tools, or a ferminal identifier -- and the

License Key from the card.
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<

Ad

MName

d License

License Key

Figure 519: License Key Entered

5. Click the check mark at lower right.
6. Click the Cloud/Key icon &= in the menu bar. The Online License Activation screen will display. Enter the

User Name and Password associated with the activation account, then click the check mark Bd.
7. Alicense Activation Successful message will display, The software is now activated.

( Information

License Activation
Successful. All
Licenses are activated.

Figure 520: License Activation Confirmation Screen

8. The License Manager screen will now display the activated license.

< License Manager + &S th
State Name License Key Product
v ProWorks Multi-Tools IND700 Lice

Figure 521: License Manager Showing Activated License

4.1.2 Activation from Outside the METTLER TOLEDO Intranet

If the IND700 is connected to a network outside the METTLER TOLEDO intranet, the activation procedure can be
carried out manually.

Before beginning the procedure, confirm that the correct server (depending on fransfer fool used) is active at

[Terminal > Security Options » Page 215] -- FTP, sFTP or Remote Desktop.

Service and Maintenance
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Note: The password for ferminal access by an external ufility is 248163264.
1. Make sure the IND700 is connected fo the network via an Ethernet connection.

2. In setup, access Terminal > Licensing. The License Manager screen will display.

¢{ License Manager +

State Name License Key Product

+  Add License

Figure 522: License Manager Screen

3. Click the =, either in the menu bar or in the license list pane. The Add License screen will display.

<  Add License

Mame

License Key

Figure 523: Add License Screen

4. Confirm the entry to return to the License Manager screen.

5. Click the EXPORT icon f1 in the menu bar. A .lic (license) file will be exporfed to the terminal's hard drive
at C:\Export.

6. Access the terminal from a PC via the Ethernet connection, and use a tool such as UliraVNC fo access the
Export folder.
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[ moasiBest |

L mossoeeg ]

LI roasoToos ]
Ch[neel]

L[ packages ]
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[ Program Fies [x85) ]
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L Programbata ]
Ch[Recovery]
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L[ temn]

Cilusers]
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(5) wwfsweap.sys

FRRERERRRRRRERRERERERDY

e
g
Ba

190G

Modified

01192024 15: 17
01/19/2024 15:17
011872024 16: 30

Mstory | > D1/19/24 13:20:47 - Connected...

Progress
Connected...

Figure 524: IND700 Export Folder

7. Copy the .lic file from the Export folder to the PC.
8. From a web browser on the PC, access the Activation Portal.

-0

METTLER TOLEDO Software Portal

Wwnoms 2 the Softweres fortal

For mors inkamation oo profley, tgning i snd seeting pusTecedy 1 the First B o

Figure 525: Activation Portal
9. Enfer the required user name and password.
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Sign In

User name: | | —

HEREEA R EREEE

Password:

Internal Authentication
Forgot Login? Reset password here

+ Go back to site

Figure 526: Activation Porfal Login
10. Click on the Activation item in the site's menu bar.

METTLER TOLEDO

ACTIVATION PORTAL

Figure 527: Activation Link in Menu Bar

11. The Activation / Reactivation / System Transfer screen appears. Here, soffware can be activated or
reactivated, or transferred between systems.

Inorder: B i pour peoduct. ]
On the page, o “Submt 1o upload.

Ucense ey e || Chooes File | Mo fle chosen

A & tranafer by t0 recieve an activited Tystem from anceher uses Bocount.

Tramster ey

Actieated grodues | NorrACvated products

Pzt select - 1o changs, upeine oo view detidh of & syiten.
Thus user hait any actrvated procucts et

Figure 528: Activation Screen

12. Click the Choose File button, navigate fo the folder containing the .lic file, select the file and confirm the
selection.

13. The server wil generate an acfivation file with a .key suffix, and display a download link. Click the link to
download the file.

14. Using the ferminal access tool used in step 6, browse to the terminal's C:\Import folder, and copy the .key
file from the PC info the folder. Close the tool.
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w(r] Metwork S Ol import] Folder
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L[ moasineg | Folder
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L[ Packages ] Fokder
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L[ Program Fles (x88) ] Foider
C[Program Fies | Folder
Delete > [ ProgramData | Felder
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Hew Folder -> | | 73] Service | Eplder
L[ syatem Vel Informati,.. Foider
e s [ temp ) Fokder
Clusers] Folder
Cd [ windows 1 Folder
(2] riberfi 58 L.53Gh 0115/2024 15:17
[3) pagetie.sys 1.37Gh 01192024 15: 17
(5] wwefweap. sys 1.50Gh 0182024 16:30
Mremze
Clase
Forged Clage > 25 File{s) Folder(s)
History > 011924 13:29:47 - Cornected... w
Progress
Connected...

Figure 529: IND700 Import Folder

15. In the License Manager screen, click the Import icon 4.
16. The terminal will read the .lic file and display a confirmation that software activation has been successful.

< , Information

License Activation
o Successful. All
Licenses are activated.

Figure 5630: Activation Confirmation

17. The License Manage screen will now display the activated license.
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4.2 Precautions

IND700

< License Manager + & th

State Name

License Key Product

v ProWorks Multi-Tools IND700 Lice

Figure 531: License Manager Showing Activated License

e READ this manual BEFORE operating or servicing this equipment and FOLLOW these instructions carefully.
* SAVE this manual for future reference.

> B> P BbP

/\ WARNING

Before service, disconnect power from this device.

/\ WARNING

The protective ground connection must be checked after service work is
performed. Perform the check between the protective ground contact on the
power plug and the housing. This test must be documented in the service
report.

/\ WARNING

Only permit qualified personnel to service the equipment. Exercise care when
making checks, tests and adjustments that must be made with power on.
Failure to observe this precaution could result in bodily harm and/ or property
damage.

/\ WARNING

When this equipment is included as a component part of a system, the resulting
design must be reviewed by qualified personnel who are familiar with the
construction and operation of all components in the system and the potential
hazards involved. Failure to observe this precaution could result in bodily harm
and/ or property damage.

/\ WARNING

Before connecting/disconnecting any internal electronic components or inter-
connecting wiring between electronic equipment always remove power and wait
at least thirty (30) seconds before any connections or disconnections are made.
Failure to observe these precautions could result in damage to or destruction of
the equipment and/or bodily harm.
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/\ WARNING

Observe precautions for handling electrostatic sensitive devices.

4.3 List of Tools Required

The following fools are required to perform these procedures:
e Soft cloth and water

e Voltmeter

* Anti-static mat and wrist strap

e Socket screwdrivers

* Flat blade screwdriver

e Wrench kit

¢ Nut driver with 7 and 8 mm sockets

4.4 Cleaning and Maintenance
¢ Clean the ferminal’s keypad and cover with a clean, soft cloth that has been dampened with a mild glass
cleaner.

* Do not use any type of industrial solvent such as toluene or isopropanol (IPA) that could damage the
terminal’s finish.

Do not spray cleaner directly on the ferminal.

* Regular maintenance inspections and calibration by a qualified service fechnician are recommended.

« The terminal is a rugged stainless steel enclosed instrument; however, the front panel is a polyester
covering over sensitive electronic switches and a lighted display. Care should be faken fo avoid any
punctures tfo this surface or any vibrations or shocks to the instrument. Should the front panel become
punctured, ensure that steps are taken to prevent dust and moisture from entering the unit unfil the terminal
can be repaired

4.4.1 Enclosure Gasket

In order to preserve the enclosure’s IP rafing, inspect the sealing gasket to ensure that it makes a good seal,
and does not have permanent indentations. Gasket lifefime is shorfened by exposure fo high temperatures. The
enclosure gasket should be inspected during any maintenance activity, and replaced if it becomes damaged or
brittle. Refer fo Spare and Replacement Parts.

Figure 532: Replacement Gasket
4.5 Maintenance

4.5.1 Battery Replacement

When the main PCB battery runs low, the message cenfer on the main screen will display a warning:

=[= 8 B ol

© Init zero could not be done 18.Apr.2023 15:09

A\ Low Battery. Call Service for replacement! 18.Apr.2023 15:09

Figure 533: Replace Battery Warning Message
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IND700

Battery Replacement

When the IND700 main PCB battery is replaced, a back up of configuration and calibration
values is recommended, but not required.

To replace the battery:

1 Remove power from the terminal and open ifs enclosure.

2 Locate the baftery on the main PCB. The following images indicate its location in the Wedge and Harsh
environment versions of the ferminal.

Figure 554: Battery Location, Wedge'agp)'d'hd Harsh Environment (botfom) Ehélosures

3 Use a small flat blade screwdriver or other instrument fo press the battery to the right, as indicated by the
arrow in the image below.

Figure 535: Batfery Removal
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4 Install the replacement battery by placing it, positive side upward, in the battery holder, then pressing it fo
the left and into the slot until it is properly seated.

Close the terminal's enclosure.
Restore power fo the ferminal.
Enter setup fo check that configuration and calibration settings have been retained.

If the tferminal has an active Ethernet connection, time and date will be set automatically. Otherwise, set the
terminal's date and time at [Setup > Terminal > Region > Sef Time and Date » Page 211].

o N OO O

4.5.2 Leveling Guidance

The Leveling Guidance feature is available to PowerDeck scale systems. To assure maximum weighing
accuracy and reliable calibration, it is important that floor scales are installed such that an approximately equal
dead load is placed on each load cell.

During factory calibrafion of a PowerDeck floor scale, the zero counts of each load cell (at a no-load condition)
are stored in the load cell along with other initial factory dafa. When a PowerDeck floor scale is first installed,
its accuracy is enhanced by ensuring that it is levelled so that the current cell counts match the sfored, factory
calibration values as closely as possible.

¢ The Leveling Guidance feature in IND700 ferminals provides a graphical comparison of the current counts
vs. the factory calibration counts stored in each load cell of a PowerDeck platform. This feature is provided
as a tool for the service technician during installation, and can be accessed in setup af Scale © > Leveling
Guidance. Level Guidance is available if the Application is sef to Floor in setup af Scale n > ASM > Load
Cell > System.

e The installation guidance is valid only for platforms which include only the original, factory-installed load
cells. It should not be used for platforms in which one or more load cells have been replaced.

« Before accessing the Leveling Guidance feafure, a bubble level should be used for initial leveling.

< Leveling Guidance

Figure 536: Leveling Guidance, 4 Load Cell Scale

The Leveling Guidance graphic display represents a PowerDeck floor scale and assumes that the load cells are
addressed as node 1 through 4 starfing with the corner where the home-run cable exits and moving in @
clockwise direction.

The counts displayed in the cenfer of the graphic indicate how many counts the current reading is above or
below the stored factory value. The load cell with the largest negative count variance from the stored factory
value is highlighted — cell T in the example above. This indicates that this load cell should be shimmed first.

Acceptable count values depend on the resolution of the scale. For example, for a scale displaying 1,000
divisions, cell counts should be <5,000. For higher resolution scales, values such as <2,500 are required.
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The display updates aufomatically once a second (1 Hz) as the count variances of each load cell change, so
shims can be added or subtracted in an attempt to achieve an acceptable count variance. Due fo the high
resolution of the raw count readout, it will not be possible to achieve exact equality between the raw count
values. An acceptable count variance is determined by the plaiform size, capacity and the number of
increments as defined in the platform installation manual.

4.5.3 Master Reset
4.5.4 Troubleshooting and Error Codes

4.6 Filter and Search Tables and Logs

Maintenance and froubleshoofing procedures offen require information found in the terminal's tables and logs.
For information on filters and searches, refer to [Table Functions: Filter, Export, Import, Clear » Page 322].

4.7 Disposal
In conformance with the European Directive 2012/19/EU on Waste Elecirical and Electronic K

Equipment (WEEE) this device may not be disposed of in domestic waste. This also applies
to countries outside the EU, per their specific requirements.

Please dispose of this product in accordance with local regulations at the collecting point [
specified for electrical and electronic equipment. If you have any questions, please contact

the responsible authority or the distributor from which you purchased this device. Should this

device be passed on to other parties, the content of this regulation must also be related.

4.8 Troubleshooting

4.8.1 Internal Diagnostic Testing
The IND700 provides several internal diagnostic tests that are accessible in sefup mode.

1 From the home screen, open the main menu and select Enter Setup.

- @ Terminal >
&] Login/Logout
{Cy Enter Setup

1
Main Screen View

() Power 5 N

Figure 537: Main Menu

2 Touch Mainfenance.
3 Select Maintenance > Diagnostics.
4 Refer to [Diagnostics » Page 279] for details on the diagnostic options.

4.8.2 Alarm Codes and Messages

Alarms and alerts in the IND700 are indicated in two ways:
* In the [home screen message box » Page 15]
 Inthe IND700 [Error Log » Page 332]

The Error Log records all alert and action messages generated by the terminal. This log is helpful in diagnosing
and correcting problems and failures in the ferminal. These alarms can help predict failure and trigger
maintenance action before the problem becomes severe enough to make the terminal unusable.

Users with Admin and Supervisor credentials can view the Error Log.
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4.8.2.1 Reading Alarm Codes

When an alarm is friggered, a message will display on-screen for the number of seconds defined in setup at
[Terminal > Display > Message Timeoutf » Page 198]. The message pop-up will disappear after the set timeout
period, but all errors can be reviewed if the Error Log is enabled in setup at [Maintenance > Configure > Enable
Logs » Page 264]. To view the error log, go fo [Maintenance > Configure > View Error Log » Page 267]. A
typical error log display is shown below:

< View Error Log Y
D Log Time ™ Username Severity Error Code Scale
10 26.Jan.2024 11:20:22 Admin 200 1
26.Jan.2024 11:20:22 Admin 200 1
26.Jan.2024 11:20:22 Admin 200 1
26.Jan.2024 11:20:21 Admin 200 il
26.Jan.2024 10:14:25 Admin A10015

18.Jan.2024 11:19:57 Operator
18.Jan.2024 11:19:57 Operator
18.)an.2024 11:19:57 Operator
18.Jan.2024 11:19:57 Operator
18.)an.2024 11:19:57 Operator

108
108
108
108
108

= N W A U O NN 0 WO
AAIOAIAO A m MM Mm@ m

= | [ | s |

Figure 538: Example Error Log View

Logging Errors

For errors to appear in the Error Log, that log must be enabled in setup at Maintenance >
Configure > Enable Logs.

Error records consist of the following:

« The ID of the Error Log record. This is a sequential number provided the Error Log database
* The Log Time at which the alarm occurred, or when it was read by the user

e The Username of the user logged in at the time the alarm occurred

« A Category, indicating the type of alarm on a scale of 110 5

¢ An Alarm Code ([Alerts and Alarms » Page 3017) which can be used for froubleshoofing, and by MT
Service

 If more than one scale is configured in the ferminal, the affected Scale willl also be indicated

* An alarm/alert Message, in the currently configured language, displayed to the user in the home screen
message ared

* The same Message in English, fo facilitafe alarm reporting

« A Detail, which contains additional information about the record -- for instance, whether the Log Time
represents the fime when the alarm was triggered or when the user read it

Examples of Alarm Codes

Example Alarm Codes

ID Log Time User Category Alarm Scale |Message Message Detail
Name Code (English)
4 123.Jan.2024 | Admin 4 3333 1 Smartd Cat4 no.3 |Smartb Catd no.3 read
11:18 action message  action message
3 23.Jan.2024 |Admin 3 1234 2 Kontaktieren Sie | Contact support! | read
11:02 den Support!
2 123.Jan.2024 Admin 3 3333 3 Die verherige Cannot remove detect
10:50 Anwen- previous appli- ed
dungsversion kann cation version
nicht entfernt
werden.
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ID Log Time User Category Alarm Scale Message Message Detail
Name Code (English)
1 123.Jan.2024  Admin 4 1234 1 Smartd Cat4 no3 | Smartb Catd no3 | defect
10:39 alert message alert message ed

4.8.2.2 Alerts and Alarms

4.8.2.2.1

4.8.2.2.2

IND700

This section provides a description of the alarm/alert [Categories » Page 3011, and a comprehensive [list of all

alarms and alerts » Page 301] a user may encounter when operating the IND700.

Key to the Alarm and Alert List

In the alarms and alerts list, six aftributes are provided for each record:
* A numeric Alarm Code, as displayed in the Error Log

e A Category:
Alarm and Alert Categories
Icon Cat Type Description Result
ego
ry
5 Catastrophic | Wrong weight / equipment failure Alarm stops operating -- clearing the
failure alarm will not reset the condition. The
device must be repaired to eliminate
the alarm.
4 Imminent Wrong weight / equipment failure Alarm indicates that failure is
failure expected based on predictive imminent, within one week. The
algorithms and sensors, such as alarm can be reset but will recur each
temperature and humidity day until the cause is eliminated.
3 | Out of specifi- |Wrong operator actions or device /  |Alarm and log the event. Alarms are
? cation application is operating out of specifi- only generated / transmitted at the
° cation request of the customer.
2 Predictive Routine test, calibration or preven- Alarm and log the event. Alarms are
alarm tative mainfenance must be only generated / fransmitted at the
undertaken request of the customer.
1 [Normal Unit is operating correctly No action is required. In practice, the
J condition Category 1 alert is not displayed.

e An indicatfion of whether this error will be stored in the Error Log, and whether the error can be read and
fransmitted by SAI (the Standard Application Interface)

* A message text, representing what a viewer sees on-screen when the alarm is triggered
» A suggested response, representing actions the user should fake in response fo the alarm

The response “Call MT Service” is included for alarms which occur rarely and are severe enough fo require
service intervention.

Alerts and Alarms

[tems shown in brackets {} are variables, such as a load cell identifier. Their value is supplied dynamically by
the terminal.

Error Codes, Messages and Responses

Alarm | Category Log? SAI? Error Message Suggested Response
Code
0002 4 y y | The voltage of the ADC is foo | Call MT Service
low
0003 2 y y | Below Process Tolerance Add {0} pieces or close warning to abort

Service and Maintenance
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Alarm | Category Log? SAI? Error Message Suggested Response
Code
0025 3 y y Comparator {0} data source |Check scale communication
lost
0042 3 y y  |Implementation of interface | Cycle power, or call MT Service
{0} no registered
0058 3 y y  |Loading Alert Move load to platform center
0060 3 y y | Mainf: calibration expired Call MT Service
0064 3 y y | Mainf: metrology seal broken Call MT Service
0067 4 y y | Maint: zero failures Call MT Service
0068 4 y y | Mainf: zero commands Call MT Service
0069 5 y y  |Memory error Call MT Service
0098 3 y y | Scale Reset Failed Re-ry reset, or call MT Service
0105 4 y y | Scale seftings validation Call MT Service
error
0112 3 y y  |Symmetry errors Call MT Service
0131* 2 y y | Validation Error Call MT Service
0146 4 y y  |Zero Drift Errors Call MT Service
1001 b y y |Interface not registered: DIO |Call MT Service for replacement
and Scale interfaces
1001 4 y y  |Inferface not registered: all | Call MT Service for replacement
except DIO and Scale
interfaces
1004 4 y y  |Low battery Call MT Service for replacement
2011 ) y n | Industrial Network not Check network connection or configuration
communicating
2012 5 y y | Scale error / Scale {0} not  |Check scale connection and setfings
responding
2013* 5 y y |Scale {0}: Invalid mixture of |Check load cell types or check load cell
load cell types, or invalid serial number
load cell serial number
4043 3 n n  Zero component scale failed |Unload scales and retry
4043 3 n n Zero Failed Check scale or call MT Service
4053 3 n n |Init zero could not be Make sure scale is empty on power up
performed
4054 3 y n |Tare failed Retry tare, or call MT Service
4063* b y y  |Under Zero condition Check scale and fouch Zero key
4064 3 y y | Maint: scale overload Call MT Service
4075 2 y y | Maint: calibration expired Call MT Service
5083 5 y n | Pairing failed Check pairing or call MT Service
5084 3 y n | Scale {0} Automatic Infernal |Please inspect the connected weigh module
Calibration (FACT) Failed or call MT Service
6515 3 Y y | Symmetry error (low Call MT Service
deviation)
6515 5 y Y |Symmetry error (high Call MT Service
deviation)

* These alarm codes are subject to change.
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5 Appendices

5.1 Default Settings

The following tables indicate the default value for each configurable parameter in the IND700.

5.1.1 Scale - HSALC

IND700

HSALC Scale Settings
Parameter Default Value
Metrology
Approval| Not approved
GEO value 20
Lower temperature limit (°C)|-10
Upper temperature limit (°C) |40

Identification

Serial number

[blank: alphanumeric entry field]

Scale model

[blank: alphanumeric entry field]

Scale location

[blank: alphanumeric entry field]

Scale identification

[blank: alphanumeric entry field]

Capacity & Increments

# ranges

Single range

Primary unit

kg

Capacity 1

60

Resolution 1

0.02

Capacity 2 [if # ranges or infervals is 2]

[blank: numeric entry field]

Resolution 2[if # ranges or infervals is 2]

[blank: numeric entry field]

Capacity 3[if # ranges or intervals is 3]

[blank: numeric entry field]

Resolution 3[if # ranges or infervals is 3]

[blank: numeric entry field]

Blank over capacity (d)

5

Linearization and Calibration

Calibration

Calibration unit

kg

Linearity adjustment

Disabled

Test load 1

60

Test load 2 [if Linearity adjustment = 3]

[blank: numeric entry field]

Test load 3 [if Linearity adjustment = 4]

[blank: numeric entry field]

Test load 4 [if Linearity adjustment = 5]

[blank: numeric entry field]

Gain jumper

2 mvN

Span Adjustment

Test weight (kg)

0

Displayed weight (kg)

0

Step Calibration

Test load (kg)

60

CalFree

Cell capacity

0

Cell unit

kg

Rated cell output mV/V

3

Use zero

Calibrated

Estimated preload [If Use zero = Estimated]

0
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Parameter

Default Value

Preload unit [If Use zero = Estimated]

kg

Control Mode

[Display only]

Units

Secondary unit

kg

Host / auxiliary unit

kg

Startup unit

Primary unit

Zero

Startup zero

Use last

Power up zero -range (%)
[if Startup zero = Capture new]

0

Power up zero +range (%)
[if Startup zero = Capture new]

0

Auto zero fracking

On

Auto zero range (d)
[if Auto zero tracking = On]

0.5

Blank under zero (d)

20

Push button zero

On

Push bufton zero —range (%)
[if Push button zero = On]

Push button zero +range (%)
[if Push button zero = On]

Tare

Startup tare

Use last

Auto fare mode

Off

Auto fare threshold (kg)
[If Auto fare mode = On]

Auto tare reset threshold (kg)
[If Aufo tare mode = On]

Chain tare mode

Off

Auto clear fare

Off

Auto clear fare threshold (kg)
[If Auto clear tare = On]

Push button tare

On

Keyboard tare

On

Clear with zero

On

Filter

Low pass filter

Medium

Stability filter

Off

Stability

Motion range (d)

0.5

No motion interval (seconds)

0.3

Timeout (seconds)

3

MinWeigh

MinWeigh mode

Off

MinWeigh value (kg)
[If MinWeigh mode = on]

0

Reset

[No configurable parameters]

Maintenance

Cell counts
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5.1.2

IND700

Parameter

Default Value

Node n

[Display only]

Calibration values

Zero

0

Load 1 (k@)

60

Counts 1

6000000

Scale - POWERCELL

POWERCELL Scale Settings
Parameter Default Value
Metrology
Approval| Not approved
GEO value 20
Lower temperature limit (°C)|-10
Upper temperature limit (°C) 40

Identification

Serial number

[blank: alphanumeric entry field]

Scale model

[blank: alphanumeric entry field]

Scale location

[blank: alphanumeric entry field]

Scale identification

[blank: alphanumeric entry field]

Capacity & Increments

# ranges

Single range

Primary unit

kg

Capacity 1

60

Resolution 1

0.02

Capacity 2 [if # ranges or intervals is 2]

[blank: numeric entry field]

Resolution 2[if # ranges or intervals is 2]

[blank: numeric entry field]

Capacity 3[if # ranges or infervals is 3]

[blank: numeric entry field]

Resolution 3[if # ranges or intervals is 3]

[blank: numeric entry field]

Blank over capacity (d)

5

Linearization and Calibration

Calibration

Calibration unit

kg

Linearity adjustment

Disabled

Test load 1

60

Test load 2 [if Linearity adjustment = 3]

[blank: numeric entry field]

Test load 3 [if Linearity adjustment = 4]

[blank: numeric entry field]

Test load 4 [if Linearity adjustment = 5]

[blank: numeric entry field]

Gain jumper

2 mV/V

Span Adjustment

Test weight (kg)

0

Displayed weight (kg)

0

Step Calibration

Test load (kg)

60

CalFree

Cell capacity

0

Cell unit

Rated cell output mV/V
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Parameter

Default Value

Use zero

Calibrated

Estimated preload [If Use zero = Estimated]

0

Preload unit [If Use zero = Estimated]

kg

Control Mode

[Display only]

Units

Secondary unit

kg

Host / auxiliary unit

kg

Starfup unit

Primary unit

Zero

Startup zero

Use last

Power up zero -range (%)
[if Startup zero = Capture new]

0

Power up zero +range (%)
[if Startup zero = Capture new]

0

Auto zero tracking

On

Aufo zero range (d)
[if Auto zero tracking = On]

0.5

Blank under zero (d)

20

Push button zero

On

Push button zero —range (%)
[if Push button zero = On]

2

Push button zero +range (%)
[if Push button zero = On]

2

Tare

Startup tare

Use last

Auto tare mode

Off

Aufo tare threshold (kg)
[If Auto tare mode = On]

0

Auto tare reset threshold (kg)
[If Aufo tare mode = On]

0

Chain tare mode

Off

Auto clear tare

Off

Auto clear fare threshold (kg)
[If Aufo clear tare = On]

0

Push button fare

On

Keyboard tare

On

Clear with zero

On

Filter

Low pass filter

Medium

Stability filter

Off

Stability

Motion range (d)

0.5

No mofion interval (seconds)

0.3

Timeout (seconds)

3

MinWeigh

MinWeigh mode

off

MinWeigh value (kg)
[If MinWeigh mode = on]

0

Reset

[No configurable parameters]
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Parameter

Default Value

Maintenance

Cell counts
Node n| [Display only]
Calibration values
Zero 0
Load 1 (kg)|60
Counts 1/6000000

5.1.3 Scale - Precision

IND700

Precision Scale Settings

Parameter Default Value
Metrology
Approval|Not approved
GEO value 19
Lower temperature limit (°C)|-10
Upper temperature limit (°C) |40
Ramp [Display only]

Identification

Serial number

[blank: alphanumeric entry field]

Scale model

[blank: alphanumeric entry field]

Scale location

[blank: alphanumeric entry field]

Scale identification

[blank: alphanumeric entry field]

Capacity & Increments

# ranges

Single range

Primary unit

kg

Capacity 1

12

Resolution 1

0.002

Capacity 2 [if # ranges or infervals is 2]

[blank: numeric entry field]

Resolution 2[if # ranges or infervals is 2]

[blank: numeric entry field]

Capacity 3[if # ranges or infervals is 3]

[blank: numeric entry field]

Resolution 3[if # ranges or intervals is 3]

[blank: numeric entry field]

Blank over capacity (d)

9

Linearization and Calibration

Autoprint calibration

Autoprint calibration

On

External calibration

[No configurable parameters]

3-point lin&cal

[No configurable parameters]

5-point lin&cal

[No configurable parameters]

Span adjustment

Weight for span adjustment

12

Displayed weight for span adjustment

12

Control mode

[Display only]

Control mode

[Display only]

Units

Secondary unit [If Legacy mode = off]

None

Host / auxiliary unif [If Legacy mode = off]

None

Startup unit [If Legacy mode = off]

Primary
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5.1.4
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Parameter

Default Value

Legacy mode

Version 2

Zero

Startup zero

Capture new

Power up zero -range (%)

2

Power up zero +range (%)

18

Center of zero

off

Auto zero fracking

On

Aufo zero range (d)
[if Auto zero tracking = On]

0.5

Blank under zero (d)

20

Push button zero

On

Push button zero —range (%)
[if Push button zero = On]

Push button zero +range (%)
[if Push button zero = On]

Tare

Startup tare

Clear

Auto tare mode

On

Auto clear fare

Off

Push button tare

On

Keyboard tare

On

Filter

Vibration filter

Standard

Process filter

Universal

Stability

Stability deTec’rion\ Standard

MinWeigh

MinWeigh mode

Off

MinWeigh value (kg)
[If MinWeigh mode = on]

0

Reset

[No configurable parameters]

Diagnostics

Channels and parameters

[Display only]

Diagnostics block

Load cycle monitor

[Display only]

Overload cycle monitor

[Display only]

Shock load cycle monitor

[Display only]

Analog load cell fault detection

[Display only]

Zero deviation monitor

[Display only]

Temperature T monitor

[Display only]

Temperature gradient monifor

[Display only]

Application
Application Settings

Parameter

Default Setting

Memory

Alibi Enable

Alibi Memory fable

Enabled

IND700



Parameter Default Setting
Alibi Table
Alibi Table| [Table view]
Material table
Material Table| [Table view; editable]
Tare Table
Tare Table [Table view; editable]
Transaction Table
Transaction Table| [Table view]
ID Form

ID Form

[List view; editable]

Select Application

[List of available applications]

Disabled

Auto Start Application

[Display only]

5.1.5 Terminal

IND700

Terminal Settings

Parameter \ Default Setting
Device
Terminal ID #1 | [Blank field]
Terminal ID #2/| [Blank field]
Terminal ID #3|[Blank field]
Terminal Serial Number| [Display only]
Display

Backlight Timeout

Enabled

Backlight (minutes)

30

Screen Saver

Enabled

Screen Saver (minutes)

30

All Scale View

Enabled

Auxiliary Display

Tare Active

Transaction Counter

Transaction Counter

Disabled

Allow Counter Reset
[If Transaction Counter = Enabled]

Disabled

Next Transaction Number
[If Allow Counter Reset = Enabled]

j—

Users Table view; editable
Admin
Access Level| Administrafor
Default User| Disabled
Operator
Access Level| Operator
Default User| Enabled
Region
Language

User Language Selection

Enabled

Display Messages

English

On-Screen Keyboard

QWERTY
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Parameter

Default Setting

External Keyboard

Windows Default

Time and Datfe Format

Preview of Time and Date

[Display only]

Use 24-hour clock

Enabled

Display Seconds

Disabled

Show 2 Digit Month

Disabled

Show 2 Digit year

Disabled

Time Separator|:

Date Format

Day Month Year

Date Separator.

Set Time and D

ate

Time Zone

(UTC -05:00)

Hour : Minute

[Numeric entry fields]

Set Date

[Alphanumeric entry field]

Softkeys

Softkey Ribbon Editor

[Softkey array and Softkey row view; editable]

T

No text

Clear Messages

[No configurable parameters]

Security Options

Unified Write Filter

Enabled

Keyboard Filter

Enabled

External Mass Storage Blocking

Enabled

Enable Windows Deskfop

Disabled

Firewall

Enabled

Windows

Activate Windows Through Internet

[No configurable parameters]

Activate Windows Through Phone

[No configurable parameters]

License
License active| [Display only]
Partfial product key| [Display only]
Update Now
Target Internal File
File [Dropdown list]
Directory| [Display only]
Licensing
License Monoger\ [List view]
5.1.6 Communication
Communication Settings
Parameter Default Setting
Ethernet
MAC Address [Display only]
DHCP| Enabled
IP Address| [Numeric entry field]
[If DHCP = Disabled]
Subnet Mask [Numeric entry field]

[If DHCP = Disabled]
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5.1.7

IND700

Parameter

Default Setting

Gafeway Address
[If DHCP = Disabled]

[Numeric entry field]

Preferred DNS Server
[If DHCP = Disabled]

[Numeric entry field]

Secondary DNS Server
[If DHCP = Disabled]

[Numeric entry field]

Intefaces

Interfaces\ [List view; editable]

Connections

Connections\ [Blank list view; editable]

FTP Server
FTP Server Disabled
FTP Port| [Display only]
SFTP Server
SFTP Server Disabled
Port| [Display only]

Remote Desktop Server

Remote Desktop Server\ Disabled

Output Templates

Template 1

[Default Templafe 1 configuration; editable]

Templates 2-10

[No configuration; editable]

Input Template

Preamble Length

0

Data Length

j—

Postamble Length

0

Timeout

Enabled

Assignment

Tare

Termination Char

CR

Maintenance

Maintenance Settings

Parameter Default Setting
Configure
Enable Logs
Change Log Enabled
Maintenance Log| Disabled
Error Log Enabled
View Change Log [Log view]
View Error Log [Log view]
Run
Backup
Target for Backup| Internal File
File| [Alphanumeric entry field; default filename =
product_serial
number_year_month_day_hour_minute]
Director| [Display only] C:\Backup
Restore

Target for Restore

Internal File
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Parameter

Default Setting

File

[Dropdown list showing all available backup files]

Director

[Display only] C:\Backup

Software Update

Source

Internal File

File

[Dropdown list showing all available update files]

Director

[Display only] C:\Service

Diagnostics

Network Test

I[P Address

[Numeric entry keypad]

Ping Response

[Display only]

Touch Calibration

[Description of fest with RUN button]

Serial Port Loopback Test

Port|Mainboard (Serial Port)
Test Status| [Display only]
DIO Test
Port|Mainboard Discrete 1/0
DIO Status indicators| [Display only]
Reset
Scales| Disabled
Terminal Disabled
Application| Disabled
Communication Disabled
Maintenance Disabled
Interfaces| Disabled
Master Reset Disabled
Resef Calibration| [Avaiable if Master Resef = Enabled] Disabled
Information
Category| [Dropdown list] CountingService
List view| [Display only]

5.2 Table and Log File Structure

The IND700 terminal includes the following tables:

5.2.1

5.2.1.1
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* Alibi Table

e Material Table

e Tare Table

 Transaction Table
This chapter defails the structure of each of these.

Memory Tables

Alibi Memory

Alibi memory stores transaction information in a preset format that is not changeable. Alibi memory can be
enabled or disabled in setup at Application > Memory > Alibi Enable.

The Alibi memory stores up to 500,000 Alibi records in a battery-backed file as they occur. When this file is
full, new alibi data overwrites the oldest records in the table.
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The columns displayed in the Alibi Table vary depending on terminal configuration. Different columns will
appear depending on which application is in use.

<  Alibi Table

Y

Log Transaction Scale Gross Net Tare
ID Time Counter # Weight Weight Weii
7 06.Feb.2024 09:39:08 1 2.139 1.989 0
6 06.Feb.2024 09:38:51 1 2.140 1.990 0
5 06.Feb.2024 09:38:46 1 2.140 1.990 0
4 06.Feb.2024 09:37:09 1 2.140 1.990 0
3 06.Feb.2024 09:36:52 1 2.139 1.989 0
2 06.Feb.2024 09:36:11 1 2212 2.062 0
1 01.Feb.2024 20:12:45 1 0.000 0.000 0

Figure 539: Alibi Record Columns 1

< Alibi Table

cale Gross Net
Weight Weight

Tare
Weight

Calculated

Unit

2:139
2.140
2.140
2.140
2139
2.212
0.000

1.989
1.990
1.990
1.990
1.989
2.062
0.000

Figure 540: Alibi Record Columns 2

0.150
0.150
0.150
0.150
0.150
0.150
0.000

kg
kg
kg
kg
kg
kg
kg

Y

User
Data

Noft all columns are populated for each record. The data captured by the Alibi fable depends on the type of

operation being performed.

For details on Alibi Table searches, refer fo [Table Functions: Filter, Export, Import, Clear » Page 322]. For the

export of Alibi Table dafa, refer to [Alibi Table » Page 184].

5.2.1.2 Material Table

Correct configuration of the Material Table facilitates the use of the Applications. Depending on the currently
enabled application, different options will exist for a Record, and the record will appear in the Material Table

with its associated application listed.

The IND700 can store up to 100,000 material records.

Access the Material Table

The Material Table can be accessed in two ways:

 Access Setup > Application > memory > Material Table.

IND700
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 Touch the Material Table softkey [ from the Application Screen View.

Add New Material, No Application Selected
1. Open the Material Table
2. Touch the + icon in the header row.

3. The Add New Material screen will appear. This page includes four fields: ID, Name, Description and Tare
ID. When Valid entries have been made, fouch the confirmation check button at lower right of the screen fo
return fo the Application View screen.

<  Add New Material

ID

2

Description

Tare ID

Tare Name

Figure 541: Add New Material Screen
Add New Material Fields

ID ID is a number which simply indicates the record’s position (1, 2,...n) in the table.

Name An alphanumeric identification of the material (arficle or raw material)l This identification
is particularly useful when recalling Material records using a barcode scanner.

Description A descriptive name which will appear on the Application Screen View when the Material
Table record is loaded (if configured to display at Setup > Application > App Screen
View).

Tare ID [Optional] The numerical ID of a Tare Record associated with this item. If a valid Tare ID

is enfered here, the name of Tare name will appear af the bottom of the screen. Tare can
also be taken manually while in the Application Screen View.

Add New Material, Application Selected

When an application has been selected (in the Select Application screen), additional fields appear in the Add
New Material screen, and dots appear at the left of the screen fo indicafe that additional parameters are
available on two or three pages. Touch a dot to display the second or third page.
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<  Add New Material

ID

2

Description

Tare Name

Figure 542: Add New Material, Application Selected

The additional pages show the selected application in the screen's header:

£ Add New Material (Classification)

Lower Limit 4

[ - - -
L Classification Active
Invalid Data

Unit Lower Limit 5
g

Lower Limit 1 Lower Limit 6

Lower Limit 2 Lower Limit 7

Lower Limit 3

Figure 543: Add New Material Header Showing Selected Application

By default, the additional pages show only a slider used to activate the application for this material. Touch the
slider to activate the application, and further fields appear. In the case of an 8-category Classification configu-
ration, one more additional page appears.
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Add New Material

Lower Limit 8

Upper Limit 8

Figure 544: Add New Material - Classification, Second Page

Material Table Record Units Field

The Unit field configured in a Maferial Table record is used in the application’s calculations
(e.g. for Average Piece Weight in Counting). This unit is not affected by the Primary Unit sef
for the scale in ASM at Capacity & Increments (refer o chapter 2, Configuration, in the
IND700 Technical Manual or User's Manual). This permits the Application fo display
result appropriate for the size of the item or material — for example, grams for small items,
kilograms for large ones — using the same scale.

Add New Material Fields by Application
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Totalization APW The average piece weight of reference pieces can be included
in the Material Table record.
Note: APW can also be calculated from the Application Screen
View using the FIX 10 & and VAR 10 & softkeys.
Unit The weight unit for the APW.
Counting APW The weight, in the units defined, of a measured reference piece.
Unit The weight unit for the APW.

Fix 10 Softkey

Captures live scale weight to use as reference weight for 10
ifems.

Classification

Unit

The weight unit to be used for the classification operation.

Lower Limits 1-7

The number of fields depends on how many classes are
specified at Setup > Application > Classification.

Upper Limit The upper limit of the last defined class.
Manual Filling Target Value Target weight for Filling operation.
Unit Weight unit for Filling farget.
-Tolerance The type of value used here depends on the configuration of
+Tolerance the Filling application -- Absolute, Deviation or Percentage.
Over/Under Target Value Target weight for Over/Under operation.
Unit Weight unit for Over/Under target.
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5.2.1.3

IND700

If 3 zones selected: | -Tolerance (Under) The type of value used here depends on the configuration of
+Tolerance (Over) the Filling application -- Absolufe, Deviation or Percentage.

-Tolerance (Under)
If 5 zones selected:|-Tolerance (Low)

+Tolerance (High)
+Tolerance (Over)

When the record is correctly configured, access the first Add New Material screen and touch the confirmation
check mark.

The Material Table will display, with the new record listed and its associated application/s indicafed in the
Application column. Note that the applicatfion is indicated only for active applications. Records which show no
Application may be associated with other applications. In the example below, the Counting application is
active.

Material Table

Name Tare ID Description Application

Cookies 5 Packet

Sand 1 Bags of sand Counting

Sugar Granulated sugar

BB1 Ball bearings, 5mm Counting

Figure 545: Material Table View

Editing or Deleting a Material Table Record
Edit a Material Table Record

Access the Material Table. With the table displayed, fouch the affected record and select the Edit .« icon from
the pop-up.

< Material Table
D+ /7 v

4 Canlhine

Figure 546: Material Table Options Popup

Tare ID Description Application

Configure the record as described above. All fields, including the ID number field, can be modified.
To save the changes, touch the check mark at lower right; the Material Table will display.
Managing Material Table Records

Refer to [Table Functions: Filter, Export, Import, Clear, Table Size Limits » Page 47] for details on filtering,
exporting, importing and deleting Material Table records.

Tare Table

The Tare table in the IND700 ferminal can store 1,000 records. These records can can be recalled for use
during weighing operations, instead of manually enfering a tare value for each transaction. This recall function
is especially useful when certfain tare values are used repeatedly. When tofalization is enabled for the tare table,
each time a tfransaction is completed using an activated tare ID, the selected weight value (gross or net weight)
is added to the total and the counter increments by one.
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For details on configuring a fare record and managing the tare table, refer to [Tare Table » Page 184].

5.2.1.3.1 Quick Access to a Tare Record

Tare Records Quick Access

The Tare Table softkey [r] must be assigned fo the homescreen in configuration at [Terminal
> Softkeys » Page 212].

A Tare record can be quickly recalled for use by a user with Admin login, by enfering Setup and accessing
Application > Memory > Tare Table. Hower, a quick access method available to Operator logins is fo touch
the the Tare Table [ softkey.

The Tare Table will display; use the up and down arrows to scroll through the table, or perform a table search
(XREF) to find the desired tare record.

Tare Table Y + il

Name Description Value Unit Low Limit

Box, small Small, cardboard 0.1 kg
Box, medium Medium cardboard box 0.2 kg
Box, large Large cardboard box 0.25 kg
P Box, small Small plastic box with lid 0.18 kg

P box, large Large plastic box with lid kg

Figure 547: Tare Table View
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Touch the desired record to display its confext menu.

Tare Table \[_1” + i‘| ['1] ﬁ

Name Description Value Unit Low Limit

Box, small Small, cardboard 0.1 kg

Box, m + m / v |cardboard box 0.2 kg
Box, lari Large cardboard box 0.25 kg

P Box, small Small plastic box with lid 0.18 kg
P box, large Large plastic box with lid kg

Figure 548: Tare Record Context Menu

With the record selected, touch the OK v| icon.
The home screen will appear, with the weight in NET mode and the tare value displayed.

& @ 30,Jan_12t:):gi
M'] Max60kgd=10g

-0.406.

0.46 kg PT >0< Net
PT 0 K
Preset Tare Tare Table Switch Units | Alibi Memory | Higher Res. 1D Form Material Table

Figure 549: Home Screen, Tare Loaded

Transaction Table

The Transaction Table is accessed in Setup af Application > Memory. It can be exported to an internal file
location as a .csv or .xml file, and then copied fo a network location for storage or analysis. Refer to [Table
Functions: Filter, Export, Import, Clear » Page 322] for defails on filtering and exporting the contents of the
Transaction Table.

This table logs a number of paramefers for each weighing fransaction performed on the terminal. A transaction
occurs when the scale TRANSFER function is executed directly from the front panel [I&d or any of the available
remote means (discrete input, Industrial Network, SICS command, etc.). The Transaction Table can be
accessed from the home screen if the TRANSACTION TABLE [g] softkey is assigned in setup at [Terminal >
Softkeys » Page 212]. The REPEAT TRANSACTION .2 function does not affect the Transaction Counter.
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Columns in the Transaction Table reflect various configuration settings in the terminal -- the contents of the
[Material » Page 313] and [Tare » Page 317] Tables, the configuration and use of [ID Forms » Page 78], and
the seftings applied to the [Transaction Counter » Page 199]. A typical fransaction record might include:

Transaction Counter serial number (if enabled)

Log Time, including date and time of day

Scale # for which the transaction was recorded

Gross, Net and Tare Weights

Tare type (T or PT)

User Name associafed with the fransaction

Material ID, if any

Material Name, if any (if ProWorks Multi-Tools is licensed)

Identifiers such as Lot, Bafch number, Shiff, efc., depending on how the ID Form is configured in sefup af
Application > ID Form. Each enabled field is included as a column, with the name assigned in configu-
ration

APW, pcs, Stafus, and other parameters associafed with a running application (if ProWorks Multi-Tools is
licensed)

The following images show the complete contents of a Transaction table, scrolled to the right fo reveal
additional columns.

{ Transaction Table Y M 1
Log ” Transaction Scale Gross Net Tare
Time Counter # Weight Weight Weight
06.Feb.2024 09:39:08 1 2139 1.989 0.150
06.Feb.2024 09:38:51 1 2.140 1.990 0.150
06.Feb.2024 09:38:46 1 2.140 1.990 0.150
06.Feb.2024 09:37:09 1 2.140 1.990 0.150
06.Feb.2024 09:36:52 1 2139 1.989 0.150
06.Feb.2024 09:36:11 1 2.212 2.062 0.150
01.Feb.2024 20:12:45 1 0.000 0.000 0.000

]

Figure 550: Transaction Table 1
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< Transaction Table Yt i

Tare Preset User Material Material

Weight Tare Unit _ Name ID Name Produc
0.150 PT kg Admin 1 Aluminum scrap 22
0.150 PT kg Admin 1 Aluminum scrap 22
0.150 PT kg Admin 1 Aluminum scrap 22
0.150 PT kg Admin 1 Aluminum scrap
0.150 PT kg Admin 1 Aluminum scrap
0.150 B kg Admin 1 Aluminum scrap
0.000 kg Admin

Figure 551: Transaction Table 2

{ Transaction Table Y 1
Lot Operator Targe

Product Batch  Number  Shift ID pcs  APW __ Unit  Cont
22 43 2 1 104 Fillini
22 43 2 1 104 Fillin:
22 43 2 1 104 Filling
Fillini

Fillins

Fillini

Figure 552: Transaction Table 3
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<  Transaction Table ? LT] ﬁ

rator Target
pcs APW Unit Control Application Target Status

Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK
Filling 2.0 OK

Figure 553: Transaction Table 4

5.2.1.5 Table Functions: Filter, Export, Import, Clear

Enabled tables include a number of functions, accessed by touching an icon in the table's header row.

The Alibi Table is read-only, and its contents can be % filtered and tf1 exporfed. Alibi data cannot be imported
4, records cannot be deleted, and the fable cannot be cleared fi. Once the Alibi Table has reached its
maximum capacity, the terminal begins fo overwrite the oldest data. To avoid loss of Alibi Table data, it is
recommended that an export schedule be implemented.

The contenfs of the Material Table and Tare Table can be filtered, exported to a file, imported from a file, and
cleared. The import function permits table contents to be configured outfside the ferminal, or shared between
terminals performing the same function.

The contentsof the Transaction Table can be filtered, exported and cleared.

Exported table contents are sfored on the terminal in the C:\Export folder. Dafa to be imported must be placed
in the C:\Import folder. For details on file transfers in and out of the ferminal, refer to [File Transfer »
Page 363].

5.2.1.5.1 Filter

For an account of the filter entry methods, refer to [Data Entry » Page 42].

Because it accumulates many records, the Alibi Table has a Filter function Y which filfers the visible records
depending on up to three conditions.
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Search Condition

The Search Condition fields permit the definition of three search criteria. The three filters screens are shown
below. Note the screen indicafor dots and up/down arrows at left.

< Filter
#1
Field Operator
Log Time W4 is equal W

. First Parameter

26.Jan.2024 00:00:00

Figure 554: First Table Filter Screen

The second and third Filter screens are shown with no Field selected. Filter #2 is shown enabled but not
configured. Filter #3 is shown disabled. The other filter options -- Operator and Parameter -- are not
accessible until a Filter Field is selected.

Figure 555: Second Table Filter Screen
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4 Filter

#3

Figure 5656: Third Table Filter Screen

Field opfions are:

« None (filter not operational)

« ID

¢ Log Time

« Transaction Counter

e Scale #

e Tare Type

e Unit

The options provided by the Parameter value depend on the Field type selected. For example, if Scale # is
chosen, the Parameter field is a drop-down list of all available scales plus Sum Scale.

When a filter Field has been selected, the Operator field and a Parameter field becomes available -- two
Parameter fields, if in the range is selected as the Operator. Touch the Parameter field fo display its
associated enfry method. ([Data Entry » Page 427). The Parameter entry dialog shown below is for a numeric
parameter, in this case ID.

First Parameter

Figure 557: Example Filter Parameter Entry
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Other Field types are associated with other entry types. For example, if Log Time is selected under Field, the

Parameter field will display a calendar and Hour : Minufe input dialog.

4 February 2024

Su Mo Tu We Th

28 29 30 31 g
4 5 6 7 8
1M 12 13 14 15
18 19 20 21 22
25 26 27 28

3 4 5 6 7

Hour : Minute

0

Figure 558: Calendar Dialog for Log Time Field Parameter
Parameter options are:

e isequal

e freater

e greater or equal

* less than

e inthe range

<  Filter
#1
Field Operator
D N/ is equal
. First Parameter is equal
= 0
N reater
& ?
greater or equal
r/-_- 3
/
~ less than

Figure 559: Filter Condition Operators

Export

All tables permit the export 1 of data. The export screen requires the selection of a File Type, and the choice of

a File Name. The default form of the filename has the form [terminal]_[Year_Month_Day]_[time]_[Table
name], but this can be modified by touching the File Name field to display an alphanumeric entry screen

([Data Entry » Page 427).
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{  Table Data Export

Directory
Internal Eile v C\Export\69569416DZ
File Type
Csv XML
File Name

IND700_2024 02_09_0813_Tare

Figure 560: Table Dafa Export Screen

Touch the blue check mark |v] to confirm the export and return to the Table view screen.

5.2.1.5.3 Import

The Material and Tare fables both permit data to be imported. Data for import fo a fable must be confained in a

file of the appropriate format, either .csv or .xml. Touch the Import icon 41 to display the Table Data Import
screen.

<{  Table Data Import

Import Directory

Internal File Ny C\Import

IND700_2024 02 09 0813_Tare.csv N

Figure 561: Table Data Import Screen

Touch the blue check mark || to confirm the import. The Table view screen will appear, with the new data
displayed.

5.2.1.5.4 Clear

To manage space in the terminal's memory, it may be necessary to clear a table. Before clearing a table, it is
recommended that a table export be performed. The dafa can be stored outside the terminal. This will prevent
unwanted dafa loss.
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5.2.2

5.2.2.1

5.2.2.2

5.2.2.3

IND700

When the clear icon @ is touched, a warning displays indicating that the entire table will be cleared.

Warning

Clear Entire Table?

X v/

Figure 562: Table Clear Warning

Touch the check mark to confirm the deletion, or the X to return fo the table view.
Log Files

Scale Log Table

The Scale Log Table is accessed from the main menu under Terminal > Metrology.
For the contents of this table, refer to [Metrology » Page 45].

See also
¢ Accessing Terminal Information » Page 44
Pairing History File

The Pairing Hisfory File is accessed from the main menu, under Terminal > Metrology.
For the contents of this file, refer fo [Metrology » Page 45].

See also
& Accessing Terminal Information » Page 44

Change Log

The Change Log in the IND700 terminal file fracks all changes to shared data. The Change Log can be enabled

or disabled in setup at Maintenance > Configure/View > Change Log.

The Change Log file is a linear-type file that eventually becomes full if not reset. It will hold an estimated
30,000 records. When the file becomes 75% full, a warning message displays fo indicate the status. Another
message displays when the file is 90% full. If the file is not reset, it will continue fo store records until it is
100% full and a final 100% full message displays. Additional changes to shared data will not be recorded

until the file is reset.
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An example of Change Log view is shown below. The second image shows the same view scrolled to the right
to display more columns of information, which include current and prior values for the modified item.

{ View Change Log Y

ID Log Time ™ User Name Configure Property Nami
48 12.Feb.2024 07:40:56 Admin Sum 5 PushButtonZer
47 12.Feb.2024 07:40:50 Admin Sum 5 PushButtonZer
46 12.Feb.2024 07:40:48 Admin Sum 5 PushButtonZer
45 12.Feb.2024 07:40:41 Admin Sum 5 ' PushButtonZer
44 12.Feb.2024 07:40:22 Admin Sum 5 PushButtonZer
43 12.Feb.2024 07:40:15 Admin Sum 5 PushButtonZer
42 12.Feb.2024 07:40:13 Admin Sum 5 PushButtonZer
41 12.Feb.2024 07:40:03 Admin Sum 5 PushButtonZer
40 12.Feb.2024 07:22:17 Admin InputTemplates InputTemplate
39 12.Feb.2024 07:22:02 Admin Connections Connection Ad

Figure 563: View Change Log, 1

<{  View Change Log Y M
! Old Value p
‘oMode False 1
‘oMode True f
‘oMode False 1
‘oMode True f
‘oMode False 1
‘oMode True f

Updated MT.Singularity.Platform.InputTemplate.InputTemplateConfiguration !

ded P
ded P
ded !

Figure 564: View Change Log, 2
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< View Change Log Y

New Value

True
False
True
False
True
False
wfiguration MT.Singularity.Platform.InputTemplate.InputTemplateConfiguration
MT.Singularity.Platform.Communication.ConnectionConfiguration
MT.Singularity.Platform.Communication.ConnectionConfiguration

MT.Singularity.Platform.Communication.ConnectionConfiguration

Figure 565: View Change Log, 3

e The Maintenance Log export file, generated by the Table Data Export option t'1, is named
Terminal_YEAR_MO_HR_MIN_LogName. Example: IND700_2024_03_12_1113_ErrorLog. The log file is
exported to the terminal's C:\Exporf\Terminal Serial Number folder.

e The log file is exported to the ferminal's C:\Expori\Terminal Serial Number folder. Using the ferminal's
serial number as the sub-folder name ensures that the listed log items are associated with the specific
terminal.

» The file can be exported in either .csv or .xml format. Refer to [Table Functions: Filter, Export, Import, Clear,
Table Size Limits » Page 477 for details on table and log file exports, and [File Transfer » Page 363] for
external transfers of files.

See also
¢ Table Functions: Filter, Export, Import, Clear, Table Size Limits » Page 47

5.2.2.4 Maintenance Log

The Maintenance Log fracks service operations performed on the equipment. MT Service and Validation
Agencies or those who audit for them will use this log. This log can contain up to 32,000 records.
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A typical log view is shown below, with a second screen showing the view scrolled fo the right fo display
additional information.

View Maintenance Log + T ]'11
Log Time ™ Username Channel Cell Event Di
12.Feb.2024 06:46:04 Admin Scale2 23 M
12.Feb.2024 06:44:18 Admin Scale 23 M

Figure 566: View Maintenance Log, 1

<{ View Maintenance Log -+ Y M
1annel Cell Event Description Status
cale2 23 MAINT. CALIBRATION TEST PASSED Successful
cale’ 23 MAINT. CALIBRATION TEST PASSED Successful

. ___________________________________________________________________________|]
e
Figure 567: View Maintenance Log, 2

Overview

The maintenance log file is a ring-type file that overwrites the oldest record when is becomes full. The
maintenance log file can hold a maximum of 2500 records. The maintenance log is recorded in File-system
and won't be lost after system power-off. The used size will be checked while new log is recorded. If the used
size is more than 75%, 90% or full, hint information will be thrown to System Line of Home Screen to inform
user to do backup and clear mainfenance log.
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Maintenance Log Record
The maintenance log format shows as below.

Field Data Type Length (bytes) Description

Date and Time u32 7 Year/Month/Day/Hour/Minute/Second
Username String 13 User Sfring Name

Event Code us 1 Event code

Status String 8 Log String status

Operation

When Event identified by Event Code happens, a record is added info Maintenance Log. The Maintenance Event

Code, Event and related possible status are illustrated in the following table.

Event Code Event Description Status (String)
1 Calibration test failed. 1-n=failed at step n
2 Zero calibration performed. FAILURE, SUCCESS, Motion
3 Span calibration performed. FAILURE, SUCCESS, Motion
4 CalFree calibration performed. FAILURE, SUCCESS
8 Log file exported via FTP. MAINT, CHANGE, TACT (Action), ALIBI
9 Setup file exported - .dmt files exported via SUCCESS
FTP.
10 Metrology switch / electronic seal broken. SUCCESS
11 Calibration Expired. "1"=days
15 Added option component Manual text entry
16 Removed option component Manual text entry
17 Replaced component Manual text entry
18 Maintenance Log initialized. SUCCESS
\When Maintenance Log is Enabled,
Maintenance Log is Reset in Menu, this event
will be added.
Note: If Master Reset or Factory Reset is
detected while terminal is powered up, system
fry to add this event, but default maintenance
Log xr0103 is disabled, this event is not
added successfully.
19 Calibration values manually edifed. SUCCESS
21 Set date or time. SUCCESS
22 Table exported. tare, target, cont, caltiw1, calfest]
23 Calibration test passed. SUCCESS
28 Successful zero command SUCCESS
55 Step calibration performed. SUCCESS, FAILURE
56 1-Point Test failed. 1-n = failed at step n
57 1-Point Test expired. "1"= Days
58 1-Point Test passed. SUCCESS
59 Walk Test failed. 1-n = failed af step n
60 Walk Test expired. "1" = Days
61 Walk Test passed. SUCCESS
62 Custom Named Event Test failed. 1-n = failed at step n
63 Custom Named Event Test expired. "1" = Days
64 Custom Named Event Test passed. SUCCESS
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Event ID 15, 16, 17 are added manually. Other Events are added automatically when the Events are triggered
by Operation described in Event Description.

« The Maintenance Log export file, generated by the Table Data Export option rt1, is named
Terminal_YEAR_MO_HR_MIN_LogName. Example: IND700_2024_03_12_1113_ErrorLog. The log file is
exported fo the terminal's C:\Expori\Terminal Serial Number folder.

e The log file is exported to the terminal's C:\Expori\Terminal Serial Number folder. Using the ferminal's
serial number as the sub-folder name ensures that the listed log ifems are associated with the specific
terminal.

 The file can be exported in either .csv or .xml format. Refer to [Table Functions: Filter, Export, Import, Clear,
Table Size Limits » Page 477 for details on table and log file exports, and [File Transfer » Page 363] for
external fransfers of files.

See also
¢ Table Functions: Filter, Export, Import, Clear, Table Size Limits » Page 47
& File Transfer » Page 363

5.2.2.5 Error Log

The Error Log contains a list of all events and alarms that the ferminal has generated. Customers or technicians
can use this log fo trace operations, events and alarms fo aid froubleshooting. This log can confain up to
32,000 records.

A typical Error Log view is shown below. For further information about significant events which might be
recorded here, refer to [Alarm Codes and Messages » Page 299].

< View Error Log Y M
ID Log Time Username Severity Error Code Scale
5 09.Feb.2024 09:19:23 Admin £ A50001
4 08.Feb.2024 07:51:42 Admin C A50001
3 08.Feb.2024 06:57:38 Admin C A50001
2 18.Jan.2024 10:38:58 Admin C A70008
1 18.Jan.2024 10:36:02 Admin C A70008

Figure 568: Error Log View 1
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<{  View Error Log Y M

r Code Scale Message Message (English) Detail
1001 No error occurred

1001 No error occurred

1001 No error occurred

1008 Scale 7 not responding.

1008 Scale 7 not responding.

Figure 569: Error Log View 2

« The Maintenance Log export file, generated by the Table Data Export option rt1, is named
Terminal_YEAR_MO_HR_MIN_LogName. Example: IND700_2024_03_12_1113_ErrorLog. The log file is
exported fo the terminal's C:\Exporf\Terminal Serial Number folder.

* The log file is exported to the ferminal's C:\Expori\Terminal Serial Number folder. Using the ferminal's
serial number as the sub-folder name ensures that the listed log ifems are associated with the specific
terminal.

 The file can be exported in either .csv or .xml format. Refer to [Table Functions: Filter, Export, Import, Clear,
Table Size Limits » Page 477 for details on table and log file exports, and [File Transfer » Page 363] for
external fransfers of files.

See also
¢ Table Functions: Filter, Export, Import, Clear, Table Size Limits » Page 47

Communications

This section is infended as a reference concerning only the structure and sefup of communication protocols
supported by the IND700 terminal.

Incorrect wiring of the communication circuits
The IND700 terminal or interface board can be damaged.
— Wire the communication circuits exactly as shown in Installation.

Serial Interface Parameters

The IND700 main PCB includes one standard 9-pin serial port connector, COM1. This standard port supports
RS232, RS422 and RS485 communications, and includes a +5V output and an isolated ground.

An additional serial port is available if a Precision scale interface is installed in the ferminal. This 7-pin port is
labeled COMXx. It supports RS232, RS422 and RS485 communications, but does not include the +5V output
and ground pins.

For installation information concerning the optional COMx port, refer fo the IND700 Accessories Installation
Guide, 30753892,
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Character framing is programmable in the setup mode -- refer to [Configuration > Communication Setup >
Interfaces » Page 228] for details on selecting these parameters. Framing can be:
e 1 start bit

e 7 or 8 ASCII data bits (selectable)

e 0 or 1 parity bit (none, even, or odd)

e 1 stop bit

The baud rate can be configured from 4800 to 115.2K baud.

The IND700 ferminal uses software handshaking fo confrol data flow commonly referred to as XON/XOFF
handshaking. When a receiving device is getting information from an IND700 ferminal and cannof receive any
more in its buffer, it sends an ASCIl XOFF (13h) telling the IND700 terminal fo temporarily stop sending data
until its buffer clears.

When the device can receive more data, it sends an ASCII XON (11h) telling the terminal fo begin sending data
again. This process can occur as often as required by a receiving device.

The XON/XOFF method is the only type of handshaking supported by the IND700.
The terminal supports demand and confinuous output modes.

See also
& Configuration » Page 80
& Communication Setup » Page 226

Demand Output Mode

The demand oufput mode fransmits data only when the IND700 terminal receives a prinf request. Print requests
are sent to the ferminal when:

 The operafor presses the TRANSFER [ER butfon or the REPEAT TRANSACTION softkey [£1.

» A discrete input selected as print is triggered.

e An ASCIl “P” is sent through a command input port.

e An Industrial Network command to print is received.

e The “Print” command shared data is triggered.

When triggered, data is fransmitted in a string programmed in the templafe editing portion of setup.

Demand mode is used typically when sending data to a prinfer or PC on a fransactional basis.

Output Templates

The IND700 provides ten fully customizable templates fo define a custom string of dafa to be transmitted. A
template is used with a demand mode connection. In the sefup of the ferminal, a template is tied fo an output
connection so that when that connection is triggered, the selected template and ifs current contents will be
fransmitted.

Template 1 is the Automatic Standard Template. Details about its operation can be found in the Operation
section ([Automatic Standard (Output) Template » Page 52]) and in this section, below ([Automatic Standard
Template » Page 3367).

Each template can store up to 1,000 bytes of dafa. There is no warning if a femplate overflows this limit until
the template is saved. At this time, any information over the 1,000-byte limit will be lost. The InSite program
does track the size of the template as it is being built and provides an appropriate warning if the limit is
exceeded.

The table that follows defines how the 1,000 byfes are calculated.

Print Field Space Used

IND700 Data Field 8 characters

Special Character 4 characters + code (2 or 3 characters depending on the character)
String Field String length + quantity (1 or 2)

Justify a Field 2 characters + justify letter (L, R, C) + space limit (1, 2, or 3 characters)
Zero Fill a Field 2 characters + Z + space limit (1, 2 or 3 characters)

Repeat Character 5 characters + number (1, 2 or 3 digits for number of fimes repeated)
Line end <CR><LF> |7 characters

IND700



IND700

The default Output Template 1 appears as shown below:

{ Template 1

Element

Type Data

v + 0 1 O

Alignment

# Chars

1

O |00 | Ny NN

o

Date:
xd0103

String
SD Var
CR/LF
Time:

xd0104

String
SD Var
CR/LF
String User:
SD Var xd0171
CR/LF -

String Material ID:

Left 6

Exact

Left

Exact

Left

Exact

Left

Figure 570: Output Template 1, Default Configuration

Quantity I
1

1

Rows in a femplate can be dragged and dropped using a finger on the screen, to re-order the display of data.
In the image below, Row 8 is being dragged.

{ Template 1

Element

Type Data

v + 0 th

Alignment # Chars

Quantity

1

Date:
xd0103

String
SD Var
CR/LF
String Time:
SD Var xd0104
CR/LF -

User:

String
xd0171

Exact
CR/LF -

String Scale:

Left 6

Exact

Left

Exact

Left

1

1

Figure 571: Template 1, Re-Ordering Rows

As a general rule, the most efficient and least time-consuming way to create templates is to fake advantage of
the [Aufomatic Default Template » Page 336] feature. This method does not require access to a list of Shared
Data Variables, as the system provides the correct values.

For additional information on configuring templates, refer to [Output Templates » Page 239].
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5.3.2.1 Automatic Standard Template

The IND700 features an AST (Automatic Standard Templatfe) function which simplifies the preparation of
templates customized for particular uses and applications. Shared Data variables representing all available
information (which adds columns to the [Transaction Table » Page 185]) are automatically added to Output
Template 1.

To create multiple Output Templates with different automatically-generated content, make the necessary
changes fo the terminal configuration, then access Setup > Communication > Output Templates > Template
1. Here, all the currently configured Transaction Table fields are automaticaly represented as rows in the table
(refer fo the five-screen example shown above).

Select the Copy icon @ at top left . From the Copy Template dialog, click the To dropdown list and select the
desired femplate.

<  Copy Template

From

1

Figure 572: Copy Template Dialog
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Click the Run icon P at lower left fo execute the copy, then use the left arrow at fop left twice to return fo the
Output Templates menu view. Template 2 is now shown as configured.

R @ 03.Aug.121u:§§

Setup > Communication > Output Templates

Scales Ethernet Template 1
Application Interfaces Template 2
Terminal Connections

Communication Output Templates

Maintenance Input Template

Figure 573: Output Templates Menu View, Template 2 Configured

This customized template -- in this case, Output Template 2 -- can now be used to determine the content and
format of the output from a Connection. Multiple connections can be configured and use for different appli-
cations using other output femplates.

4 Edit Connection

Port Ethernet Connection
Ethernet Server
Ethernet Port
Ethernst 1701
Assignment
Transfer
Trigger
Active Scale

Template

Template 2

Figure 574: Connection Configuration Screen Showing Templatae 2 Selected
Template 1 will continue to reflect changes made to the configuration of the weight display. These can then
copied fo another femplate.

Remember that templates can be Exported ™1 and Importedth, so that they can be kept safely outside the
IND700, and restored fo the same ferminal or shared with other ferminals. This option makes it very easy fo
standardize output data across multiple terminals.
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5.3.3.1
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To access these options in an Output template, click the ellipsis =< in the menu bar.

o @ B+
#I'_l"l I'l'l Quantity

1

Figure 575: Output Templates Menu Bar, Import and Export Icons Displayed

See also
¢ Transaction Table » Page 185

Continuous Output Mode

The continuous output mode of the IND700can be used to continuously send weight data and scale status
information to a remote device such as a PC or a remote display.

Standard Continuous Output

Continuous mode can be assigned to COM1, COM2, COM3, COM4, COM5, COMG or Eprint. Checksum can be
enabled or disabled on any of these ports with continuous output. A data siring will be output approximately 20
times per second for baud rates above 4800 baud. A specific output rate can be set through a Shared Data
write to field csO121 (refer to the IND700 Shared Data Reference).

The format is fixed, except for baud rate, parity, data flow (XON/XOFF), and inferface type. The data consists of
17 or 18 byfes.

Non-significant weight data and tare dafa digits are fransmitfed as spaces. The contfinuous output mode
provides compatibility with METTLER TOLEDO products that require real-time weight data.

The fable that follows shows continuous format output.

Status2 Indicated Weight3 Tare Weight4
Character |1 |2 3 4 5 6 7 8 9 |10 11|12 |13 14 |15 |16 |17 18
Data STX|SWA |SswB SwC MSD - |- |- |- |LSDMS - |- |- |- |LSDCR CH
1 D 5 |K6

Notes on Continuous Output Format
e ASCII Start of Text character (02 hex), always fransmitted.
« Status words.

Status Word A Bit Definitions
Bits 2, 1, and 0

2 1 0 Decimal Point Location
0 0 0 XXXXX00
0 0 1 XXXXXO0
0 1 0 XXXXXX
0 1 1 XXXXX. X
1 0 0 XXXX. XX
1 0 1 XXX XXX
1 1 0 XX XXXX
1 1 1 X XXXXX
Bits 4 and 3

4 3 Build Code
0 1 X1
1 0 X2
1 1 X5

Bit 5 Always =1

Bit 6 Always =0
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Status Word B Bit Definitions

Status Bits Function
Bit O Gross =0, Net =1
Bit 1 Sign, Positive = 0, Negative = 1
Bit 2 Out of Range = 1 (Over capacity or Under Zero)
Bit 3 Motion = 1, Stable = 0
Bit 4 Ib =0, kg = 1 (see also Status Byte 3, bits 0-2)
Bit b Always =1
Bit 6 Zero Not Captured = 1

Status Word C Bit Definitions

Weight Description

Bits 2, 1, and 0 -

Ib or kg, selected by Status Byte B, bit 4

grams (g)

mefric tons ()

ounces (0z)

troy ounces (ozt)

penny weight (dwt)

tons (ton)

— | = == O/O0OO0O/O|N

custom units

Bit 3 Print Request = 1

Bit 4 Expand Dafa x 10 = 1, Normal = 0

Bit 5 Always =1

Bit 6 Always = 0

5.3.3.2 Continuous Template Output

If continuous template is selected as the assignment for a connection, a custom string of dafa can be
configured using one of the five available templates. When a continuous template output is selected, the output
rate depends on the size of the template and the baud rate selected. The rate varies from approximately once
per second up to approximately 20 fimes per second.

The table that follows shows the estimated output rafes of a 160-byte femplate.

Continuous Template Output Rate

Baud Rate Outputs / Second Baud Rate Outputs / Second
4800 8 38400 14
9600 10 57600 16
19200 12 115200 18

The template can include any combination of elements (IND700 Field Codes, ASCII characters, or print strings).

Note that the output rate may be adversely affected by transmitting a large template or selecting a slow baud
rafe.

The femplate is configured as explained at [Configuration > Communication Setup > Output Templafes »
Page 239], and this template has the same size restrictions as described above in the Output Templates
section of Demand Output Mode.
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CTPZ

The CTPZ input mode provides a method for a remote serial device fo trigger several basic functions when a
control character is sent to the IND700. Remote ASCII control characters and the terminal responses include:
e (G — Clears the scale to gross mode

¢ T-—Tares the scale (causes a pushbutton tare)

e P —Initiates a print command

e/ —Zeros the scale

All other characters are ignored. ASCII control characters can be sent in upper- or lower-case.

Example: Initiate A Pushbutton Tare

1 Program the terminal for CTPZ input for a specific port.

2 Program the serial port parameters to matfch the other device.
3 Send the ASCII character “T”.

= A pushbutton tare is initiafed.

Standard Interface Command Set (SICS) Protocol

The IND700 terminal supports the METTLER TOLEDO Standard Inferface Command Set (MT-SICS), which is
divided info four levels (O, 1, 2, 3), depending on the functionality of the device. The IND700 terminal supports
parts of levels 0 and 1:

e MT-SICS level O — Command set for the simplest device

e MT-SICS level 1 — Extension of the command set for standard devices

A feature of this concept is that the commands combined in MT-SICS level O and 1 are identical for all devices.
Both the simplest weighing device and a fully expanded weighing workstation recognize the commands of MT-
SICS levels O and 1.

SICS communication is enabled by configuring the Assignment of a [connection » Page 233] as SICS.

Data Interface Configuration

Interface settings such as baud rate, number of data bits, parity, handshake protocols and connector pin
assignments are described in [Configuration > Communication Setup > Interfaces » Page 228].

Version Number of the MT-SICS

Each level of the MT-SICS has ifs own version number, which can be requested with the command |1 from level
0. The IND700 supports:
e MT-SICS level O, version 2.2x (except the ZI command)

e MT-SICS level 1, version 2.2x (except the D, DW and K commands)

Command Formats
Each command received by the scale via the data interface is acknowledged by a response of the device fo the
fransmitter. Commands and responses are data sirings with a fixed format.

Commands sent to the IND700 terminal comprise one or more characters of the ASCII character set.
Commands are enfered only in uppercase.

* The parameters of the command must be separafed from one another and from the command name by a
space (ASCII 32 dec., in the examples shown in this section, a space is represented as _ ).

e Each command must be terminafed by CR LF (ASCII 13 dec., 10 dec.).

The characters CR and LF, which can be inpufted using the ENTER or RETURN key of most eniry keypads, are
not listed in this description. However, they are essential to be included for communication with the terminal.

Example
Command fo tare the terminal: “TA_20.00_Ib" (The command terminator CR LF is not shown.)

Response Formats

All responses sent by the IND700 terminal to the fransmitter to acknowledge the received commands have one
of the following formats:

e Response with weight value
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* Response without weight value
e Error message

Format of the Response with Weight Value

ID Status Weight Value unit C, L
\ 1
1-2 1 10 1-3
characters character characters characters

Figure 576: Format of response with weight value

* |ID — Response identification
e __ —Space (ASCIl 32 dec.)
» Status — Status of the IND700 terminal. See description of the commands and responses.

« \Weight Value — Weighing result, which is shown as a number with 10 digits, including sign directly in front

of the first digit. The weight value appears right justified. Preceding zeroes are suppressed with the

exception of the zero to the left of the decimal point.
e Unit — Weight unit displayed.
e CR - Carriage Refurn (ASCII 13 dec.)
e LF - Line Feed (ASCII 10 dec.)
Example

Response with a stable weight value of 0.266 kg: S _S_ _ _ _ _ _ 0.256 _ kg
Format of the Response without Weight Value
ID Status Parameters C, L,
|
1-4 |
characters character

Figure 577: Format of response without weight value

* |D — Response identification

e _ —Space (ASCII 32 dec.)

o Status — Status of the IND700 terminal. See description of the commands and responses.
e Parameters — Command-dependent response code

e CR - Carriage Refurn (ASCII 13 dec.)

e LF - Line Feed (ASCII 10 dec.)
Format of Error Messages

D C, L
Figure 578: Format of error message
e |D — Error Identification

There are four different error messages. The identification always comprises two characters.

- ES — Syntax error
The ferminal has not recognized the received command.

— ET — Transmission error
The scale has received a “faulty” command, such as a parity error.

— EL - Logical error
The command is understood, the parameter is wrong.

— Internal Error
The command is understood but cannot be executed at this time.

e CR - Carriage return (ASCII 13 dec.)
e LF - Line Feed (ASCII 10 dec.)

Tips for the Programmer

This section contains tips for using the SICS protocol in the IND700 terminal.
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Command and Response

The dependability of application software can be improved by having the program evaluate the response of the
terminal to a command. The response is the acknowledgment that the terminal has received the command.
Reset

When establishing communication between the IND700 terminal and system, a reset command can be sent to
the ferminal to enable a start from a defermined state. When the ferminal or system is switched on or off, faulty
characters can be received or sent.

Quotation Marks (“ )

Quotation marks included in the command responses are used fo designate fields and will always be sent.

Commands & Responses MT-SICS Level 0

The IND700 terminal receives a command from the system computer and acknowledges the command with an
appropriate response. This section contains a detailed description of the command set in alphabetical order
with the associated responses. Commands and responses are closed with CR and LF. These termination
characters are not shown in the following description, but they must always be entered with commands or sent
with responses.

The commands of MT-SICS level O are available with even the simplest devices, which support the METTLER
TOLEDO Standard Interface Command Set. The commands are listed as follows:

¢ 10 Inquiry of all implemented MT-SICS commands
e T Inquiry of MT-SICS level and MT-SICS versions
¢ 12 Inquiry of balance data

I3 Inquiry of balance SW version and type definition number
e |4 Inquiry of serial number

e S Send stable weight value

¢ Sl Send weight value immediately

* SIR Send weight value immediately and repeat

e ZZero

e /I Zero immediately

* @ Reset (clear out serial buffer)

10 — INQUIRY OF ALL IMPLEMENTED MT-SICS COMMANDS
Command: 10 — Inquiry of all implemented MT-SICS commands

Response

0B 0O “I0” Level O “I0” command imple- [0BO " Level O “IT” command imple-
mented menfed

I0BO“12” Level O “12” command imple- [0BO“13” Level O “13” command imple-
mented menfed

0B O “14” Level O “14” command imple- [0BO"S Level 0 “S” command imple-
mented menfed

0B O "SI Level O “SI” command imple- 0B O “SIR” Level O “ SIR” command imple-
mented mented

[0BO“Z" Level 0 “Z” command imple- [0BO"@" Level O “@" command imple-
mented menfed

0B 1 "SR’ Level 1 “SR” command imple- 0B 1T Level T “T” command imple-
mented menfed

0B 1TA” Level 1 “TA” command imple- 0B 1 “TAC" Level 1 “TAC” command imple-
mented mented

0B 1Tl Level 1 “TI” command imple-
mented

Error Response 10 | - Cannot execute command at this time.
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1T — INQUIRY OF MT-SICS LEVEL AND MT-SICS VERSIONS
Command: T — Inquiry of MT-SICS level and MT-SICS versions

Response: 11 A _“" “2.2x" “2.2x" “= 4=
No Levels fully implemented

2.2x Level O, version V

2.2x Level 1, version V2.2x

No MT-SICS 2 commands

No MT-SICS 3 commands

Error Response 11 _ | — Command understood, not executable at present.
Comments

* Inthe case of the MT-SICS level, only fully implemented levels are listed. In this case, neither level O nor
level 1 were fully implemented so the level is not specified.

 In the case of the MT-SICS version, all levels are specified even those only partially implemented.

12 — INQUIRY OF DATA
Command: 12 — Inquiry of data.
Response: | 2 _ A _ “IND700 _ Standard _50.00 kg”

Response: | 2 _ A _ “IND700 _ 700Fill _50.00 kg”
e [IND700 - Model number of terminal

e Standard - Basic model with no special application software

e 70OFill - Sent when an IND700-Fill is queried

* 50.00 kg - Capacity and primary unit of the base connected fo the IND700

e Error Response 12 _ | — Command understood, not executable at present.

Comments

The number of characters of “text” depends on the application software and scale capacity.

I3 — INQUIRY OF SW VERSION AND TYPE DEFINITION NUMBER
Command I3: Inquiry of SW version number(s) and type definition number.
Response: I3 _ A _“200.11"

e 2.00.11 — Firmware version of the IND700

e Error Response 13 _ | — Command understood, not executable at present.
Comment

The number of characters of “text” depends on the revision and device type.

14 — INQUIRY OF SERIAL NUMBER

Command: 14 — Inquiry of serial number.

Response: 14 _ A _ “text”

e Serial number as “text” (content of shared dafa xsO105 in IND700 terminal)

» Error Response 14 _ | — Command understood, not executable at present.

Example

Command: | 4 — Inquiry of serial number

Response: | 4 _ A _"123456-6GG"

Comments

The serial number response is the content of the ferminal serial number as entered in the setup.

S — SEND STABLE WEIGHT VALUE

Command: S — Send the current stable net weight.
Response:

e S _S_ WeightValue _ Unit — Current stable weight value.
e S _ | —Weight value is in the current displayed units.

* S_+—IND700 in overload range.

e S_-—IND700 in underload range.
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Example

Command: S — Send a stable weight value.

Response: S _ S 100.00 _ kg. — The current, stable weight value is 100.00 kg.
Comments

The terminal will wait for up fo 3 seconds after receiving an “S” command for no-mofion. If motion does not
settle within this time, the command is aborted.

S| — SEND WEIGHT VALUE IMMEDIATELY

Command: SI — Send the current nef weight value regardless of scale stability.

Response:

e S _S_ WeightValue _ Unit — Stable weight value.

¢ S _ D _ WeightValue _ Unit — Non-stable (dynamic) weight value.

e S _|-The command is understood, cannot execute the received command at this time (scale currently
executing another command, such as tare).

¢ S _+—IND700 in overload range.

e S _--IND700 in underload range.

Example

Command: SI — Send current weight value.

Response: S _ D 129.07 _ kg — The current weight value is unstable (dynamic) and is 129.07kg.
Comments

* The response to the command Sl is the last internal weight value (stable or dynamic) before receipt of the
command SI.

* Weight value is in the current displayed units.

SIR — SEND WEIGHT VALUE IMMEDIATELY AND REPEAT
Command: SIR — Send the net weight values repeatedly, regardless of scale stability.

Response:
e S _S_ WeightValue _ Unit — Stable weight value.

¢ S _ D _ WeightValue _ Unit — Non-stable (dynamic) weight value.

¢ S _|-The command is understood, cannot execute the received command at this time (IND700 ferminal
is executing another command, such as fare).

e S_+—IND700 in overload range.
e S _-—-IND700 in underload range.

Example

Command: SIR — Send current weight values at intervals.

Response:

e S_D_____ 129.07 _kg

e S_D_____ 129.08 _kg

e S_D_____ 129.09 _ kg

e S_D_____ 129.09 _kg

« S_D_____ 114.87 _kg

e ...—The scale sends stable or non-stable weight values at intervals.
Comments

* SIR is overwritten and cancelled by the commands S, S, SR, and @.

e The number of weight values per second depends on the scale type and will vary from approximately 6
(older IDNet bases) to approximately 50 (SICSpro bases).

« Weight value is in the current displayed units.

Z - ZERO
Command: Z — Zero the scale.
Response:

e/ _ A—The following then holds:
Scale is in gross mode
Zero sefting performed, (stability criterion and zero seffing range complied with).
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Z _ 1 - The command is understood, cannot execute the received command af this fime (IND700 ferminal is

currently executing another command, such as tare, or timeout as stability was not reached.)
Z _ + — Upper limit of zero sefting range exceeded.
Z _ - — Lower limit of zero setfing range exceeded.

Example

Command: Z — Zero.

Response: Z _ A — Zero setting performed.
Comments

If enabled in setup a tare value will be cleared during zero setting.

The zero point defermined during swifching on is not influenced by this command (the measurement ranges

remain unchanged).
The duration of the timeout is approximately one second.

ZI - ZERO IMMEDIATELY

Commmand:

Z| - Zero the scale irrespective of stability
Response:

Z|_D Zero setting performed under dynamic conditions
ZI_S Zero sefting performed under stable conditions
Z_| Command undersfood but nof executiable

Z_+ Upper limit of zero setting range exceeded

Z_- Lower limif of zero sefting range exceeded

Example

Command: ZI Zero immediately

Response: ZI_S Zero setting performed, scale was stable
Comments

Tare memory is cleared during zero setting

The zero point defermined during switching on is not influenced by this command. i.e. the measurement
ranges remain unchanged

@ — RESET

Command: @ — Reset the scale to the condition found affer switching on, but without a zero setting being
performed.

Response: | 4 _ A _ “text” — Serial number of the scale, the scale is ready for operation.
Example

Command: @

Response: 14 _ A _“123456-6GG" — The IND700 terminal is reset and sends the serial number.
Comments

All commands awaiting responses are canceled.
The “reset” command is always executed.

A reset command received by the IND700 ferminal during the calibration and test procedure cannot be
processed.

Commands & Responses MT-SICS Level 1

The following commands of MT-SICS level 1 are available:

D - Write to Terminal Display

DW - Display Standard Weight Display

K — Keyboard Monitoring

SR — Send weight value on weight change (Send and Repeart)
TA — Set tare value

TAC — Clear fare value

Tl — Tare Immediately
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D - WRITE TO TERMINAL DISPLAY

Command:

D D_"text” (" “ are required for proper command execution)

D “” (clears previously fransmitted text from the Data line)

Responses:

e D_A - Text appears unabridged, left-aligned in Data line just above the softkeys

¢ D_R-The end of the fext appears in Data line. The start of the text is cut off and marked by the symbol “*”.

e D_I-Command is understood but cannot be executed at this time.(the IND700 ferminal is currently
executing another command, such as tare, or timeout as stability was not reached.)

¢ D_L - Command understood, parameter wrong.

Example

Command: D_"HELLO”

Response: D_ A — “HELLO” appears in the Data line.

Note:The maximum number of characters of "text" visible in the Data line is 30. Above 30 characters,
beginning characters in the siring will be dropped represented with a “*”.
DW - DISPLAY STANDARD WEIGHT DISPLAY

Command: DW — Returns display fo previous seftings/status.
Responses:

« DW_A — Display showing previous settings/status.

¢ DW_I - Command understood, parameter wrong.

K - KEYBOARD MONITORING

Commands

e K_1 When a key is pressed, execute the corresponding function buf do not send the corresponding key
code

e K_2 When a key is pressed, do not execute the corresponding function and do not send the corresponding
key code

e K_3 When a key is pressed, do not execute the corresponding function but send the corresponding key
code

e K_4 When a key is pressed, execute the corresponding function and send the corresponding function code.

If the corresponding function cannot be executed immediately, the function code K_B_y for the start of the
function and K_A_y or K_|_y for the end of the function are sent

This behavior applies to taring, zeroing, calibrating, testing, transferring, etc.
If a function cannot be executed, the function code K_|_y is sent
Responses

e K_A Command executed successfully

¢ K_I Command understood but not executable

¢ K_L Command understood buf not executable, wrong or missing parameter
Example for K_3 mode

Command K_3: Disable keyboard

K_A: K_3 mode enabled

K_C_2: Zero key pressed

K_C_4: Transfer key pressed

SR — SEND WEIGHT VALUE ON WEIGHT CHANGE (SEND AND REPEAT)
Command: SR

e SR _ PresetValue _ Unit — Send the current stable weight value and then confinuously after every weight
change greater or equal to the preset value a non-stable (dynamic) value followed by the next stable value,
range = 1d fo maximum load.

e SR —If no presef value is entered, the weight change must be af least 12.5% of the last stable weight value,
minimum = 30d.
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Response:
e S _S_ WeightValue _ Unit — Current, stable weight value. Weight change.

e S_ D _ WeightValue _ Unit — Non-stable weight value.
° S _S_ WeightValue _ Unit — Next stable weight value.

e S _|-The command is understood, the received command cannot be executed at this time (the IND700
terminal is currently executing another command, such as tare, or timeout as stability was not reached.)

e S _L-Command understood, parameter wrong.
* S_+—IND700 in overload range.
e S _-—-IND700 in underload range.

Example

Command: SR _ 0.50 _ kg — Send the current stable weight value followed by every load change > 0.50 kg.
Response:

e S_S_____ 100.00 _ kg — Scale stable.

e S_D_____ 115.23 _ kg — More than 0.50 kg loaded.

e S_S_____ 200.00 _ kg — Scale again stable.

Comments

* SR is overwritten and cancelled by the commands S, SI, SIR, @ and hardware break.

* If, following a non-stable (dynamic) weight value, stability has not been reached within the fimeout interval,
the response “S _ 1 ” is sent and then a non-stable weight value. Timeout then starts again from the
beginning.

e The preset value must be enfered in the first unit that is the weight unit displayed after the IND700 terminal
is swifched on.

T - TARE

Command: T — Tare a stable weight value

Response:
e T_S_WeightValue_Unit — Taring performed. Stability criferion and taring range comply with seftings.

Current Tare weight value in current units is returned.
e T_1-Taring not performed (scale is executing another command, zero setting, or stability timeout
reached.)

e T_+— Upper limit of taring range exceeded.
e T_-— Lower limit of faring range exceeded.
Example
Command: T
Response: T _S
Comments

e The new tfare weight value overwrites fare memory.

» The duration of the fimeout depends on the scale type and its seftings. If motion does not seftle within this
time, the command is aborted.

e Clearing tare value: See command TAC

TA — INQUIRE/ENTER TARE VALUE

Command:

e TA - Inquiry of tare weight value

e TA _Tare Preset Value _ Unit — Entry of a fare value.

Response:
e TA_A_TareWeightValue _ Unit — Current Tare weight value.

e« TA_1-The command is understood, the received command cannot be executed af this time (the IND700
terminal is currently executing another command, such as zero seffing).

e TA_L-Command understood, parameter wrong.

Example

Command: TA _ 10.00 _ kg — Load a preset fare of 10 kg.

Response: TA_A 10.00_k g — The IND700 accepts the 10.00 kg tare value.

100.00_kg — The IND700 accepts a tare value of 100.00 kg.
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Comments

« The existing tare will be overwritten by the preset tare weight value.

e The IND700 terminal will automatically round the inputted fare value to the current readability.
e The preset value must be entered in the current units.

TAC — CLEAR TARE VALUE
Command: TAC - Clear fare value.

Response:
e TAC _ A - Tare value cleared.

e TAC _ | —The command is undersfood, the received command cannot be executed at this time (the IND700
terminal is currently executing another command, such as zero setting, or timeout as stability was not
reached).

Tl — TARE IMMEDIATELY

Command: Tl — Tare immediafely, (store the current weight value, which can be stable or nonstable (dynamic),
as fare weight value).

Response:
e TI1_S _ WeightValue _ Unit — Taring performed, stable tare value.
e TI1_D _ WeightValue _ Unit — Taring performed, non-stable (dynamic) fare value.

e TI_1-The command is understood, the received command cannot be execufed at this time (the IND700
terminal is currently executing another command, such as zero setting.)

e TI1_L-The command is understood, the parameter is wrong.
e T1_+ - Upper limit of taring range exceeded.

e T1_-—Lower limit of faring range exceeded.

Example

Command: Tl — Tare.

Response: T1_D
Comments

« Any previous tare value will be overwritten by the new fare weight value.

e Even during a non-stable (dynamic) condition, a tare weight value can be determined. However, the tare
value defermined in this manner may not be accurate.

« The stored fare weight value is sent in the current units.

117.57 _ kg — The fare memory holds a non-stable (dynamic) weight value.

Commands & Responses MT-SICS Level 2

The following commands of MT-SICS level 2 are available:
e PRN — Initiate a prinfout/transfer

e R - Switch keyboard on or off

e SIH - Send net weight value in high resolution immediately

¢ SIRU — Send weight value with currently-displayed unit immediately, and repeat

e SIS — Inquiry of the current net information with the currently-displayed unit and with status information
¢ SIU - Send weight value with currently-displayed weight immediately

e SRU - Send weight value with currently-displayed unit on weight channel (send and repear)
¢ ST — Send stable weight value after pressing transfer key

e SU - Send stable weight value with currently-displayed unit

e SV — Send stable net weight value

e SVI—Send net weight value immediafely

¢ SVIR — Send net weight value immediately and repeat

e SWU — Switch display unit

¢ SX - Send stable weight data

e SXI - Send weight dafa immediately

¢ U - Switch units
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PRN - INITIATE A PRINTOUT/TRANSFER

Command: PRN

Responses:

*  PRN_A: Command executed successfully

e PRN_I: Command undersfood but not executable

Example

Command: PRN: Initiate printout/transfer

Response: PRN_A: Command executed successfully

Comments

e A printer must be correctly connected to an inferface, or a transfer destination defined in setup
» The printout can be configured in the Communication menu

e The PRN command has the same effect as the TRANSFER key 11

R - SWITCH KEYPAD ON OR OFF

Command: R

e RO — Swifch on IND700 keypad.

e RT - Switch off IND700 keypad.

Responses:

* RO _ A - Keypad enabled

* RT _A- Keypad disabled

Example

Command: R1 — Disable ferminal keypad and keyboard.
Response: R1 _ A — Keypad and keyboard disabled.
Comments

e By default and affer power-up the keypad is always enabled
* When the keypad is disabled, the terminal cannot be manually operated

SIH — SEND NET WEIGHT VALUE IN HIGH RESOLUTION IMMEDIATELY

Command: SIH

Responses:

e H_S_Weight value_unit: Stable nef weight in high-resolution and in the unit currently set as Unit 1
e H_D_Weight value_unit: Dynamic net weight in high-resolution and in the unit currently set as Unit 1
e H_I: Command undersfood but notf executable

e H_+: Scale in overload range

e H_-: Scale in underload raange

Example

Command: SIH

Respond: H_.S__ 1.99982_ kg -- current net weight in high resolution is 1.99982 kg and stable
Comments

 Like SI command

* High resolution dafa i.e. highest possible resolution of the connected scale

SIRU — SEND WEIGHT VALUE WITH CURRENTLY-DISPLAYED UNIT IMMEDIATELY, AND REPEAT

Command: SIRU - like the [SIR command » Page 342], but send the weight value immediately with the
currently displayed unit, and repeat

Responses:

e S_S_Weight value_Unit: Current stable weigth in currently-displayed unit

e S_D_Weight value_Unit: Dynamic (unstable) weight in currently-displayed unit
e S_I: Command understood but not executable

e S_+: Scale in overload range

e S_-: Scale in underload range
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SIS — INQUIRY OF THE CURRENT NET INFORMATION WITH THE CURRENTLY-DISPLAYED UNIT AND

WITH STATUS INFORMATION
Command: SIS
Responses:
e SIS_A_Status_"Value"_Unit_Dec_Step_App_Info
Status - refer fo table below
Value - net weight value
Unit - refer to table below
Dec - number of decimal places
Step - Display step
App - refer to table below
Info - refer to fable below
¢ S_I: Command understood but not executable

Status Information

0 |= | Stable weight value

1 = Dynamic weight value

2 = |Stable value below MinWeigh

3 |= | Dynamic value below MinWeigh

4 |= |Overload

5 = |Underload

6 = |Emor, invalid

Unit Information

0 = g
1 = kg
2 = t
7 = Ib
8 = 0z
9 = Ib-0z

Approval State Information

0 = |Nof approved
1 = Approved, e=d
2 = Approved, e=10d

Weight Information

Without fare

Net with weighed tare

Net with preset tare

Example
Command: SIS

not approved, without fare

SIU — SEND WEIGHT VALUE WITH CURRENTLY-DISPLAYED WEIGHT IMMEDIATELY
Command: SIU

Responses:

e S_S_Weight value_Unit: Current stable weight value in the currently-displayed unit

¢ S_D_Weight value_Unit: Dynamic (unstable) weight value in the currently-displayed unit
e S_I: Command understood butf not executable

e S_+: Scale in overload range
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e S_-: Scale in underload range

Example

Command: SIU

Response: S_.D__ 129.07_IborS_S 129.11_Ib-- The scale sends stable or unstable weight conti-
nously in the currently-displayed unit

SRU — SEND WEIGHT VALUE WITH CURRENTLY-DISPLAYED UNIT ON WEIGHT CHANNEL (SEND AND
REPEAT)

Inquiry Command: SRU_Preset value_Unit

Responses:

e S_S_Weight value_Unit: Current stable weight in the unit currently set as Unit 1
-- weight change --

S_D_Weight value_Unit: Dynamic (unstable) weight in the unit currently set as Unit 1
-- sfable --

S_S_Weight value_Unit: Next stable weight in the unit currently set for Unit 1

e S_I: Command understood but not executable

e S_L: Command understood but not executable, wrong or missing parameter

e S_+: Scale in overload range

e S_-: Scale in underload range

ST — SEND STABLE WEIGHT VALUE AFTER PRESSING TRANSFER KEY
Inquiry Command: ST

Responses:

e STAX

x = | Function inactive; do not send weight value when transfer key is pressed

0

x = | Function active until restart of the scale or the restart command is sent; weight will be sent when transfer
1 key is pressed

x = |Function permanently active, even after device is restarted; weight will be sent when fransfer key is

2 pressed

e ST_I: Command understood but not executable

Setting Command: ST_X, where x is as for response above
Response: ST_A -- Command executed successfully
Example

Command: ST_T -- Activate ST function

Response:
e ST_A -- ST function activated

-- Transfer key pressed --
e S S 123.456_g -- current net weight is 123.456 ¢
Comments
e ST_0 is the default seffing (function inactive)
» The duration of the fimeout depends on the scale type

SU — SEND STABLE WEIGHT VALUE WITH CURRENTLY-DISPLAYED UNIT

Command: SU -- like the [S command » Page 342], but send the current stable weight value with the
currently-displayed uniit

Responses:

e S_S_Weight value_Unit: Current stable weight value in currently-displayed unit
e S_I: Command understood but not executable

e S_+: Scale in overload range

e S_-: Scale in underload range

Example

Command: SU
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Response: S_S 100.00_g -- the current stable weight value is 100.00 g

Comment
 The duration of the fimeout depends on the scale type

SV — SEND STABLE NET WEIGHT VALUE
Command: SV
Responses:

e SV_Weight value_Unit___HR value, where Weight value = net weight value, HR value = High resolution
net weight value

e SV_I: Command undersfood but not executable

e SV_+: Scale in overload range

e SV_-: Scale in underload range

Example

Commannd: SV

Response: SV 1.995_kg 1.9972 -- stable net weight is 1.995 kg, stable high resolution
weight is 1.9972 kgh

SVI — SEND NET WEIGHT VALUE IMMEDIATELY

Command: SVl

Responses:
e SV_Weight value_Unit___HR Value -- stable weight

e SVD_Weight value_Unit_D_HR value -- dynamic (unstable) weight
D: D if weight value dynamic, blank if stable
Weight value: Net weight value
HR value: High resolution net weight value

e SV_I: Command understood but not execufable

¢ SV_+: Scale in overload range

e SV_-: Scale in underload range

SVIR — SEND NET WEIGHT VALUE IMMEDIATELY AND REPEAT
Command: SVIR

Responses:
e SV__Weight value_Unit___HR Value

e SVD_Weight value_Unit_D_HR Value
D: D if dynamic weight, blank if stable
Weight value: Nef weight value
HR value: High resolution net weight value
e SV_I: Command understood but not execufable
e SV_+: Scale in overload range
e SV_-: Scale in underload range
Example
Command: SVIR
Response: SVD____ 0.826_kg___ D___ 0.8263
Respons: SV 0.876_kg 0.8764
Comment
e SVIR is overwritten, and hence cancelled, by all send commands and hardware breaks

SWU — SWITCH DISPLAY UNIT

Command: SWU -- switch to next display unit
Responses:

¢ SWU_A: Command executed successfully

e SWU_I: Command understood but not execufable
Comments
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The available units depend on
» The setting of unit 1, Unit 2 and Unit roll (On/Off)
e The approval status of the scale

SX - SEND STABLE WEIGHT DATA
Command: SX — Send the current stable weighing data.
Responses:

o SX_S_x1_y__x2_y__x3_y- Stable weight data where x1 = G _ GrossWeight, x2 = N _
NetWeight, x3 = T _ TareWeight, y = WeightUnits.

e SX _ - Command not performed (scale is executing another command, zero setting, or stability fimeout
reached).

e SX _ + —Scale in overload range. SX _ - — Scale in underload range.

Example

Command: SX — Send stable weight data.

Response: SX_S_G 15620 _kg _ _ _N______
kg_ — The current, stable gross, net and tare weight data is sent.

Comments

» The duration of the fimeout depends on the scale type and its seftings. If motion does not seftle within this
time, the command is aborted.

* The weight values are in the current displayed units.

SXI - SEND WEIGHT DATA IMMEDIATELY
Command: SXI — Send the current weighing data immediately regardless of scale stability.
Responses:

o SX_S_xI_y__x2_y__x3_y-_Current stable weight data where X1 = G _ GrossWeight, x2 = N _
NetWeight, x3 = T _ TareWeight, y = WeightUnits.

e SX_D_x1_y__x2_y__x3_y-_Current unstable weight data where x1 = G _ GrossWeight, x2 = N
_ NetWeight, x3 = T _ TareWeight, y = WeightUnits.

e SX_I—Command not performed (scale is executing another command).
e SX_ +—Scale in overload range.

e SX_ - —Scale in underload range.

Example

Command: SXI — Send the current weighing dafa immediately.

Responses:

e SX_S_G______ 22220 _kg___N______ 22220 _kg _ _ _T__ ________ 0_kg_-
The current, stable gross, net and tare weight data is sent.

e SX_D_G______ 2520 _ton__N______ 2520 _ton_ _T______ 0.000_ton —The
current, unstable dynamic gross, net and tare weight data is sent.

Comments

e The response to the command SXI is the last internal weight value (stable or dynamic) before receipt of the
command SXI.

» Weight value is in the current displayed units.

U - SWITCH UNITS

Command:

U Switch fo main primary units

e U_Unit Switch fo specified units

Responses

e U _A-Units switched

e U _I-Command not performed (incorrect units specified)

Comments

 Units switching is limited to the current seftings for the primary and secondary units
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Commands & Responses MT-SICS Level 3

The following commands of MT-SICS level 3 are available:
* AMR - Readout Alibi data

e AR - Read Shared Data file
e AW - Write Shared Data file
¢ DY - Specify SmarTrac target value
[11 - Inquiry of model designation
e |14 - Inquiry/setting of ID3
« SNS - Inquiry/setting of the active scale
e STA — Preset tare weight value in the defined unit
e UPD - Update rate of host inferface

AMR - READOUT OF ALIBIT MEMORY DATA
Command: AMR_OPT

OPT definitions:

All Send all Alibi data

First Send the first (oldest) Alibi record

Last Send the last (newest) Alibi record

ID_x Send Alibi record number x

ID_x_y Send Alibi records numbers x fo y
DT_DD/MM/YYY Send alibi records from date DD/MM/YYY
SEP_x Define data separator (factory setting: “;*)
Responses:

¢ AMR_A Command executed successfully
e AMR_I: Command understood but not executable

AR — READ SHARED DATA FIELD

Command: AR _ SDName — Read a specific shared data field.

Responses:

¢ AR _ A _ SDValue — Shared data field value returned (Content format is dependent on the shared data field
fype)

¢ AR _ | - Command not performed (invalid shared data field)

Example

Command: AR _wt0101 — Read displayed gross weight for scale 1.

Response: AR _A _ " _ 12.180" — The displayed gross weight value is returned.

Command: AR _ wx0131 — Read scale 1 motion status.

Response: AR _ A _ 0 — Scale 1 motion status returned.

Comments
« SDName is the shared data field name with a length of six A/N characters.

 String type SDValue fields returned are surrounded by quofe marks
« Array type SDValue fields are returned as a series of values separafed by spaces
¢ Composite variables of the entire shared data block are not supported.

AW - WRITE SHARED DATA FIELD
Command: AW_SDName_SDValue - write to a specific shared data field

Responses:
e AW _ A — Written successfully to shared data field.

e AW _ | - Invalid shared data field.
e AW _ L — Shared data field cannot be wriften.
Example
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Command: AW _ wcO0101 _ T — Pushbutton fare for scale 1.

Response: AW _ A —Scale 1 pushbutton tared.

Command: AW _aw0101 _ “HELLO” — Write the fext HELLO fo message table ID 1.
Response: AW _ A — HELLO is wriften into the message table ID 1.

Comments

e SDName is the shared data field name with a length of six A/N characters.

e String type SDValue fields have to be surrounded by quote marks.

 Array type SDValue fields have fo be formatted as a series of values separated by spaces.
e Composite variables of the entire shared data block are not supported.

» Only operator and supervisor level access SDName fields can be writfen fo.

DY - SPECIFY SMARTRAC TARGET VALUE

e DY _ TargetWeight _ Unit _ LowTol _ Unit _ HighTol _ Unit — Specify the active target and tolerance values
in weight units.

e DY _ TargetWeight _ Unit _ Tol _ % — Specify the active farget and percentage tolerance values.
o DY - Clear the active target and tolerance values fo zero.

Responses:

e DY _ A—Target and folerance values are set.

e DY _I-Command not performed (specified units are not valid).

Example

Command: DY _ 150 _Ib _12 _Ib _ 10 _Ib— Set target = 160 Ib, low tolerance = 12 Ib and high tolerance
=10 Ib.

Response: DY _ A — Target and tolerance values are sef for the scale.

Command: DY _ 100 _kg _ 10 _ % — Set target = 100 kg and low / high tolerance =10 % of farget.
Response: DY _ A — Target and folerance values are set for the scale.

Comments:

= \Weight units can only be specified in the primary or secondary units for the scale. Tolerance weight units
must match the farget weight units.

* % folerance can be entered provided it is enabled in SETUP as the appropriate target folerance type.
 Target and tolerance entries must match displayed increment sizes.

111 - INQUIRY MODEL DESIGNATION

Command: 1T Inquiry of model designation of the weighing ferminal
Responses:

o |T1_A_"fext” Text represents the model designation

* 111_I The model designation cannot be transferred at present as another operation is faking place.
Example

Command: 11

Response:IT0_A_“IND700"

Comments

» The scale can display the device name

* The device name has a max. length of 40 characters

» The device name cannot be changed

114 - INQUIRY/SETTING OF IDENTIFICATION ID3
Command: 114 Inquiry of Identification 3

Response: I14_A_"text” Text specified Identification 3
Sefting

Command: [14_"text” Set the fext for ID3

Responses:

e |T4_A: Identification 3 has been set
 I|dentification 3 cannot be set af present

e |dentification 3 is too long, or wrong parameter
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Comments
e The scale can display, transfer and print the identifications.
« Up to 40 characters can be entered

SNS - INQUIRY/SETTING OF THE ACTIVE SCALE
Inquiry Command: SNS

Inquiry Responses:

¢ SNS_x: x = active scale

¢ SNS_I: Command understood but not executable

Setting Command: SNS_x
e SNS_x: Sefs x as the active scale

Setting Responses
e SNS_A: Command executed successfully

e SNS_I: Command understood but not executable
¢ SNS_L_Command understood but not executable - wrong or missing parameter

STA - PRESET TARE WEIGHT VALUE IN THE DEFINED UNIT

Command

e STA_Weigh value_Unit: Presets a fare value in the defined unit

Responses:

o STA-A_Weight_value_Unit: Current tare weight value in the unit currently set under Unit 1
e STA_L: Command understood but not executable; reemote scale active or average weighing inactive
e STA_I: Comman undersfood but nof executable

Example

Command: STA_100.00_g -- sets a tare value of 100.00 grams

Response: STA_A____100.00_g -- the scale has 100.00g in the fare memory
Comments

« The tare memory will be overwritten by the preset tare weight

e The input tare value will be aufomatically rounded by the scale to its current readability
« If no unit is entered, the currently displayed unit will be used

 The taring range is specific fo the scale type

UPD - UPDATE RATE OF HOST INTERFACE

Command: UPD Query the host interface update rate

UPDD_<rate> Set the update rate

¢ UPD_A_<rate> Current host update rate

e UPD_I Command understood but not currently execufable (balance is currently executing another
command)

e UPD_L Command undersfood but not executable (incorrect parameter, etc.)

Remote Discrete 1/0 (ARM100)

The IND700 provides the ability fo expand its discrete input and output control options to include up to eight
ARM100 devices. This ability is required when more inputs and outputs are needed than are natively supported
by the IND700 mainboard and option boards. Depending on the application, it may be beneficial to have all
the 1/0 external to the terminal.

The communication link from the IND700 terminal to an ARM100 remote discrefe I/O module is an RTU-based
RS-485 communication protocol. During power-up, if remofe discrete I/0 has been enabled communication
will be established between the IND700 and the remote modules. Any communication errors will be indicated
in the message box on the IND700 home screen.

This communication uses both the input and output portions of the port, so it cannot be shared with any other
connections. When "Remofe Discrete 1/0" is selected as the assignment for COM1 or COMX, the communication
parameters are set automatically by the ferminal and cannot be changed from the front panel - they can only be
viewed.

The parameters include:

e Baud Rafe: 115200
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e Data bits: 8

e Parity: Even

e Stop bits: 1

e Flow Control: None
e Interface: RS-485

After the ARM100 modules are wired per the defails in the ARM100 Installation Guide and the assignment is
programmed af Communication > Connections, the remote modules will be operational. When assigning
functions fo the remote discrete I/0 locations, the remote modules are addressed by 1.0.x for module #1, 2.0.x
for module #2, and so on. Each module provides four inputs and six dry-contact relay outputs.

For defails on ARM100 configuration in the IND700, refer to [ARM100 Inferface Configuration » Page 231].

Example
Tare assigned to discrete 1/0 input addresses 1.0.1.
This indicates that when input #1 is furned on in the remote module #1, a tare will be taken.

ASCII Input

A bar code scanner or other ASCII device can be connected to a port in the IND700, and used as an input
device to enter ASCII data, using an ASCII Input connection type. When this input type is selected, the
assignment for the data received must also be specified at Communication > Templates > Input. Available
assignments include:

* IDI

* Keypad

e Tare

e TarelD

e Target ID

e Filling Material ID for Filling & Drum Filling
e Active Target.

As part of the programming for using the ASCII input, an input femplate must be configured. The template
feature permits removal of a preamble (preceeding characters) and a postamble (irailing characters) that are
not part of the desired data. Using these parameters in the setup of the input template, the number of characters
to be ignored before and affer the data are programmed. These must be the same for each data input string that
the IND700 receives.

An inpuf will be terminated after the receipt of the programmable “Termination Character” or a 1 second timeout
of no new characters received. At this fime, any input data that has been collected will be applied to the
assignment that has been selected. This could be an actual value such as a preset tare value or a response for
IDs, or it could initiate a look-up into the tare or target table by selecting Tare ID or Target ID.

The following notes apply fo how the ASCII input is handled through the input template:

» The Preamble Length selects how many characters should be skipped at the beginning of an input string
before the desired dafa.

» Data Length defines the maximum length of a string. All characters beginning affer the Preamble through the
Length selection will be used as the input.

e The Postamble length is the number of characters (before the Termination Character) that will be stripped off
the dafa stfring. All other dafa from the Preamble Length to the Termination Character minus the Postamble
Length will be used as the inpuf string. When using an input that is always the same fixed length, this field
would remain blank.

» The Termination Character is used to signal the end of the string input. It can be any ASCII control character.
If “None” is selected, the timeout feature will terminate the entry.

e Thereis also a 1 second fimeout feature that fracks the amount of time between characters. If this 1 second
time is exceeded, the string will also be considered terminafed.

Example
Preamble of 2, Data length of 5, Postamble of O, Termination Character of <CR>, Input assignment of Tare.
Data received is: <STX>P001.5 kg<CR>

The preamble of 2 removes the <STX> and P characters. The next 5 characters of 001.5 are the actual data.
The postamble is set to O because the data field has already been filled so no characters have fo be removed.
The <CR> ferminates the input.
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This string would input 1.5 as a preset fare fo the IND700.

This same data could be obtained by programming a Preamble of 2, Data length of 8, Postamble of 3, Termi-
nation Character of <CR>. The Postamble length of 3 would remove the <space>kg from the data field since
they are the last 3 characters received in front of the <CR>.

Shared Data Access

All sefup paramefers, friggers and statuses in the IND700 are stored and routed through Shared Data variables.
This is a system of memory mapping that permits remote clients to send commands and receive dafa from the
terminal. In order to access the shared data variables in the IND700, a remote client must login to the Shared
Data Server. Access is provided through either the COM1 serial port or through the Ethernet port. Regardless of
the method used, the same access is provided and the login procedure is very similar. Up to 25 Shared Data
Server logins are supporfed by the IND700 -- a single connection using a serial interface, and multiple
connections using a TCP/IP Ethernet inferface .

Note that the Shared Data server does not support serial RS485 or USB connectivity.

Server connections are configured in setup at [Communication Sefup > Connections » Page 233], by selecting
SharedData as the connection's Assignment.

Shared Data Name Structure

Each SD variable includes a class, an instance and an affribute, and uses the following structure:

e Class: Example -- wt (dynamic scale weight)

e Instance: Example -- 01 (scale #1)

« Afiribute: Example -- 02 (Displayed Net Weight)

Mulfiple instances are indicated by dashes in place of the instance number -- for example, wt--02.

Shared Data Types
SD variables may take any of the following forms (where nn indicates the length of an array):

Shared Data Types

Label Data Type Description

B Boolean Boolean fields are one-byte
integers, buf can only have values
of Oorl

By Byte One-byte integer

us Unsigned Short Two-byte unsigned integer (double)

uL Unsigned Long Four-byte unsigned infeger (word)

F Float Single-precision floating point

D Double Double-precision floating point

ABy nn1 Array of Bytes Array of one-byte integers

ABI nn1 Array of Booleans Array of one-byte integers used asa
Boolean

S mm2 String A Unicode String, NULL terminated.
Array of two-byte unsigned integers
(doubles)

AL nn1 Array of Longs Array of four-byte unsigned integers
(words)

Struct Structure Composite structure of the entire
block (multiple data types together)

For further detail on Shared Data variables and structures, refer to the IND700 Shared Data Reference,

30753890.

Commonly Used Shared Data Variables

This section lists Shared Data Variables most commonly used with the IND700 in its base configuration. For a
lisit of additional,. application-specific variables, refer to the IND700 ProWorks Multi-Tools User's Manual

(30753893).
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Share Data Variables in On-Screen Display

The Tare Table image below and the following fable illustrate the relationship between data in the terminal and

the corresponding Shared Data Variables.

1 2

Tare Table

3

Description

Unit Low Limit

Small blue

Hopper 2

Sugar container

Flour container

kg
kg

Water vessel 3
Within range tare
CB0O1

Figure 579: Data in Tare Table

kg
kg

Small cardboard box kg

Example of Tare Table Elements Represented by Shared Data

Shared Data Name Shared Data Variable
1 Tare ID ws0027
2 Tare name ws0028
3 Tare description ws0029

Terminal Identification Shared Data
Terminal Identification Shared Data

xs0105 Terminal Serial Number
xs0106 Terminal ID1

xs0107 Terminal ID2

xs0108 Terminal ID3
xd0103 Current Date

xd0104 Time of Day

xs0103 Software ID

xp0101 Transaction counter
Scales Shared Data

wi0101 Gross weight, Scale 1
wi0102 Net weight, Scale 1
wt0103 Display Unit, Scale 1
ws0102 Tare value, Scale 1
wi0201 Gross weight, Scale 2
wit0202 Net weight, Scale 2
wi0203

Display Unit, Scale 2
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ws0202 Tare value, Scale 2
wi0501 Gross weight, Sum Scale
wi0502 Net weight, Sum Scale
wi0503 Display Unit, sum Scale

ID Form Shared Data

When ID Form fields are configured, Shared Data variables are available both for the configuration of fields, and

for information added fo the fields.

ID Form

Name Status

Numeric Only

Preserve Prev. Value

Disabled
Enabled

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Lot Enabled
Enabled
Enabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Vendor
Order

Ident D
Ident E
Ident F
Ident G
Ident H
Ident1
Ident |

Figure 580: ID Form Configured with Three Data Fields

Enabled

Enabled

Enabled

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Each ID Form prompt has a Shared Data Variable associated with it:

prO131 Lott

pr0132 Vendor

pr0133 Order

prO134 ID Form 04 prompt
prO135 ID Form 05 prompt
pr0136 ID Form 06 prompt
prO137 ID Form O7 prompt
prO138 ID Form 08 prompt
pr0139 ID Form 09 prompt
prO14- ID Form 10 prompt
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When the ID Form is configured as shown above, fouching the ID from softkey [ will display all enabled fields.

ID Form

Lot

MAT-0OIL-7222

Vendor

3

Order

OR-2023-0921

Figure 581: ID Form, Three Fields Enabled

Information entered into the ID Form
Each field of information has a Shared Data Variable associated with it:

pa010T MAT-OIL-7222

pa0101 3

pa0103 OR-2023-0921

pa0102 ID Form 04 response

pa0105 ID Form 05 response

pa0106 ID Form 06 response

pa0107 ID Form O7 response

pa0108 ID Form 08 response

pa0109 ID Form 09 response

pa0110 ID Form 10 response

DIO Shared Data

I/0 Pins Mainboard Scale 1 Scale 2
Input 1 dio001 dio101 di0201
Input 2 dio002 dio102 di0202
Output 1 di0005 di0105 di0205
Output 2 dio006 di0106 di0206
Ethernet

The IND700 Ethernet port provides a 1000 Base-T connection for connection fo an Ethernet network. The

Ethernet port can be used for the following functions:
e Shared data access (described previously)

* Demand output
e Continuous output
e FTP

e Sending calibrafion alert emails

e \Web Server access
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Ethernet communication is configured in sefup af [Communication > Ethernet » Page 227].

Ethernet Connection to A PC

The IND700 Ethernet port provides a way to interface a PC to the IND700 to download and upload files and
configuration information. To use the Ethernet port to transfer templates or Shared Data, a properly configured
[Connection » Page 233] is necessary.

Ethernet Demand Output

If a demand output connection to Ethernet is made in the connections section of setup, a remote device may
“register” to receive the data through the Ethernet port. In order to do this, the remofe device must login fo the
shared data server and send the command to register for the data. The login can be any valid username and
password for the terminal.

When a user logs into the shared data server, he or she acquires the level of access for the username and
password used. All levels of users can receive a demand string.

If a demand output connection to EPrint is made in the Connections section of sefup, a remote device is not
required fo “register” with the Shared Data Server to receive the data through the Ethernet port. The data string
simply contains the assigned femplate’s information. The EPrint connection is made via the secondary TCP/IP
port at the user-defined port number (set up af Communication>Network>Port).

Register for the Demand Output

The “printout” command allows the client to define a Demand Print Stream as a callback field. The Demand
Print Streams include demand print (triggered by the scale) and custom triggers (friggers 1, 2, and 3). The
console print server sends a message fo the client at each print output. Since print messages can span multiple
message blocks (depending upon size), the start of the print message has a <dprint> tag and the end of the
message has a </dprint > tag. After registering for the demand output, the client will receive the appropriafe
data stream. The “ctimer” command specifies the minimum time between repeafed callback messages. The
“xprinfout” command removes the registration from the terminal and the communication will stop.

The “xgroup all” command will also terminate any demand output registrations.
Sequence Example 1

1 Enfer the menu free of setup.

2 In the Connections sub-branch of the Communications branch of setup, create a connection for Demand
Output assignment to the Ethernet port triggered by Scale using Template 2.

3 Ensure that the IP and Gateway addresses are programmed properly.
Login to the shared dafa server from the client, (see “user” command in the Shared Data Server section).
5 Register to receive the demand data by enfering the “printout 1” command.

= The IND700 will acknowledge the registrafion with a message [00Gxxx~number PRINTOUT
streams=1]. Now, whenever a demand print is generated, the Template 2 data will be senf to the client.
00P004 <dprint>Scale 1
01:33:10
06/Sep/2005
17.08 Ib
17.08 b T
0.00Ib N
</dprint>

The “xprintout” command allows the client to remove the print oufput callback registration thus stopping the
demand output.

o~

Sequence Example 2

1 Enfer the menu free of setup.

2 In the Connections sub-branch of the Communications branch of setup, create a connection for Demand
Output assignment to the Ethernet port triggered by Trigger 1 using Template 1.

3 Ensure that the IP and Gateway addresses are programmed properly.
4 Login to the shared data server from the client, (see “user” command in the Shared Data Server section).
5 Register to receive the demand dafa by enfering the “printout 1“ command.
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= The IND700 will acknowledge the registration with a message [00Gxxx~number PRINTOUT
streams=1]. Now, whenever the custom trigger is initiated (by a programmed discrete input or Industrial
Network command), the Template 1 data will be sent to the client.
00P004 <dprint> 17.08 Ib
17.081b T
0.00Ib N
</dprint>

The “xprintout” command allows the client to remove the print oufput callback registration thus stopping the
demand output.

Ethernet Continuous Output

If a confinuous outpuf type of connection fo Eprint is made in the connections section of setup, a remote device
is not required “register” with the Shared Data server, to receive dafa through the Ethernet port. The dafa string
simply contains the assigned continuous output or template information. The Eprint connection is made via the
secondary TCP/IP port at the user-defined secondary port number (configured in setup at Communication >
Network > Port).

If a continuous output or continuous template output connection to Ethernet is made in the connections section
of setup, a remote device may “register” fo receive the data through the Ethernet port. In order fo do this, the
remofe device must login fo the shared data server and send the command fo “register” for the data. The login
can be any valid username and password for the terminal.

When a user logs onfo the shared dafa server, they acquire the level of access for the username and password
used. All levels of users can receive a confinuous string.

Register for the Continuous Output

The “contout” command allows the clientf to define the confinuous output string as a callback field. The Console
Print Server sends a message to the client at each confinuous output. The continuous oufput message is either
in the Standard METTLER TOLEDO Confinuous Output format or in a confinuous femplate format. The “ctimer”
command specifies the minimum time between repeated callback messages. The “xcontout” command
removes the registration from the terminal and the communication will stop.

The “xgroup all” command will also terminafe any continuous output registrations.
Sequence Example

1 Enfer the menu free of setup.

2 In the Connections sub-branch of the Communications branch of setup, creafe a connection for Confinuous
Output assignment to the Ethernet port triggered by Scale.

3 Ensure that the IP and Gateway addresses are programmed properly.
4 Login to the shared data server from the client, (see “user” command in the Shared Data Server section).
5 Register to receive the confinuous data by entering the “contout” command.

= The IND700 will acknowledge the registration with a message [00Gxxx~number CONTOUT streams=1].
NQW, whenever a confinuous outpuf siring is generated by the IND700, the data will be sent to the
500148 141364 236
800149 141354 236
SOC]SO 141354 236
800151 141354 236

The “xconfout” command allows the client to remove the continuous oufput callback registration thus stopping
the continuous output.

The output rate of a Confinuous type output over Ethernet is 20Hz by default. This rate cannot be modified
through the terminal setup menu. However, the output rafe can be modified by a Shared Data write fo a field in
the “cs” block of Shared Data. Please refer to the IND700 Shared Dafa Reference for specifics.

File Transfer

The IND700 can transfer files using a PC tool such as VNC, or an FTP (file transfer protocol) client. The VNC
method simplifies the process, because the VNC's File Transfer function permits the user to browse to the
appropriate folder on the IND700 and select the required file/s from a list.
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FTP Method

To access files in the IND700 via ftp, the client must login to the FTP server. Valid usernames and passwords
are entered as configured in setup at [Terminal > Users » Page 199], and each username is assigned an
access level. All access levels can read files but only maintenance and administrator levels can write new files
to the ferminal. Refer fo [Terminal > Security Opfions » Page 215] to enable the FTP or sFTP server ports.

« fget (Shared Datfa server) or get (FTP) — All files can be read using this command.
« fput (Shared Data server) or put (FTP) — Only certain files can be downloaded back to the IND700 terminal.

VNC Method

VNC or an equivalent tool must be installed on a PC accessible to the IND700, and Remote Desktop Servet
enabled in the terminal in sefup at [Terminal > Security Options » Page 215].

With the terminal connected, click the file fransfer icon in the VNC fool menu bar, indicated in the image below:

{  Table Data Export

Figure 582: VNC File Transfer Icon

When the file transfer icon is clicked, the transfer screen will display, with the local PC's contents displayed on
the left, the ferminal's on the right. In the image below, the folder containing the exported files has been
accessed, but the PC contents appear in their default state.

B File Transfer with < win-muupihfgden ( 192.168.86.213 ) - application mode > - UltraVNC - O x
~ LOCAL MACHINE V. [C:] - Local Disk w | REMOTE MACHINE \
C:\Export\53569416DFY
Mame Size Medified Name Size Modified
g C] Local Disk IUVNCDIR-69569416D2Z .2zip 862 bytes 02/09/2024 11:17
[ Desktop ] 4r.1 Folder
L[ My Documents IND7O0_2024_02_09_08L.. 184bytes  02/09/2024 11:14
[ Network Favorites ] IND700_2024_02_09_081... 184bytes  02/09/2024 11:17
e [] Metwork IND700_2024 _02_15_071... 115bytes 02/15/2024 10:14
g [] Metwark
ww[7:] Metwork SEril 22
=< Receive
Delete -=
Mew Folder -=
Rename -
!
Minimize
Close

Forced Close = 5 File(s)Folder (s}

History > 02f15/24 10:26:43 - Connected... i

Progress

Connected...

Figure 583: VNC File Transfer Screen

Browse to an appropriate location on the host PC, and click the <<Receive button af center.
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5.3.10.1
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Exported File Names and Paths
The following list indicates the path for exportable files.

 File Names: All fable file names have the form IND700_YYYY_MM_DD_HHMM. The content type is added at
the end of this sfandard name.

« The contents of each exported file may include the entire set of table records, or a [filtered » Page 47] sub-
set.

e Exported files can be formatted either as comma-separated values (.csv) or XML (.xml)

File Name File Path File Content
_Alibi.csv or xml C:\Exporf\[Terminal Serial Records from [Alibi Table » Page 184]
Number]

_Maferial.csv or xml Records from Material Table (refer to the ProWorks

Multi-Tools User's Manual for details)
_Tare.csv or xml Records from the [Tare Table » Page 184]
_Transaction.csv or xml Records from the [Transaction Table » Page 185]
_Changelog Records from the [Change Log » Page 265]
_ErrorLog Records from the [Error Log » Page 267]
IND700_[Terminal Serial  C:\Backup A [backup » Page 269] of the ferminal's configu-
Number]_YYY_MM_DD- ration, current at the date and time indicated in the
HHMM.mtbak filename.

File imports can be performed in the same way, for the following files types and at the listed IND700 C:\
locations:

File suffix File Path File Types

.mot C:\ToUpdate An update file for the scale interface's firmware

(Various) C:\Service Updates for Windows OS files; ProWorks licensing;
script file

.csv or .xml C:\Import Table and log files kept on a host PC

.mtbak C:\Backup Saved terminal configuration

FTP Example

The example describes how to upload the fare fable to a PC running Microsoft Windows, modify the file, and
then download it again fo the terminal.

The following procedures assume that the user has:

e A valid username and password for the IND700 terminal.

* The IP address of the IND700.

» A valid network connection established between the client and the ferminal. Refer fo Ethernet Connection to
A PC.

Making the Connection

1. Open the command prompt window in the client PC and type ftp.

2. Press enter. The command line will show ftp>.

3. To open the FTP connection, fype open XXX.XXX.XXX.XXX nnnn, where the XXX.XXX.XXX.XXX represents the
IP address of the IND700 terminal and nnnn represents the port number.

4. Press ENTER. The display will indicate that the service is ready and prompts for the user name.

5. Enfer a valid user name for the IND700. If the name is valid, the display will prompt for the password
associafed with that user.

6. Enter the password and press ENTER.
7. If the password is valid, the prompt line will display ftp>.

Copying files Via FTP

Use the following procedure to fransfer files to and from the IND700 using fip. Not that by default files will be
copied to the folder location shown in the ftp prompt line.
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366 | Appendices

To download a file from the IND700:
1. Enter the command get filename.nnn, using the desired file name with its correct extension.
2. Press ENTER.

3. The file will be copied from the IND700 and the system will indicate that the command was executed
succesfully.

To upload a file to the IND700:
1. Enter the command put filename.nnn, using the desired file name with its correct extension.
2. Press ENTER.

3. The file will be copied fo the IND700 and the system will indicate that the command was executed
successfully.

File Transfer Using Other Software

Files can also be transferred via Ethernet between a host PC and an IND700 using a utility such as VNCViewer.
The file transfer feature will display an intuitive browser application, in which file locations can be found, and
one or more files selected and copied to or from the IND700.

B vin-dimtfestgms ( 192.168.86.34 ) - application made — O ¥
192.168.86.34
@ 12:05
7 255ep.2023
[
KA 2 Max 60 kgd=20g
3 . 9 8 kg
|
Material ID Material Name Start Thresh. Under Tol. Low Tol. High Tol.
Qver Tol. Lot Vendor Order

B | W |2 | &R Q| B | @

ransaction Tabl{ Tare Table Switch Scale | Switch Units | Alibi Memory | Higher Res. 1D Form Target

Figure 584: File Transfer Utility in VNCViewer
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When the file icon is clicked, a fransfer window will display on the PC.

[€:] - Local Disk ~| | LOCAL MACHINE \
C:\Users\Halliday-1\Documents\IND700\FTF Test},
MName Size Modified
0. Folder
FTP test. txt 0 bytes 09/25/2023 11:41
Send ==
<< Receive
Delete
New Folder
Rename
Minimize
Close
= 3 File(s)/Folder(s) Forced Close
History > 09/25/23 11:52:59 - Connected...
Progress
Connected...

Figure 585: VNC File Transfer Window

— ]

REMOTE MACHINE A

Mame

s [C]

D [ Desktop ]

L[ My Documents |
D [ Metwork Favorites |

Size

Local Disk

Modified

In this window, files can be selected by clicking on them (CTRL-click fo select multiple files). Once the desired
files are selected and the correct destination folder displayed, click Send>> or <<Receive to copy the files

either fo or from the IND700.

Note that, for such an application to work with the IND700, the Terminal > Security Options must be correctly

configured in [setup » Page 215]. Remote Desktop Server must be enabled.

GEO, ASCII and Control Codes

These sections contain codes for geographical setup of the terminal, and for characters used in terminal

communication.

GEO Codes

The Geo code feature provided in the weighing terminal permits adjustment by a METTLER TOLEDO service
technician due fo changes in elevation or latitude without reapplying test weights. This assumes that a
previously accurate adjustment was done with the Geo code set properly for that original location and that the

Geo code for the new location can be accurately determined.

When a weighing terminal is fo be reinstalled at a different geographic location, gravitational and altitude

changes can be accounted for by the following steps.

Note that this procedure is not necessary if an on-site adjustment is performed.

Determining the Geo code value

There are fwo methods to determine the Geo code value for your location.

Method A

1 Go to www.welmec.org and find the Gravity Information page to obtain the g value (e.g. 9.770390 m/s?)

for your specific geographic location.

Appendices

367


https://www.welmec.org

368 | Appendices

2 Check the METTLER TOLEDO Geo code Table A to select the Geo code according fo your g value,
e.g. Geo code 20 should be applied if your g value is 9.810304.

Method B

— Use the METTLER TOLEDO Geo code Table B to defermine the Geo code for the new altitude and location

where the scale will be used.

The lafitude and height above sea level can be found using this link www.mapcoordinates.net/en.

Checking the Geo code value in the instrument

Comparing Geo codes

1 Compare the defermined Geo code with the current Geo code setting of the weighing terminall.

2 If the two Geo code values do not match, call the METTLER TOLEDO service technician.
When the system is cerfified, a re-verification will be necessary.

Note

Using the Geo code value for calibration adjustment is not as accurate as re-applying certified test weights and
re-calibrating the scale in a new location.

Table A: Definition of METTLER TOLEDO Geo codes with g value

Geo code g value (m/s?>) Geo code g value (m/s?) Geo code g value (m/s*>) Geo code g value (m/s?)
0 9.770390 8 9.786316 16 9.802295 24 9.818326
1 9.772378 9 9.788311 17 9.804296 25 9.820333
2 9.774367 10 9.790306 18 9.806298 26 9.822341
3 9.776356 11 9.792302 19 9.808300 27 9.824351
4 9.778347 12 9.794299 20 9.810304 28 9.826361
5 9.780338 13 9.796297 21 9.812308 29 9.828371
6 0.782330 14 9.798295 22 9.814313 30 9.830383
7 9.784323 15 9.800295 23 9.816319 31 9.832396
Table B: Definition of METTLER TOLEDO Geo codes with geographic latitude and height
Height above sea level
[m] © 325 650 975 1300 1625 1950 2275 5600 2925 | 3250
Geographical latitude, -325 | -650 | -975 | -1300 - 1625 - 1950 | -2275 -2600 -2925 - 3250 - 3575
North or South [fm o 1060 | 2130 @ 3200 4260 5330 @ 6400 7460 8530 9600 | 10660
-1060 -2130 -3200 -4260 -5330 -6400 -7460 -8530 - 9600 - 10660 - 11730
0°0' - 5° 46' 5 4 4 3 3 2 2 1 1 0 0
(0.0° - 5.77°)
5° 46' - 9° 52' 5 5 4 4 3 3 2 2 1 1 0
(5.77° - 12.87°)
9° 52' - 12° 44' 6 5 5 4 4 3 3 2 2 1 1
(12.87°-12.73%
12°44' - 15° 6' 6 6 5 5 4 4 3 3 2 2 1
(12.73°-15.1%)
15°6'-17° 10" 7 6 6 5 5 4 4 3 3 2 2
(15.1°-17.17%)
17°10'- 19° 2' 7 7 6 6 5 5 4 4 3 3 2
(17.17° - 19.03%)
19°2' - 20° 45' 8 7 7 6 6 5 5 4 4 3 3
(19.03° - 20.75%)
20° 45' - 22° 22' 8 8 7 7 6 6 5 5 4 4 3
(20.75° - 22.37%)
22°22' - 23° 54! 9 8 8 7 7 6 6 5 5 4 4
(22.37° - 23.9%)
23°54' - 25° 21 9 9 8 8 7 7 6 6 5 5 4
(23.9° - 25.35°)
25° 21" - 26° 45' 10 9 9 8 8 7 7 6 6 5 5
(23.35° - 26.75%)
26° 45' - 28° 6' 10 10 9 9 8 8 7 7 6 6 5
(26.75° - 28.1°)
28° 6' - 29° 25' 11 10 10 9 9 8 8 7 7 6 6
(28.1° - 29.42°)
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Height above sea level

m] o 325 = 650 975 1300 1625 1950 2275 5600 2925 3250
Geographical latitude, -325 -650 -975 -1300 -1625 -1950 -2275 -2600 -2925 -3250 - 3575
North or South M o 1060 | 2130 3200 4260 5330 6400 7460 8530 9600 = 10660

-1060 -2130 -3200 -4260 -5330 -6400 -7460 -8530 -9600 - 10660 - 11730

29° 25' - 30° 41" 1 1 10 10 9 9 8 8 7 7 6
(29.42° - 30.68°)
30°41' - 31° 56' 12 M 1 10 10 9 9 8 8 7 7
(30.68° - 31.93°%)
31°56' - 33° 9 12 12 1 1 10 10 9 9 8 8 7
(31.93° - 33.15%)
33°9'- 34° 21" 13 12 12 1 M 10 10 9 9 8 8
(33.15° - 34.35°)
34°21' - 35° 31" 13 13 12 12 1 1 10 10 9 9 8
(34.35° - 35.52°)
35°31'-36° 41" 14 13 13 12 12 M M 10 10 9 9
(35.52° - 36.68°)
36°41' - 37° 50" 14 14 13 13 12 12 1 1 10 10 9
(36.68° - 37.83°%)
37° 50' - 38° 58' 15 14 14 13 13 12 12 1 i} 10 10
(37.83° - 38.97°)
38°58' - 40° 5 15 15 14 14 13 13 12 12 1 1 10
(38.97° - 40.08°)
40°5' - 41° 12" 16 15 15 14 14 13 13 12 12 1 n
(40.08° - 41.2°)
41°12'-42° 19" 16 16 15 15 14 14 13 13 12 12 M
(41.2° - 42.32°)
42°19' - 43° 26' 17 16 16 15 15 14 14 13 13 12 12
(42.32° - 43.43°)
43° 26' - 44° 32' 17 17 16 16 15 15 14 14 13 13 12
(43.43° - 44.53°)
44° 32' - 45° 38' 18 17 17 16 16 15 15 14 14 13 13
(44.53° - 45.63°)
45° 38' - 46° 45' 18 18 17 17 16 16 15 15 14 14 13
(45.63° - 46.75°)
46° 45' - 47° 51" 19 18 18 17 17 16 16 15 15 14 14
(46.75° - 47.85°)
47°51' - 48° 58' 19 19 18 18 17 17 16 16 15 15 14
(47.85° - 48.97°)
48° 58' - 50° 6' 20 19 19 18 18 17 17 16 16 15 15
(48.97° - 50.1°)
50°6' - 51° 13" 20 20 19 19 18 18 17 17 16 16 15
(50.1° - 51.22°)
51°13' - 52° 22" 21 20 20 19 19 18 18 17 17 16 16
(51.22° - 52.37°)
52°22' - 53° 31" 21 21 20 20 19 19 18 18 17 17 16
(52.37° - 53.52°)
53°31'- 54° 41" 22 21 21 20 20 19 19 18 18 17 17
(53.52° - 54.68°)
54° 41" - 55° 52" 22 22 21 21 20 20 19 19 18 18 17
(54.68° - 55.87°)
55° 52' - 57° 4' 23 22 22 21 21 20 20 19 19 18 18
(55.87° - 57.07°)
57°4' - 56° 17" 23 23 22 22 21 21 20 20 19 19 18
(57.07° - 56.28°)
56° 17' - 59° 32" 24 23 23 22 22 21 21 20 20 19 19
(56.28° - 59.53°)
59° 32' - 60° 49" 24 24 23 23 22 22 21 21 20 20 19
(59.53° - 60.82°)
60° 49' - 62° 9' 25 24 24 23 23 22 22 21 21 20 20
(60.82° - 62.15°)
62°9' - 63° 30' 25 25 24 24 23 23 22 22 21 21 20
(62.15° - 63.5°)
63° 30' - 64° 55' 26 25 25 24 24 23 23 22 22 21 21
(63.5° - 64.92°)
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Height above sea level
[m] 0 325 650 975 1300 1625 | 1950 | 2275 | 5600 2925 3250
Geographical Iatitude, -325 | -650 -975 -1300 -1625 -1950 -2275 -2600 -2925  -3250 | - 3575
North or South [ft] 0 1060 | 2130 3200 | 4260 5330 | 6400 | 7460 | 8530 9600 10660
-1060 -2130 -3200 -4260 -5330 -6400 -7460 -8530 -9600 - 10660 - 11730
64° 55' - 66° 24' 26 26 25 25 24 24 23 23 22 22 21
(64.92° - 66.4°)
66° 24' - 67° 57" 27 26 26 25 25 24 24 23 23 22 22
(66.4° - 67.95°)
67° 57' - 69° 35' 27 27 26 26 25 25 24 24 23 23 22
(67.95° - 69.58°)
69°35'-71° 21" 28 27 27 26 26 25 25 24 24 23 23
(69.58° - 71.35°
71°21'-73°16' 28 28 27 27 26 26 25 25 24 24 23
(71.35° - 73.27°)
73°16' - 75° 24' 29 28 28 27 27 26 26 25 25 24 24
(73.27° - 75.4°)
75°24'-77° 52" 29 29 28 28 27 27 26 26 25 25 24
(75.4° - 77.87°)
77° 52" - 80° 56' 30 29 29 28 28 27 27 26 26 25 25
(77.87° - 80.93°)
80° 56' - 85° 45! 30 30 29 29 28 28 27 27 26 26 25
(80.93° - 85.75°)
85°45'-90° 0' 31 30 30 29 29 28 28 27 27 26 26
(86.75° - 90.0°)
5.4.2 ASCII Standard and Control Codes
DEC HEX Symbol DEC  HEX Symbol DEC  HEX Symbol DEC = HEX Symbol
0 00 NUL 64 40 @ 128 80 € 192 co A
1 01 SOH 65 41 A 129 81 193 C1 A
2 02 STX 66 42 B 130 82 , 194 c2 A
3 03 ETX 67 43 c 131 83 f 195 c3 A
4 04 EOT 68 44 D 132 84 196 c4 A
5 05 ENQ 69 45 E 133 85 " 197 C5 A
6 06 ACK 70 46 F 134 86 T 198 c6 £
7 07 BEL 71 47 G 135 87 I 199 c7 C
8 08 BS 72 48 H 136 88 g 200 c8 E
9 09 HT 73 49 | 137 89 %o 201 co E
10 0A LF 74 4A J 138 8A S 202 CA E
11 0B VT 75 4B K 139 8B ¢ 203 CB E
12 0C FF 76 AC L 140 8C CE 204 cC |
13 oD CR 77 4D M 141 8D 205 CD f
14 O SO 78 AE N 142 8E VA 206 CE )
15 OF S| 79 AF 0 143 8F 207 CF i
16 10 DLE 80 50 P 144 90 208 DO )
17 11 DC1 81 51 Q 145 91 209 D1 N
18 12 DC2 82 52 R 146 92 210 D2 0
19 13 DC3 83 53 S 147 93 . 211 D3 0
20 14 DC4 84 54 T 148 94 . 212 D4 0
21 15 NAK 85 55 U 149 95 . 213 D5 0
22 16 SYN 86 56 Vv 150 96 - 214 D6 0
23 17 ETB 87 57 W 151 97 — 215 D7 X
24 18 CAN 88 58 X 152 98 - 216 D8 4]
25 19 EM 89 59 Y 153 99 ™ 217 D9 U
26 1A SuB 90 5A Z 154 9A ) 218 DA U
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DEC HEX | Symbol DEC HEX Symbol DEC HEX | Symbol DEC HEX | Symbol
27 1B ESC 91 5B [ 1565 9B ) 219 DB U
28 1C FS 92 5C \ 156 9C . 220 DC U
29 1D GS 93 5D ] 157 9D 221 DD Y
30 1E RS 94 5E A 158 9E V4 222 DE b
31 1F usS 95 bF _ 1569 oF Y 223 DF B
32 20 96 60 160 AO 224 EO a
33 21 ! 97 61 a 161 Al i 225 El a
34 22 ! 98 62 b 162 A2 ¢ 226 E2 a
35 23 # 99 63 c 163 A3 £ 227 E3 a
36 24 S 100 64 d 164 A4 a 228 E4 a
37 25 % 101 65 e 165 A5 ¥ 229 Eb ol
38 26 & 102 66 f 166 A6 | 230 E6 03!
39 27 ' 103 67 g 167 A7 § 231 E7 c
40 28 ( 104 68 h 168 A8 ) 232 E8 e
41 29 ) 105 69 i 169 A9 © 233 E9 é
42 2A * 106 6A j 170 AA a 234 EA é
43 2B + 107 6B k 171 AB « 235 EB é
44 2C , 108 6C I 172 AC - 236 EC i
45 2D 109 6D m 173 AD 237 ED i
46 2E . 110 6E n 174 AE ® 238 EE i
47 2F / 111 6F 0 175 AF - 239 EF i
48 30 0 112 70 p 176 BO ° 240 FO o)
49 31 1 113 71 q 177 Bl + 241 F1 A
50 32 2 114 72 r 178 B2 2 242 F2 o
51 33 3 115 73 S 179 B3 3 243 F3 0
52 34 4 116 74 t 180 B4 244 F4 0
53 35 b 117 75 u 181 B5 U 245 F5 0
54 36 6 118 76 v 182 B6 1 246 F6 0
55 37 7 119 77 W 183 B7 247 F7 +
56 38 8 120 78 X 184 B8 s 248 F8 @
57 39 9 121 79 y 185 B9 ! 249 F9 u
58 3A 122 7A z 186 BA ° 250 FA U
59 3B ; 123 7B { 187 BB » 251 FB a
60 3C < 124 7C I 188 BC Va 252 FC U
61 3D = 125 7D 1 189 BD ) 253 FD y
62 3E > 126 7E ~ 190 BE % 254 FE b
63 3F ? 127 7F 191 BF ¢ 255 FF y

5.4.2.1 Control Characters

Symbol Definition Function

SOH Start of Heading A transmission control character used as the first character of a heading
of an information message.

STX Start of Text A fransmission control character that precedes a text and that is used to
terminate a heading.

ETX End of Text A transmission control character that ferminates a text.

EOT End of Transmission |A transmission control character used to indicate the conclusion of the

IND700

fransmission of one or more texts.
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Symbol

Definition

Function

ENQ

Enquiry

A transmission control character used as a request for a response from
a remote station; the response may include station identification and/or
sfation status. When a “Who are you” function is required on the
general switched fransmission network, the first use of ENQ after the
connection is established will have the meaning “Who are you” (station
identification). Subsequent use of ENQ may, or may nof, include the
function “Who are you”, as determined by agreement.

ACK

Acknowledgment

A transmission control character transmitted by a receiver as an affir-
mative response to the sender.

BEL

Bell

A control character that is used when there is a need fo call for
attention; it may control alarm or atfention devices.

BS

Back Space

A format effector that moves the active position one character position
backwards on the same line.

HT

Horizontal Tab

A format effector that advances the active position fo the next pre-
determined character position on the same line.

LF

Line Feed

A format effector that advances the active position fo the same character
position of the next line.

Vertical Tab

A format effector that advances the active position to the same character
position on the next pre-determined line.

FF

Form Feed

A format effector that advances the active position fo the same character
position on a pre-determined line of the next form or page.

CR

Carriage Refurn

A format effector that moves the active position to the first character
position on the same line.

SO

Shift Out / X-On

A control character that is used in conjunction with SHIFT IN and
ESCAPE fo extend the graphic character set of the code.

Sl

Shift In / X-Off

A control character that is used in conjunction with SHIFT OUT and
ESCAPE 1o extend the graphic character set of the code.

DLE

Data Line Escape

A fransmission control character that will change the meaning of a
limited number of contiguously following characters. It is used exclu-
sively to provide supplementary data fransmission control functions.
Only graphic characters and fransmission control characters can be
used in DLE sequences.

DC1

Device Control 1 (oft.
XON)

A device control character that is primarily infended for turning on or
starting an ancillary device. If it is not required for this purpose, it may
be used to restore a device to the basic mode of operation (see also
DC2 and DC3), or for any other device control function not provided by
other DCs.

DC2

Device Control 2

A device control character that is primarily intended for turning on or
starting an ancillary device. If it is not required for this purpose, it may
be used fo set a device to a special mode of operation (in which case
DCT is used fo restore normal operation), or for any other device
control function not provided by other DCs.

DC3

Device Control 3 (oft.
XOFF)

A device control character that is primarily intended for turning off or
sfopping an ancillary device. This function may be a secondary level
stop, for example, wait, pause, stand-by or halt (in which case DCT is
used to restore normal operation). If it is not required for this purpose, it
may be used for any other device control function not provided by other
DCs.

DC4

Device Control 4

A device control character that is primarily infended for turning off,
stopping, or interrupting an ancillary device. If it is not required for this
purpose, it may be used for any other device control function not
provided by other DCs.

NAK

Negative Acknowl-
edgement

A fransmission confrol character transmitted by a receiver as a negative
response fo the sender.
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Symbol

Definition

Function

SYN

Synchronous Idle

A fransmission control character used by a synchronous transmission
system in the absence of any other character (idle condition) to provide
a signal from which synchronism may be achieved or refained between
data terminal equipment.

ETB

End of Transmit
Block

A transmission control character used to indicate the end of a frans-
mission block of data where data is divided into such blocks for trans-
mission purposes.

CAN

Cancel

A character, or the first character of a sequence, indicating that the data
preceding it is in error. As a result, this dafa is to be ignored. The
specific meaning of this character must be defined for each application
and/or between sender and recipient.

EM

End of Medium

A control character that may be used to identify the physical end of a
medium, or the end of the used portion of a medium, or the end of the
wanfed portion of data recorded on a medium. The position of this
character does not necessarily correspond fo the physical end of the
medium.

SuB

Substitute

A control character used in the place of a character that has been found
to be invalid or in error. SUB is infended to be introduced by automatic
means.

ESC

Escape

A control character that is used fo provide additional control functions. It
alters the meaning of a limited number of contiguously following bit
combinations.

FS

File Separator

A control character used to separate and qualify dafa logically; its
specific

meaning has fo be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a file.

GS

Group Separator

A control character used to separate and qualify dafa logically; its
specific

meaning has to be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a group.

RS

Record Separator

A control character used to separate and qualify data logically; its
specific

meaning has to be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a record.

us

Unit Separator

A control character used to separate and qualify dafa logically; its
specific

meaning has fo be specified for each application. If this character is
used in hierarchical order, it delimits a data item called a unit.
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METTLER TOLEDO Service

To protect your product’s future:
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precision of METTLER TOLEDO. Proper use
according to these instructions and regular
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